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Preface

THE Java Tutorial has been an indispensable resource for many program
learning the Java programming language. This tutorial hopes to serve the
role for developers encountering the Java™ 2 Platform, Enterprise Edi
(J2EE™) for the first time. It follows an example-oriented focus similar to t
Java Tutorial.

Who Should Use This Tutorial xvii
About the Examples xviii
Related Information xx
How to Print This Tutorial xxi
Typographical Conventions xxi
Acknowledgments xxii

Who Should Use This Tutorial
This tutorial is intended for programmers interested in developing and deploy
J2EE applications. It covers the main component technologies comprising
J2EE platform and describes how to develop J2EE components and deploy
on the J2EE SDK.

This tutorial is not intended for J2EE server or tool vendors. It does not exp
how to implement the J2EE architecture, nor does it explain the internals of
J2EE SDK. The J2EE specifications describe the J2EE architecture and ca
downloaded from:

http://java.sun.com/j2ee/docs.html#specs

http://java.sun.com/j2ee/docs.html#specs
http://java.sun.com/docs/books/tutorial
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About the Examples
This tutorial includes many complete, working examples.

Prerequisites for the Examples
To understand the examples you will need a good knowledge of the Java
gramming language, SQL, and relational database concepts. The following
ics in the Java Tutorial are particularly relevant:

Downloading the Examples
If you are viewing this online, and you want to build and run the examples, y
need to download the tutorial bundle from:

http://java.sun.com/j2ee/download.html#tutorial

Once you have installed the bundle, the example source code is in
j2eetutorial/examples/src directory, with subdirectoriesejb for enterprise
bean technology examples,web for web technology examples, andconnector
for connector technology examples. For most of the examples, the bundle
includes J2EE application EAR files, which are located in thej2eetutorial/

examples/ears directory.

Topic Java Tutorial

JDBC™ http://java.sun.com/docs/books/tutorial/jdbc

Threads http://java.sun.com/docs/books/tutorial/essential/threads

JavaBeans™ http://java.sun.com/docs/books/tutorial/javabeans

Security http://java.sun.com/docs/books/tutorial/security1.2

http://java.sun.com/j2ee/docs.html#specs
http://java.sun.com/docs/books/tutorial/jdbc
http://java.sun.com/docs/books/tutorial/essential/threads
http://java.sun.com/j2ee/download.html#tutorial
http://java.sun.com/docs/books/tutorial/javabeans
http://java.sun.com/docs/books/tutorial/security1.2
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How to Build and Run the Examples
This tutorial documents the J2EE SDK version 1.3. To build, deploy, and run
examples you need a copy of the J2EE SDK 1.3 and the J2SE™ SDK 1.3.1
lier versions were called JDK). You can download the J2EE SDK from:

http://java.sun.com/j2ee/download.html#sdk

and the J2SE 1.3.1 from:

http://java.sun.com/j2se/1.3/

The examples are distributed with a configuration file for version 1.3 ofant a
portable make tool. Theant utility is hosted by the Jakarta project at the Apach
Software Foundation. You can downloadant from:

http://jakarta.apache.org/builds/jakarta-ant/release/v1.3/bin

To build the tutorial examples:

1. Download and install the J2SE SDK 1.3.1, J2EE SDK 1.3, andant.

2. The installation instructions for the J2SE SDK, J2EE SDK, andant

explain how to set the required environment variables. Verify that the en
ronment variables have been set to the values noted in the following ta

3. Go to thej2eetutorial/examples/src directory.

4. Executeant target. For example, to build all the examples, executeant

all or to build the web layer examples, executeant web. The build process
deposits the output into the directoryj2eetutorial/examples/build.

Environment Variable Value

JAVA_HOME The location of the J2SE SDK installation.

J2EE_HOME The location of the J2EE SDK installation.

ANT_HOME The location of theant installation.

PATH
Should include thebin directories of the J2EE SDK, J2SE SDK,
andant installations.

http://java.sun.com/j2ee/download.html#sdk
http://jakarta.apache.org/ant
http://jakarta.apache.org/builds/jakarta-ant/release/v1.3/bin
http://java.sun.com/j2se/1.3/


xxiv

ent
olo-

fly
Related Information
This tutorial provides a concise overview of how to use the central compon
technologies in the J2EE platform. For more information about these techn
gies, see:

The J2EE platform includes a wide variety of APIs that this tutorial only brie
touches on. Some of these technologies have their own tutorials:

For complete information on these topics see:

Component Technology Web Site

Enterprise JavaBeans™ (EJB™) http://java.sun.com/products/ejb

Java Servlet http://java.sun.com/products/servlets

JavaServer Pages™ (JSP™) http://java.sun.com/products/jsp

API Tutorial

Java Message Service (JMS) http://java.sun.com/products/jms/tutorial/

Java Naming and Directory
Interface™ (JNDI)

http://java.sun.com/products/jndi/tutorial/

Extensible Markup Language
(XML)

http://java.sun.com/xml/tutorial_intro.html

API Web Site

XML http://java.sun.com/xml

J2EE Connector http://java.sun.com/j2ee/connector

http://java.sun.com/xml
http://java.sun.com/products/ejb
http://java.sun.com/products/servlets
http://java.sun.com/products/jsp
http://java.sun.com/j2ee/connector
http://java.sun.com/products/jms/tutorial
http://java.sun.com/products/jndi/tutorial
http://java.sun.com/xml/tutorial_intro.html
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Once you have become familiar with the J2EE technologies described in
tutorial, you may be interested in guidelines for architecting J2EE applicatio
The J2EE BluePrints illustrate best practices for developing and deploying J
applications. You can obtain the J2EE BluePrints from:

http://java.sun.com/j2ee/blueprints

How to Print This Tutorial
To print this tutorial, follow these steps:

• Ensure that Adobe Acrobat Reader is installed on your system.

• Download the PDF version of this book from
http://java.sun.com/j2ee/download.html#tutorial.

• Click the printer icon in Adobe Acrobat Reader.

Typographical Conventions
The following table lists the typographical conventions used in this tutorial.

JavaMail™ http://java.sun.com/products/javamail

JMS http://java.sun.com/products/jms

JNDI http://java.sun.com/products/jndi

JDBC™ http://java.sun.com/products/jdbc

Font Style Uses

italic Emphasis, titles, first occurrence of terms

monospace URLs, code examples, file names, command
names, programming language keywords

italic monospace Programming variables, variable file names

API Web Site

http://java.sun.com/j2ee/blueprints
http://java.sun.com/products/jndi
http://java.sun.com/products/jdbc
http://java.sun.com/products/javamail
http://java.sun.com/j2ee/download.html#tutorial
http://java.sun.com/products/jms
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Overview
by Monica Pawlan

TODAY, more and more developers want to write distributed transactio
applications for the enterprise and leverage the speed, security, and reliabil
server-side technology. If you are already working in this area, you know tha
today’s fast-moving and demanding world of e-commerce and information te
nology, enterprise applications have to be designed, built, and produced for
money, with greater speed, and with fewer resources than ever before.

To reduce costs and fast-track enterprise application design and developm
the Java™ 2 Platform, Enterprise Edition (J2EE™) technology provides a c
ponent-based approach to the design, development, assembly, and deploym
enterprise applications. The J2EE platform gives you a multitiered distribu
application model, the ability to reuse components, integrated XML-based
interchange, a unified security model, and flexible transaction control. Not o
can you deliver innovative customer solutions to market faster than ever,
your platform-independent J2EE component-based solutions are not tied t
products and APIs of any one vendor. Vendors and customers enjoy the free
to choose the products and components that best meet their business and te
logical requirements.

This tutorial takes an examples-based approach to describing the feature
functionalities available in J2EE SDK version 1.3. Whether you are a new o
experienced enterprise developer, you should find the examples and accom
ing text a valuable and accessible knowledge base for creating your own e
prise solutions.

If you are new to J2EE applications development, this chapter is a good plac
start. Here you will learn the J2EE architecture, become acquainted with im
tant terms and concepts, and find out how to approach J2EE application
gramming, assembly, and deployment.
27
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Distributed Multitiered Applications
The J2EE platform uses a multitiered distributed application model. This me
application logic is divided into components according to function, and the v
ous application components that make up a J2EE application are installed on
ferent machines depending on which tier in the multitiered J2EE environm
the application component belongs. Figure 1 shows two multitiered J2EE ap
cations divided into the tiers described in the bullet list below. The J2EE appl
tion parts shown in Figure 1 are presented inJ2EE Application
Components (page 29).

• Client tier components run on the client machine

• Web tier components run on the J2EE server

• Business tier components run on the J2EE server

• Enterprise information system (EIS) tier software runs on the EIS ser

While a J2EE application can consist of the three or four tiers shown in Figur
J2EE multitiered applications are generally considered to be three-tiered a
cations because they are distributed over three different locations: c
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machines, J2EE server machine, and the database or legacy machines
back-end. Three-tiered applications that run in this way extend the standard
tiered client and server model by placing a multithreaded application se
between the client application and back-end storage.

Figure 1 Multitiered Applications

J2EE Application Components
J2EE applications are made up of components. A J2EE component is a self
tained functional software unit that is assembled into a J2EE application with
related classes and files and communicates with other components. The
specification defines the following J2EE components:

• Application clients and applets are client components.

• Java Servlet and JavaServer Pages™ (JSP™) technology componen
web components.

• Enterprise JavaBeans™ (EJB™) components (enterprise beans) are
ness components.

J2EE components are written in the Java programming language and com
in the same way as any program in the language. When you work with the J
platform, the difference is that J2EE components are assembled into a J
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application, verified that they are well-formed and in compliance with the J2
specification, and deployed to production where they are run and manage
the J2EE server.

Client Components
A J2EE application can be web-based or non-web-based. An application c
executes on the client machine for a non-web-based J2EE application, and a
browser downloads web pages and applets to the client machine for a web-b
J2EE application.

Application Clients

An application client runs on a client machine and provides a way for user
handle tasks such as J2EE system or application administration. It typically h
graphical user interface created from Swing or Abstract Window Toolkit (AW
APIs, but a command-line interface is certainly possible.

Application clients directly access enterprise beans running in the business
However, if the J2EE application client requirements warrant it, an applicat
client can open an HTTP connection to establish communication with a ser
running in the web tier.

Web Browsers

The user’s web browser downloads static or dynamic Hypertext Markup L
guage (HTML), Wireless Markup Language (WML), or Extensible Marku
Language (XML) web pages from the web tier. Dynamic web pages are ge
ated by servlets or pages created with JavaServer Pages (JSP) technology
running in the web tier.

Applets

A web page downloaded from the web tier can include an embedded apple
applet is a small client application written in the Java programming langu
that executes in the Java VM installed in the web browser. However, client
tems will likely need Java Plug-in and possibly a security policy file so the app
can successfully execute in the web browser.

JSP pages are the preferred API for creating a web-based client program be
no plug-ins or security policy files are needed on the client systems. Also,
pages enable cleaner and more modular application design because they p
a way to separate applications programming from web page design. This m
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personnel involved in web page design do not need to understand Java prog
ming language syntax to do their jobs.

Applets that run in other network-based systems such as handheld devices
phones can render Wireless Markup Language (WML) pages generated by a
page or servlet running on the J2EE server. The WML page is delivered
Wireless Application Protocol (WAP) and the network configuration require
gateway to translate WAP to HTTP and back again. The gateway translate
WAP request coming from the handheld device to an HTTP request for the J
server, and then translates the HTTP server response and WML page to a
server response and WML page for display on the handheld device.

JavaBeans™ Component Architecture

The client tier might also include a component based on the JavaBeans™
ponent architecture (JavaBeans component) to manage the data flow betwe
application client or applet and components running on the J2EE server. J
Beans components are not considered J2EE components by the J2EE spe
tion.

JavaBeans components written for the J2EE platform have instance varia
andget andset methods for accessing the data in the instance variables. J
Beans components used in this way are typically simple in design and im
mentation, but should conform to the naming and design conventions outline
the JavaBeans component architecture.

J2EE Server Communications

Figure 2 shows the various elements that can make up the client tier. The c
communicates with the business tier running on the J2EE server either dire
or as in the case of a client running in a browser, by going through JSP pag
servlets running in the web tier.
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Figure 2 Server Communications

Thin Clients

A thin client is a lightweight and typically browser-based interface to the app
cation. Thin clients do not do things like query databases, execute complex
ness rules, or connect to legacy applications. When you use a thin cl
heavyweight operations like these are off-loaded to web or enterprise beans
cuting on the J2EE server where they can leverage the security, speed, ser
and reliability of J2EE server-side technologies.

Your J2EE application uses a thin browser-based client or thick application
ent. In deciding which one to use, you should be aware of the tradeoffs betw
keeping functionality on the client and close to the user (thick client) and o
loading as much functionality as possible to the server (thin client). The m
functionality you offload to the server, the easier it is to distribute, deploy, a
manage the application; however, keeping more functionality on the client
make for a betterperceived user experience.

Web Components
J2EE web components can be either JSP pages or servlets. Servlets are Ja
gramming language classes that dynamically process requests and con
responses. JSP pages are text-based documents that execute as servlets, b
a more natural approach to creating static content.

Static HTML pages and applets are bundled with web components during a
cation assembly, but are not considered web components by the J2EE spec
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and optional 
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Business 
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tion. Server-side utility classes can also be bundled with web components,
like HTML pages, are not considered web components.

Like the client tier and as shown in Figure 3, the web tier might include a Ja
Beans object to manage the user input and send that input to enterprise
running in the business tier for processing.

Figure 3 Web Tier and J2EE Application

Business Components
Business code, which is logic that solves or meets the needs of a particular
ness domain such as banking, retail, or finance, is handled by enterprise b
running in the business tier. Figure 4 shows how an enterprise bean receives
from client programs, processes it (if necessary), and sends it to the enter
information system tier for storage. An enterprise bean also retrieves data
storage, processes it (if necessary), and sends it back to the client program
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Figure 4 Business and EIS Tiers

There are three kinds of enterprise beans: session beans, entity beans, an
sage-driven beans. A session bean represents a transient conversation with
ent. When the client finishes executing, the session bean and its data are go
contrast, an entity bean represents persistent data stored in one row of a da
table. If the client terminates or if the server shuts down, the underlying serv
ensure the entity bean data is saved.

A message-driven bean combines features of a session bean and a Java M
Service (JMS) message listener, allowing a business component to receive
messages asynchronously. This tutorial describes entity beans and session
For information on message-driven beans, see the Java Message Service
rial, which is online at:

http://java.sun.com/products/jms/tutorial/index.html

Enterprise Information System Tier
The enterprise information system tier handles enterprise information sys
software, and includes enterprise infrastructure systems such as ente
resource planning (ERP), mainframe transaction processing, database sys
and other legacy information systems. J2EE application components might
access to enterprise information systems for database connectivity, for exam

J2EE Architecture
Normally, thin-client multitiered applications are hard to write because th
involve many lines of intricate code to handle transaction and state managem
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multithreading, resource pooling, and other complex low-level details. The c
ponent-based and platform-independent J2EE architecture makes J2EE ap
tions easy to write because business logic is organized into reusable compo
and the J2EE server provides underlying services in the form of a containe
every component type. Because you do not have to develop these services
self, you are free to concentrate on solving the business problem at hand.

Containers and Services
Containers are the interface between a component and the low-level platf
specific functionality that supports the component. Before a web, enterp
bean, or application client component can be executed, it must be assemble
a J2EE application and deployed into its container.

The assembly process involves specifying container settings for each compo
in the J2EE application and for the J2EE application itself. Container setti
customize the underlying support provided by the J2EE server, which incl
services such as security, transaction management, Java Naming and Dire
Interface™ (JNDI) lookups, and remote connectivity. Here are some of the h
lights:

• The J2EE security model lets you configure a web component or enterp
bean so system resources are accessed only by authorized users.

• The J2EE transaction model lets you specify relationships among meth
that make up a single transaction so all methods in one transaction
treated as a single unit.

• JNDI lookup services provide a unified interface to multiple naming a
directory services in the enterprise so application components can ac
naming and directory services.

• The J2EE remote connectivity model manages low-level communicati
between clients and enterprise beans. After an enterprise bean is crea
client invokes methods on it as if it were in the same virtual machine.

The fact that the J2EE architecture provides configurable services means
application components within the same J2EE application can behave differe
based on where they are deployed. For example, an enterprise bean can
security settings that allow it a certain level of access to database data in one
duction environment and another level of database access in another produ
environment.

The container also manages non-configurable services such as enterprise
and servlet life cycles, database connection resource pooling, data persist
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and access to the J2EE platform APIs described inJ2EE APIs (page 42).
Although data persistence is a non-configurable service, the J2EE archite
lets you override container-managed persistence by including the approp
code in your enterprise bean implementation when you want more control
the default container-managed persistence provides. For example, you migh
bean-managed persistence to implement your own finder (search) methods
create a customized database cache.

Container Types
The deployment process installs J2EE application components in the J2EE
tainers illustrated in Figure 5.

• J2EE server—is the runtime portion of a J2EE product. A J2EE server p
vides EJB and web containers.

• Enterprise JavaBeans (EJB) container—manages the execution of e
prise beans for J2EE applications. Enterprise beans and their containe
on the J2EE server.

• Web container—manages the execution of JSP page and servlet co
nents for J2EE applications. Web components and their container run
the J2EE server.

• Application client container—manages the execution of application cli
components. Application clients and their container run on the client.

• Applet container—manages the execution of applets. Consists of a
browser and Java Plug-in together running on the client.
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Figure 5 J2EE Server and Containers

Packaging
J2EE components are packaged separately and bundled into a J2EE appli
for deployment. Each component, its related files such as GIF and HTML file
server-side utility classes, and a deployment descriptor (DD), are assembled
a module and added to the J2EE application. A J2EE application is compose
one or more enterprise bean, web, or application client component modules
final enterprise solution can use one J2EE application or be made up of tw
more J2EE applications depending on design requirements

A J2EE application and each of its modules has its own deployment descri
A deployment descriptor is an Extensible Markup Language (XML) text-bas
file with an .xml extension that describes a component’s deployment settin
An enterprise bean module deployment descriptor, for example, declares t
action attributes and security authorizations for an enterprise bean. Bec
deployment descriptor information is declarative, it can be changed with
modifying the bean source code. At run time, the J2EE server reads the de
ment descriptor and acts upon the component accordingly.

A J2EE application with all of its modules is delivered in an Enterprise ARch
(EAR) file. An EAR file is a standard JAR file with an.ear extension. In the
GUI version of the J2EE SDK application deployment tool, you create an E
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file first and add JAR and WAR files to the EAR. If you use the command l
packager tools, however, you create the Java ARchive (JARs) and Web ARc
(WAR) files first and create the EAR. The J2EE SDK tools are described
Tools (page 45).

• Each EJB JAR file contains its deployment descriptor, related files, and
.class files for the enterprise bean.

• Each application client JAR file contains its deployment descriptor, rela
files, and the.class files for the application client.

• Each WAR file contains its deployment descriptor, related files, and
.class files for the servlet or.jsp files for a JSP page.

Using modules and EAR files makes it possible to assemble a number of di
ent J2EE applications using some of the same components. No extra codi
needed; it is just a matter of assembling various J2EE modules into J2EE E
files.

Development Roles
Reusable modules make it possible to divide the application development
deployment process into distinct roles so different people or companies can
form different parts of the process.

The first two roles involve purchasing and installing the J2EE product and to
Once software is purchased and installed, J2EE components can be develop
application component providers, assembled by application assemblers,
deployed by application deployers. In a large organization, each of these
might be executed by different individuals or teams. This division of labor wo
because each of the earlier roles outputs a portable file that is the input for a
sequent role. For example, in the application component development phas
enterprise bean software developer delivers EJB JAR files. In the applica
assembly role, another developer combines these EJB JAR files into a J
application and saves it in an EAR file. In the application deployment role, a s
tem administrator at the customer site uses the EAR file to install the J2EE a
cation into a J2EE server.

The different roles are not always executed by different people. If you work fo
small company, for example, or if you are prototyping a sample application,
might perform the tasks in every phase.
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J2EE Product Provider
The J2EE product provider is the company that designs and makes availab
purchase the J2EE platform, APIs, and other features defined in the J2EE s
fication. Product providers are typically operating system, database sys
application server, or web server vendors who implement the J2EE platf
according to the Java 2 Platform, Enterprise Edition Specification.

Tool Provider
The tool provider is the person or company who creates development, asse
and packaging tools used by component providers, assemblers, and deplo
SeeTools (page 45) for information on the tools available with J2EE SDK ve
sion 1.3.

Application Component Provider
The application component provider is the company or person who creates
components, enterprise beans, applets, or application clients for use in J
applications.

Enterprise Bean Creation

A software developer performs the following tasks to deliver an EJB JAR
that contains the enterprise bean:

• Writes and compiles the source code

• Specifies the deployment descriptor

• Bundles the.class files and deployment descriptor into an EJB JAR fi

Web Component Creation

A web designer (JSP pages) or software developer (servlets) performs the
lowing tasks to deliver a WAR file containing the web component.

• Writes and compiles servlet source code

• Writes JSP and HTML files

• Specifies the deployment descriptor for the web component

• Bundles the.class, .jsp, .html, and deployment descriptor files in the
WAR file
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J2EE Application Client Creation

A software developer performs the following tasks to deliver a JAR file conta
ing the J2EE application client.

• Writes and compiles the source code

• Specifies the deployment descriptor for the client

• Bundles the.class files and deployment descriptor into the JAR file

Application Assembler
The application assembler is the company or person who gets application c
ponent JAR files from component providers and assembles them into a J
application EAR file. The assembler or deployer can edit the deploym
descriptor directly or use tools that correctly add XML tags according to inter
tive selections. A software developer performs the following tasks to deliver
EAR file containing the J2EE application.

• Assembles EJB JAR and web components (WAR) files created in the
vious phases into a J2EE application (EAR) file.

• Specifies the deployment descriptor for the J2EE application.

• Verifies that the contents of the EAR file are well-formed and comply w
the J2EE specification.

Application Deployer and Administrator
The company or person who configures and deploys the J2EE applica
administers the computing and networking infrastructure where J2EE app
tions run, and oversees the runtime environment. Duties include such thing
setting transaction controls and security attributes, and specifying connectio
databases.

During configuration, the deployer follows instructions supplied by the appli
tion component provider to resolve external dependencies, specify security
tings, and assign transaction attributes. During installation, the deployer m
the application components to the server, and generates the container-sp
classes and interfaces.
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A deployer/system administrator performs the following tasks to install and c
figure a J2EE application.

• Adds the J2EE application (EAR) file created in the preceding phase to
J2EE server.

• Configures the J2EE application for the operational environment by m
ifying the deployment descriptor of the J2EE application.

• Verifies that the contents of the EAR file are well-formed and comply w
the J2EE specification.

• Deploys (installs) the J2EE application EAR file into the J2EE server.

Reference Implementation Software
The J2EE SDK is a non-commercial operational definition of the J2EE platfo
and specification made freely available by Sun Microsystems for demons
tions, prototyping, and educational use. It comes with the J2EE applica
server, web server, relational database, J2EE APIs, and complete set of dev
ment and deployment tools. You can download the J2EE SDK from the web

http://java.sun.com/j2ee/download.html#sdk

• Product providers use the J2EE SDK to determine what their impleme
tions must do under a given set of application conditions, and to run
J2EE Compatibility Test Suite to test that their J2EE products fully com
with the specification.

• Application component developers run their J2EE applications on
J2EE SDK to verify that applications are fully portable across all J2E
products and tools.

Web Server
The web server provides services to one or more web containers. For exam
web container typically relies on a web server to provide HTTP message h
dling. A J2EE implementation is not required to support a particular type of w
server, which means the web server supported by different J2EE products
vary.

http://java.sun.com/j2ee/download.html#sdk
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Database Access
The relational database provides persistent storage for application data. A
implementation is not required to support a particular type of database w
means the database supported by different J2EE products can vary. Se
Release Notes included with the J2EE SDK download for a list of the datab
currently supported by the reference implementation.

J2EE APIs
The Java 2 Platform, Standard Edition (J2SE™) SDK is required to run the J
SDK and provides core APIs for writing J2EE components, core developm
tools, and the Java virtual machine. The J2EE SDK provides the following A
to be used in J2EE applications.

Enterprise JavaBeans Technology 2.0

An enterprise bean is a body of code with fields and methods to implement m
ules of business logic. You can think of an enterprise bean as a building b
that can be used alone or with other enterprise beans to execute business lo
the J2EE server.

There are three kinds of enterprise beans: session beans, entity beans, an
sage-driven beans as described inBusinessComponents (page 33). You do no
have to write any SQL code or use the JDBC™ API directly to perform datab
access operations with an entity bean. The EJB container handles this for
However, if you override the default container-managed persistence for any
son, you will need to use the JDBC API. Also, if you choose to have a ses
bean access the database, you have to use the JDBC API.

JDBC™ 2.0 API

The JDBC API lets you invoke SQL commands from Java programing langu
methods. You use the JDBC API in an enterprise bean when you override
default container-managed persistence or have a session bean access th
base. With container-managed persistence, database access operations a
dled by the container and your enterprise bean implementation contain
JDBC code or SQL commands. You can also use the JDBC API from a servl
JSP page to access the database directly without going through an ente
bean.
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The JDBC API has two parts: an application-level interface used by the app
tion components to access a database, and a service provider interface to a
JDBC driver to the J2EE platform.

Java Servlet Technology 2.3

Java Servlet technology lets you define HTTP-specific servlet classes. A se
class extends the capabilities of servers that host applications accessed by w
a request-response programming model. Although servlets can respond to
type of request, they are commonly used to extend the applications hoste
web servers.

JavaServer Pages (JSP) Technology 1.2

JSP pages technology lets you put snippets of servlet code directly into a
based document. A JSP page is a text-based document that contains two ty
text: static template data which can be expressed in any text-based format
as HTML, WML, and XML, and JSP elements that determine how the page c
structs dynamic content.

Java Message Service (JMS) 1.0

The JMS API is a messaging standard that allows J2EE application compon
to create, send, receive, and read messages. It enables distributed commun
that is loosely coupled, reliable, and asynchronous. For more information
JMSsee theonline Java Message Service Tutorial:

http://java.sun.com/products/jms/tutorial/index.html

Java Transaction API (JTA) 1.0

The JTA API provides a standard demarcation interface for demarcating tran
tions. The J2EE architecture provides a default auto commit to handle tran
tion commits and roll backs. An auto commit means any other applicati
viewing data will see the updated data after each database read or write o
tion. However, if your application performs two separate database access o
tions that depend on each other, you will want to use the JTA API to demar
where the entire transaction, including both operations, begins, rolls back,
commits.

JavaMail™ Technology 1.2

Many Internet applications need to send email notifications so the J2EE platf
includes the JavaMail API with a JavaMail service provider that applicat

http://java.sun.com/products/jms/tutorial/index.html
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components can use to send Internet mail. The JavaMail API has two parts
application-level interface used by the application components to send mail,
a service provider interface.

JavaBeans Activation Framework 1.0

The JavaBeans Activation Framework is included because JavaMail uses
provides standard services to determine the type of an arbitrary piece of
encapsulate access to it, discover the operations available on it, and crea
appropriate JavaBean component to perform those operations.

Java API for XML Processing (JAXP) 1.1

XML is a language for representing and describing text-based data so the
can be read and handled by any program or tool that uses XML APIs. Progr
and tools can generate XML files that other programs and tools can read
handle.

For example, a J2EE application can use XML to produce reports, and diffe
companies that receive the reports can handle the data in a way that best
their needs. One company might put the XML data through a program to tra
late the XML to HTML so it can post the reports to the web, another compa
might put the XML data through a tool to create a marketing presentation,
yet another company might read the XML data into its J2EE application for p
cessing.

J2EE Connector Architecture 1.0

The J2EE Connector Architecture is used by J2EE tools vendors and sy
integrators to create resource adapters that support access to enterprise inf
tion systems that can be plugged into any J2EE product. A resource adapte
software component that allows J2EE application components to access
interact with the underlying resource manager. Because a resource adap
specific to its resource manager, there is typically a different resource adapte
each type of database or enterprise information system.

Java Authentication and Authorization Service (JAAS) 1.0

The Java Authentication and Authorization Service (JAAS) provides a way fo
J2EE application to authenticate and authorize a specific user or group of u
to run it.
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JAAS is a Java programing language version of the standard Pluggable Auth
cation Module (PAM) framework that extends the Java 2 platform security arc
tecture to support user-based authorization.

Simplified Systems Integration
The J2EE platform is a platform-independent and full systems integration s
tion that creates an open marketplace in which every vendor can sell to e
customer. Such a marketplace encourages vendors to compete, not by try
lock customers into their technologies, but by trying to outdo each other by p
viding products and services that benefit customers such as better perform
better tools, or better customer support.

The J2EE APIs enable systems and applications integration as follows:

• Unified application model across tiers with enterprise beans.

• Simplified response and request mechanism with JSP pages and ser

• Reliable security model with JAAS API.

• XML-based data interchange integration with the JAXP API.

• Simplified interoperability with the J2EE Connector Architecture.

• Easy database connectivity with the JDBC API.

• Enterprise application integration with message-driven beans and the J
JTS, and JNDI APIs.

You can learn more about using the J2EE platform to build integrated busin
systems by readingJ2EE Technology in Practice.

http://java.sun.com/j2ee/inpractice/aboutthebook.html

Tools
The J2EE reference implementation provides an application deployment
and an array of scripts for assembling, verifying, and deploying J2EE appl
tions and managing your development and production environments.
J2EE™ SDK Tools (page 453) for a discussion of the tools.

Application Deployment Tool

The J2EE reference implementation provides an application deployment too
assembling, verifying, and deploying J2EE applications. There are two versi
command-line and GUI.

http://java.sun.com/j2ee/inpractice/aboutthebook.html
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The GUI tool includes wizards for

• Packaging, configuring, and deploying J2EE applications

• Packaging and configuring enterprise beans

• Packaging and configuring web components

• Packaging and configuring application clients

• Packaging and configuring resource adaptors

In addition, configuration information can be set for each component and m
ule type in the tabbed inspector panels.

Scripts

Table 1 lists the scripts included with the J2EE reference implementation tha
you perform operations from the command line.

Table 1 J2EE Scripts

Script Description

j2ee Start and stop the J2EE server.

cloudscape Start and stop the default database.

j2eeadmin Add JDBC drivers, JMS destinations, and connection factories for various
resources.

keytool Create public and private keys and generate X509 self-signed certificates.

realmtool Import certificate files. Add J2EE users to and remove J2EE users from th
authentication and authorization list for a J2EE application.

packager Package J2EE application components into EAR, EJB JAR, application cli
ent JAR, and WAR files.

verifier Verify that EAR, EJB JAR, application client JAR, and WAR files are well-
formed and comply with the J2EE specification.

runclient Run a J2EE application client.

cleanup Remove all deployed applications from the J2EE server.
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THIS chapter shows you how to develop, deploy, and run a simple client-se
application that consists of an currency conversion enterprise bean and two
ents: a J2EE™ application client and a web client that consists of a JSP pa
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Setting Up
Before you start developing the example application, you should follow
instructions in this section.

Getting the Example Code
The source code for components is inj2eetutorial/examples/src/ejb/con-
verter, a directory that is created when you unzip the tutorial bundle. If you
viewing this tutorial online, you need to download the tutorial bundle from:

http://java.sun.com/j2ee/download.html#tutorial

Getting the Build Tool (ant)
To build the example code you’ll need installations of the J2EE SDK andant, a
portable make tool. For more information, seeHow to Build and Run the
Examples (page xxiii).

http://java.sun.com/j2ee/download.html#tutorial
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Checking the Environment Variables
The installation instructions for the J2EE SDK andant explain how to set the
required environment variables. Please verify that the environment varia
have been set to the values noted in the following table.

Starting the J2EE™ Server
To launch the J2EE server, open a terminal window and type this command

j2ee -verbose

Although optional, theverbose option is useful for debugging. To stop the
server, type the following command:

j2ee -stop

Starting the deploytool
The deploytool has two modes: command-line and GUI. The instructions in
chapter refer to the GUI version. To start thedeploytool GUI, open a terminal
window and type this command:

deploytool

To view the tool’s context-sensitive help, pressf1.

Table 2 Required Environment Variables

Environment Variable Value

JAVA_HOME The location of the J2SE™ SDK installation.

J2EE_HOME The location of the J2EE™ SDK installation.

ANT_HOME The location of theant installation.

PATH
Should include thebin directories of the J2EE SDK, J2SE, and
ant installations.
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Creating the J2EE™ Application
The sample application contains three J2EE components: an enterprise be
J2EE application client, and a web component. Before building these com
nents, you will create a new J2EE application calledConverterApp and will
store it in a file namedConverterApp.ear.

1. In thedeploytool, select File -> New-> Application.

2. Click Browse.

3. In the file chooser, navigate toj2eetutorial/examples/src/ejb/con-
verter.

4. In the File Name field enterConverterApp.ear.

5. Click New Application.

6. Click OK.

Creating the Enterprise Bean
An enterprise bean is a server-side component that contains the business lo
an application. At run time, the application clients execute the business logi
invoking the enterprise bean’s methods. The enterprise bean in our exampl
stateless session bean calledConverterEJB. The source code for theConvert-
erEJB bean is in thej2eetutorial/examples/src/ejb/converter directory.

Coding the Enterprise Bean
The enterprise bean in this example requires the following code:

• Remote interface

• Home interface

• Enterprise bean class

Coding the Remote Interface

A remote interface defines the business methods that a client may call. The
ness methods are implemented in the enterprise bean code. The source co
theConverter remote interface follows.
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import javax.ejb.EJBObject;
import java.rmi.RemoteException;
import java.math.*;

public interface Converter extends EJBObject {

   public BigDecimal dollarToYen(BigDecimal dollars)
      throws RemoteException;
   public BigDecimal yenToEuro(BigDecimal yen)
      throws RemoteException;
}

Coding the Home Interface

A home interface defines the methods that allow a client to create, find
remove an enterprise bean. TheConverterHome interface contains a single cre
ate method, which returns an object of the remote interface type. Here is
source code for theConverterHome interface:

import java.io.Serializable;
import java.rmi.RemoteException;
import javax.ejb.CreateException;
import javax.ejb.EJBHome;

public interface ConverterHome extends EJBHome {

Converter create() throws RemoteException, CreateException;
}

Coding the Enterprise Bean Class

The enterprise bean class for this example is calledConverterBean. This class
implements the two business methods,dollarToYen and yenToEuro, that the
Converter remote interface defines. The source code for theConverterBean

class follows.

import java.rmi.RemoteException;
import javax.ejb.SessionBean;
import javax.ejb.SessionContext;
import java.math.*;

public class ConverterBean implements SessionBean {

      BigDecimal yenRate = new BigDecimal(“121.6000”);
      BigDecimal euroRate = new BigDecimal(“0.0077”);

   public BigDecimal dollarToYen(BigDecimal dollars) {
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      BigDecimal result = dollars.multiply(yenRate);
      return result.setScale(2,BigDecimal.ROUND_UP);
   }

   public BigDecimal yenToEuro(BigDecimal yen) {

      BigDecimal result = yen.multiply(euroRate);
      return result.setScale(2,BigDecimal.ROUND_UP);
   }

   public ConverterBean() {}
   public void ejbCreate() {}
   public void ejbRemove() {}
   public void ejbActivate() {}
   public void ejbPassivate() {}
   public void setSessionContext(SessionContext sc) {}

}

Compiling the Source Files
Now you are ready to compile the remote interface (Converter.java), home
interface (ConverterHome.java), and the enterprise bean class (Converter-

Bean.java):

1. In a terminal window, go to thej2eetutorial/examples/src directory.

2. Type the following command:

ant converter

This command compiles the source files for the enterprise bean and the J
application client. It places the resulting class files in thej2eetutorial/exam-

ples/build/ejb/converter directory. For more information aboutant, see
How to Build and Run the Examples (page xxiii).

Note:When compiling the code, the precedingant task includes thej2ee.jar file
in the classpath. This file resides in thelib directory of your J2EE SDK installa-
tion. If you plan on using other tools to compile the source code for J2EE compo
nents, make sure that the classpath includes thej2ee.jar file.
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Packaging the Enterprise Bean
In this section you will run the New Enterprise Bean Wizard of thedeploytool

to perform these tasks:

• Create the bean’s deployment descriptor.

• Package the deployment descriptor and the bean’s classes in an EJB
file.

• Insert the EJB JAR file into the application’sConverterApp.ear file.

To start the New Enterprise Bean Wizard, select File->New-> Enterprise Be
The wizard displays the following dialog boxes.

1. Introduction Dialog Box

a. Read this explanatory text for an overview of the wizard’s features.

b. Click Next.

2. EJB JAR Dialog Box

a. Select the Create new JAR File in Application button.

b. In the combo box, select ConverterApp.

c. In the JAR Display Name field enterConverterJAR.

d. Click Edit.

e. In the tree under Available Files, locate thej2eetutorial/exam-
ples/build/ejb/converter directory. (If theconverter directory is
many levels down in the tree, you can simplify the tree view by enter
all or part of theconverter directory’s path name in the Starting Direc
tory field.)

f. Select the following classes from the Available Files tree and click Ad
Converter.class, ConverterBean.class, ConverterHome.class.
(You may also drag and drop these class files to the Contents text a

g.  Click OK.

h.  Click Next.

3. General Dialog Box

a.  Under Bean Type, select the Session radio button.

b.  Select the Stateless radio button.

c.  In the Enterprise Bean Class combo box, select ConverterBean.

d. In the Enterprise Bean Name field, enterConverterEJB.

e. In the Remote Home Interface combo box, select ConverterHome.
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f.  In the Remote Interface combo box, select Converter.

g. Click Next.

4. Transaction Management Dialog Box

 Because you may skip the remaining dialog boxes, click Finish.

Creating the J2EE™ Application Client
A J2EE application client is a program written in the Java™ programming l
guage. At run time, the client program executes in a different virtual mach
(VM) than the J2EE server.

The J2EE application client in this example requires two different JAR files. T
first JAR file is for the J2EE component of the client. This JAR file contains
client’s deployment descriptor and its class files. When you run the New Ap
cation Client wizard, thedeploytool automatically creates the JAR file and
stores it in the application’s EAR file. Defined by theJ2EE Specification, the
JAR file is portable across all compliant J2EE servers.

The second JAR file contains stub classes that are required by the client pro
at run time. These stub classes enable the client to access the enterprise
that are running in the J2EE server. Because this second JAR file is not cov
by theJ2EE Specification, it is implementation-specific, intended only for th
J2EE SDK.

The J2EE application client source code is inj2eetutorial/exam-
ples/src/ejb/converter/ConverterClient.java. You already compiled this
code along with the enterprise bean code in the section,Compiling the Source
Files (page 52).

Coding the J2EE Application Client
The ConverterClient.java source code illustrates the basic tasks perform
by the client of an enterprise bean:

• Locating the home interface

• Creating an enterprise bean instance

• Invoking a business method
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Locating the Home Interface

TheConverterHome interface defines life-cycle methods such ascreate. Before
the ConverterClient can invoke thecreate method, it must instantiate an
object whose type isConverterHome. This is a three-step process:

1. Create a JNDI naming context. SeeAbout JNDI Naming (page 71) for
background on naming contexts.

 Context initial = new InitialContext();

2. Retrieve the object bound to the nameejb/SimpleConverter.

Object objref = initial.lookup
("java:comp/env/ejb/SimpleConverter");

3.  Narrow the reference to aConverterHome object.

ConverterHome home =
(ConverterHome) PortableRemoteObject.narrow(objref,

ConverterHome.class);

Creating an Enterprise Bean Instance

To create the bean instance, the client invokes thecreate method on theCon-
verterHome object. Thecreate method returns an object whose type isCon-

verter. The remoteConverter interface defines the business methods of t
bean that the client may call. When the client invokes thecreate method, the
EJB container instantiates the bean and then invokes theConverterBean.ejb-

Create method. The client invokes thecreate method as follows:

Converter currencyConverter = home.create();

Invoking a Business Method

Calling a business method is easy—you simply invoke the method on theCon-

verter object. The EJB container will invoke the corresponding method on
ConverterEJB instance that is running on the server. The client invokes thedol-

larToYen business method in the following lines of code.

BigDecimal param = new BigDecimal ("100.00");
BigDecimal amount = currencyConverter.dollarToYen(param);

ConverterClient Source Code

The full source code for theConverterClient program follows.
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import javax.naming.Context;
import javax.naming.InitialContext;
import javax.rmi.PortableRemoteObject;
import java.math.BigDecimal;

import Converter;
import ConverterHome;

public class ConverterClient {

   public static void main(String[] args) {
       try {
           Context initial = new InitialContext();
           Object objref = initial.lookup
              (“java:comp/env/ejb/SimpleConverter”);

           ConverterHome home =
(ConverterHome)PortableRemoteObject.narrow(objref,

ConverterHome.class);

           Converter currencyConverter = home.create();

           BigDecimal param = new BigDecimal (“100.00”);
           BigDecimal amount =
              currencyConverter.dollarToYen(param);
           System.out.println(amount);
           amount = currencyConverter.yenToEuro(param);
           System.out.println(amount);

           System.exit(0);

       } catch (Exception ex) {
System.err.println(“Caught an unexpected exception!”);

           ex.printStackTrace();
       }
   }
}

Compiling the Application Client
The application client files are compiled at the same time as the enterprise
files, as described inCompiling the Source Files (page 52).
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Packaging the J2EE Application Client
To package an application client component, you run the New Application Cl
Wizard of thedeploytool. During this process, the wizard puts the client file
into a JAR file and then adds the JAR file to the application’sConverterApp.ear

file.

To start the New Application Client Wizard, select File->New->Application C
ent. The wizard displays the following dialog boxes.

1. Introduction Dialog Box:

a. Read this explanatory text for an overview of the wizard’s features.

b. Click Next.

2.  JAR File Contents Dialog Box

a. In the combo box, select ConverterApp.

b. Click Edit.

c. In the tree under Available Files, locate thej2eetutorial/exam-
ples/build/ejb/converter directory.

d. Select the ConverterClient.class file and click Add.

e. Click OK.

f. Click Next.

3. General Dialog Box:

a. In the Main Class combo box, select ConverterClient.

b. Verify that the entry in the Display Name field is ConverterClient.

c. In the Callback Handler Class combo box, select container-mana
authentication.

d. Click Next.

e. Click Finish.

Specifying the Application Client’s Enterprise Bean
Reference
When it invokes thelookup method, the ConverterClient refers to an enterpri
bean:

Object objref = initial.lookup
("java:comp/env/ejb/SimpleConverter");
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You specify this reference as follows:

1. In the tree, select ConverterClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name column enterejb/SimpleConverter.

5. In the Type column, select Session.

6. In the Interfaces column, select Remote.

7. In the Home Interface column enterConverterHome.

8. In the Local/Remote Interface column enterConverter.

Creating the Web Client
The web client is contained in the JSP pagej2eetutorial/exam-
ples/src/ejb/converter/index.jsp. A JSP page is a text-based docume
that contains static template data, which can be expressed in any text-base
mat such as HTML, WML, and XML and JSP elements, which constru
dynamic content.

Coding the Web Client
The statements (highlighted below) for locating the home interface, creating
enterprise bean instance, and invoking a business method are nearly identi
those of the J2EE application client. The parameter of thelookup method is the
only difference; the motivation for using a different name is discussed inSpeci-
fying the JNDI Names (page 61).

The classes needed by the client are declared with a JSP directive (enc
within the<%@ %> characters). Because locating the home interface and crea
the enterprise bean are performed only once, they appear in a JSP decla
(enclosed within the<%! %> characters), that contains the initialization metho
jspInit, of the JSP page. The declaration is followed by standard HTM
markup for creating a form with an input field. A scriptlet (enclosed within t
<% %> characters) retrieves a parameter from the request and converts it to a
ble. Finally, JSP expressions (enclosed within<%= %> characters) invoke the
enterprise bean’s business methods and insert the result into the stream o
returned to the client.
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<%@ page import="Converter,ConverterHome,javax.ejb.*,
javax.naming.*, javax.rmi.PortableRemoteObject,
java.rmi.RemoteException" %>
<%!

private Converter converter = null;
public void jspInit() {

try {
InitialContext ic = new InitialContext();
Object objRef = ic.lookup("

java:comp/env/ejb/TheConverter");
ConverterHome home =
(ConverterHome)PortableRemoteObject.narrow(
objRef, ConverterHome.class);
converter = home.create();

} catch (RemoteException ex) {
...

}
}
...

%>
<html>
<head>

 <title>Converter</title>
</head>

<body bgcolor="white">
<h1><center>Converter</center></h1>
<hr>
<p>Enter an amount to convert:</p>
<form method="get">
<input type="text" name="amount" size="25">
<br>
<p>
<input type="submit" value="Submit">
<input type="reset" value="Reset">
</form>
<%

 String amount = request.getParameter("amount");
if ( amount != null && amount.length() > 0 ) {

BigDecimal d = new BigDecimal (amount);
%>

<p><%= amount %> dollars are
<%= converter.dollarToYen(d) %>  Yen.

<p><%= amount %> Yen are
<%= converter.yenToEuro(d) %>  Euro.

<%
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 }
%>
</body>
</html>

Compiling the Web Client
The J2EE server automatically compiles web clients that are JSP pages.
web client were a servlet, you would have to recompile it.

Packaging the Web Client
To package a web component, you run the New Web Component Wizard o
deploytool. During this process, the wizard puts the client files into a WAR fi
and then adds the WAR file to the application’sConverterApp.ear file.

To start the New Web Component Wizard, select File->New->Web Compon
The wizard displays the following dialog boxes.

1. Introduction Dialog Box:

a. Read this explanatory text for an overview of the wizard’s features.

b. Click Next.

2. WAR File Dialog Box

a. Select Create New WAR File in Application.

a. In the combo box, select ConverterApp.

b. In the WAR Display Name field, enterConverterWAR.

c. Click Edit.

d. In the tree under Available Files, locate thej2eetutorial/exam-
ples/build/ejb/converter directory.

e. Select index.jsp and click Add.

f. Click OK.

g. Click Next.

3. Choose Component Type Dialog Box

a. Select the JSP radio button.

b. Click Next.

4. Component General Properties Dialog Box

a. In the JSP Filename combo box, select index.jsp.
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b. Click Finish.

Specifying the Web Client’s Enterprise Bean
Reference
When it invokes thelookup method, the web client refers to an enterprise bea

Object objref = initial.lookup
("java:comp/env/ejb/TheConverter");

You specify this reference as follows:

1. In the tree, select ConverterWAR.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name column enterejb/TheConverter.

5. In the Type column, select Session.

6. In the Interfaces column, select Remote.

7. In the Home Interface column enterConverterHome.

8. In the Local/Remote Interface column enterConverter.

Specifying the JNDI Names
Although the J2EE application client and the web client access the same e
prise bean, their code refers to the bean by different names. The J2EE app
tion client refers to the bean asSimpleConverter, but the web client refers to it
asTheConverter. These references are in the parameters of thelookup calls. In
order for thelookup method to retrieve the bean, you must map the reference
the code to the bean’s JNDI name. Although this mapping adds a level of i
rection, it decouples the clients and the beans, making it easier to asse
applications from J2EE components. For more information, seeAbout JNDI
Naming (page 71).

To map the bean references in the clients to the JNDI name of the bean, fo
these steps:

1. In the tree, select ConverterApp.

2. Select the JNDI Names tab.
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3. To specify a JNDI name for the bean, in the Application table locate
ConverterEJB component and enterMyConverter in the JNDI Name col-
umn.

4. To map the references, in the References table enterMyConverter in the
JNDI Name for each row.

The following screen shot shows what the JNDI Names tab should look like a
you’ve performed the preceding steps.

Figure 6 ConverterApp JNDI Names

Deploying the J2EE™ Application
Now that the J2EE application contains the components, it is ready for dep
ment.

1. Select the ConverterApp application.

2. Select Tools->Deploy.

3. In the Introduction dialog box, confirm that ConverterApp is shown for t
Object to Deploy andlocalhost for the Target Server.

4. Select the checkbox labelled Return Client Jar.
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5. In the text field that appears, enter the full path name for the fileConvert-

erAppClient.jar so that it will reside in thej2eetutorial/exam-
ples/src/ejb/converter subdirectory. TheConverterAppClient.jar
file contains the stub classes that enable remote access to theConvert-

erEJB bean.

6. Click Next.

7. In the JNDI Names dialog box, verify the names you entered in the pr
ous section.

8. Click Next.

9. In the WAR Context Root dialog box, enterconverter in the Context Root
field. When you run the web client, theconverter context root will be part
of the URL.

10. Click Next.

11.In the Review dialog box, click Finish.

12.In the Deployment Progress dialog box, click OK when the deploym
completes.

Running the J2EE™ Application Client
1. In a terminal window, go to thej2eetutorial/examples/src/ejb/con-

verter directory.

2. Verify that this directory contains theConverterApp.ear andConverter-
AppClient.jar files.

3. Set the APPCPATH environment variable to ConverterAppClient.jar.

4. Type the following command (on a single line):

runclient -client ConverterApp.ear -name ConverterClient
-textauth

5. The client container prompts you to login. Enterguest for the user name
andguest123 for the password.

6. In the terminal window, the client displays these lines:

Binding name:‘java:comp/env/ejb/SimpleConverter‘
12160.00
0.77
Unbinding name:‘java:comp/env/ejb/SimpleConverter‘
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Running the Web Client
To run the web client point your browser at the following URL. Replace<host>

with the name of the host running the J2EE server. If your browser is running
the same host as the J2EE server, you may replace<host> with localhost.

http://<host>:8000/converter

You should see the following after entering100 in the input field and clicking
Submit:

Figure 7 Converter Web Client

Modifying the J2EE™ Application
Since the J2EE SDK is intended for experimentation, it supports iterative de
opment. Whenever you make a change to a J2EE application, you must red
the application.
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Modifying a Class File
To modify a class file in an enterprise bean, you change the source code, re
pile it, and redeploy the application. For example, suppose that you wan
change the exchange rate in thedollarToYen business method of theConvert-
erBean class:

1. EditConverterBean.java.

2. RecompileConverterBean.java by typingant converter.

3. In the deploytool, select Tools->Update Files.

4. A dialog appears reporting the changed file. Verify thatConverter-

Bean.class has been changed and dismiss the dialog.

5. Select Tools->Deploy. Make sure the checkbox labeled Save object be
deploying is checked.

You can also perform steps 4. and 5. by selecting Tools->Update and Rede
The deploytool replaces the old JSP file inConverterApp.ear with the new
one and then redeploys the application.

Adding a File
To add a file to the EJB JAR or WAR of the application, you would perfor
these steps:

1. Select the JAR or WAR in the tree.

2. Select the General tab.

3. Click Edit.

4. In the tree of the Available Files field, locate the file and click Add.

5. Click OK

6. From the main toolbar, select Tools->Update and Redeploy.

Modifying the Web Client
To modify the web client:

1. Editindex.jsp.

2. Executeant converter to copy the modified file to the build directory.

3. In the deploytool, select Tools->Update Files.

4. A dialog appears reporting the changed file. Verify thatindex.jsp has
been changed and dismiss the dialog.
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5. Select Tools->Deploy. Make sure the checkbox labeled Save object be
deploying is checked.

You can also perform steps 4. and 5. by selecting Tools->Update and Rede
The deploytool replaces the old JSP file inConverterApp.ear with the new
one and then redeploys the application.

Modifying a Deployment Setting
To modify a deployment setting ofConverterApp, you edit the appropriate field
in a tabbed pane and redeploy the application. For example, to change the
name of theConverterBean from ATypo to MyConverter, you would follow
these steps:

1. In thedeploytool, select ConverterApp in the tree.

2. Select the JNDI Names tab.

3. In the JNDI Name field, enterMyConverter.

4. From the main toolbar, select File->Save.

5. Select Tools->Update and Redeploy.

Common Problems and Their Solutions

Cannot Start the J2EE Server

Naming and Directory Service Port Conflict

Symptom: When you start the J2EE server with the-verbose option, it displays
these lines:

J2EE server listen port: 1050
RuntimeException: Could not initialize server. . .

Solution: Another process is using port 1050. If the J2EE server is already
ning, you can stop it by typingj2ee -stop. If some other program is using the
port, then you can change the default port number (1050) by editing thecon-

fig/orb.properties file of your J2EE SDK installation.

For more information about default port numbers, see theConfiguration Guide
in the documentation download bundle of the J2EE SDK.
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Web Service Port Conflict

Symptom: When you start the J2EE server with the-verbose option, it displays
these lines:

LifecycleException: HttpConnector[8000].open:
java.net.BindException: Address in use. . .

Solution: Another process is using port 8000. You can change the default
number (8000) by editing theconfig/web.properties file of your J2EE SDK
installation.

Incorrect XML Parser

Symptom: When you start the J2EE server with the-verbose option, it displays
these lines:

Exception in thread "main"
javax.xml.parsers.FactoryConfigurationError:
org.apache.xerces.jaxp.SAXParserFactoryImpl at . . .

Solution: Remove thejre/lib/jaxp.properties file from your J2SE installa-
tion.

Compilation Errors

Ant Cannot Locate the Build File

Symptom: When you typeant converter, these messages appear:

Buildfile: build.xml does not exist!
Build failed.

Solution: Before runningant, go to thej2eetutorial/examples/src directory.
If you want to runant from your current directory, then you must specify th
build file on the command line. For example, on Windows you would type t
command on a single line:

ant -buildfile C:\j2eetutorial\examples\src\build.xml
converter

The Compiler Cannot Resolve Symbols

Symptom: When you typeant converter, the compiler reports many errors
including these:
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cannot resolve symbol
. . .
BUILD FAILED
. . .
Compile failed, messages should have been provided

Solution: Make sure that you’ve set the J2EE_HOME environment variable c
rectly. SeeChecking the Environment Variables (page 49).

Ant 1.4 Will Not Compile the Example After You Run the Client

Symptom: Ant 1.4 displays this error:

The filename, directory name, or volume label syntax is
incorrect.

Solution: Use version 1.3 ofant. The 1.4 version of theant.bat script and the
scripts of the J2EE SDK all use theJAVACMD environment variable. The SDK’s
runclient.bat script, for example, setsJAVACMD to a value that causes prob
lems forant.bat.

Deployment Errors

The Incorrect XML Parser Is In Your Classpath

Symptom: The error displayed has the following text:

. . .
[]java.rmi.RemoteException:Error saving/opening

Deployment Error:Bad mapping of key{0} class{1},
not found: com.sum.enterprise.deployment.xml.ApplicationNode

Solution: Remove thejaxp.jar file from the jre/lib/ext directory of your
J2SE installation. This JAR file contains XML parsing routines that are inco
patible with the J2EE server. If you do not have ajaxp.jar file, then perhaps
your classpath refers to the XML routines of a Tomcat installation. In this ca
you should remove that reference from your classpath.

The Remote Home Interface Was Specified As a Local Home
Interface

Symptom: An error such as the following is displayed:
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LocalHomeImpl must be declared abstract.
It does not define javax.ejb.HomeHandle getHomeHandle()
from interface javax.ejb.EJBHome.

Solution: Remove the enterprise bean from the EAR file (Edit->Delete) and
ate a new bean with the New Enterprise Bean Wizard. In the General dialog
of the wizard, select values from the Remote Home Interface and Remote I
face combo boxes.

J2EE Application Client Runtime Errors

The Client Throws an Exception

Symptom: The client reports this exception:

java.lang.NoClassDefFoundError:converter.ConverterHome

Solution: Make sure that you set APPCPATH to the path of the client jar y
returned when you deployed the application.

The Client Cannot Find ConverterApp.ear

Symptom: The client reports this exception:

IOException: ConverterApp.ear does not exist

Solution: Ensure that theConverterApp.ear file exists and that you’ve specified
it with the-client option:

runclient -client ConverterApp.ear -name ConverterClient

You created theConverterApp.ear file in the section,Creatingthe J2EE™
Application (page 50). See also,Running the J2EE™ Application
Client (page 63).

The Client Cannot Find the ConverterClient Component

Symptom: The client displays this line:

No application client descriptors defined for: . . .

Solution: Verify that you’ve created the ConverterClient component and t
you’ve specified it for the-name option of therunclient command. You created
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the ConverterClient component in the section,Packagingthe J2EEApplication
Client (page 57).

The Login Failed

Symptom: After you login, the client reports displays this line:

Incorrect login and/or password

Solution: At the login prompts, enterguest as the user name andguest123 as
the password.

The J2EE Application Has Not Been Deployed

Symptom: The client reports the following exception:

NameNotFoundException. Root exception is org.omg.CosNaming. . .

Solution: Deploy the application. For instructions, seeDeploying the J2EE™
Application (page 62).

The JNDI Name is Incorrect

Symptom: The client reports the following exception:

NameNotFoundException. Root exception is org.omg.CosNaming. . .

Solution: In the JNDI Names tabbed pane of theConverterApp, make sure that
the JNDI names for theConverterBean and theejb/SimpleConverter match.
Edit the appropriate JNDI Name field and then redeploy the application.

Web Client Runtime Errors

The Web Context in the URL is Incorrect

Symptom: The browser reports that the page cannot be found (HTTP 404).

Solution: Verify that the web context (converter) in the URL matches the one
you specified in the Component General Properties dialog box in the sec
PackagingtheWebClient (page 60). The case (upper or lower) of the web co
text is significant.

The J2EE Application Has Not Been Deployed

Symptom: The browser reports that the page cannot be found (HTTP 404).
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Solution: Deploy the application.

The JNDI Name is Incorrect

Symptom: When you click Submit on the web page, the browser reports thA

Servlet Exception Has Occurred.

Solution: In the JNDI Names tabbed pane of theConverterApp, make sure that
the JNDI names for theConverterBean and theConverterWAR match. Edit the
appropriate JNDI Name field and then redeploy the application.

Detecting Problems With the Verifier Tool
The verifier tool can detect inconsistencies in deployment descriptors a
method signatures. These inconsistencies often cause deployment or ru
errors. From thedeploytool, you can run the GUI version of theverifier tool
by selecting Tools-> Verifier. You can also run a stand-alone GUI or comma
line version of theverifier tool. For more information, see theJ2EE™SDK
Tools (page 453).

Comparing Your EAR Files With Ours
For most of the examples, the download bundle of the tutorial includes J2
application EAR files, which are located in thej2eetutorial/examples/ears
directory.

When All Else Fails
If none of these suggestions fixes the problem, you can uninstall the applica
and clean out the server’s repository by running thecleanup script. You’ll also
need to shutdown and restart the server:

j2ee -stop
cleanup
j2ee -verbose

About JNDI Naming
J2EE naming services provide application clients, enterprise beans, and
components with access to a JNDI naming environment. Anaming environment
allows a component to be customized without the need to access or chang
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component’s source code. A container implements the component’s env
ment, and provides it to the component as a JNDInaming context.

J2EE components locate their environment naming contexts using JNDI in
faces. A component creates ajavax.naming.InitialContext object and looks
up the environment naming context inInitialContext under the name
java:comp/env. A component’s naming environment is stored directly in th
environment naming context, or in any of its direct or indirectsubcontexts.

A J2EE component can access named system-provided and user-defined o
The names of system-provided objects, such as JTAUserTransaction objects,
are stored in the environment naming context,java:comp/env. The J2EE plat-
form allows a component to name user-defined objects, such as enterprise b
environment entries, JDBCDataSource objects, and message connections. A
object should be named within a subcontext of the naming environment acc
ing to the type of the object. For example, enterprise beans are named withi
subcontextjava:comp/env/ejb and JDBCDataSource references in the sub-
contextjava:comp/env/jdbc.
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Enterprise Beans
by Dale Green

ENTERPRISEbeans are the J2EE™ components that implement Enterp
JavaBeans™ (EJB™) technology. Enterprise beans run in the EJB contain
runtime environment within the J2EE server. (See Figure 5.) Although trans
ent to the application developer, the EJB container provides system-level
vices such as transactions to its enterprise beans. These services enable
quickly build and deploy enterprise beans, which form the core of transactio
J2EE applications.
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Defining Client Access With Interfaces 84
Remote Access 85
Local Access 85
Local Interfaces and Container-Managed Relationships 86
Deciding on Remote or Local Access 86
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The Entity Bean Life Cycle 92
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What is an Enterprise Bean?
Written in the Java™ programming language, an enterprise bean is a serve
component that encapsulates the business logic of an application. The bus
logic is the code that fulfills the purpose of the application. In an inventory c
trol application, for example, the enterprise beans might implement the busi
logic in methods calledcheckInventoryLevel andorderProduct. By invoking
these methods, remote clients can access the inventory services provided b
application.

Benefits of Enterprise Beans
For several reasons, enterprise beans simplify the development of large, di
uted applications.

First, because the EJB container provides system-level services to enter
beans, the bean developer can concentrate on solving business problems
EJB container—not the bean developer—is responsible for system-level ser
such as transaction management and security authorization.

Second, because the beans—and not the clients—contain the application’s
ness logic, the client developer can focus on the presentation of the client.
client developer does not have to code the routines that implement business
or access databases. As a result, the clients are thinner, a benefit that is pa
larly important for clients that run on small devices.
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Third, because enterprise beans are portable components, the application a
bler can build new applications from existing beans. These applications can
on any compliant J2EE server.

When To Use Enterprise Beans
You should consider using enterprise beans if your application has any of t
requirements:

• The application must be scalable. To accommodate a growing numbe
users, you may need to distribute an application’s components across
tiple machines. Not only can the enterprise beans of an application run
different machines, but their location will remain transparent to the clien

• Transactions are required to ensure data integrity. Enterprise beans su
transactions, the mechanisms that manage the concurrent access of s
objects.

• The application will have a variety of clients. With just a few lines of cod
remote clients can easily locate enterprise beans. These clients can be
various, and numerous.

Types of Enterprise Beans
Table 3 summarizes the three different types of enterprise beans. The follo
sections discuss each type in more detail.

Table 3 Summary of Enterprise Bean Types

Enterprise Bean Type Purpose

Session Performs a task for a client.

Entity
Represents a business entity object that exists in persistent
storage.

Message-Driven
Acts as a listener for the Java™ Message Service API, pro-
cessing messages asynchronously.
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What is a Session Bean?
A session bean represents a single client inside the J2EE server. To acce
application that is deployed on the server, the client invokes the session be
methods. The session bean performs work for its client, shielding the client f
complexity by executing business tasks inside the server.

As its name suggests, a session bean is similar to an interactive session. A
sion bean is not shared—it may have just one client, in the same way tha
interactive session may have just one user. Like an interactive session, a se
bean is not persistent. (That is, its data is not saved to a database.) When th
ent terminates, its session bean appears to terminate and is no longer asso
with the client.

For code samples, see the chapter,Bean-ManagedPersistenceExamples (page
109).

State Management Modes
There are two types of session beans: stateful and stateless.

Stateful Session Beans

The state of an object consists of the values of its instance variables. In a sta
session bean, the instance variables represent the state of a unique clien
session. Because the client interacts (“talks”) with its bean, this state is o
called the conversational state.

The state is retained for the duration of the client-bean session. If the c
removes the bean or terminates, the session ends and the state disappear
transient nature of the state is not a problem, however, because when the co
sation between the client and the bean ends there is no need to retain the s

Stateless Session Beans

A stateless session bean does not maintain a conversational state for a par
client. When a client invokes the method of a stateless bean, the bean’s ins
variables may contain a state, but only for the duration of the invocation. W
the method is finished, the state is no longer retained. Except during me
invocation, all instances of a stateless bean are equivalent, allowing the EJB
tainer to assign an instance to any client.

Because stateless session beans can support multiple clients, they can offer
scalability for applications that require large numbers of clients. Typically,
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application requires fewer stateless session beans than stateful session be
support the same number of clients.

At times, the EJB container may write a stateful session bean out to secon
storage. However, stateless session beans are never written out to secondar
age. Therefore, stateless beans may offer better performance than stateful 

When to Use Session Beans
In general, you should use a session bean under the following circumstance

• At any given time, only one client has access to the bean instance.

• The state of the bean is not persistent, existing only for a short perio
time (perhaps a few hours).

Stateful session beans are appropriate if any of the following conditions are

• The bean’s state represents the interaction between the bean and a sp
client.

• The bean needs to hold information about the client across method inv
tions.

• The bean mediates between the client and the other components o
application, presenting a simplified view to the client.

• Behind the scenes, the bean manages the work flow of several enter
beans. For an example, see theAccountControllerEJB in theTheDuke’s
Bank Application (page 411).

To improve performance, you might choose a stateless session bean if it ha
of these traits:

• The bean’s state has no data for a specific client.

• In a single method invocation, the bean performs a generic task for all
ents. For example, you might use a stateless session bean to send an
that confirms an online order.

• The bean fetches from a database a set of read-only data that is often
by clients. Such a bean, for example, could retrieve the table rows that
resent the products that are on sale this month.
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What is an Entity Bean?
An entity bean represents a business object in a persistent storage mecha
Some examples of business objects are customers, orders, and products.
J2EE SDK, the persistent storage mechanism is a relational database. Typi
each entity bean has an underlying table in a relational database, and
instance of the bean corresponds to a row in that table.

For code examples of entity beans, please refer to these chapters:

• Bean-Managed Persistence Examples (page 109)

• Container-Managed Persistence Examples (page 145)

What Makes Entity Beans Different From Session
Beans
Entity beans differ from session beans in several ways. Entity beans are pe
tent, allow shared access, have primary keys, and may participate in rela
ships with other entity beans.

Persistence

Because the state of an entity bean is saved in a storage mechanism, it is p
tent. Persistence means that the entity bean’s state exists beyond the lifetim
the application or the J2EE server process. If you’ve worked with databa
you’re familiar with persistent data. The data in a database is persistent bec
it still exists even after you shut down the database server or the applicatio
services.

There are two types of persistence for entity beans: bean-managed and
tainer-managed. With bean-managed persistence, the entity bean code tha
write contains the calls that access the database. If your bean has container
aged persistence, the EJB container automatically generates the necessar
base access calls. The code that you write for the entity bean does not inc
these calls. For additional information, seeContainer-ManagedPersistence
(page 79).

Shared Access

Entity beans may be shared by multiple clients. Because the clients might w
to change the same data, it’s important that entity beans work within tran
tions. Typically, the EJB container provides transaction management. In
case, you specify the transaction attributes in the bean’s deployment descr



WHAT IS AN ENTITY BEAN? 79

ainer
-

for
pri-
ma-

ntity

ed-
naged
con-
ps for
per-

ndles
ns no
ecific

f you
data-
our

n that

s the
this

onal
ch as
You do not have to code the transaction boundaries in the bean—the cont
marks the boundaries for you. SeeTransactions (page 335) for more informa
tion.

Primary Key

Each entity bean has a unique object identifier. A customer entity bean,
example, might be identified by a customer number. The unique identifier, or
mary key, enables the client to locate a particular entity bean. For more infor
tion seeEntity Bean Class (page 110).

Relationships

Like a table in a relational database, an entity bean may be related to other e
beans. For example, in a college enrollment application theStudentEJB and
CourseEJB beans would be related because students enroll in classes.

You implement relationships differently for entity beans with bean-manag
persistence and those with container-managed-persistence. With bean-ma
persistence, the code that you write implements the relationships. But with
tainer-managed persistence, the EJB container takes care of the relationshi
you. For this reason, relationships in entity beans with container-managed
sistence are often referred to as container-managed relationships.

Container-Managed Persistence
The term container-managed persistence means that the EJB container ha
all database access required by the entity bean. The bean’s code contai
database access (SQL) calls. As a result, the bean’s code is not tied to a sp
persistent storage mechanism (database). Because of this flexibility, even i
redeploy the same entity bean on different J2EE servers that use different
bases, you won’t need to modify or recompile the bean’s code. In short, y
entity beans are more portable.

In order to generate the data access calls, the container needs informatio
you provide in the entity bean’s abstract schema.

Abstract Schema

Part of an entity bean’s deployment descriptor, the abstract schema define
bean’s persistent fields and relationships. The term “abstract” distinguishes
schema from the physical schema of the underlying datastore. In a relati
database, for example, the physical schema is made up of structures su
tables and columns.
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You specify the name of an abstract schema in the deployment descriptor.
name is referenced by queries written in the Enterprise JavaBeans™ Query
guage (EJB™ QL). For an entity bean with container-managed persistence
must define an EJB QL query for every finder method (exceptfindByPrima-

ryKey). The EJB QL query determines the query that is executed by the E
container when the finder method is invoked. To learn more about EJB QL,
the chapter,Enterprise JavaBeans™ Query Language (page 187).

You’ll probably find it helpful to sketch the abstract schema before writing a
code. The following figure represents a simple abstract schema that describe
relationships between three entity beans. These relationships are discusse
ther in the sections that follow.

Figure 8 A High-Level View of an Abstract Schema

Persistent Fields. The persistent fields of an entity bean are stored in t
underlying datastore. Collectively, these fields constitute the state of the bea
runtime, the EJB container automatically synchronizes this state with the d

OrderEJB
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base. During deployment, the container typically maps the entity bean to a d
base table and the persistent fields to the table’s columns.

A CustomerEJB bean, for example, might have persistent fields such asfirst-

Name, lastName, phone, andemailAddress. In container-managed persistence
these fields are virtual. You declare them in the abstract schema, but you d
code them as instance variables in the entity bean class. Instead, the pers
fields are identified in the code by access methods (getters and setters).

Relationship Fields. A relationship field is like a foreign key in a databas
table—it identifies a related bean. Like a persistent field, a relationship fiel
virtual and is defined in the enterprise bean class with access methods
unlike a persistent field, a relationship field does not represent the bean’s s
Relationship fields are discussed further inDirection in Container-Managed
Relationships (page 81).

Multiplicity in Container-Managed Relationships

There are four types of multiplicities:

One-to-One - Each entity bean instance is related to a single instance of an
entity bean. For example, to model a physical warehouse in which each sto
bin contains a single widget, theStorageBinEJB andWidgetEJB beans would
have a one-to-one relationship.

One-to-Many - An entity bean instance may be related to multiple instance
the other entity bean. A sales order, for example, can have multiple line item
the order application, anOrderEJB bean would have a one-to-many relationsh
with theLineItemEJB beans.

Many-to-One - Multiple instances of an entity bean may be related to a sin
instance of the other entity bean. This multiplicity is the opposite of one-
many. In the example mentioned in the previous paragraph, from the perspe
of theLineItemEJB bean the relationship to theOrderEJB bean is many-to-one.

Many-to-Many - The entity bean instances may be related to multiple instan
of each other. For example, in college each course has many students and
student may take several courses. Therefore, in an enrollment application
CourseEJB andStudentEJB beans would have a many-to-many relationship.

Direction in Container-Managed Relationships

The direction of a relationship may be either bidirectional or unidirectional.
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In a bidirectional relationship, each entity bean has a relationship field that re
to the other bean. Through the relationship field, an entity bean’s code can a
its related object. If an entity bean has a relative field, then we often say th
“knows” about its related object. For example, if anOrderEJB bean knows what
LineItemEJB beans it has and if eachLineItemEJB bean knows whatOrderEJB
bean it belongs to, then they have a bidirectional relationship.

In a unidirectional relationship, only one entity bean has a relationship field
refers to the other. For example, aLineItemEJB bean would have a relationship
field that identifies aProductEJB bean, but theProductEJB bean would not have
a relationship field for theLineItemEJB bean. In other words, theLineItemEJB
bean knows about theProductEJB bean, but theProductEJB bean doesn’t know
whichLineItemEJB beans refer to it.

EJB QL queries often navigate across relationships. The direction of a rela
ship determines whether a query can navigate from one bean to another
example, a query may navigate from theLineItemEJB bean to theProductEJB
bean, but may not navigate in the opposite direction. For theOrderEJB and
LineItemEJB beans, a query could navigate in both directions, since these
beans have a bidirectional relationship.

When To Use Entity Beans
You should probably use an entity bean under the following conditions:

• The bean represents a business entity, not a procedure. For example,Cred-

itCardEJB would be an entity bean, butCreditCardVerifierEJB would
probably be a session bean.

• The bean’s state must be persistent. If the bean instance terminates or
J2EE server is shut down, the bean’s state still exists in persistent sto
(a database).

What is a Message-Driven Bean?

Note:This section contains text from the Java™ Message Service Tutorial. Becaus
message-driven beans rely on Java Message Service (JMS) technology, to fu
understand how these beans work you should consult the tutorial at this URL:

http://java.sun.com/products/jms/tutorial/index.html

http://java.sun.com/products/jms/tutorial/index.html
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A message-driven bean is an enterprise bean that allows J2EE applicatio
process messages asynchronously. It acts as a JMS message listener, w
similar to an event listener except that it receives messages instead of events
messages may be sent by any J2EE component—an application client, an
enterprise bean, or a Web component—or by a JMS application or system
does not use J2EE technology.

Message-driven beans currently process only JMS messages, but in the f
they may be used to process other kinds of messages.

For a code sample, see the chapter,A Message-Driven Bean Example (page
177).

What Makes Message-Driven Beans Different From
Session and Entity Beans
The most visible difference between message-driven beans and session
entity beans is that clients do not access message-driven beans through
faces. Interfaces are described in the sectionDefiningClient AccessWith Inter-
faces (page 84). Unlike a session or entity bean, a message-driven bean ha
a bean class.

In several respects, a message-driven bean resembles a stateless session 

• A message-driven bean’s instances retain no data or conversational
for a specific client.

• All instances of a message-driven bean are equivalent, allowing the
container to assign a message to any message-driven bean instance
container can pool these instances to allow streams of messages to be
cessed concurrently.

• A single message-driven bean can process messages from multiple cl

The instance variables of the message-driven bean instance can contain
state across the handling of client messages—for example, a JMS API con
tion, an open database connection, or an object reference to an enterprise
object.

When a message arrives, the container calls the message-driven bean’sonMes-

sage method to process the message. TheonMessage method normally casts the
message to one of the five JMS message types and handles it in accordanc
the application’s business logic. TheonMessage method may call helper meth-
ods, or it may invoke a session or entity bean to process the information in
message or to store it in a database.

http://java.sun.com/products/jms/tutorial/index.html
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A message may be delivered to a message-driven bean within a transaction
text, so that all operations within theonMessage method are part of a single
transaction. If message processing is rolled back, the message will be red
ered. For more information seeTransactions (page 335).

When to Use Message-Driven Beans
Session beans and entity beans allow you to send JMS messages and to r
them synchronously, but not asynchronously. To avoid tying up server resou
you may prefer not to use blocking synchronous receives in a server-side com
nent. To receive messages asynchronously, use a message-driven bean.

Defining Client Access With Interfaces

Note: The material in this section applies only to session and entity beans, not t
message-driven beans. Because they have a different programming model, m
sage-driven beans do not have interfaces that define client access.

A client may access a session or an entity bean only through the methods de
in the bean’s interfaces. These interfaces define the client’s view of a bean
other aspects of the bean—method implementations, deployment descripto
tings, abstract schemas, database access calls—are hidden from the client

Well designed interfaces simplify the development and maintenance of J
applications. Not only do clean interfaces shield the clients from any compl
ties in the EJB tier, but they allow the beans to change internally without affe
ing the clients. For example, even if you change your entity beans from be
managed to container-managed persistence, you won’t have to alter the c
code. But if you were to change the method definitions in the interfaces, t
you might have to modify the client code as well. Therefore, to isolate your
ents from possible changes in the beans, it is important that you design the i
faces carefully.

When you design a J2EE application, one of the first decisions you make is
type of client access allowed by the enterprise beans: remote or local.
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Remote Access
A remote client of an enterprise bean has the following traits:

• It may run on a different machine and a different Java™ Virtual Machi
(JVM) than the enterprise bean it accesses. (It is not required to run
different JVM.)

• It can be a web component, a J2EE application client, or another enterp
bean.

• To a remote client, the location of the enterprise bean is transparent.

To create an enterprise bean with remote access, you must code a remote
face and a home interface. The remote interface defines the business me
that are specific to the bean. For example, the remote interface of aBankAc-

countEJB bean might have business methods nameddebit and credit. The home
interface defines the bean’s life-cycle methods—create andremove. For entity
beans, the home interface also defines finder methods and home methods. F
methods are used to locate entity beans. Home methods are business me
that are invoked on all instances of an entity bean class. The following fig
shows how the interfaces control the client’s view of an enterprise bean.

Figure 9 Interfaces for an Enterprise Bean With Remote Access

Local Access
A local client has these characteristics:

• It must run in the same JVM as the enterprise bean it accesses.

BankAccountEJB

Remote Interface

deposit() 
credit()

create() 
remove() 
findByPrimaryKey()

Home Interface

Remote 
Client
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• It may be a web component or another enterprise bean.

• To the local client, the location of the enterprise bean it accesses is
transparent.

• It is often an entity bean that has a container-managed relationship
another entity bean.

To build an enterprise bean that allows local access, you must code the
interface and the local home interface. The local interface defines the be
business methods and the local home interface defines its life-cycle and fi
methods.

Local Interfaces and Container-Managed
Relationships
If an entity bean is the target of a container-managed relationship, then it m
have local interfaces. The direction of the relationship determines whether o
a bean is the target. In Figure 8, for example, theProductEJB bean is the target
of a unidirectional relationship with theLineItemEJB bean. Because the
LineItemEJB accesses theProductEJB locally, theProductEJB must have the
local interfaces. TheLineItemEJB also needs local interfaces—not because
its relationship with the ProductEJB—but because it is the target of a relat
ship with theOrderEJB. And because the relationship between theLineItemEJB

andOrderEJB is bidirectional, both beans must have local interfaces.

Because they require local access, entity beans that participate in a conta
managed relationship must reside in the same EJB container. The primary b
fit of this locality is increased performance—local calls are usually faster th
remote calls.

Deciding on Remote or Local Access
The decision on whether to allow local or remote access depends on the fo
ing factors:

• Container-Managed Relationships

If an entity bean is the target of a container-managed relationship, it m
use local access.

• Tight or Loose Coupling of Related Beans

Tightly coupled beans depend on one another. For example, a comp
sales order must have one or more line items, which cannot exist withou



DEFINING CLIENT ACCESSWITH INTERFACES 87

y fit
en-

ould
ost

eans,
po-

an be
m-
rise

hould

then
ture
your

ote
es.

than
ent
ese
pera-
ica-
order to which they belong. TheOrderEJB and LineItemEJB beans that
model this relationship are tightly coupled.

Tightly coupled beans are good candidates for local access. Since the
together as a logical unit, they probably call each other often and would b
efit from the increased performance that is possible with local access.

• Type of Client

If an enterprise bean is accessed by J2EE application clients, then it sh
allow remote access. In a production environment, these clients alm
always run on different machines than the J2EE server.

If an enterprise bean’s clients are web components or other enterprise b
then the type of access depends on how you want to distribute your com
nents.

• Component Distribution

J2EE applications are scalable because their server-side components c
distributed across multiple machines. In a distributed application, for exa
ple, the web components may run on a different server than the enterp
beans they access. In this distributed scenario, the enterprise beans s
allow remote access.

If you aren’t sure which type of access an enterprise bean should have,
choose remote access. This decision gives you more flexibility—in the fu
you can distribute your components to accommodate growing demands on
application.

Although uncommon, it is possible for an enterprise bean to allow both rem
and local access. Such a bean would require both remote and local interfac

Performance and Access
Because of factors such as network latency, remote calls may be slower
local calls. On the other hand, if you distribute components among differ
servers, you might improve the application’s overall performance. Both of th
statements are generalizations; actual performance can vary in different o
tional environments. Nevertheless, you should keep in mind how your appl
tion design might impact performance.
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Method Parameters and Access
The type of access affects the parameters of the bean methods that are cal
clients. The following topics apply not only to method parameters, but also
method return values.

Isolation

An argument in a remote call is passed by value; it is a copy of an object.
an argument in a local call is passed by reference, just like a normal me
call in the Java programming language.

The parameters of remote calls are more isolated than those of local c
With remote calls, the client and bean operate on different copies o
parameter object. If the client changes the value of the object, the valu
the copy in the bean does not change. This layer of isolation can help pro
the bean if the client accidentally modifies the data.

In a local call, both the client and the bean may modify the same object
general, you should not rely on this side-effect of local calls. Perhaps so
day you will want to distribute your components, replacing the local ca
with remote ones.

Granularity of Accessed Data

Because remote calls are likely to be slower than local calls, the parame
in remote methods should be relatively coarse-grained. Since a coa
grained object contains more data than a fine-grained one, fewer access
are required.

For example, suppose that aCustomerEJB is accessed remotely. This bea
would have a single getter method that returns aCustomerDetails object,
which encapsulates all of the customer’s information. But if theCustomer-

EJB is to be accessed locally, it could have a getter method for each insta
variable: getFirstName, getLastName, getPhoneNumber, and so forth.
Since local calls are fast, the multiple calls to these finer-grained ge
methods would not significantly degrade performance.

The Contents of an Enterprise Bean
To develop an enterprise bean, you must provide the following files:

• Deployment descriptor - An XML file that specifies information about th
bean such as its persistence type and transaction attributes. Thedeploy-
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tool creates the deployment descriptor when you step through the N
Enterprise Bean Wizard.

• Enterprise bean class - Implements the methods defined in the follow
interfaces.

• Interfaces - The remote and home interfaces are required for rem
access. For local access, the local and local home interfaces are requ
SeeDefining Client AccessWith Interfaces (page 84). (Please note th
these interfaces are not used by message-driven beans.)

• Helper classes - Other classes needed by the enterprise bean class, s
exception and utility classes.

You package the files in the preceding list into an EJB JAR file, the module
stores the enterprise bean. An EJB JAR file is portable and may be used fo
ferent applications. To assemble a J2EE application, you package one or
modules—such as EJB JAR files—into an EAR file, the archive file that ho
the application. When you deploy the EAR file that contains the bean’s EJB J
file, you also deploy the enterprise bean onto the J2EE server.

Naming Conventions for Enterprise Beans
Because enterprise beans are composed of multiple parts, it’s useful to foll
naming convention for your applications. Table 4 summarizes the convent
for the example beans of this tutorial. (The DD abbreviation means that the
is an element in the bean’s deployment descriptor.)

Table 4 Naming Conventions for Enterprise Beans

Item Syntax Example

enterprise bean name (DD) <name>EJB AccountEJB

EJB JAR display name (DD) <name>JAR AccountJAR

enterprise bean class <name>Bean AccountBean

home interface <name>Home AccountHome

remote interface <name> Account

local home interface Local<name>Home LocalAccountHome
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The Life Cycles of Enterprise Beans
An enterprise bean goes through various stages during its lifetime, or life cy
Each type of enterprise bean— session, entity, or message-driven— has a d
ent life cycle.

The descriptions that follow refer to methods that are explained along with
code examples in the next two chapters. If you are new to enterprise beans
should skip this section and try out the code examples first.

The Stateful Session Bean Life Cycle
Figure 10 illustrates the stages that a session bean passes through during i
time. The client initiates the life cycle by invoking thecreate method.The EJB
container instantiates the bean and then invokes thesetSessionContext and
ejbCreate methods in the session bean. The bean is now ready to have its b
ness methods invoked.

While in the ready stage, the EJB container may decide to deactivate, or p
vate, the bean by moving it from memory to secondary storage. (Typically,
EJB container uses a least-recently-used algorithm to select a bean for pa
tion.) The EJB container invokes the bean’sejbPassivate method immediately
before passivating it. If a client invokes a business method on the bean while
in the passive stage, the EJB container activates the bean, moving it back t
ready stage, and then calls the bean’sejbActivate method.

At the end of the life cycle, the client invokes the remove method and the E
container calls the bean’sejbRemove method. The bean’s instance is ready fo
garbage collection.

Your code controls the invocation of only two life cycle methods—thecreate

andremove methods in the client. All other methods in Figure 10 are invoked
the EJB container. TheejbCreate method, for example, is inside the bean clas
allowing you to perform certain operations right after the bean is instantia

local interface Local<name> LocalAccount

abstract schema (DD) <name> Account

Table 4 Naming Conventions for Enterprise Beans (Continued)

Item Syntax Example
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For instance, you may wish to connect to a database in theejbCreate method.
SeeResource Connections (page 373) for more information.

Figure 10 Life Cycle of a Stateful Session Bean

The Stateless Session Bean Life Cycle
Because a stateless session bean is never passivated, its life cycle has ju
stages: non-existent and ready for the invocation of business methods. Figu
illustrates the stages of a stateless session bean.

1. create 
2. setSessionContext 
3. ejbCreate 

1. remove 
2. ejbRemove

ejbPassivate

ejbActivate

Does Not 
Exist

Ready Passive
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Figure 11 Life Cycle of a Stateless Session Bean

The Entity Bean Life Cycle
Figure 12 shows the stages that an entity bean passes through during its life
After the EJB container creates the instance, it calls thesetEntityContext

method of the entity bean class. ThesetEntityContext method passes the
entity context to the bean.

After instantiation, the entity bean moves to a pool of available instances. W
in the pooled stage, the instance is not associated with any particular EJB o
identity. All instances in the pool are identical. The EJB container assigns
identity to an instance when moving it to the ready stage.

There are two paths from the pooled stage to the ready stage. On the first
the client invokes thecreate method, causing the EJB container to call theejb-

Create and ejbPostCreate methods. On the second path, the EJB contain
invokes theejbActivate method. While in the ready stage, an entity bean
business methods may be invoked.

There are also two paths from the ready stage to the pooled stage. First, a
may invoke theremove method, which causes the EJB container to call t
ejbRemove method. Second, the EJB container may invoke theejbPassivate

method.

1. setSessionContext 
2. ejbCreate 

 ejbRemove

Does Not 
Exist

Ready
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At the end of the life cycle, the EJB container removes the instance from
pool and invokes theunsetEntityContext method.

Figure 12 Life Cycle of an Entity Bean

In the pooled state, an instance is not associated with any particular EJB o
identity. With bean-managed persistence, when the EJB container move
instance from the pooled state to the ready state, it does not automatically se
primary key. Therefore, theejbCreate andejbActivate methods must set the
primary key. If the primary key is incorrect, theejbLoad andejbStore methods
cannot synchronize the instance variables with the database. In theAccountEJB

example, theejbCreate method assigns the primary key from one of the inp
parameters. TheejbActivate method sets the primary key (id) as follows:

 
setEntityContext unsetEntityContext 

ejbPassivateejbActivate

Does Not 
Exist

Pooled

Ready

1. remove 
2. ejbRemove

1. create 
2. ejbCreate 
3. ejbPostCreate

../examples/src/ejb/account/AccountEJB.java
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id = (String)context.getPrimaryKey();

In the pooled state, the values of the instance variables are not needed. Yo
make these instance variables eligible for garbage collection by setting the
null in theejbPasssivate method.

The Message-Driven Bean Life Cycle
Figure 13 illustrates the stages in the life cycle of a message-driven bean.

The EJB container usually creates a pool of message-driven bean instance
each instance, the EJB container instantiates the bean and performs these 

1. It calls thesetMessageDrivenContext method to pass the context objec
to the instance.

2. It calls the instance’sejbCreate method.

Like a stateless session bean, a message-driven bean is never passivated
has only two states: nonexistent and ready to receive messages.

At the end of the life cycle, the container calls theejbRemove method. The
bean’s instance is ready for garbage collection.
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Figure 13 Life Cycle of a Message-Driven Bean

Does Not 
Exist

1. setMessageDrivenContext 
2. ejbCreate

ejbRemove

ReadyonMessage
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A Session Bean
Example

by Dale Green

SESSIONbeans are powerful because they extend the reach of your clients
remote servers—yet they’re easy to build. InGettingStarted (page 47), you built
a stateless session bean namedConverterEJB. This chapter examines the sourc
code of a stateful session bean calledCartEJB.

The CartEJB Example 94
Session Bean Class 94
Home Interface 98
Remote Interface 100
Helper Classes 100
Running the CartEJB Example 100

Other Enterprise Bean Features 101
Accessing Environment Entries 101
Comparing Enterprise Beans 102
Passing an Enterprise Bean’s Object Reference 103
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The CartEJB Example
TheCartEJB bean represents a shopping cart in an online book store. The be
client may add a book to the cart, remove a book, or retrieve the cart’s conte
To construct theCartEJB bean, you need the following code:

• Session bean class (CartBean)

• Home interface (CartHome)

• Remote interface (Cart)

All session beans require a session bean class. All enterprise beans that p
remote access must have a home and remote interface. To meet the need
specific application, an enterprise bean may also need some helper classe
CartEJB session bean uses two helper classes,BookException andIdVerifier,
which are discussed in the section,Helper Classes (page 104).

Source Code. The source code for this example is in th
j2eetutorial/examples/src/ejb/cart directory. To compile the code, go to
thej2eetutorial/examples/src directory and typeant cart. A sampleCar-
tApp.ear file is in the j2eetutorial/examples/ears directory.

Session Bean Class
The session bean class for this example is calledCartBean. Like any session
bean, theCartBean class must meet these requirements:

• It implements theSessionBean interface.

• The class is defined as public.

• The class cannot be defined asabstract or final.

• It implements one or moreejbCreate methods.

• It implements the business methods.

• It contains apublic constructor with no parameters.

• It must not define thefinalize method.

 The source code for theCartBean class follows:

import java.util.*;
import javax.ejb.*;

public class CartBean implements SessionBean {

   String customerName;
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   String customerId;
   Vector contents;

public void ejbCreate(String person) throws CreateException {

      if (person == null) {
        throw new CreateException(“Null person not allowed.”);
      }
      else {
         customerName = person;
      }

      customerId = “0”;
      contents = new Vector();
   }

   public void ejbCreate(String person, String id)
     throws CreateException {

      if (person == null) {
        throw new CreateException(“Null person not allowed.”);
      }
      else {
         customerName = person;
      }

      IdVerifier idChecker = new IdVerifier();
      if (idChecker.validate(id)) {
         customerId = id;
      }
      else {
         throw new CreateException(“Invalid id: “ + id);
      }

      contents = new Vector();
   }

   public void addBook(String title) {

      contents.addElement(title);
   }

   public void removeBook(String title) throws BookException {

      boolean result = contents.removeElement(title);
      if (result == false) {
         throw new BookException(title + “ not in cart.”);
      }
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   public Vector getContents() {
      return contents;
   }

   public CartBean() {}
   public void ejbRemove() {}
   public void ejbActivate() {}
   public void ejbPassivate() {}
   public void setSessionContext(SessionContext sc) {}

}

The SessionBean Interface

The SessionBean interface extends theEnterpriseBean interface, which in
turn extends theSerializable interface. TheSessionBean interface declares
the ejbRemove, ejbActivate, ejbPassivate, andsetSessionContext meth-
ods. TheCartBean class doesn’t use these methods, but it must implement th
because they’re declared in theSessionBean interface. Consequently, these
methods are empty in theCartBean class. Later sections explain when yo
might use these methods.

The ejbCreate Methods

Because an enterprise bean runs inside an EJB container, a client cannot di
instantiate the bean. Only the EJB container can instantiate an enterprise
During instantiation, the example program performs these steps:

1. The client invokes acreate method on the home object:

Cart shoppingCart = home.create(“Duke DeEarl”,”123”);

2. The EJB container instantiates the enterprise bean.

3. The EJB container invokes the appropriateejbCreate method inCart-
Bean:

 public void ejbCreate(String person, String id)
   throws CreateException {

   if (person == null) {
     throw new CreateException(“Null person not allowed.”);
   }
   else {
      customerName = person;

http://java.sun.com/j2ee/tutorial/api/javax/ejb/SessionBean.html
http://java.sun.com/j2ee/tutorial/api/javax/ejb/EnterpriseBean.html
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   IdVerifier idChecker = new IdVerifier();
   if (idChecker.validate(id)) {
      customerId = id;
   }
   else {
      throw new CreateException(“Invalid id: “ + id);
   }

   contents = new Vector();
}

Typically, anejbCreate method initializes the state of the enterprise bean. T
precedingejbCreate method, for example, initializes thecustomerName and
customerId variables with the arguments passed by thecreate method.

An enterprise bean must have one or moreejbCreate methods. The signatures
of the methods must meet the following requirements:

• The access control modifier must bepublic.

• The return type must bevoid.

• If the bean allows remote access, the arguments must be legal type
Java RMI.

• The modifier cannot bestatic or final.

The throws clause may include thejavax.ejb.CreateException and other
exceptions that are specific to your application. TheejbCreate method usually
throws aCreateException if an input parameter is invalid.

Business Methods

The primary purpose of a session bean is to run business tasks for the client
client invokes business methods on the remote object reference that is retu
by the create method. From the client’s perspective, the business meth
appear to run locally, but they actually run remotely in the session bean. The
lowing code snippet shows how theCartClient program invokes the business
methods:

Cart shoppingCart = home.create(“Duke DeEarl”, “123”);
. . .
shoppingCart.addBook(“The Martian Chronicles”);
shoppingCart.removeBook(“Alice In Wonderland”);
bookList = shoppingCart.getContents();
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TheCartBean class implements the business methods in the following code:

public void addBook(String title) {

   contents.addElement(new String(title));
}

public void removeBook(String title) throws BookException {

   boolean result = contents.removeElement(title);
   if (result == false) {
      throw new BookException(title + “ not in cart.”);
   }
}

public Vector getContents() {
   return contents;
}

The signature of a business method must conform to these rules:

• The method name must not conflict with one defined by the EJB archi
ture. For example, you cannot call a business methodejbCreate or
ejbActivate.

• The access control modifier must bepublic.

• If the bean allows remote access, the arguments and return types mu
legal types for Java RMI.

• The modifier must not bestatic or final.

Thethrows clause may include exceptions that you define for your applicati
TheremoveBook method, for example, throws theBookException if the book is
not in the cart.

To indicate a system-level problem, such as the inability to connect to a d
base, a business method should throw thejavax.ejb.EJBException. When a
business method throws anEJBException, the container wraps it in aRemote-
Exception, which is caught by the client. The container will not wrap applic
tion exceptions such asBookException. BecauseEJBException is a subclass of
RuntimeException, you do not need to include it in thethrows clause of the
business method.
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Home Interface
A home interface extends theEJBHome interface. For a session bean, the purpo
of the home interface is to define the create methods that a remote client
invoke. TheCartClient program, for example, invokes thiscreate method:

Cart shoppingCart = home.create(“Duke DeEarl”, “123”);

Every create method in the home interface corresponds to anejbCreate

method in the bean class. The signatures of theejbCreate methods in theCart-
Bean class follow:

public void ejbCreate(String person) throws CreateException
. . .
public void ejbCreate(String person, String id)
   throws CreateException

Compare theejbCreate signatures with those of thecreate methods in the
CartHome interface:

import java.io.Serializable;
import java.rmi.RemoteException;
import javax.ejb.CreateException;
import javax.ejb.EJBHome;

public interface CartHome extends EJBHome {
    Cart create(String person) throws RemoteException,
                                      CreateException;
    Cart create(String person, String id) throws
RemoteException, CreateException;
}

The signatures of theejbCreate andcreate methods are similar, but differ in
important ways. The rules for defining the signatures of thecreate methods of a
home interface follow:

• The number and types of arguments in acreate method must match those
of its correspondingejbCreate method.

• The arguments and return type of thecreate method must be valid RMI
types.

• A create method returns the remote interface type of the enterprise be
(But anejbCreate method returns void.)

• The throws clause of the create method must include the
java.rmi.RemoteException and thejavax.ejb.CreateException.
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Remote Interface
The remote interface, which extendsjavax.ejb.EJBObject, defines the busi-
ness methods that a remote client may invoke. Here is the source code fo
Cart remote interface:

import java.util.*;
import javax.ejb.EJBObject;
import java.rmi.RemoteException;

public interface Cart extends EJBObject {

   public void addBook(String title) throws RemoteException;
   public void removeBook(String title) throws BookException,

RemoteException;
   public Vector getContents() throws RemoteException;
}

The method definitions in a remote interface must follow these rules:

• Each method in the remote interface must match a method implemente
the enterprise bean class.

• The signatures of the methods in the remote interface must be identic
the signatures of the corresponding methods in the enterprise bean c

• The arguments and return values must be valid RMI types.

• Thethrows clause must include thejava.rmi.RemoteException.

Helper Classes
TheCartEJB bean has two helper classes:BookException andIdVerifier. The
BookException is thrown by theremoveBook method and theIdVerifier vali-
dates thecustomerId in one of theejbCreate methods. Helper classes mus
reside in the EJB JAR file that contains the enterprise bean class.

Running the CartEJB Example
1. Start the J2EE server and thedeploytool. For instructions, seeSetting

Up (page 48).

2. In the deploytool open the j2eetutorial/examples/ears/Car-

tApp.ear file (File->Open).
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3. Deploy theCartApp application (Tools->Deploy). In the Introduction dia
log box, make sure that you select the Return Client JAR checkbox.
detailed instructions, seeDeploying the J2EE™ Application (page 62).

4. Run the application:

a. In a terminal window, go to thej2eetutorial/examples/ears direc-
tory.

b. Set theAPPCPATH environment variable to CartAppClient.jar.

c. Type the following command:

runclient -client CartApp.ear -name CartClient -textauth

d. At the login prompts, enterguest for the user name andguest123 for
the password.

Other Enterprise Bean Features
The topics that follow apply to both session and entity beans.

Accessing Environment Entries
Stored in an enterprise bean’s deployment descriptor, an environment entry
name-value pair that allows you to customize the bean’s business logic wit
changing its source code. An enterprise bean that calculates discounts, for e
ple, might have an environment entry named “Discount Percent.” Before dep
ing the bean’s application, you could assign “Discount Percent” a value of .05
the Environment tabbed pane of thedeploytool. When you run the application,
the enterprise bean fetches the .05 value from its environment.

In the following code example, theapplyDiscount method uses environmen
entries to calculate a discount based on the purchase amount. First, the m
locates the environment naming context by invokinglookup with the
java:comp/env parameter. Then it callslookup on the environment to get the
values for the “Discount Level” and “Discount Percent” names. For example
you assign a value of .05 to the “Discount Percent” name in thedeploytool, the
code will assign .05 to thediscountPercent variable. TheapplyDiscount
method, which follows, is in theCheckerBean class. The source code for this
example is inj2eetotorial/examples/src/ejb/checker. A sampleChecker-
App.ear file is in the j2eetutorial/examples/ears directory.
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public double applyDiscount(double amount) {

      try {

         double discount;

         Context initial = new InitialContext();
         Context environment =
           (Context)initial.lookup(“java:comp/env”);

         Double discountLevel =
            (Double)environment.lookup(“Discount Level”);
         Double discountPercent =
            (Double)environment.lookup(“Discount Percent”);

         if (amount >= discountLevel.doubleValue()) {
            discount = discountPercent.doubleValue();
         }
         else {
            discount = 0.00;
         }

         return amount * (1.00 - discount);

      } catch (NamingException ex) {
           throw new EJBException(“NamingException: “ +
              ex.getMessage());
      }
   }

Comparing Enterprise Beans
A client can determine if two stateful session beans are identical by invoking
isIdentical method:

bookCart = home.create(“Bill Shakespeare”);
videoCart = home.create(“Lefty Lee”);
...
if (bookCart.isIdentical(bookCart)) {
   // true ... }
if (bookCart.isIdentical(videoCart)) {
   // false ... }

Because stateless session beans have the same object identity, theisIdentical

method always returnstrue when used to compare them.
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To determine if two entity beans are identical, the client can invoke theisIden-

tical method, or it can fetch and compare the beans’s primary keys:

String key1 = (String)accta.getPrimaryKey();
String key2 = (String)acctb.getPrimaryKey();

if (key1.compareTo(key2) == 0)
   System.out.println(“equal”);

Passing an Enterprise Bean’s Object Reference
Suppose that your enterprise bean needs to pass a reference to itself to a
bean. You might want to pass the reference, for example, so that the second
can call the first bean’s methods. You can’t pass thethis reference because it
points to the bean’s instance, which is running in the EJB container. Only
container may directly invoke methods on the bean’s instance. Clients acces
instance indirectly by invoking methods on the object whose type is the be
remote interface. It is the reference to this object (the bean’s remote refere
that the first bean would pass to the second bean.

A session bean obtains its remote reference by calling thegetEJBObject method
of theSessionContext interface. An entity bean would call thegetEJBObject
method of theEntityContext interface. These interfaces provide beans wi
access to the instance contexts maintained by the EJB container. Typically
bean saves the context in thesetSessionContext method. The following code
fragment shows how a session bean might use these methods.

public class WagonBean implements SessionBean {

   SessionContext context;
   ...
   public void setSessionContext(SessionContext sc) {
      this.context = sc;
   }
   ...
   public void passItOn(Basket basket) {
   ...
      basket.copyItems(context.getEJBObject());
   }
   ...
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DATA is at the heart of most business applications. In J2EE™ applicatio
entity beans represent the business objects that are stored in a databas
entity beans with bean-managed persistence, you must write the code fo
database access calls. Although writing this code is an additional responsib
you will have more control over how the entity bean accesses a database.

This chapter discusses the coding techniques for entity beans with bean-
aged persistence. For conceptual information on entity beans, please seeWhatis
an Entity Bean? (page 78).
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The SavingsAccountEJB Example
The entity bean illustrated in this section represents a simple bank account
state of theSavingsAccountEJB bean is stored in thesavingsaccount table of a
relational database. Thesavingsaccount table is created by the following SQL
statement:

CREATE TABLE savingsaccount
   (id VARCHAR(3)
    CONSTRAINT pk_savingsaccount PRIMARY KEY,
    firstname VARCHAR(24),
    lastname  VARCHAR(24),
    balance   NUMERIC(10,2));

TheSavingsAccountEJB example requires the following code:

• Entity bean class (SavingsAccountBean)

• Home interface (SavingsAccountHome)

• Remote interface (SavingsAccount)

This example also makes use of the following classes:

• A helper class namedInsufficientBalanceException.

• A client class calledSavingsAccountClient.

Source Code. The source code for this example is in th
j2eetutorial/examples/src/ejb/savingsaccount directory. To compile the
code, go to thej2eetutorial/examples/src directory and typeant sav-

ingsaccount. A sample SavingsAccountApp.ear file is in the
j2eetutorial/examples/ears directory.

Entity Bean Class
The sample entity bean class is calledSavingsAccountBean. As you look
through its code, note that it meets the requirements of any entity bean
bean-managed persistence. First of all, it implements the following:

• EntityBean interface

• Zero or moreejbCreate andejbPostCreate methods

• Finder methods

• Business methods

• Home methods
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In addition, an entity bean class with bean-managed persistence has
requirements:

• The class is defined aspublic.

• The class cannot be defined asabstract or final.

• It contains an empty constructor.

• It does not implement thefinalize method.

The EntityBean Interface

TheEntityBean interface extends theEnterpriseBean interface, which extends
the Serializable interface. TheEntityBean interface declares a number o
methods, such asejbActivate andejbLoad, which you must implement in your
entity bean class. These methods are discussed later sections.

The ejbCreate Method

When the client invokes a create method, the EJB container invokes the c
spondingejbCreate method. Typically, anejbCreate method in an entity bean
performs the following tasks:

• Inserts the entity state into the database

• Initializes the instance variables

• Returns the primary key

TheejbCreate method ofSavingsAccountBean inserts the entity state into the
database by invoking the privateinsertRow method, which issues the SQL
INSERT statement. Here is the source code for theejbCreate method:

public String ejbCreate(String id, String firstName,
   String lastName, BigDecimal balance)
   throws CreateException {

   if (balance.signum() == -1)  {
      throw new CreateException
         (“A negative initial balance is not allowed.”);
   }

   try {
      insertRow(id, firstName, lastName, balance);
   } catch (Exception ex) {
       throw new EJBException(“ejbCreate: “ +
          ex.getMessage());
   }

http://java.sun.com/j2ee/tutorial/api/javax/ejb/EnterpriseBean.html
http://java.sun.com/j2ee/tutorial/api/javax/ejb/EntityBean.html
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   this.id = id;
   this.firstName = firstName;
   this.lastName = lastName;
   this.balance = balance;

   return id;
}

Although theSavingsAccountBean class has just oneejbCreate method, an
enterprise bean may contain multipleejbCreate methods. For an example, se
theCartEJB.java source code in thej2eetutorial/examples/src/ejb/cart
directory.

When writing anejbCreate method for an entity bean, be sure to follow thes
rules:

• The access control modifier must bepublic.

• The return type must be the primary key.

• The arguments must be legal types for Java RMI.

• The method modifier cannot befinal or static.

The throws clause may include thejavax.ejb.CreateException and excep-
tions that are specific to your application. AnejbCreate method usually throws
a CreateException if an input parameter is invalid. If anejbCreate method
cannot create an entity because another entity with the same primary key alr
exists, it should throw ajavax.ejb.DuplicateKeyException (a subclass of
CreateException). If a client receives aCreateException or a Dupli-

cateKeyException, it should assume that the entity was not created.

The state of an entity bean may be directly inserted into the database by an a
cation that is unknown to the J2EE server. For example, a SQL script m
insert a row into thesavingsaccount table. Although the entity bean for this
row was not created by anejbCreate method, the bean can be located by a c
ent program.

The ejbPostCreate Method

For eachejbCreate method, you must write anejbPostCreate method in the
entity bean class. The EJB container invokesejbPostCreate immediately after
it calls ejbCreate. Unlike theejbCreate method, theejbPostCreate method
can invoke thegetPrimaryKey andgetEJBObject methods of theEntityCon-
text interface. For more information on thegetEJBObject method, seePassing
anEnterpriseBean’s ObjectReference (page 107). Often, yourejbPostCreate

methods will be empty.
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The signature of anejbPostCreate must meet the following requirements:

• The number and types of arguments must match a correspondingejbCre-

ate method.

• The access control modifier must bepublic.

• The method modifier cannot befinal or static.

• The return type must bevoid.

The throws clause may include thejavax.ejb.CreateException and excep-
tions that are specific to your application.

The ejbRemove Method

A client deletes an entity bean by invoking theremove method. This invocation
causes the EJB client to call theejbRemove method, which deletes the entity
state from the database. In theSavingsAccountBean class, theejbRemove
method invokes a private method nameddeleteRow, which issues a SQLDELETE
statement. TheejbRemove method is short:

public void ejbRemove() {
    try {
        deleteRow(id);
    catch (Exception ex) {
        throw new EJBException(“ejbRemove: “ +
        ex.getMessage());
    }
}

If the ejbRemove method encounters a system problem, it should throw
javax.ejb.EJBException. If it encounters an application error, it should throw
a javax.ejb.RemoveException. For a comparison of system and applicatio
exceptions, see the section,Handling Exceptions (page 142).

An entity bean may also be removed directly by a database deletion. For ex
ple, if a SQL script deletes a row that contains an entity bean state, then
entity bean is removed.

The ejbLoad and ejbStore Methods

If the EJB container needs to synchronize the instance variables of an entity
with the corresponding values stored in a database, it invokes theejbLoad and
ejbStore methods. TheejbLoad method refreshes the instance variables fro
the database, and theejbStore method writes the variables to the database. T
client may not callejbLoad andejbStore.
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If a business method is associated with a transaction, the container invokesejb-

Load before the business method executes. Immediately after the busi
method executes, the container callsejbStore. Because the container invoke
ejbLoad andejbStore, you do not have to refresh and store the instance va
ables in your business methods. TheSavingsAccountBean class relies on the
container to synchronize the instance variables with the database. Therefor
business methods ofSavingsAccountBean should be associated with transac
tions.

If the ejbLoad andejbStore methods cannot locate an entity in the underlyin
database, they should throw thejavax.ejb.NoSuchEntityException. This
exception is a subclass ofEJBException. BecauseEJBException is a subclass
of RuntimeException, you do not have to include it in thethrows clause. When
NoSuchEntityException is thrown, the EJB container wraps it in aRemoteEx-
ception before returning it to the client.

In theSavingsAccountBean class,ejbLoad invokes theloadRow method, which
issues a SQLselect statement and assigns the retrieved data to the insta
variables. TheejbStore method calls thestoreRow method, which stores the
instance variables in the database with a SQLUPDATE statement. Here is the code
for theejbLoad andejbStore methods:

public void ejbLoad() {

   try {
      loadRow();
    } catch (Exception ex) {
        throw new EJBException(“ejbLoad: “ +
           ex.getMessage());
    }
}

public void ejbStore() {

   try {
      storeRow();
    } catch (Exception ex) {
        throw new EJBException(“ejbStore: “ +
           ex.getMessage());
    }
}
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The Finder Methods

The finder methods allow clients to locate entity beans. TheSavingsAccount-

Client program locates entity beans with three finder methods:

SavingsAccount jones = home.findByPrimaryKey(“836”);
...
Collection c = home.findByLastName(“Smith”);
...
Collection c = home.findInRange(20.00, 99.00);

For every finder method available to a client, the entity bean class must im
ment a corresponding method that begins with the prefixejbFind. The Sav-

ingsAccountBean class, for example, implements theejbFindByLastName
method as follows:

public Collection ejbFindByLastName(String lastName)
   throws FinderException {

   Collection result;

   try {
      result = selectByLastName(lastName);
    } catch (Exception ex) {
        throw new EJBException(“ejbFindByLastName “ +
           ex.getMessage());
    }
    return result;
}

The finder methods that are specific to your application, such asejbFindBy-

LastName and ejbFindInRange, are optional—but theejbFindByPrimaryKey
method is required. As its name infers, theejbFindByPrimaryKey method
accepts as an argument the primary key, which it uses to locate an entity bea
the SavingsAccountBean class, the primary key is theid variable. Here is the
code for theejbFindByPrimaryKey method:

public String ejbFindByPrimaryKey(String primaryKey)
   throws FinderException {

   boolean result;

   try {
      result = selectByPrimaryKey(primaryKey);
    } catch (Exception ex) {
        throw new EJBException(“ejbFindByPrimaryKey: “ +
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           ex.getMessage());
    }

   if (result) {
      return primaryKey;
   }
   else {
      throw new ObjectNotFoundException
         (“Row for id “ + primaryKey + “ not found.”);
   }
}

TheejbFindByPrimaryKey method may look strange to you, because it use
primaryKey for both the method argument and return value. However, reme
ber that the client does not callejbFindByPrimaryKey directly. It is the EJB
container that calls theejbFindByPrimaryKey method. The client invokes the
findByPrimaryKey method, which is defined in the home interface.

The following list summarizes the rules for the finder methods that you imp
ment in an entity bean class with bean-managed persistence:

• TheejbFindByPrimaryKey method must be implemented.

• A finder method name must start with the prefixejbFind.

• The access control modifier must bepublic.

• The method modifier cannot befinal or static.

• The arguments and return type must be legal types for Java RMI. (T
requirement applies only to methods defined in a remote— not loca
home interface.)

• The return type must be the primary key or a collection of primary key

The throws clause may include thejavax.ejb.FinderException and excep-
tions that are specific to your application. If a finder method returns a single
mary key and the requested entity does not exist, the method should throw
javax.ejb.ObjectNotFoundException (a subclass ofFinderException). If a
finder method returns a collection of primary keys and it does not find a
objects, it should return an empty collection.

The Business Methods

The business methods contain the business logic that you want to encaps
within the entity bean. Usually, the business methods do not access the data
allowing you to separate the business logic from the database access code
SavingsAccountBean class contains these business methods:
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public void debit(BigDecimal amount)
   throws InsufficientBalanceException {

   if (balance.compareTo(amount) == -1) {
       throw new InsufficientBalanceException();
   }
   balance = balance.subtract(amount);
}

public void credit(BigDecimal amount) {

   balance = balance.add(amount);
}

public String getFirstName() {

   return firstName;
}

public String getLastName() {

   return lastName;
}

public BigDecimal getBalance() {

   return balance;
}

TheSavingsAccountClient program invokes the business methods as follow

BigDecimal zeroAmount = new BigDecimal(“0.00”);
SavingsAccount duke = home.create(“123”, “Duke”, “Earl”,
    zeroAmount);
. . .
duke.credit(new BigDecimal(“88.50”));
duke.debit(new BigDecimal(“20.25”));
BigDecimal balance = duke.getBalance();
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The requirements for the signature of a business method are the same for
session and entity beans:

• The method name must not conflict with a method name defined by
EJB architecture. For example, you cannot call a business methodejbCre-

ate or ejbActivate.

• The access control modifier must bepublic.

• The method modifier cannot befinal or static.

• The arguments and return types must be legal types for Java RMI. (T
requirement applies only to methods defined in a remote— not loca
home interface.)

Thethrows clause may include the exceptions that you define for your appli
tion. Thedebit method, for example, throws theInsufficientBalanceExcep-
tion. To indicate a system-level problem, a business method should throw
javax.ejb.EJBException.

The Home Methods

A home method contains the business logic that applies to all entity beans
particular class. In contrast, the logic in a business method applies to a s
entity bean, an instance with a unique identity. During a home method invo
tion, the instance has neither a unique identity nor a state that represents a
ness object. Consequently, a home method must not access the b
persistence state (instance variables). (For container-managed persisten
home method also must not access relationships.)

Typically, a home method locates a collection of bean instances and invo
business methods as it iterates through the collection. This approach is take
the ejbHomeChargeForLowBalance method of theSavingsAccountBean class.
TheejbHomeChargeForLowBalance method applies a service charge to all sa
ings accounts with balances less than a specified amount. The method lo
these accounts by invoking thefindInRange method. As it iterates through the
collection of SavingsAccount instances, theejbHomeChargeForLowBalance
method checks the balance and invokes thedebit business method. Here is the
source code of theejbHomeChargeForLowBalance method:

public void ejbHomeChargeForLowBalance(
    BigDecimal minimumBalance, BigDecimal charge)
    throws InsufficientBalanceException {

   try {
       SavingsAccountHome home =
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       (SavingsAccountHome)context.getEJBHome();
       Collection c = home.findInRange(new BigDecimal(“0.00”),
           minimumBalance.subtract(new BigDecimal(“0.01”)));

       Iterator i = c.iterator();

       while (i.hasNext()) {
          SavingsAccount account = (SavingsAccount)i.next();
          if (account.getBalance().compareTo(charge) == 1) {
             account.debit(charge);
          }
       }

   } catch (Exception ex) {
       throw new EJBException(“ejbHomeChargeForLowBalance: “
           + ex.getMessage());
   }
}

The home interface defines a corresponding method namedchargeForLowBal-

ance. (SeeHomeMethodDefinitions (page 122)). Since the interface provide
the client view, theSavingsAccountClient program invokes the home method
as follows:

SavingsAccountHome home;
. . .
home.chargeForLowBalance(new BigDecimal(“10.00”),
    new BigDecimal(“1.00”));

In the entity bean class, the implementation of a home method must adhe
these rules:

• A home method name must start with the prefixejbHome.

• The access control modifier must bepublic.

• The method modifier cannot bestatic.

Thethrows clause may include exceptions that are specific to your applicati
it must not throw thejava.rmi.RemoteException.
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Database Calls

The following table summarizes the database access calls in theSavingsAc-

countBean class:

The business methods of theSavingsAccountBean class are absent from the
preceding table because they do not access the database. Instead, these b
methods update the instance variables, which are written to the database
the EJB container callsejbStore. Another developer may have chosen to acce
the database in the business methods of theSavingsAccountBean class. This
choice is one of those design decisions that depend on the specific needs o
application.

Before accessing a database you must connect to it. For more information
the section,Resource Connections (page 373).

Home Interface
The home interface defines the methods that allow a client to create and fin
entity bean. TheSavingsAccountHome interface follows:

import java.util.Collection;
import java.math.BigDecimal;
import java.rmi.RemoteException;
import javax.ejb.*;

Table 5 SQL Statements inSavingsAccountBean

Method SQL Statement

ejbCreate INSERT

ejbFindByPrimaryKey SELECT

ejbFindByLastName SELECT

ejbFindInRange SELECT

ejbLoad SELECT

ejbRemove DELETE

ejbStore UPDATE
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public interface SavingsAccountHome extends EJBHome {

    public SavingsAccount create(String id, String firstName,
        String lastName, BigDecimal balance)
        throws RemoteException, CreateException;

    public SavingsAccount findByPrimaryKey(String id)
        throws FinderException, RemoteException;

    public Collection findByLastName(String lastName)
        throws FinderException, RemoteException;

    public Collection findInRange(BigDecimal low,
        BigDecimal high)
        throws FinderException, RemoteException;

public void chargeForLowBalance(BigDecimal minimumBalance,
       BigDecimal charge)
       throws InsufficientBalanceException, RemoteException;
}

Create Method Definitions

Eachcreate method in the home interface must conform to these requireme

• It has the same number and types of arguments as its matchingejbCreate

method in the enterprise bean class.

• It returns the remote interface type of the enterprise bean.

• Thethrows clause includes the exceptions specified by thethrows clause
of the correspondingejbCreate andejbPostCreate methods.

• The throws clause includes thejava.rmi.CreateException.

• If the method is defined in a remote— not local— home interface, then
throws clause includes thejavax.ejb.RemoteException.

Finder Method Definitions

Every finder method in the home interface corresponds to a finder method in
entity bean class. The name of a finder method in the home interface begins
find, whereas the corresponding name in the entity bean class begins
ejbFind. For example, theSavingsAccountHome class defines thefindByLast-
Name method, and theSavingsAccountBean class implements theejbFindBy-
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LastName method. The rules for defining the signatures of the finder method
a home interface follow:

• The number and types of arguments must match those of the corresp
ing method in the entity bean class.

• The return type is the entity bean’s remote interface type, or a collectio
those types.

• The exceptions in thethrows clause include those of the correspondin
method in the entity bean class.

• Thethrows clause contains thejavax.ejb.FinderException.

• If the method is defined in a remote— not local— home interface, then
throws clause includes thejavax.ejb.RemoteException.

Home Method Definitions

Each home method definition in the home interface corresponds to a metho
the entity bean class. In the home interface, the method name is arbitrary,
vided that it does not begin withcreate or find. In the bean class, the matching
method name begins withejbHome. For example, in theSavingsAccountBean
class the name isejbChargeForLowBalance, but in theSavingsAccountHome
interface the name ischargeForLowBalance.

The home method signature must follow the same rules specified for fin
methods in the previous section (except that a home method does not thr
FinderException).

Remote Interface
The remote interface extendsjavax.ejb.EJBObject and defines the business
methods that a remote client may invoke. Here is theSavingsAccount remote
interface:

import javax.ejb.EJBObject;
import java.rmi.RemoteException;
import java.math.BigDecimal;

public interface SavingsAccount extends EJBObject {

    public void debit(BigDecimal amount)
        throws InsufficientBalanceException, RemoteException;

    public void credit(BigDecimal amount)
        throws RemoteException;
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    public String getFirstName()
        throws RemoteException;

    public String getLastName()
        throws RemoteException;

    public BigDecimal getBalance()
        throws RemoteException;
}

The requirements for the method definitions in a remote interface are the s
for both session and entity beans:

• Each method in the remote interface must match a method in the enter
bean class.

• The signatures of the methods in the remote interface must be identic
the signatures of the corresponding methods in the enterprise bean c

• The arguments and return values must be valid RMI types.

• The throws clause must includejava.rmi.RemoteException.

A local interface has the same requirements, with the following exceptions:

• The arguments and return values are not required to be valid RMI typ

• The throws clause does not includejava.rmi.RemoteException.

Running the SavingsAccountEJB Example

Setting Up the Database

The instructions that follow explain how to use theSavingsAccountEJB exam-
ple with a Cloudscape database. The Cloudscape software is included wit
J2EE SDK download bundle.

1. From the command-line prompt, run the Cloudscape database serve
typingcloudscape -start. (When you are ready to shut down the serve
typecloudscape -stop.)

2. Create thesavingsaccount database table.

a. Go to thej2eetutorial/examples/src directory

b. Typeant create-savingsaccount-table.

You may also run this example with databases other than Cloudscape. (Se
Release Notesof the J2EE SDK for a list of supported databases.) If you a
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using one of these other databases, you may run thej2eetutorial/exam-

ples/src/ejb/sql/savingsaccount.sql script to create thesavingsaccount
table.

Deploying the Application

1. In thedeploytool open thej2eetutorial/examples/ears/SavingsAc-
countApp.ear file (File->Open).

2. Deploy the SavingsAccountApp application (Tools->Deploy). In the
Introduction dialog box, make sure that you select the Return Client J
checkbox. For detailed instructions, seeDeploying the J2EE™
Application (page 62).

Running the Client

1. In a terminal window, go to thej2eetutorial/examples/ears directory.

2. Set theAPPCPATH environment variable to SavingsAccountAppCli-

ent.jar.

3. Type the following command on a single line:

runclient -client SavingsAccountApp.ear -name
SavingsAccountClient -textauth

4. At the login prompts, enterguest for the user name andguest123 for the
password.

5. The client should display the following lines:

balance = 68.25
balance = 32.53
456: 44.77
730: 19.54
268: 100.07
836: 32.55
456: 44.77
4.00
7.00
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Deploytool Tips for Entity Beans With Bean-
Managed Persistence

An earlier chapter,GettingStarted (page 47), gave step-by-step instructions
creating and packaging a session bean. To build an entity bean you follow
same procedures, but with the following exceptions.

1. In the New Enterprise Bean Wizard, specify the bean’s type and persis
management.

a. In the General dialog box, select the Entity radio button.

b. In the Entity Settings dialog box, select the radio button for Bean-Ma
aged Persistence.

2. In the Resource Refs Tabbed Pane, specify the resource factories r
enced by the bean. These settings enable the bean to connect to the
base. For instructions, seeDeploytool Tips for Resource
References (page 374).

3. Before you deploy the bean, verify that the JNDI names are correct.

a. Select the application from the tree.

b. Select the JNDI Names tab.

Mapping Table Relationships For Bean-
Managed Persistence

In a relational database, tables can be related by common columns. The rela
ships between the tables affect the design of their corresponding entity be
The entity beans discussed in this section are backed up by tables with the
lowing types of relationships:

• One-to-One relationships

• One-to-Many relationships

• Many-to-Many relationships

One-to-One Relationships
In a one-to-one relationship, each row in a table is related to a single row
another table. For example, in a warehouse application astoragebin table
might have a one-to-one relationship with awidget table. This application
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would model a physical warehouse where each storage bin contains one ty
widget and each widget resides in one storage bin.

Figure 14 illustrates thestoragebin andwidget tables. Because thestorage-
binid uniquely identifies a row in thestoragebin table, it is that table’s primary
key. Thewidgetid is the primary key of thewidget table. The two tables are
related because thewidgetid is also a column in thestoragebin table. By
referring to the primary key of thewidget table, thewidgetid in thestorage-
bin table identifies which widget resides in a particular storage bin in the wa
house. Because thewidgetid of thestoragebin table refers to the primary key
of another table, it is called a foreign key. (The figure denotes a primary key w
PK and a foreign key with FK.)

Figure 14 One-to-One Table Relationship

A dependent (child) table includes a foreign key that matches the primary ke
the referenced (parent) table. The values of the foreign keys in thestoragebin

(child) table depend on the primary keys in thewidget (parent) table. For exam-
ple, if thestoragebin table has a row with awidgetid of 344, then the widget
table should also have a row whosewidgetid is 344.

When designing a database application, you may choose to enforce the d
dency between the parent and child tables. There are two ways to enforce s
dependency: by defining a referential constraint in the database or by perform
checks in the application code. Thestoragebin table has a referential constrain
namedfk_widgetid:

CREATE TABLE storagebin
   (storagebinid VARCHAR(3)
    CONSTRAINT pk_storagebin PRIMARY KEY,
    widgetid VARCHAR(3),
    quantity INTEGER,
    CONSTRAINT fk_widgetid
    FOREIGN KEY (widgetid)
     REFERENCES widget(widgetid));

StorageBin Table

storagebinid (PK) 
widgetid (FK) 
quantity

widgetid (PK) 
description 
price

Widget Table

1 : 1
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Source Code. The source code for the following example is in th
j2eetutorial/examples/src/ejb/storagebin directory. To compile the
code, go to thej2eetutorial/examples/src directory and typeant storage-

bin. A sampleStorageBinApp.ear file is in the j2eetutorial/examples/ears
directory.

TheStorageBinBean andWidgetBean classes illustrate the one-to-one relation
ship of thestoragebin and widget tables. TheStorageBean class contains
variables for each column in thestoragebin table, including the foreign key,
widgetId:

private String storageBinId;
private String widgetId;
private int quantity;

The ejbFindByWidgetId method of theStorageBean class returns thestor-
ageBinId that matches a givenwidgetId:

public String ejbFindByWidgetId(String widgetId)
   throws FinderException {

   String storageBinId;

   try {
      storageBinId = selectByWidgetId(widgetId);
    } catch (Exception ex) {
        throw new EJBException(“ejbFindByWidgetId: “ +
           ex.getMessage());
    }

   if (storageBinId == null) {
      throw new ObjectNotFoundException
         (“Row for widgetId “ + widgetId + “ not found.”);
   }
   else {
      return storageBinId;
   }
}

TheejbFindByWidgetId method locates the widgetId by querying the databa
in theselectByWidgetId method:

private String selectByWidgetId(String widgetId)
   throws SQLException {

   String storageBinId;
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   String selectStatement =
         “select storagebinid “ +
         “from storagebin where widgetid = ? “;
   PreparedStatement prepStmt =
         con.prepareStatement(selectStatement);
   prepStmt.setString(1, widgetId);

   ResultSet rs = prepStmt.executeQuery();

   if (rs.next()) {
      storageBinId = rs.getString(1);
   }
   else {
      storageBinId = null;
   }

   prepStmt.close();
   return storageBinId;
}

To find out which storage bin a widget resides in, theStorageBinClient pro-
gram calls thefindByWidgetId method:

String widgetId = “777”;
StorageBin storageBin =
   storageBinHome.findByWidgetId(widgetId);
String storageBinId = (String)storageBin.getPrimaryKey();
int quantity = storageBin.getQuantity();

Running the StorageBinEJB Example

1. Create thestoragebin database table:

a. Go to thej2eetutorial/examples/src directory.

b. Typeant create-storagebin-table.

2. Deploy theStorageBinApp.ear file (located in thej2eetutorial/exam-
ples/ears directory).

3. Run the client:

a. Go to thej2eetutorial/examples/ears directory.

b. Set theAPPCPATH environment variable toStorageBinAppClient.jar.

c. Type the following command on a single line:
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runclient -client StorageBinApp.ear -name StorageBinClient
-textauth

d. At the login prompts, enterguest for the user name andguest123 for
the password.

One-to-Many Relationships
If the primary key in a parent table matches multiple foreign keys in a ch
table, then the relationship is one-to-many. This relationship is common in d
base applications. For example, an application for a sports league might acc
team table and aplayer table. Each team has multiple players and each pla
belongs to a single team. Every row in the child table (player), has a foreign key
identifying the player’s team. This foreign key matches theteam table’s primary
key.

The sections that follow describe how you might implement one-to-many re
tionships in entity beans. When designing such entity beans, you must de
whether both tables are represented by entity beans, or just one.

A Helper Class for the Child Table

Not every database table needs to be mapped to an entity bean. If a dat
table doesn’t represent a business entity, or if it stores information that is c
tained in another entity, then the table should be represented with a helper c
In an online shopping application, for example, each order submitted by a
tomer can have multiple line items. The application stores the information in
database tables shown by Figure 15.

Figure 15 One-to-Many Relationship: Order and Line Items

1 : Many

Orders Table

orderid (PK) 
customerid  
totalprice 
status

LineItems Table

itemno (PK) 
orderid (FK) 
productid 
unitprice 
quantity
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Not only does a line item belong to an order, it does not exist without the or
Therefore, thelineitems table should be represented with a helper class and
with an entity bean. Using a helper class in this case is not required, but doin
might improve performance because a helper class uses fewer system reso
than an entity bean.

Source Code. The source code for the following example is in th
j2eetutorial/examples/src/ejb/order directory. To compile the code, go
to thej2eetutorial/examples/src directory and typeant order. A sample
OrderApp.ear file is in the j2eetutorial/examples/ears directory.

The LineItem andOrderBean classes show how to implement a one-to-man
relationship with a helper class (LineItem). The instance variables in the
LineItem class correspond to the columns in thelineitems table. TheitemNo
variable matches the primary key for thelineitems table and theorderId vari-
able represents the table’s foreign key. Here is the source code for theLineItem

class:

public class LineItem implements java.io.Serializable {

   String productId;
   int quantity;
   double unitPrice;
   int itemNo;
   String orderId;

   public LineItem(String productId, int quantity,
     double unitPrice, int itemNo, String orderId) {

      this.productId = productId;
      this.quantity = quantity;
      this.unitPrice = unitPrice;
      this.itemNo = itemNo;
      this.orderId = orderId;
   }

   public String getProductId() {
      return productId;
   }

   public int getQuantity() {
      return quantity;
   }

   public double getUnitPrice() {
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      return unitPrice;
   }

   public int getItemNo() {
      return itemNo;
   }

   public String getOrderId() {
      return orderId;
   }
}

The OrderBean class contains anArrayList variable namedlineItems. Each
element in thelineItems variable is aLineItem object. ThelineItems vari-
able is passed to theOrderBean class in theejbCreate method. For every
LineItem object in thelineItems variable, theejbCreate method inserts a row
into thelineitems table. It also inserts a single row into theorders table. The
code for theejbCreate method follows:

public String ejbCreate(String orderId, String customerId,
    String status, double totalPrice, ArrayList lineItems)
    throws CreateException {

    try {
       insertOrder(orderId, customerId, status, totalPrice);
       for (int i = 0; i < lineItems.size(); i++) {
          LineItem item = (LineItem)lineItems.get(i);
          insertItem(item);
       }
    } catch (Exception ex) {
        throw new EJBException(“ejbCreate: “ +
           ex.getMessage());
    }

    this.orderId = orderId;
    this.customerId = customerId;
    this.status = status;
    this.totalPrice = totalPrice;
    this.lineItems = lineItems ;

    return orderId;
}

TheOrderClient program creates and loads anArrayList of LineItem objects.
The program passes thisArrayList to the entity bean when it invokes thecre-
ate method:
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ArrayList lineItems = new ArrayList();
lineItems.add(new LineItem(“p23”, 13, 12.00, 1, “123”));
lineItems.add(new LineItem(“p67”, 47, 89.00, 2, “123”));
lineItems.add(new LineItem(“p11”, 28, 41.00, 3, “123”));
. . .
Order duke = home.create(“123”, “c44”, “open”,
   totalItems(lineItems), lineItems);

Other methods in theOrderBean class also access both database tables. T
ejbRemove method, for example, deletes not only a row from theorders table,
but also deletes all corresponding rows in thelineitems table. TheejbLoad and
ejbStore methods synchronize the state of anOrderEJB instance, including the
lineItems ArrayList, with theorders andlineitems tables.

TheejbFindByProductId method enables clients to locate all orders that hav
particular line item. This method queries thelineitems table for all rows with a
particularproductId. The method returns aCollection of productId String
objects. TheOrderClient program iterates through theCollection and prints
the primary key of each order:

Collection c = home.findByProductId(“p67”);
Iterator i=c.iterator();
while (i.hasNext()) {
   Order order = (Order)i.next();
   String id = (String)order.getPrimaryKey();
   System.out.println(id);
 }

Running the OrderEJB Example

1. Create theorders database table:

a. Go to thej2eetutorial/examples/src directory.

b. Typeant create-order-table.

2. Deploy the OrderApp.ear file (located in thej2eetutorial/exam-
ples/ears directory).

3. Run the client:

a. Go to thej2eetutorial/examples/ears directory.

b. Set theAPPCPATH environment variable to OrderAppClient.jar.

c. Type the following command on a single line:

runclient -client OrderApp.ear -name OrderClient
-textauth
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d. At the login prompts, enterguest for the user name andguest123 for
the password.

An Entity Bean for the Child Table

You should consider building an entity bean for a child table under the follow
conditions:

• The information in the child table is not dependent on the parent table

• The business entity of the child table could exist without that of the par
table.

• The child table might be accessed by another application that does
access the parent table.

These conditions exist in the following scenario. Suppose that each sales r
sentative in a company has multiple customers and that each customer has
one sales representative. The company tracks its sales force with a dat
application. In the database, each row in thesalesrep table (parent) matches
multiple rows in thecustomer table (child). Figure 16 illustrates this relation
ship.

.

Figure 16 One-to-Many Relationship: Sales Representative and Customers

TheSalesRepBean andCustomerBean entity bean classes implement the one-t
many relationship of the ofsales andcustomer tables.

Source Code. The source code for this example is in th
j2eetutorial/examples/src/ejb/salesrep directory. To compile the code,
go to thej2eetutorial/examples/src directory and typeant salesrep. A
sampleSalesRepApp.ear file is in the j2eetutorial/examples/ears direc-
tory.

1 : Many

SalesRep Table

salesrepid (PK) 
name

Customer Table

customerid (PK) 
salesrepid (FK) 
name
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The SalesRepBean class contains a variable namedcustomerIds, which is an
ArrayList of String elements. TheseString elements identify which custom-
ers belong to the sales representative. Because thecustomerIds variable reflects
this relationship, theSalesRepBean class must keep the variable up to date.

TheSalesRepBean class instantiates thecustomerIds variable in thesetEnti-
tyContext method, not inejbCreate. The container invokessetEntityCon-
text just once—when it creates the bean instance—ensuring thatcustomerIds

is instantiated just once. Because the same bean instance can assume di
identities during its life cycle, instantiatingcustomerIds in ejbCreate might
cause multiple and unnecessary instantiations. Therefore, theSalesRepBean

class instantiates thecustomerIds variable insetEntityContext:

public void setEntityContext(EntityContext context) {

   this.context = context;
   customerIds = new ArrayList();

   try {
      makeConnection();
      Context initial = new InitialContext();
      Object objref =

initial.lookup(“java:comp/env/ejb/Customer”);

      customerHome =
        (CustomerHome)PortableRemoteObject.narrow(objref,
         CustomerHome.class);
   } catch (Exception ex) {
       throw new EJBException(“setEntityContext: “ +
          ex.getMessage());
   }
}

Invoked by theejbLoad method,loadCustomerIds is a private method that
refreshes thecustomerIds variable. There are two approaches when coding
method such asloadCustomerIds: fetch the identifiers from thecustomer data-
base table or get them from theCustomerEJB entity bean. Fetching the identifi-
ers from the database might be faster, but exposes the code in theSalesRepBean

class to theCustomerEJB bean’s underlying database table. In the future, if yo
were to change theCustomerEJB bean’s table (or move the bean to a differen
J2EE server), then you might need to change theSalesRepBean code. But if the
SalesRepBean class gets the identifiers from theCustomerEJB entity bean, no
coding changes would be required. The two approaches present a trade-off
formance versus flexibility. TheSalesRepEJB example opts for flexibility, load-
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ing thecustomerIds variable by calling thefindSalesRep andgetPrimaryKey
methods of theCustomerEJB bean. Here is the code for theloadCustomerIds
method:

private void loadCustomerIds() {

   customerIds.clear();

   try {
      Collection c = customerHome.findBySalesRep(salesRepId);
      Iterator i=c.iterator();

      while (i.hasNext()) {
         Customer customer = (Customer)i.next();
         String id = (String)customer.getPrimaryKey();
         customerIds.add(id);
      }

} catch (Exception ex) {
throw new EJBException(“Exception in loadCustomerIds: “ +

          ex.getMessage());
}

}

If a customer’s sales representative changes, the client program updates the
base by calling thesetSalesRepId method of theCustomerBean class. The next
time a business method of theSalesRepBean class is called, theejbLoad method
invokes loadCustomerIds, which refreshes thecustomerIds variable. (To
ensure thatejbLoad is invoked before each business method, set the transac
attributes of the business methods to Required.) For example, theSalesRepCli-

ent program changes thesalesRepId for a customer named Mary Jackson:

Customer mary = customerHome.findByPrimaryKey(“987”);
mary.setSalesRepId(“543”);

The salesRepId 543 identifies a sales representative named Janice Martin
list all of Janice’s customers, theSalesRepClient program invokes thegetCus-
tomerIds method, iterates through the ArrayList of identifiers, and locates e
CustomerEJB bean by calling its findByPrimaryKey method:

SalesRep janice = salesHome.findByPrimaryKey(“543”);
ArrayList a = janice.getCustomerIds();
i = a.iterator();

while (i.hasNext()) {
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   String customerId = (String)i.next();
   Customer customer =
customerHome.findByPrimaryKey(customerId);
   String name = customer.getName();
   System.out.println(customerId + “: “ + name);
}

Running the SalesRepEJB Example

1. Create the database tables:

a. Go to thej2eetutorial/examples/src directory.

b. Typeant create-salesrep-table.

2. Deploy theSalesRepApp.ear file (located in thej2eetutorial/exam-
ples/ears directory).

3. Run the client:

a. Go to thej2eetutorial/examples/ears directory.

b. Set theAPPCPATH environment variable to SalesRepAppClient.jar.

c. Type the following command on a single line:

runclient -client SalesRepApp.ear -name SalesRepClient
-textauth

d. At the login prompts, enterguest for the user name andguest123 for
the password.

Many-to-Many Relationships
In a many-to-many relationship, each entity may be related to multiple occ
rences of the other entity. For example, a college course has many student
each student may take several courses. In a database, this relationship is
sented by a cross reference table containing the foreign keys. In Figure 17
cross reference table is theenrollment table. (PK indicates a primary key and
FK a foreign key.)
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Figure 17 Many-to-Many Relationship: Students and Courses

These tables are accessed by theStudentBean, CourseBean, andEnrollerBean
classes.

Source Code. The source code for this example is in th
j2eetutorial/examples/src/ejb/enroller directory. To compile the code,
go to thej2eetutorial/examples/src directory and typeant enroller. A
sampleEnrollerApp.ear file is in the j2eetutorial/examples/ears directory.

TheStudentBean andCourseBean classes are complementary. Each class co
tains anArrayList of foreign keys. TheStudentBean class, for example, con-
tains anArrayList namedcourseIds, which identifies the courses the studen
is enrolled in. Likewise, theCourseBean class contains anArrayList named
studentIds.

TheejbLoad method of theStudentBean class adds elements to thecourseIds
ArrayList by calling loadCourseIds, a private method. TheloadCourseIds
method gets the course identifiers from theEnrollerEJB session bean. The
source code for theloadCourseIds method follows:

1 : Many

Student Table

studentid (PK) 
name

Many : 1

Enrollment Table

studentid (FK) 
courseid (FK)

Course Table

courseid (PK) 
name
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private void loadCourseIds() {

   courseIds.clear();

   try {
      Enroller enroller = enrollerHome.create();
      ArrayList a = enroller.getCourseIds(studentId);
      courseIds.addAll(a);

} catch (Exception ex) {
       throw new EJBException(“Exception in loadCourseIds: “ +
          ex.getMessage());

}
}

Invoked by theloadCourseIds method, thegetCourses method of theEnrol-
lerBean class queries theenrollment table:

select courseid from enrollment
where studentid = ?

Only the EnrollerBean class accesses theenrollment table. Therefore, the
EnrollerBean class manages the student-course relationship represented i
enrollment table. If a student enrolls in a course, for example, the client ca
theenroll business method, which inserts a row:

insert into enrollment
values (studentid, courseid)

If a student drops a course, theunEnroll method deletes a row:

delete from enrollment
where studentid = ? and courseid = ?

And if a student leaves the school, thedeleteStudent method deletes all rows
in the table for that student:

delete from enrollment
where student = ?

The EnrollerBean class does not delete the matching row from thestudent

table. That action is performed by theejbRemove method of theStudentBean
class. To ensure that both deletes are executed as a single operation, they s
belong to the same transaction. SeeTransactions (page 335) for more informa
tion.
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Running the EnrollerEJB Example

1. Create the database tables:

a. Go to thej2eetutorial/examples/src directory.

b. Typeant create-enroller-table.

2. Deploy theEnrollerApp.ear file (located in thej2eetutorial/exam-
ples/ears directory).

3. Run the client:

a. Go to thej2eetutorial/examples/ears directory.

b. Set theAPPCPATH environment variable to EnrollerAppClient.jar.

c. Type the following command on a single line:

runclient -client EnrollerApp.ear -name EnrollerClient
-textauth

d. At the login prompts, enterguest for the user name andguest123 for
the password.

Primary Keys for Bean-Managed
Persistence

You specify the primary key class in the entity bean’s deployment descripto
most cases, your primary key class will be aString, anInteger, or some other
class that belongs to the J2SE or J2EE standard libraries. For some entity b
you will need to define your own primary key class. For example, if the bean
a composite primary key (that is, composed of multiple fields) then you m
create a primary key class.

The Primary Key Class
The following primary key class is a composite key— theproductId andven-
dorId fields together uniquely identify an entity bean.

public class ItemKey implements java.io.Serializable {

   public String productId;
   public String vendorId;

   public ItemKey() { };
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   public ItemKey(String productId, String vendorId) {

     this.productId = productId;
     this.vendorId = vendorId;
   }

   public String getProductId() {

      return productId;
   }

   public String getVendorId() {

      return vendorId;
   }

   public boolean equals(Object other) {

      if (other instanceof ItemKey) {
         return (productId.equals(((ItemKey)other).productId)

&& vendorId.equals(((ItemKey)other).vendorId));
      }
      return false;
   }

   public int hashCode() {

      return productId.concat(vendorId).hashCode();
   }
}

For bean-managed persistence, a primary key class must meet these re
ments:

• The access control modifier of the class ispublic.

• All fields are declared aspublic.

• The class has a public default constructor.

• The class implements thehashCode() andequals(Object other) meth-
ods.

• The class is serializable.
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Primary Keys in the Entity Bean Class
With bean-managed persistence, theejbCreate method assigns the input param
eters to instance variables and then returns the primary key class:

public ItemKey ejbCreate(String productId, String vendorId,
   String description) throws CreateException {

   if (productId == null || vendorId == null) {
      throw new CreateException(
                “The productId and vendorId are required.”);
   }

   this.productId = productId;
   this.vendorId = vendorId;
   this.description = description;

   return new ItemKey(productId, vendorId);
}

The ejbFindByPrimaryKey verifies the existence of the database row for th
given primary key:

public ItemKey ejbFindByPrimaryKey(ItemKey primaryKey)
   throws FinderException {

   try {
      if (selectByPrimaryKey(primaryKey))
         return primaryKey;
   ...
}

private boolean selectByPrimaryKey(ItemKey primaryKey)
   throws SQLException {

   String selectStatement =
         “select productid “ +
         “from item where productid = ? and vendorid = ?”;
   PreparedStatement prepStmt =
         con.prepareStatement(selectStatement);
   prepStmt.setString(1, primaryKey.getProductId());
   prepStmt.setString(2, primaryKey.getVendorId());
   ResultSet rs = prepStmt.executeQuery();
   boolean result = rs.next();
   prepStmt.close();
   return result;
}
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Getting the Primary Key
A client can fetch the primary key of an entity bean by invoking thegetPrima-

ryKey method of theEJBObject class:

SavingsAccount account;
...
String id = (String)account.getPrimaryKey();

The entity bean retrieves its own primary key by calling thegetPrimaryKey

method of theEntityContext class:

EntityContext context;
...
String id = (String) context.getPrimaryKey();

Handling Exceptions
The exceptions thrown by enterprise beans fall into two categories: system
application.

A system exception indicates a problem with the services that support an a
cation. Examples of these problems include the following: a database conne
cannot be obtained, a SQL insert fails because the database is full, alookup

method cannot find the desired object. If your enterprise bean encounters a
tem-level problem, it should throw ajavax.ejb.EJBException. The container
will wrap theEJBException in a RemoteException, which it passes back to the
client. Because theEJBException is a subclass of theRuntimeException, you
do not have to specify it in thethrows clause of the method declaration. If a sys
tem exception is thrown, the EJB container might destroy the bean insta
Therefore, a system exception cannot be handled by the bean’s client progra
requires intervention by a system administrator.

An application exception signals an error in the business logic of an enterp
bean. There are two types of application exceptions: customized and predefi
A customized exception is one that you’ve coded yourself, such as theInsuffi-

centBalanceException thrown by thedebit business method of theSav-
ingsAccountEJB example. Thejavax.ejb package includes several predefine
exceptions that are designed to handle common problems. For example, anejb-

Create method should throw aCreateException to indicate an invalid input
parameter. When an enterprise bean throws an application exception, the
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any application exception it receives.

If a system exception occurs within a transaction, the EJB container rolls b
the transaction. However, if an application exception is thrown within a trans
tion, the container does not roll back the transaction.

The following table summarizes the exceptions of thejavax.ejb package. All
of these exceptions are application exceptions, except for theNoSuchEntityEx-

ception and theEJBException, which are system exceptions.

Table 6 Exceptions

Method Name Exception It Throws Reason for Throwing

ejbCreate CreateException
An input parameter is
invalid.

ejbFindByPrimaryKey
(and other finder
methods that return
a single object)

ObjectNotFoundException
(subclass of FinderException)

The database row for the
requested entity bean is
cannot be found.

ejbRemove RemoveException
The entity bean’s row can-
not be deleted from the
database.

ejbLoad NoSuchEntityException
The database row to be
loaded cannot be found.

ejbStore NoSuchEntityException
The database row to be
updated cannot be found.

(all methods) EJBException
A system problem has
been encountered.
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Container-Managed
Persistence Examples

by Dale Green

AN entity bean with container-managed persistence offers important ad
tages to the bean developer. First, the EJB™ container handles all database
age and retrieval calls. The container also manages the relationships betwe
entity beans. Because of these services, you don’t have to code the dat
access calls in the entity bean. Instead, you specify settings in the bean’s de
ment descriptor. Not only does this approach save you time, but it makes
bean portable across various database servers.

This chapter focuses on the source code and deployment settings for an exa
calledRosterApp, an application that features entity beans with container-m
aged persistence. If you are unfamiliar with the terms and concepts mention
this chapter, please consult the section,Container-Managed
Persistence (page 79).

Overview of the RosterApp Application 144
The PlayerEJB Code 145

Entity Bean Class 146
Local Home Interface 150
Local Interface 151

A Guided Tour of the RosterApp Settings 152
RosterApp 152
RosterClient 152
RosterJAR 153
TeamJAR 154
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Bios.html


146 CONTAINER-MANAGED PERSISTENCEEXAMPLES

69

1

rts

y

. The
ip.
alue
EJB
port

is
ague.
Method Invocations in RosterApp 157
Creating a Player 158
Adding a Player To a Team 159
Removing a Player 160
Dropping a Player From a Team 161
Getting the Players Of a Team 162
Getting a Copy of a Team’s Players 163
Finding the Players By Position 165
Getting the Sports of a Player 166

Running the RosterApp Example 168
Setting Up 168
Deploying the Application 168
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Specifying the Bean’s Type 169
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The Primary Key Class 172
Primary Keys in the Entity Bean Class 173
Generating Primary Key Values 174

Overview of the RosterApp Application
The RosterApp application maintains the team rosters for players in spo
leagues. The application has five components. TheRosterAppClient compo-
nent is a J2EE™ application client that accesses theRosterEJB session bean
through the bean’s remote interfaces. TheRosterEJB bean accesses three entit
beans—PlayerEJB, TeamEJB, andLeagueEJB—through their local interfaces.

The entity beans use container-managed persistence and relationships
TeamEJB andPlayerEJB beans have a bidirectional, many-to-many relationsh
In a bidirectional relationship, each bean has a relationship field whose v
identifies the related bean instance. The multiplicity of the TeamEJB-Player
relationship is many-to-many: Players who participate in more than one s
belong to multiple teams and each team has multiple players. TheLeagueEJB

andTeamEJB beans also have a bidirectional relationship, but the multiplicity
one-to-many: A league has many teams but a team can belong to just one le
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Figure 18 shows the components and relationships of theRosterApp application.
The dotted lines represent the access gained through invocations of the
lookup method. The solid lines represent the container-managed relationsh

Figure 18 RosterApp J2EE™ Application

The PlayerEJB Code
ThePlayerEJB entity bean represents a player in a sports league. Like any en
bean with container-managed persistence, thePlayerEJB bean needs the follow-
ing code:

• Entity Bean Class (PlayerBean)

• Local Home Interface (LocalPlayerHome)

• Local Interface (LocalPlayer)

Source Code. The source code for this example is in th
j2eetutorial/examples/src/ejb/cmproster directory. To compile the code,
go to thej2eetutorial/examples/src directory and typeant cmproster. A
sampleRosterApp.ear file is in the j2eetutorial/examples/ears directory.

PlayerEJB TeamEJB LeagueEJB

RosterClient

RosterEJB

Many : Many Many : One
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For container-managed persistence, the code of the entity bean class mus
the several syntax requirements. First, the class must be defined aspublic and
abstract. Also, the class must implement the following:

• TheEntityBean interface

• Zero or moreejbCreate andejbPostCreate methods

• The get and set access methods, defined asabstract, for the persistent and
relationship fields

• Any select methods, defining them asabstract

• The home methods

• The business methods.

The entity bean class must not implement these methods:

• The finder methods

• Thefinalize method

Differences Between Container-Managed and Bean-Managed
Code

Because it contains no calls to access the database, an entity bean with cont
managed persistence requires a lot less code than one with bean-managed
tence. For example, thePlayerBean.java source file discussed in this chapter i
much smaller than theSavingsAccountBean.java code documented in the
Bean-ManagedPersistenceExamples (page 109) chapter. The following tab
compares the code of the two types entity beans.

Table 7 Coding Differences Between Persistent Types

Difference Container-Managed Bean-Managed

class definition abstract not abstract

database access calls generated by tools coded by developers

persistent state
represented by virtual
persistent fields

coded as instance
variables

access methods for per-
sistent and relationship
fields

required none
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Note that for both types of persistence, the rules for implementing business
home methods are the same. SeeThe BusinessMethods (page 116) andThe
Home Methods (page 118).

Access Methods

An entity bean with container-managed persistence has persistent and rela
ship fields. These fields are virtual, so you do not code them in the clas
instance variables. Instead, you specify them in the bean’s deployment des
tor. To permit access to the fields, you define abstract get and set methods
entity bean class.

Access Methods for Persistent Fields. The EJB container automatically
performs the database storage and retrieval of the bean’s persistent fields
deployment descriptor of thePlayerEJB bean specifies the following persisten
fields:

• playerId (primary key)
• name

• position

• salary

ThePlayerBean class defines the access methods for the persistent fields as
lows:

public abstract String getPlayerId();
public abstract void setPlayerId(String id);

public abstract String getName();

findByPrimaryKey
method

handled by container coded by developers

customized
finder methods

handled by container, but the
developer must define the EJB
QL queries

coded by developers

select methods handled by container none

return value of ejbCreate should be null must be the primary key

Table 7 Coding Differences Between Persistent Types (Continued)

Difference Container-Managed Bean-Managed
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public abstract void setName(String name);

public abstract String getPosition();
public abstract void setPosition(String position);

public abstract double getSalary();
public abstract void setSalary(double salary);

The name of an access method begins withget or set, followed by the capital-
ized name of the persistent or relationship field. For example, the accessor m
ods for thesalary field aregetSalary andsetSalary. This naming convention
is similar to that of JavaBeans™ components.

Access Methods for Relationship Fields. In the RosterApp application,
since a player can belong to multiple teams, aPlayerEJB instance may be
related to manyTeamEJB instances. To specify this relationship, the deployme
descriptor of thePlayerEJB defines a relationship field namedteams. In the
PlayerBean class, the access methods for theteams relationship field are as fol-
lows:

public abstract Collection getTeams();
public abstract void setTeams(Collection teams);

Select Methods

A select method is similar to a finder method in the following ways:

• A select method queries a database and returns objects.

• The deployment descriptor specifies an EJB QL query for a select met

• The entity bean class does not implement the select method.

However, a select method differs significantly from a finder method:

• A select method can return persistent fields or the home interface
related entity beans. A finder method can return only the home interf
(or a collection thereof) that defines it.

• Since it is not exposed in any of the local or remote interfaces, a se
method cannot be invoked by a client. It may be invoked only by the me
ods implemented within the entity bean class. A select method is usu
invoked by a business method.

• A select method is defined in the entity bean class. For bean-managed
sistence, a finder method is defined in the entity bean class, but for c
tainer-managed persistence it is not.
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ThePlayerBean class defines these select methods:

public abstract Collection ejbSelectLeagues(LocalPlayer player)
    throws FinderException;

public abstract Collection ejbSelectSports(LocalPlayer player)
    throws FinderException;

The signature for a select method must follow these rules:

• The prefix of the method name must beejbSelect.

• The access control modifier must bepublic.

• The method must be declared asabstract.

• The throws clause must include thejavax.ejb.FinderException.

Business Methods

Since clients cannot invoke select methods, thePlayerBean class wraps them in
thegetLeagues andgetSports business methods:

public Collection getLeagues() throws FinderException {

     LocalPlayer player =
         (team.LocalPlayer)context.getEJBLocalObject();
     return ejbSelectLeagues(player);
}

public Collection getSports() throws FinderException {

     LocalPlayer player =
         (team.LocalPlayer)context.getEJBLocalObject();
     return ejbSelectSports(player);
}

Entity Bean Methods

Because the container handles persistence, the life-cycle methods in thePlayer-

Bean class are nearly empty.

TheejbCreate method initializes the bean instance by assigning the input ar
ments to the persistent fields. After theejbCreate method completes, the con
tainer inserts a row into the database. Here is the source code for theejbCreate

method:
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public String ejbCreate (String id, String name,
    String position, double salary) throws CreateException {

    setPlayerId(id);
    setName(name);
    setPosition(position);
    setSalary(salary);
    return id;
}

Except for a debug statement, theejbRemove method in thePlayerBean class is
empty. The container invokesejbRemove right before it deletes the database row

The ejbPostCreate method must have the same input parameters and re
type as theejbCreate method. If you want to set a relationship field to initializ
the bean instance, you should do so in theejbPostCreate method. You may not
set a relationship field in theejbCreate method.

The container automatically synchronizes the state of the entity bean with
database. After the container loads the bean’s state from the database, it in
theejbLoad method. In like manner, before storing the state in the database
container invokes theejbStore method.

Local Home Interface
The local home interface defines thecreate, finder, and home methods that ma
be invoked by local clients.

The syntax rules for acreate method follow:

• The name begins withcreate.

• It has the same number and types of arguments as its matchingejbCreate

method in the entity bean class.

• It returns the local interface type of the entity bean.

• Thethrows clause includes the exceptions specified by thethrows clause
of the correspondingejbCreate method.

• The throws clause contains thejavax.ejb.CreateException.

These rules apply for a finder method:

• The name begins withfind.

• The return type is the entity bean’s local interface type, or a collection
those types.

• Thethrows clause contains thejavax.ejb.FinderException.
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• ThefindByPrimaryKey method must be defined.

An excerpt of theLocalPlayerHome interface follows:

package team;

import java.util.*;
import javax.ejb.*;

public interface LocalPlayerHome extends EJBLocalHome {

    public LocalPlayer create (String id, String name,
        String position, double salary)
        throws CreateException;

    public LocalPlayer findByPrimaryKey (String id)
        throws FinderException;

    public Collection findByPosition(String position)
        throws FinderException;
     . . .
    public Collection findByLeague(LocalLeague league)
        throws FinderException;
    ...
  }

Local Interface
This interface defines the business and access methods that a local clien
invoke. ThePlayerBean class implements two business methods:getLeagues

andgetSports. It also defines several get and set access methods for the pe
tent and relationship fields. The set methods are hidden from the bean’s cl
because they are not defined in theLocalPlayer interface. However, the get
methods are exposed to the clients by the interface:

package team;

import java.util.*;
import javax.ejb.*;

public interface LocalPlayer extends EJBLocalObject {

    public String getPlayerId();
    public String getName();
    public String getPosition();
    public double getSalary();
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    public Collection getTeams();

    public Collection getLeagues() throws FinderException;
    public Collection getSports() throws FinderException;
}

A Guided Tour of the RosterApp Settings
This section introduces you to the settings of the deployment descriptors
entity beans with container-managed persistence and relationships. As this
guides you through thedeploytool screens, it discusses the highlights of th
tabbed panes and dialog boxes that appear.

To begin our tour, please run thedeploytool and open theRosterApp.ear file,
which is in thej2eetutorial/examples/ears directory.

RosterApp
To view the deployment settings for the application, select theRosterApp node
in the tree view.

General Tabbed Pane (RosterApp)

The Contents field displays the files contained in theRosterApp.ear file,
including the two EJB JAR files (team-ejb.jar, roster-ejb.jar) and the
J2EE application client JAR file (roster-ac.jar).

JNDI Names Tabbed Pane (RosterApp)

The Application table lists the JNDI names for the enterprise beans in theRos-

terApp application.

The References table has two entries. The EJB Ref entry maps the coded
(ejb/SimpleRoster) in theRosterClient to the JNDI name of theRosterEJB
session bean. The Resource entry specifies the JNDI name for the databas
is accessed by the entity beans contained in theTeamJAR module.

RosterClient
To view this client, expand theRosterApp node by clicking its adjacent key icon
in the tree view. Next, selectRosterClient.
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JAR File Tabbed Pane (Roster Client)

The Contents field shows the files contained by theroster-ac.jar file: two
XML files (the deployment descriptors) and a single class file (RosterCli-

ent.class).

EJB Refs Tabbed Pane (Roster Client)

TheRosterClient accesses a single bean, theRosterEJB session bean. Becaus
this access is remote, the value in the Interfaces column is Remote and the
for the Local/Remote Interface column is the bean’s remote interface (ros-

ter.Roster).

RosterJAR
In the tree view, selectRosterJAR. This JAR file contains theRosterEJB session
bean.

General Tabbed Pane (RosterJAR)

The Contents field lists three packages of class files. Theroster package con-
tains the class files required for theRosterEJB—the session bean class, remo
interface, and home interface. Theteam package includes the local interfaces fo
the entity beans accessed by theRosterEJB session bean. Theutil package
holds the utility classes for this application.

RosterEJB

In the tree view, expand theRosterJAR node and selectRosterEJB.

General Tabbed Pane (RosterEJB). This tabbed pane shows thatRos-
terEJB is a stateful session bean with remote access. Since it allows no l
access, the Local Interfaces fields are empty.

EJB Refs Tabbed Pane (RosterEJB). The RosterEJB session bean accesse
three entity beans:PlayerEJB, TeamEJB, andLeagueEJB. Because this access is
local, the entries in the Interfaces columns are defined as Local. The Home I
face column lists the local home interfaces of the entity beans. T
Local/Remote Interfaces column displays the local interfaces of the entity be

To view the runtime deployment settings, select a row in the table. For exam
when you select the row with the Coded Name ofejb/SimpleLeague, the
LeagueEJB name appears in the Enterprise Bean Name Field. If a compon



156 CONTAINER-MANAGED PERSISTENCEEXAMPLES

nced

d

rfaces

con-
sum-

B. In

ve

the
e is

ny
player

ion-
ip
references a local entity bean, then you must enter the name of the refere
bean in the Enterprise Bean Name field.

TeamJAR
In the tree view, select theTeamJAR node. This JAR file contains the three relate
entity beans:LeagueEJB, TeamEJB, andPlayerEJB.

General Tabbed Pane (TeamJAR)

The Contents field shows two packages of class files:team andutil. Theteam
package has the entity bean classes, local interfaces, and local home inte
for all three entity beans. Theutil package contains utility classes.

Relationships Tabbed Pane (TeamJAR)

On this tabbed pane you define the relationships between entity beans with
tainer-managed persistence. The Container Managed Relationships table
marizes two relationships: TeamEJB-PlayerEJB and LeagueEJB-TeamEJ
the TeamEJB-PlayerEJB relationship, theTeamEJB bean is designated as EJB A
and thePlayerEJB bean as EJB B. (This designation is arbitrary—we could ha
assignedPlayerEJB to EJB A andTeamEJB to EJB B.)

Edit Relationship Dialog Box (TeamJAR). To view this dialog box, on the
Relationships tab select a row and click Edit. For example, to view
TeamEJB-PlayerEJB relationship, select the row in which the EJB A valu
Team and then click Edit.

TeamEJB-PlayerEJB Relationship

The Multiplicity combo box offers four choices. For this relationship, the Ma
to Many choice should be selected because a team has many players and a
can belong to more than one team.

The information in the Enterprise Bean A box defines theTeamEJB bean’s side of
the relationship. The Field Referencing Bean B combo box displays the relat
ship field (players) in TeamEJB. This field corresponds to the relationsh
access methods in theTeamBean.java source code:

public abstract Collection getPlayers();
public abstract void setPlayers(Collection players);

The selection of the Field Type combo box isjava.util.Collection, which
matches theplayers type in the access methods. Theplayers type is a multi-
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valued object (Collection) because on theTeamEJB side of the relationship the
multiplicity is many. (The type is aCollection instead of aSet because aCol-
lection does not allow duplicates—a player cannot belong to the same te
more than once.)

The TeamEJB-PlayerEJB relationship is bidirectional—each bean has a rela
ship field that identifies the related bean. If this relationship were unidirectio
then one of the beans would not have a relationship field identifying the o
bean. For the bean without the relationship field, the value of the Field Refer
ing combo box would be<none>.

LeagueEJB-TeamEJB Relationship

In the Edit Relationship dialog box, the Multiplicity choice should be One
Many. This choice indicates that a single league has multiple teams.

For the LeagueEJB, the relationship field isteams and for theTeamEJB it is
league. Because theTeamEJB is on the multiple side of the relationship, th
teams field is aCollection. In contrast, since theLeagueEJB is on the single
side of the relationship, theleague field is a single-valued object, aLocal-
League. The TeamBean.java code defines the league relationship field wit
these access methods:

public abstract LocalLeague getLeague();
public abstract void setLeague(LocalLeague players);

For theTeamEJB (Enterprise Bean B), the Delete When Bean A is Deleted che
box is selected. Because of this selection, when aLeagueEJB instance is deleted
the relatedTeamEJB instances are automatically deleted. This type of deletion
which one deletion triggers another, is called acascade delete. For the
LeagueEJB, the corresponding checkbox is disabled: If you delete a team,
don’t want to automatically delete the league because there may be other t
in that league. In general, if a bean is on the multiple side of a relationship,
other bean cannot be automatically deleted.

PlayerEJB

In the tree view, expand theTeamJAR node and select thePlayerEJB entity bean.

General Tabbed Pane (PlayerEJB). This tab shows the enterprise bea
class and interfaces. SincePlayerEJB entity bean uses container-managed pe
sistence, it has local interfaces. It does not have remote interfaces because i
not allow remote access.
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Entity Tabbed Pane (PlayerEJB). The radio buttons at the top define th
bean’s persistence type. For thePlayerEJB, bean this type is container-manage
persistence, version 2.0. Since version 1.0 did not support relationships, it is
recommended. These version numbers identify a particular release of theEnter-
prise JavaBeans™ Specification, not the J2EE SDK software.

The Fields To Be Persisted box lists the persistent and relationship fields de
by the access methods in thePlayerBean.java code. The checkboxes for the
persistent fields must be selected, but those for the relationship fields must n
selected. ThePlayerEJB bean has one relationship field:teams.

The Abstract Schema Name isPlayer, a name that represents the relationshi
and persistent fields of thePlayerEJB entity bean. This abstract name is refe
enced in thePlayerEJB bean’s Enterprise JavaBeans™ (EJB™ QL) queries. F
more information on EJB QL, see the chapter,EnterpriseJavaBeans™Query
Language (page 187).

Finder/Select Methods Dialog Box (PlayerEJB). To open this dialog box,
on the Entity tabbed pane click Finder/Select Methods.

This dialog box enables you to view and edit the EJB QL queries for a bea
finder and select methods. For example, to list the finder methods defined in
LocalPlayerHome interface, select the Local Finders radio button. When y
select the finder method, its EJB QL query appears in an editable text field.

Entity Deployment Settings Dialog Box (PlayerEJB). To view this dia-
log box, in the Entity tabbed pane click Deployment Settings.

In this dialog box, you define the runtime settings of an entity bean with c
tainer-managed persistence. These runtime settings are specific to the J2
SDK; other implementations of the J2EE platform may take a differe
approach.

In the J2EE SDK, the bean’s persistent fields are stored in a relational data
table. In the checkboxes of the Database Table box, you specify whether o
the server automatically creates or drops the table. If you want to save the da
your table between deployments, then make sure that the Delete Table chec
is not selected. Otherwise, every time you undeploy the bean, the table wi
deleted.

The J2EE server accesses the database by issuing SQL calls. In an entity
with container-managed persistence, you do not code these calls. Thedeploy-

tool creates the SQL calls automatically when you click the Generate Def
SQL button. To view the SQL statement for a finder method, for example, se
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the Local Finder radio button and then select an entry in the Method list. Y
may modify a SQL statement by editing the text in the SQL Query field.

For the finder and select methods, the corresponding EJB QL query is also
played. When you click Generate Default SQL, thedeploytool translates the
EJB QL queries into SQL calls. If you change an EJB QL query, you sho
click the Generate Default SQL button again.

To view the SQLCREATE TABLE statement, for example, click the Containe
Methods radio button and then select the createTable entry in the Method
The CREATE TABLE statement defines column names for the bean’s persis
fields and specifies a primary key constraint forplayerId, the bean’s primary
key field.

When the EJB container creates a newPlayerEJB instance, it issues a SQL
INSERT statement. To examine this statement, select createRow from the Me
list. In theINSERT statement, the parameters in thevalues clause correspond to
the arguments of thecreate method that is defined in theLocalPlayerHome
interface:

public LocalPlayer create (String id, String name,
    String position, double salary) throws CreateException;

Database Deployment Settings Dialog Box (PlayerEJB). To access this
dialog box, on the Entity tabbed pane click Deployment Settings. On
Deployment Settings dialog box that appears, click Database Settings.
Deployment Settings dialog box with the Database Settings label should ap

It is important that you set the JNDI name of the database. (If it is not set,
bean cannot connect to the database.) For this example, the Database
Name field should bejdbc/Cloudscape. The User Name and Password field
are blank because they are not required for Cloudscape.

Method Invocations in RosterApp
To show how the various components interact, this section describes
sequence of method invocations that occur for particular functions. The so
code for the components is in thej2eetutorial/examples/src/ejb/cmpros-
ter directory.
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Creating a Player

1. RosterClient

The RosterClient invokes thecreatePlayer business method of theRos-
terEJB session bean. In the following line of code, the type of themyRoster

object isRoster, the remote interface of theRosterEJB bean. The argument of
thecreatePlayer method is aPlayerDetails object, which encapsulates infor
mation about a particular player.

myRoster.createPlayer(new PlayerDetails(“P1”, “Phil Jones”,
    “goalkeeper”, 100.00));

2. RosterEJB

The createPlayer method of theRosterEJB session bean creates a ne
instance of thePlayerEJB entity bean. Because the access toPlayerEJB bean is
local, thecreate method is defined in the local home interface,LocalPlayer-

Home. The type of theplayerHome object is LocalPlayerHome. Here is the
source code for thecreatePlayer method:

public void createPlayer(PlayerDetails details) {

try {
LocalPlayer player = playerHome.create(details.getId(),

           details.getName(), details.getPosition(),
           details.getSalary());
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}

3. PlayerEJB

The ejbCreate method assigns the input arguments to the bean’s persis
fields by calling the set access methods. After invoking theejbCreate method,
the container saves the persistent fields in the database by issuing a SQLINSERT

statement. The code for theejbCreate method follows.

public String ejbCreate (String id, String name,
    String position,double salary) throws CreateException {

    setPlayerId(id);
    setName(name);
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    setPosition(position);
    setSalary(salary);
    return id;
}

Adding a Player To a Team

1. RosterClient

The RosterClient calls the addPlayer business method of theRosterEJB
bean. TheP1 and T1 parameters are the primary keys of thePlayerEJB and
TeamEJB instances, respectively.

 myRoster.addPlayer(“P1”, “T1”);

2. RosterEJB

TheaddPlayer method performs two steps. First, it callsfindByPrimaryKey to
locate thePlayerEJB andTeamEJB instances. Second, it invokes theaddPlayer
business method of theTeamEJB bean. Here is the source code for theaddPlayer

method of theRosterEJB session bean:

public void addPlayer(String playerId, String teamId) {

    try {
        LocalTeam team = teamHome.findByPrimaryKey(teamId);
        LocalPlayer player =
            playerHome.findByPrimaryKey(playerId);
        team.addPlayer(player);
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}

3. TeamEJB

TheTeamEJB entity bean has a relationship field namedplayers, aCollection

that represents the players that belong to the team. The access methods f
players relationship field are as follows:

public abstract Collection getPlayers();
public abstract void setPlayers(Collection players);

The addPlayer method of theTeamEJB bean invokes thegetPlayers access
method to fetch theCollection of relatedLocalPlayer objects. Next, the
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addPlayer method invokes theadd method of theCollection interface. Here is
the source code for theaddPlayer method:

public void addPlayer(LocalPlayer player) {
    try {
        Collection players = getPlayers();
        players.add(player);
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}

Removing a Player

1. RosterClient

To remove playerP4, the client would invoke theremovePlayer method of the
RosterEJB session bean:

myRoster.removePlayer(“P4”);

2. RosterEJB

TheremovePlayer method locates thePlayerEJB instance by callingfindByP-
rimaryKey and then invokes theremove method on the instance. This invocatio
signals the container to delete the row in the database that corresponds t
PlayerEJB instance. The container also removes the item for this instance f
the players relationship field in theTeamEJB entity bean. By this removal, the
container automatically updates the TeamEJB-PlayerEJB relationship. He
theremovePlayer method of theRosterEJB session bean:

public void removePlayer(String playerId) {
    try {
        LocalPlayer player =
            playerHome.findByPrimaryKey(playerId);
        player.remove();
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}
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Dropping a Player From a Team

1. RosterClient

To drop playerP2 from teamT1, the client would call thedropPlayer method of
theRosterEJB session bean:

myRoster.dropPlayer(“P2”, “T1”);

2. RosterEJB

ThedropPlayer method retrieves thePlayerEJB andTeamEJB instances by call-
ing theirfindByPrimaryKey methods. Next, it invokes thedropPlayer business
method of theTeamEJB entity bean. ThedropPlayer method of theRosterEJB
bean follows:

public void dropPlayer(String playerId, String teamId) {

    try {
        LocalPlayer player =
            playerHome.findByPrimaryKey(playerId);
        LocalTeam team = teamHome.findByPrimaryKey(teamId);
        team.dropPlayer(player);
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}

3. TeamEJB

The dropPlayer method updates the TeamEJB-PlayerEJB relationship. Fi
the method retrieves theCollection of LocalPlayer objects that correspond to
the players relationship field. Next, it drops the targetplayer by calling the
remove method of theCollection interface. Here is thedropPlayer method of
theTeamEJB entity bean:

public void dropPlayer(LocalPlayer player) {

  try {
        Collection players = getPlayers();
        players.remove(player);
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }
}
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Getting the Players Of a Team

1. RosterClient

The client can fetch a team’s players by calling thegetPlayersOfTeam method
of theRosterEJB session bean. This method returns anArrayList of Player-
Details objects. APlayersDetails object contains four variables—playerId,
name, position, and salary—which are copies of thePlayerEJB persistent
fields. TheRosterClient calls thegetPlayersOfTeam method as follows:

playerList = myRoster.getPlayersOfTeam("T2");

2. RosterEJB

The getPlayersOfTeam method of theRosterEJB session bean locates the
LocalTeam object of the target team by invoking thefindByPrimaryKey
method. Next, thegetPlayersOfTeam method calls thegetPlayers method of
the TeamEJB entity bean. Here is the source code for thegetPlayersOfTeam

method:

public ArrayList getPlayersOfTeam(String teamId) {

    Collection players = null;

    try {
        LocalTeam team = teamHome.findByPrimaryKey(teamId);
        players = team.getPlayers();
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }

    return copyPlayersToDetails(players);
}

The getPlayersOfTeam method returns theArrayList of PlayerDetails

objects that is generated by thecopyPlayersToDetails method:

private ArrayList copyPlayersToDetails(Collection players) {

     ArrayList detailsList = new ArrayList();
     Iterator i = players.iterator();

     while (i.hasNext()) {
         LocalPlayer player = (LocalPlayer) i.next();
         PlayerDetails details =
             new PlayerDetails(player.getPlayerId(),
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                 player.getName(), player.getPosition(),
                 player.getSalary());
         detailsList.add(details);
     }

     return detailsList;
}

3. TeamEJB

ThegetPlayers method of theTeamEJB entity bean is an access method of th
players relationship field:

public abstract Collection getPlayers();

This method is exposed to local clients because it is defined in the local in
face,LocalTeam:

public Collection getPlayers();

When invoked by a local client, a get access method returns a reference t
relationship field. If the local client alters the object returned by a get acc
method, it also alters the value of the relationship field inside the entity bean.
example, a local client of theTeamEJB entity bean could drop a player from a
team as follows:

LocalTeam team = teamHome.findByPrimaryKey(teamId);
Collection players = team.getPlayers();
players.remove(player);

If you want to prevent a local client from modifying a relationship field in th
manner, then you should take the approach described in the next section.

Getting a Copy of a Team’s Players
In contrast to the methods discussed in the preceding section, the methods i
section demonstrate the following techniques:

• Filtering the information passed back to the remote client

• Preventing the local client from directly modifying a relationship field

1. RosterClient

If you wanted to hide the salary of a player from a remote client, you wo
require the client to call thegetPlayersOfTeamCopy method of theRosterEJB
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session bean. Like thegetPlayersOfTeam method, thegetPlayersOfTeamCopy
method returns anArrayList of PlayerDetails objects. However, the objects
returned bygetPlayersOfTeamCopy are different—theirsalary variables have
been set to zero. TheRosterClient calls thegetPlayersOfTeamCopy method
as follows:

playerList = myRoster.getPlayersOfTeamCopy("T5");

2. RosterEJB

Unlike the getPlayersOfTeam method, thegetPlayersOfTeamCopy method
does not invoke thegetPlayers access method that is exposed in theLocalTeam

interface. Instead, thegetPlayersOfTeamCopy method retrieves a copy of the
player information by invoking thegetCopyOfPlayers business method that is
defined in theLocalTeam interface. As a result, thegetPlayersOfTeamCopy
method cannot modify theplayers relationship field of theTeamEJB bean. Here
is the source code for thegetPlayersOfTeamCopy method of theRosterEJB
bean:

public ArrayList getPlayersOfTeamCopy(String teamId) {

    ArrayList playersList = null;

    try {
        LocalTeam team = teamHome.findByPrimaryKey(teamId);
        playersList = team.getCopyOfPlayers();
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }

    return playersList;
}

3. TeamEJB

The getCopyOfPlayers method of theTeamEJB bean returns anArrayList of
PlayerDetails objects. To create thisArrayList, the method iterates through
the Collection of relatedLocalPlayer objects and copies information to the
variables of thePlayerDetails objects. The method copies the values of th
PlayerEJB bean’s persistent fields—except for thesalary field, which it sets to
zero. As a result, a player’s salary is hidden from a client that invokes theget-

PlayersOfTeamCopy method. The source code for thegetCopyOfPlayers of the
TeamEJB bean follows:
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public ArrayList getCopyOfPlayers() {

    ArrayList playerList = new ArrayList();
    Collection players = getPlayers();

    Iterator i = players.iterator();
    while (i.hasNext()) {
        LocalPlayer player = (LocalPlayer) i.next();
        PlayerDetails details =
            new PlayerDetails(player.getPlayerId(),
            player.getName(), player.getPosition(), 0.00);
        playerList.add(details);
    }

    return playerList;
}

Finding the Players By Position

1. RosterClient

The client starts the procedure by invoking thegetPlayersByPosition method
of theRosterEJB session bean:

playerList = myRoster.getPlayersByPosition("defender");

2. RosterEJB

ThegetPlayersByPosition method retrieves theplayers list by invoking the
findByPosition method of thePlayerEJB entity bean:

public ArrayList getPlayersByPosition(String position) {

   Collection players = null;

    try {
        players = playerHome.findByPosition(position);
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }

    return copyPlayersToDetails(players);
}

3. PlayerEJB

TheLocalPlayerHome interface defines thefindByPosition method:
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public Collection findByPosition(String posistion)
    throws FinderException;

Because thePlayerEJB entity bean uses container-managed persistence,
entity bean class (PlayerBean) does not implement its finder methods. To spe
ify the queries associa1ted with the finder methods, EJB QL queries mus
defined in the bean’s deployment descriptor. For example, thefindByPosition

method has this EJB QL query:

SELECT DISTINCT OBJECT(p) FROM Player p
WHERE p.position = ?1

Thedeploytool translates the EJB QL query into an SQLSELECT statement. At
runtime, when the container invokes thefindByPosition method it will execute
the SQLSELECT statement.

For details about EJB QL, please refer to the chapter,EnterpriseJavaBeans™
QueryLanguage (page 187). To learn how to view and edit an EJB QL quer
the deploytool, seeFinder/Select Methods Dialog Box (PlayerEJB) (page 158

Getting the Sports of a Player

1. RosterClient

The client invokes thegetSportsOfPlayer method of theRosterEJB session
bean:

sportList = myRoster.getSportsOfPlayer("P28");

2. RosterEJB

The getSportsOfPlayer method returns anArrayList of String objects that
represent the sports of the specified player. It constructs theArrayList from a
Collection returned by thegetSports business method of thePlayerEJB.
bean. Here is the source code for thegetSportsOfPlayer method of theRos-
terEJB bean:

public ArrayList getSportsOfPlayer(String playerId) {

ArrayList sportsList = new ArrayList();
    Collection sports = null;

    try {
        LocalPlayer player =
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            playerHome.findByPrimaryKey(playerId);
        sports = player.getSports();
    } catch (Exception ex) {
        throw new EJBException(ex.getMessage());
    }

    Iterator i = sports.iterator();
    while (i.hasNext()) {
        String sport = (String) i.next();
        sportsList.add(sport);
    }
    return sportsList;
}

3. PlayerEJB

The getSports method is a wrapper for theejbSelectSports method. Since
the parameter of theejbSelectSports method is of typeLocalPlayer, the
getSports method passes along a reference to the entity bean instance.
PlayerBean class implements thegetSports method as follows:

public Collection getSports() throws FinderException {

     LocalPlayer player =
         (team.LocalPlayer)context.getEJBLocalObject();
     return ejbSelectSports(player);
}

ThePlayerBean class defines theejbSelectSports method:

public abstract Collection ejbSelectSports(LocalPlayer player)
    throws FinderException;

The bean’s deployment descriptor specifies the following EJB QL query for
ejbSelectSports method:

SELECT DISTINCT t.league.sport
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Before deploying thePlayerEJB entity bean, you run thedeploytool to gener-
ate SQLSELECT statements for the bean’s EJB QL queries. Because thePlay-

erEJB bean uses container-managed persistence, when theejbSelectSports

method is invoked the EJB container will execute its corresponding SQLSELECT

statement.
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Running the RosterApp Example

Setting Up
1. In a terminal window, start the Cloudscape database server.

cloudscape -start

2. In another terminal window, start the J2EE server.

j2ee -verbose

3. Run thedeploytool.

deploytool

Deploying the Application
1. In thedeploytool, open theRosterApp.ear file.

a. Choose File->Open from the main menu.

b. In the Open Object dialog box, navigate to thej2eetutorial/exam-

ples/ears directory.

c. Select theRosterApp.ear file.

d. Click Open Object.

2. Deploy the application.

a. In the deploytool, selectRosterApp from the tree view.

b. Choose Tools->Deploy from the main menu.

c. In the Introduction dialog box, select the Return Client JAR checkb

d. In the Client JAR File Name field, make sure that the file is calledRos-

terAppClient.jar and that its path refers to thej2eetutorial/exam-
ples/ears directory.

e. Click Next until the Review dialog box appears.

f. Click Finish.

Running the Client
1. In a terminal window, go to thej2eetutorial/examples/ears directory.

2. Set theAPPCPATH environment variable toRosterAppClient.jar.
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3. Type the following command:

runclient -client RosterApp.ear -name RosterClient -textauth

4. At the login prompts, enterguest for the user name andguest123 for the
password.

Deploytool Tips for Entity Beans With
Container-Managed Persistence

The GettingStarted (page 47) chapter covered the basic steps for building
packaging enterprise beans. This section highlights the tasks in thedeploytool

that are needed for entity beans with container-managed persistence. The e
ples referenced in this section are fromA Guided Tour of the RosterApp
Settings (page 154).

Specifying the Bean’s Type
In the New Enterprise Bean Wizard, specify the bean’s type and persistent m
agement.

1. In the Edit Contents dialog box, add all of the classes required by the en
bean and by its related beans.

2. In the General dialog box, select the Entity radio button.

3. In the General dialog box, specify the local interfaces of the entity be
(If the bean also has remote interfaces, you specify them as well.)

4. In the Entity Settings dialog box, select the radio button for Contain
Managed Persistence (2.0). You may skip the other settings in this dia
and enter them later in the Entity tabbed pane.

Selecting the Persistent Fields and Abstract Schema
Name
In the Entity tabbed pane, enter the field information and the abstract sch
name.

1. In the Fields To Be Persisted list, select the fields that will be saved in
database. The names of the persistent fields are determined by the a
methods defined in the entity bean code.
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2. Enter values in the Primary Key Class and Primary Key Field Name fie
The primary key uniquely identifies the entity bean.

3. In the Abstract Schema Name field, enter a name that represents the e
bean. This name will be referenced in the EJB QL queries.

Example:Entity Tabbed Pane (PlayerEJB) (page 158)

Defining EJB QL Queries for Finder and Select
Methods
You specify these settings in the Finder/Select Methods dialog box.

1. To open this dialog box, go to the Entity tabbed pane and cl
Finder/Select Methods.

2. To display a set of finder or select methods, click one of the radio butt
under the Show label.

3. To specify an EJB QL query, choose the name of the finder or se
method from the Method list and then enter the query in the field label
EJB QL Query.

Example:Finder/Select Methods Dialog Box (PlayerEJB) (page 158)

Generating SQL and Specifying Table Creation
In the deploytool, the various Deployment Settings dialog boxes enable yo
enter information needed by the server at runtime. These settings are spec
the J2EE SDK implementation.

1. To open this Deployment Settings dialog box, go to the Entity tabbed p
and click Deployment Settings.

2. With container-managed persistence, the container can automatically
ate or delete the database table used by the entity bean. If you’ve loa
test data into the table, you may want to de-select the checkboxes in
Database Table box.

3. To translate the EJB QL queries into SQL SELECT statements, click G
erate Default SQL. If this button is disabled, you must first specify t
database settings.

Example:Entity Deployment Settings Dialog Box (PlayerEJB) (page 158)
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Specifying the Database JNDI Name, User Name,
and Password
You make these settings In the Database Settings dialog box.

1. To open this dialog box, go to the Entity tabbed pane and click Deploym
Settings. In the Deployment Settings dialog box, click Database Setti

2. Enter a value in the Database JNDI Name field. The examples in this b
use the jdbc/Cloudscape JNDI name.

3. The Cloudscape databases shipped with the J2EE SDK does not req
user name or password. So, if your bean connects to the Cloudscape
base, you may leave the User Name and Password fields blank. To con
to other types of databases, you may need to enter values into these fi

Example:Database Deployment Settings Dialog Box (PlayerEJB) (page 159)

Defining Relationships
The Relationships tabbed pane enables you to define relationships bet
entity beans that reside in the same EJB JAR file.

1. Before you create a relationship between two entity beans, you must
create both beans with the New Enterprise Bean wizard.

2. To display the Relationships tabbed pane, select the EJB JAR in the
view and then select the Relationships tab.

3. To add or edit a relationship, go the Relationships tabbed pane and
the appropriate button.

4. The Add (or Edit) Relationship dialog box appears. (The Add Relations
and Edit Relationship dialog boxes are identical.)

Example:Edit Relationship Dialog Box (TeamJAR) (page 156)

Primary Keys for Container-Managed
Persistence

If the primary key class does not belong to the J2SE or J2EE standard libra
then you must implement the class and package it along with the entity bean
example, if your entity bean requires a composite primary key (which is made
of multiple fields), then you need to provide a customized primary key class
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The Primary Key Class
In the following example, thePurchaseOrderKey class implements a composite
key for thePurchaseOrderEJB entity bean. The key is composed of two fields
productModel and vendorId, whose names must match two of the persiste
fields in the entity bean class.

public class PurchaseOrderKey implements java.io.Serializable {

    public String productModel;
    public String vendorId;

    public PurchaseOrderKey() { };

    public String getProductModel() {

        return productModel;
    }

    public String getVendorId() {

        return vendorId;
    }

    public boolean equals(Object other) {

        if (other instanceof PurchaseOrderKey) {
           return (productModel.equals(
               ((PurchaseOrderKey)other).productModel) &&
               vendorId.equals(
               ((PurchaseOrderKey)other).vendorId));
        }
        return false;
    }

    public int hashCode() {

        return productModel.concat(vendorId).hashCode();
    }

}
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For container-managed persistence, a primary key class must meet these re
ments:

• The access control modifier of the class ispublic.

• All fields are declared aspublic.

• The fields are a subset of the bean’s persistent fields.

• The class has a public default constructor.

• The class implements thehashCode() andequals(Object other) meth-
ods.

• The class is serializable.

Primary Keys in the Entity Bean Class
In the PurchaseOrderBean class, the following access methods define the p
sistent fields (vendorId andproductModel) that make up the primary key:

public abstract String getVendorId();
public abstract void setVendorId(String id);

public abstract String getProductModel();
public abstract void setProductModel(String name);

The next code sample shows theejbCreate method of thePurchaseOrderBean
class. The return type of theejbCreate method is the primary key, but the return
value is null. Although not required, for container-managed persistence
null return value is recommended. This approach saves overhead becaus
bean does not have to instantiate the primary key class for the return value.

public PurchaseOrderKey ejbCreate (String vendorId,
    String productModel, String productName)
    throws CreateException {

setVendorId(vendorId);
    setProductModel(productModel);
    setProductName(productName);

    return null;
}
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Generating Primary Key Values
For some entity beans, the value of a primary key has a meaning for the bus
entity. For example, in an entity bean that represents a phone call to a sup
center, the primary key might include a time stamp that indicates when the
was received. But for other beans, the key’s value is arbitrary— provided tha
unique. With container-managed persistence, these key values can be gen
automatically by the EJB container. To take advantage of this feature, an e
bean must meet these requirements:

• In the deployment descriptor, the primary key class is defined a
java.lang.Object. The primary key field is not specified.

• In the home interface, the argument of thefindByPrimaryKey method
must be ajava.lang.Object.

• In the entity bean class, the return type of theejbCreate method must be
ajava.lang.Object.
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A Message-Driven
Bean Example

by Dale Green and Kim Haase

SINCE message-driven beans are based on the Java™ Message Service
technology, in order to understand the example in this chapter you sh
already be familiar with basic JMS concepts such as queues and message
best place to learn about these concepts is the Java™ Message Service Tu

http://java.sun.com/products/jms/tutorial/index.html

This chapter describes the source code of a simple message-driven bean
ple. Before proceeding, you should read the basic conceptual informatio
What is a Message-Driven Bean? (page 82).

Example Application Overview 172
The J2EE™ Application Client 173
The Message-Driven Bean Class 174

The onMessage Method 174
The ejbCreate and ejbRemove Methods 175

Running the SimpleMessageEJB Example 176
Starting the J2EE™ Server 176
Creating the Queue 176
Deploying the Application 176
Running the Client 176

Deploytool Tips for Message-Driven Beans 177
Specifying the Bean’s Type and Transaction Management 177
Setting the Message-Driven Bean’s Characteristics 177
177

http://java.sun.com/products/jms/tutorial/index.html
Bios.html
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Deploytool Tips for JMS Clients 178
Setting the Resource References 178
Setting the Resource Environment References 179
Specifying the JNDI Names 179

Example Application Overview
This application has the following components:

• SimpleMessageClient - A J2EE™ application client that sends sever
messages to a queue.

• SimpleMessageEJB - A message-driven bean that asynchronously recei
and processes the messages that are sent to the queue.

Figure 16 illustrates the structure of this application. The application client se
messages to the queue, which was created administratively using thej2eeadmin

command. The JMS provider (in this, case the J2EE™ server) delivers the
sages to the instances of the message-driven bean, which then processes th
sages.

Figure 19 TheSimpleMessageApp Application

Source Code. The source code for this application is in th
j2eetutorial/examples/src/ejb/simplemessage directory. To compile the
code, go to thej2eetutorial/examples/src directory and typeant simple-

message. A sampleSimpleMessageApp.ear file is in the j2eetutorial/exam-
ples/ears directory.
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The J2EE™ Application Client
The SimpleMessageClient sends messages to the queue that theSimpleMes-

sageBean listens to. The client starts out by locating the connection factory a
queue:

queueConnectionFactory = (QueueConnectionFactory)
    jndiContext.lookup
    (“java:comp/env/jms/MyQueueConnectionFactory”);
queue = (Queue)
     jndiContext.lookup(“java:comp/env/jms/QueueName”);

Next, the client creates the queue connection, session, and sender:

queueConnection =
    queueConnectionFactory.createQueueConnection();
queueSession =
    queueConnection.createQueueSession(false,
    Session.AUTO_ACKNOWLEDGE);
queueSender = queueSession.createSender(queue);

Finally, the client sends several messages to the queue:

message = queueSession.createTextMessage();

for (int i = 0; i < NUM_MSGS; i++) {
     message.setText(“This is message “ + (i + 1));
     System.out.println(“Sending message: “ +
         message.getText());
     queueSender.send(message);
}
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The Message-Driven Bean Class
The code for theSimpleMessageEJB class illustrates the requirements of a me
sage-driven bean class:

• It implements theMessageDrivenBean andMessageListener interfaces.

• The class is defined as public.

• The class cannot be defined asabstract or final.

• It implements oneonMessage method.

• It implements oneejbCreate method and oneejbRemove method.

• It contains apublic constructor with no arguments.

• It must not define thefinalize method.

Unlike session and entity beans, message-driven beans do not have the rem
local interfaces that define client access. Client components do not locate
sage-driven beans and invoke methods on them. Although message-driven
do not have business methods, they may contain helper methods that are inv
internally by theonMessage method.

The onMessage Method
When the queue receives a message, the EJB™ container invokes theonMessage

method of the message-driven bean. In theSimpleMessageBean class, the
onMessage method casts the incoming message to aTextMessage and displays
the text:

public void onMessage(Message inMessage) {
    TextMessage msg = null;

    try {
        if (inMessage instanceof TextMessage) {
            msg = (TextMessage) inMessage;
            System.out.println
                (“MESSAGE BEAN: Message received: “
                + msg.getText());
        } else {
            System.out.println
                (“Message of wrong type: “
                + inMessage.getClass().getName());
        }
    } catch (JMSException e) {
        e.printStackTrace();
        mdc.setRollbackOnly();
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    } catch (Throwable te) {
        te.printStackTrace();
    }
}

The ejbCreate and ejbRemove Methods
The signatures of these methods have the following requirements:

• The access control modifier must bepublic.

• The return type must bevoid.

• The modifier cannot bestatic or final.

• Thethrows clause must not define any application exceptions.

• It has no arguments.

In the SimpleMessageBean class, theejbCreate and ejbRemove methods are
empty.

Running the SimpleMessageEJB Example

Starting the J2EE™ Server
To view the output of the message-driven bean, you must start the server in
bose mode:

j2ee -verbose

Creating the Queue
1. Create the queue with thej2eeadmin command:

j2eeadmin -addJmsDestination jms/MyQueue queue

2. Verify that the queue was created:

j2eeadmin -listJmsDestination

Deploying the Application
1. In thedeploytool open thej2eetutorial/examples/ears/SimpleMes-

sageApp.ear file (File->Open).
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2. Deploy theSimpleMessageApp application (Tools->Deploy). In the Intro-
duction dialog box, make sure that you select the Return Client JAR che
box. For detailed instructions, seeDeploying the J2EE™
Application (page 62).

Running the Client
1. In a terminal window, go to thej2eetutorial/examples/ears directory.

2. Set the APPCPATH environment variable toSimpleMessageAppCli-
ent.jar.

3. Type the following command on a single line:

runclient -client SimpleMessageApp.ear -name
SimpleMessageClient -textauth

4. At the login prompts, enterj2ee for the user name andj2ee for the pass-
word.

5. The client displays these lines:

Sending message: This is message 1
Sending message: This is message 2
Sending message: This is message 3

6. In the terminal window in which you’ve started thej2ee server (in -ver-
bose mode), the following lines should be displayed:

MESSAGE BEAN: Message received: This is message 1
MESSAGE BEAN: Message received: This is message 2
MESSAGE BEAN: Message received: This is message 3

Deploytool Tips for Message-Driven Beans
The GettingStarted (page 47) chapter covered the basic steps for building
packaging enterprise beans. This section describes the tasks in thedeploytool

that are that are necessary for message-driven beans. To view an exam
deploytool, open the j2eetutorial/examples/ears/SimpleMessageApp.ear
file and select the SimpleMessageEJB bean from the tree view.
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Specifying the Bean’s Type and Transaction
Management
You specify the type when you create the bean with the New Enterprise B
wizard.

1. To start the wizard, select File->New->Enterprise Bean.

2. In the General dialog box of the wizard, select the Message-Driven ra
button.

3. In the Transaction Management dialog box, you may select either
Bean-Managed or Container-Managed radio button. If you select
Bean-Managed button, then in step (4.) of the next section, you may se
the acknowledgement type.

Setting the Message-Driven Bean’s Characteristics
You may specify these settings in two places:

• The Message-Driven Bean Settings dialog box of the New Enterprise B
wizard

• The Message tabbed pane of the bean

These settings are as follows:

1. For the Destination Type, select either the Queue or Topic radio button
queue uses the point-to-point messaging domain and may have at mos
consumer. A topic uses the publish-subscribe messaging domain; it
have zero, one, or many consumers.

2. In the Destination combo box, select the JNDI name of the destination
you have created administratively. For an example, seeCreating the
Queue (page 181). The destination is either aQueue or aTopic object; it
represents the source of incoming messages and the target of outg
messages.

3. In the Connection Factory combo box, select the appropriate object, e
a QueueConnectionFactory or a TopicConnectionFactory. These ob
produce the connections through which J2EE components access the
saging service.

4. If you’ve specified bean-managed transactions, then you may selec
acknowledgement type— either Auto-Acknowledge or Duplicates-OK
from the Acknowledgement combo box. The Auto-Acknowledge ty
instructs the session to automatically acknowledge that the bean has
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sumed the message. The Duplicates-OK type instructs the session to l
acknowledge the delivery of messages; this type may result in duplic
messages but it reduces session overhead.

5. In the JMS Message Selector field, you may enter a statement that fi
the messages received by the bean.

Deploytool Tips for JMS Clients
For more information on JMS clients, please see the Java™ Message Se
Tutorial:

http://java.sun.com/products/jms/tutorial/index.html

Setting the Resource References
1. In the tree view, select the client’s node.

2. Select the Resource Refs tab.

3. Click Add.

4. In the Coded Name field, enter the name matches the parameter o
lookup method in the client’s code. For example, if thelookup parameter
is java:comp/env/jms/MyQueueConnectionFactory, the Coded Name
should bejms/QueueConnectionFactory.

5. In the Type field, select the connection factory class that matches the
tination type.

6. In the Authentication field, in most cases you will select Container. Y
would select Application if your code explicitly logs on to the messagi
service.

7. In the Sharable field, make sure the checkbox is selected. This ch
allows the container to optimize connections.

8. Enter strings in the User Name and Password fields. The authentica
service of the J2EE SDK will prompt you for these fields when you run t
client.

Setting the Resource Environment References
1. Select the Resource Env. Refs tab.

2. Click Add.
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3. In the Coded Name field, enter a name that matches the parameter o
lookup call that locates the queue or topic. For example, if thelookup

parameter isjava:comp/env/jms/QueueName, the Coded Name should be
jms/QueueName.

4. In the Type field, select the class that matches the destination type.

Specifying the JNDI Names
1. In the tree view, select the application’s node.

2. Select the JNDI Names tab and enter the appropriate names. For exa
the SimpleMessageApp discussed in this chapter uses the JNDI nam
shown in the following table.

Table 8 JNDI Names for theSimpleMessageApp

Component or Reference Name JNDI Name

SimpleMessageEJB jms/MyQueue

jms/MyQueueConnectionFactory jms/QueueConnectionFactory

jms/QueueName jms/MyQueue
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Query Language
by Dale Green

THE Enterprise JavaBeans™ Query Language (EJB™ QL) defines the qu
for the finder and select methods of an entity bean with container-managed
sistence. A subset of SQL92, EJB QL has extensions that allow navigation
the relationships defined in an entity bean’s abstract schema. The scope
EJB QL query spans the abstract schemas of related entity beans that are
aged in the same EJB JAR file.

You define EJB QL queries in the deployment descriptor of the entity bean. T
ically, a tool will translate these queries into the target language of the unde
ing data store. Because of this translation, entity beans with container-man
persistence are portable—their code is not tied to a specific type of data sto

This chapter relies on the material presented in earlier chapters. For conce
information, seeContainer-ManagedPersistence (page 79). For code example
seeContainer-Managed Persistence Examples (page 145).

Terminology 184
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187
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Example Queries 185
Simple Finder Queries 185
Finder Queries That Navigate to Related Beans 187
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Path Expressions 197
WHERE Clause 200
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EJB QL Restrictions 209

Terminology
The following list defines some of the terms referred to in this chapter:

• abstract schema- The part of an entity bean’s deployment descriptor th
defines the bean’s persistent fields and relationships.

• abstract schema name- A logical name that is referenced in EJB QL que
ries. You specify an abstract schema name for each entity bean with
tainer-managed persistence.

• abstract schema type- All EJB QL expressions evaluate to a type. If th
expression is an abstract schema name, by default its type is the local h
interface of the entity bean for which the abstract schema name is defi

• Backus-Naur Form (BNF)- A notation that describes the syntax of high
level languages. The syntax diagrams in this chapter are in BNF nota

• Navigation- The traversal of relationships in an EJB QL expression. T
navigation operator is a period.

• Path expression - An expression that navigates to a related entity bean

• persistent field- A virtual field of an entity bean with container-manage
persistence, it is stored in a database.

• relationship field- A virtual field of an entity bean with container-manage
persistence, it identifies a related entity bean.
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Simplified Syntax
This section briefly describes the syntax of EJB QL so that you can quic
move on to theExampleQueries (page 189). When you are ready to learn ab
the syntax in more detail, seeFull Syntax (page 195).

An EJB QL query has three clauses:SELECT, FROM, andWHERE. TheSELECT and
FROM clauses are required, but theWHERE clause is optional. Here is the high-leve
BNF syntax of an EJB QL query:

EJB QL :: = select_clause from_clause [where_clause]

The SELECT clause defines the types of the objects or values returned by
query. A return type is either a local interface, a remote interface, or a persis
field.

TheFROM clause defines the scope of the query by declaring one or more iden
cation variables, which may be referenced in theSELECT andWHERE clauses. An
identification variable represents one of the following elements:

• The abstract schema name of an entity bean

• A member of a collection that is the multiple side of a one-to-many re
tionship

TheWHERE clause is a conditional expression that restricts the objects or va
retrieved by the query. Although optional, most queries have aWHERE clause.

Example Queries
The following queries are from thePlayerEJB entity bean of theRosterApp
J2EE™ application, which is documented in the chapter,Container-Managed
PersistenceExamples (page 145). To see the relationships between the bea
theRosterApp, see Figure 18 (page 147).

Simple Finder Queries
If you are unfamiliar with EJB QL, these simple queries are a good place to st

Example 1

SELECT OBJECT(p)
FROM Player p
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Data Retrieved: All players.

Finder Method:findall()

Description: TheFROM clause declares an identification variable namedp, omit-
ting the optional keywordAS. If the AS keyword were included, the clause woul
be written as follows:

FROM Player AS p

ThePlayer element is the abstract schema name of thePlayerEJB entity bean.
Because the bean defines thefindall method in theLocalPlayerHome inter-
face, the objects returned by the query have that interface’s type.

See Also:Identification Variables (page 199)

Example 2

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.position = ?1

Data Retrieved: The players with the position specified by the finder metho
parameter.

Finder Method: findByPosition(String position)

Description: In aSELECT clause, theOBJECT keyword must precede a stand-alon
identification variable such asp. The DISTINCT keyword eliminates duplicate
values.

The WHERE clause restricts the players retrieved by checking theirposition, a
persistent field of thePlayerEJB entity bean. The?1 element denotes the inpu
parameter of thefindByPosition method.

See Also:Input Parameters (page 204)

DISTINCT and OBJECT Keywords (page 213)

Example 3

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.position = ?1 AND p.name = ?2

Data Retrieved: The players with the specified position and name.
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Finder Method:findByPositionAndName(String position, String name)

Description: Theposition andname elements are persistent fields of thePlay-

erEJB entity bean. TheWHERE clause compares the values of these fields with t
parameters of thefindByPositionAndName method. EJB QL denotes an inpu
parameter with a question mark followed by an integer. The first input param
is ?1, the second is?2, and so forth.

Finder Queries That Navigate to Related Beans
In EJB QL, an expression can traverse—or navigate—to related beans. T
expressions are the primary difference between EJB QL and SQL. EJB QL n
gates to related beans, whereas SQL joins tables.

Example 4

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.city = ?1

Data Retrieved: The players whose teams belong to the specified city.

Finder Method:findByCity(String city)

Description: TheFROM clause declares two identification variables:p andt. The
p variable represents thePlayerEJB entity bean and the t variable represents th
relatedTeamEJB beans. The declaration fort references the previously declare
p variable. TheIN keyword signifies thatteams is a collection of related beans
Thep.teams expression navigates from aPlayerEJB bean to its relatedTeamEJB
beans. The period in thep.teams expression is the navigation operator.

In theWHERE clause, the period preceding thecity persistent variable is a delim-
iter, not a navigation operator. Strictly speaking, expressions can navigat
relationship fields (related beans), but not to persistent fields. To access a p
tent field, an expression uses the period as a delimiter.

Expressions may not navigate (or further qualify) beyond relationship fields
are collections. In the syntax of an expression, a collection-valued field is a
minal symbol. Because theteams field is a collection, theWHERE clause cannot
specify p.teams.city—an illegal expression.

See Also:Path Expressions (page 201)
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Example 5

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league = ?1

Data Retrieved: The players that belong to the specified league.

Finder Method:findByLeague(LocalLeague league)

Description: The expressions in this query navigate over two relationships.
p.teams expression navigates thePlayerEJB-TeamEJB relationship and the
t.league expression navigates theTeamEJB-LeagueEJB relationship.

In the other examples, the input parameters areString objects, but in this exam-
ple the parameter is an object whose type is aLocalLeague interface. This type
matches theleague relationship field in the comparison expression of theWHERE

clause.

Example 6

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league.sport = ?1

Data Retrieved: The players who participate in the specified sport.

Finder Method:findBySport(String sport)

Description: Thesport persistent field belongs to theLeagueEJB bean. To reach
the sport field, the query must first navigate from thePlayerEJB bean to the
TeamEJB bean (p.teams) and then from theTeamEJB bean to theLeagueEJB bean
(t.league). Because theleague relationship field is not a collection, it may be
followed by thesport persistent field.

Finder Queries With Other Conditional Expressions
Every WHERE clause must specify a conditional expression, of which there
several kinds. In the previous examples, the conditional expressions are com
ison expressions that test for equality. The following examples demonst
some of the other kinds of conditional expressions. For descriptions of all co
tional expressions, seeWHERE Clause (page 204).
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Example 7

SELECT OBJECT(p)
FROM Player p
WHERE p.teams IS EMPTY

Data Retrieved: All players who do not belong to a team.

Finder Method:findNotOnTeam()

Description: Theteams relationship field of thePlayerEJB bean is a collection.
If a player does not belong to a team, then theteams collection is empty and the
conditional expression isTRUE.

See Also:Empty Collection Comparison Expressions (page 208)

Example 8

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.salary BETWEEN ?1 AND ?2

Data Retrieved: The players whose salaries fall within the range of the spec
salaries.

Finder Method:findBySalaryRange(double low, double high)

Description: ThisBETWEEN expression has three arithmetic expressions: a per
tent field (p.salary) and the two input parameters (?1, ?2). The following
expression is equivalent to theBETWEEN expression:

p.salary >= ?1 AND p.salary <= ?2

See also:BETWEEN Expressions (page 206)

Example 9

SELECT DISTINCT OBJECT(p1)
FROM Player p1, Player p2
WHERE p1.salary > p2.salary AND p2.name = ?1

Data Retrieved: All players whose salaries are higher than the salary of
player with the specified name.

Finder Method:findByHigherSalary(String name)
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Description: TheFROM clause declares two identification variables (p1, p2) of the
same type (Player). Two identification variables are needed because theWHERE

clause compares the salary of one player (p2) with that of the other players (p1).

See Also:Identification Variables (page 199)

Select Queries
The queries in this selection are for select methods. Unlike finder method
select method may return persistent fields or other entity beans.

Example 10

SELECT DISTINCT t.league
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Data Retrieved: The leagues that the specified player belongs to.

Select Method:ejbSelectLeagues(LocalPlayer player)

Description: The return type of this query is the abstract schema type of
LeagueEJB entity bean. This abstract schema type maps to theLocalLeague-

Home interface. Because the expressiont.league is not a stand-alone identifica-
tion variable, theOBJECT keyword is omitted.

See Also:SELECT Clause (page 212)

Example 11

SELECT DISTINCT t.league.sport
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Data Retrieved: The sports that the specified player participates in.

Select Method:ejbSelectSports(LocalPlayer player)

Description: This query returns aString namedsport, which is a persistent
field of theLeagueEJB entity bean.
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Full Syntax
This section discusses the EJB QL syntax, as defined in theEnterprise Java-
Beans™ Specification. Much of the following material paraphrases or direct
quotes theEnterprise JavaBeans™ Specification.

BNF Grammar of EJB QL
Here is the entire BNF diagram for EJB QL:

EJB QL ::= select_clause from_clause [where_clause]

from_clause ::= FROM identification_variable_declaration
    [, identification_variable_declaration]*

identification_variable_declaration ::=
    collection_member_declaration |
    range_variable_declaration

collection_member_declaration ::=
    IN (collection_valued_path_expression) [AS] identifier

range_variable_declaration ::=
    abstract_schema_name [AS] identifier

single_valued_path_expression ::=
    {single_valued_navigation |
    identification_variable}.cmp_field |
    single_valued_navigation

single_valued_navigation ::=
    identification_variable.[single_valued_cmr_field.]*
    single_valued_cmr_field

collection_valued_path_expression ::=
    identification_variable.[single_valued_cmr_field.]*
    collection_valued_cmr_field

select_clause ::= SELECT [DISTINCT]
    {single_valued_path_expression |

OBJECT(identification_variable)}

where_clause ::= WHERE conditional_expression

conditional_expression ::= conditional_term |
    conditional_expression OR conditional_term
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conditional_term ::= conditional_factor |
    conditional_term AND conditional_factor

conditional_factor ::= [ NOT ] conditional_test

conditional_test :: = conditional_primary

conditional_primary ::=
    simple_cond_expression | (conditional_expression)

simple_cond_expression ::=
    comparison_expression |
    between_expression |
    like_expression |
    in_expression |
    null_comparison_expression |
    empty_collection_comparison_expression |
    collection_member_expression

between_expression ::=
    arithmetic_expression [NOT] BETWEEN
    arithmetic_expression AND arithmetic_expression

in_expression ::=
    single_valued_path_expression
    [NOT] IN (string_literal [, string_literal]* )

like_expression ::=
    single_valued_path_expression
    [NOT] LIKE pattern_value [ESCAPE escape-character]

null_comparison_expression ::=
    single_valued_path_expression IS [NOT] NULL

empty_collection_comparison_expression ::=
    collection_valued_path_expression IS [NOT] EMPTY

collection_member_expression ::=
    {single_valued_navigation | identification_variable |
    input_parameter}
    [NOT] MEMBER [OF] collection_valued_path_expression

comparison_expression ::=
    string_value { =|<>} string_expression |
    boolean_value { =|<>} boolean_expression} |
    datetime_value { = | <> | > | < } datetime_expression |
    entity_bean_value { = | <> } entity_bean_expression |
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    arithmetic_value comparison_operator
    single_value_designator

arithmetic_value ::= single_valued_path_expression |
    functions_returning_numerics

single_value_designator ::= scalar_expression

comparison_operator ::=
    = | > | >= | < | <= | <>

scalar_expression ::= arithmetic_expression

arithmetic_expression ::= arithmetic_term |
    arithmetic_expression { + | - } arithmetic_term

arithmetic_term ::= arithmetic_factor |
    arithmetic_term { * | / } arithmetic_factor

arithmetic_factor ::= { + |- } arithmetic_primary

arithmetic_primary ::= single_valued_path_expression |
    literal | (arithmetic_expression) |
    input_parameter | functions_returning_numerics

string_value ::= single_valued_path_expression |
    functions_returning_strings

string_expression ::= string_primary | input_expression

string_primary ::= single_valued_path_expression | literal |
    (string_expression) | functions_returning_strings

datetime_value ::= single_valued_path_expression

datetime_expression ::= datetime_value | input_parameter

boolean_value ::= single_valued_path_expression

boolean_expression ::= single_valued_path_expression |
  literal | input_parameter

entity_bean_value ::=
    single_valued_navigation | identification_variable

entity_bean_expression ::= entity_bean_value | input_parameter

functions_returning_strings ::=
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    CONCAT(string_expression, string_expression) |
    SUBSTRING(string_expression, arithmetic_expression,
    arithmetic_expression)

functions_returning_numerics::=
    LENGTH(string_expression) |
    LOCATE(string_expression,
    string_expression[, arithmetic_expression]) |
    ABS(arithmetic_expression) |
    SQRT(arithmetic_expression)

BNF Symbols
Table 9 describes the BNF symbols used in the preceding diagram.

FROM Clause
TheFROM clause defines the domain of the query by declaring identification v
ables. Here is the syntax of theFROM clause:

from_clause ::= FROM identification_variable_declaration

    [, identification_variable_declaration]*

Table 9 BNF Symbol Summary

Symbol Description

::=
the element to the left of the symbol is defined by the con-
structs on the right

* the preceding construct may occur zero or more times

{...} the constructs within the curly braces are grouped together

[...] the constructs within the square brackets are optional

| an exclusive OR

BOLDFACE
a keyword (although capitalized in the BNF diagram, key-
words are not case sensitive)

whitespace
a whitespace character can be a space, horizontal tab, or
form feed
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identification_variable_declaration ::=

    collection_member_declaration |

    range_variable_declaration

collection_member_declaration ::=

    IN (collection_valued_path_expression) [AS] identifier

range_variable_declaration ::=

    abstract_schema_name [AS] identifier

Identifiers

An identifier is a sequence of one or more characters. The first character mu
a valid first character (letter, $, _) in an identifier of the Java™ programming l
guage (hereafter in this chapter called simply “Java”). Each subsequent char
in the sequence must be a valid non-first character (letter, digit, $, _) in a
identifier. (For details, see the J2SE™ API documentation of theisJavaIdenti-

fierStart andisJavaIdentifierPart methods of theCharacter class.) The
question mark (?) is a reserved character in EJB QL and cannot be used
identifier. Unlike a Java variable, an EJB QL identifier is not case sensitive.

An identifier cannot be the same as an EJB QL keyword:

EJB QL keywords are also reserved words in SQL. In the future, the list of E
QL keywords may expand to include other reserved SQL words. TheEnterprise
JavaBeans™ Specificationrecommends that you not use other reserved SQ
words for EJB QL identifiers.

Identification Variables

An identification variable is an identifier declared in theFROM clause. Although
theSELECT andWHERE clauses may reference identification variables, they can
declare them. All identification variables must be declared in theFROM clause.

AND
AS
BETWEEN
DISTINCT
EMPTY
FALSE
FROM
IN
IS
LIKE

MEMBER
NOT
NULL
OBJECT
OF
OR
SELECT
TRUE
UNKNOWN
WHERE
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Since an identification variable is an identifier, it has the same naming con
tions and restrictions as an identifier. For example, an identification variabl
not case sensitive and it cannot be the same as an EJB QL keyword. (See th
vious section for more naming rules.) Also, within a given EJB JAR file an ide
tifier name must not match the name of any entity bean or abstract schema

The FROM clause may contain multiple declarations, separated by commas
declaration may reference another identification variable that has been p
ously declared (to the left). In the followingFROM clause, the variablet refer-
ences the previously declared variablep:

FROM Player p, IN (p.teams) AS t

Even if an identification variable is not used in theWHERE clause, its declaration
can affect the results of the query. For an example, compare the next two que
This query returns all players, whether or not they belong to a team:

SELECT OBJECT(p)
FROM Player p

In contrast, because the next query declares thet identification variable, it
fetches all players that belong to a team:

SELECT OBJECT(p)
FROM Player p, IN (p.teams) AS t

The following query returns the same results as the preceding query, bu
WHERE clause makes it easier to read:

SELECT OBJECT(p)
FROM Player p
WHERE p.teams IS NOT EMPTY

An identification variable always designates a reference to a single value, w
type is that of the expression used in the declaration. There are two kinds of
larations: range variable and collection member.

Range Variable Declarations

To declare an identification variable as an abstract schema type, you spec
range variable declaration. In other words, an identification variable can ra
over the abstract schema type of an entity bean. In the following example
identification variable namedp represents the abstract schema namedPlayer:
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FROM Player p

A range variable declaration may include the optionalAS operator:

FROM Player AS p

In most cases, to obtain objects a query navigates through the relationships
path expressions. But for those objects that cannot be obtained by naviga
you can use a range variable declaration to designate a starting point (or “ro

If the query compares multiple values of the same abstract schema type, the
FROM clause must declare multiple identification variables for the abstr
schema:

FROM Player p1, Player p2

For a sample of such a query, see Example 9 (page 193).

Collection Member Declarations

In a one-to-many relationship, the multiple side consists of a collection of en
beans. An identification variable may represent a member of this collection
access a collection member, the path expression in the variable’s declaration
igates through the relationships in the abstract schema. (For more informatio
path expressions, see the following section.) Because a path expression m
based on another path expression, the navigation can traverse across sever
tionships. See Example 6 (page 192).

A collection member declaration must include theIN operator, but it may omit
the optionalAS operator.

In the following example, the entity bean represented by the abstract sch
namedPlayer has a relationship field calledteams. The identification variable
namedt represents a single member of theteams collection.

FROM Player p, IN (p.teams) AS t

Path Expressions
Path expressions are important constructs in the syntax of EJB QL, for sev
reasons. First, they define navigation paths through the relationships in
abstract schema. These path definitions affect both the scope and the resul
query. Second, they may appear in any of the three main clauses of an EJB
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query (SELECT, WHERE, FROM). Finally, although much of EJB QL is a subset o
SQL, path expressions are extensions not found in SQL.

Syntax

There are two types of path expressions: single-valued and collection-val
Here is the syntax for path expressions:

single_valued_path_expression ::=
    {single_valued_navigation |
    identification_variable}.cmp_field |
    single_valued_navigation

single_valued_navigation ::=
    identification_variable.[single_valued_cmr_field.]*
    single_valued_cmr_field

collection_valued_path_expression ::=
    identification_variable.[single_valued_cmr_field.]*
    collection_valued_cmr_field

In the preceding diagram, thecmp_field element represents a persistent fie
and the cmr_field element designates a relationship field. The ter
single_valued qualifies the relationship field as the single side of a one-to-o
or one-to-many relationship; the termcollection_valued designates it as the
multiple (collection) side of a relationship.

The period (.) in a path expression serves two functions. If a period preced
persistent field, it is a delimiter between the field and the identification varia
If a period precedes a relationship field, it is a navigation operator.

Examples

In the following query, theWHERE clause contains a single-valued expressio
Thep is an identification variable and thesalary is a persistent field ofPlayer.

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.salary BETWEEN ?1 AND ?2

TheWHERE clause of the next example also contains a single-valued express
The t is an identification variable, theleague is a single-valued relationship
field, and thesport is a persistent field ofleague.
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SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league.sport = ?1

In the next query, theWHERE clause contains a collection-valued expression. T
p is an identification variable and theteams designates a collection-valued rela
tionship field.

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.teams IS EMPTY

Expression Types

The type of an expression is the type of the object represented by the ending
ment, which can be either of the following:

• persistent field

• single-valued relationship field

• collection-valued relationship field

For example, the type of the expressionp.salary is adouble because the termi-
nating persistent field (salary) is adouble.

In the expressionp.teams, the terminating element is a collection-valued rel
tionship field (teams). This expression’s type is a collection of the abstra
schema type namedTeam. BecauseTeam is the abstract schema name for th
TEAMEJB entity bean, this type maps to the bean’s local home interface,Local-

TeamHome. For more information the type mapping of abstract schemas,
Return Types (page 212).

Navigation

A path expression enables the query to navigate to related entity beans. Th
minating elements of an expression determine whether navigation is allowe
an expression contains a single-valued relationship field, the navigation
continue to an object that is related to the field. However, an expression ca
navigate beyond a persistent field or a collection-valued relationship field.
example, the expressionp.teams.league.sport is illegal, sinceteams is a col-
lection-valued relationship field. To reach thesport field, theFROM clause could
define an identification variable namedt for theteams field:

FROM Player AS p, IN (p.teams) t
WHERE t.league.sport = ‘soccer’
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WHERE Clause
The WHERE clause specifies a conditional expression that limits the valu
returned by the query. The query returns all corresponding values in the
store for which the conditional expression isTRUE. Although usually specified,
the WHERE clause is optional. If theWHERE clause is omitted, then the query
returns all values. The high-level syntax for theWHERE clause follows:

Where_clause ::= WHERE conditional_expression

Literals

There are three kinds of literals: string, numeric, and boolean.

String Literals. A string literal is enclosed in single quotes:

‘Duke’

If a string literal contains a single quote, you indicate the quote with two sin
quotes:

‘Duke’’s’

Like a JavaString, a string literal in EJB QL uses the Unicode character enco
ing.

Numeric Literals. There are two types of numeric literals: exact and appro
mate.

An exact numeric literal is a numeric value without a decimal point, such as 6
233, +12. Using the Java integer syntax, exact numeric literals support num
in the range of a Javalong .

An approximate numeric literal is a numeric value in scientific notation, such
57., -85.7, +2.1. Using the syntax of the Java floating point literal, approxim
numeric literals support numbers in the range of a Javadouble .

Boolean Literals. A boolean literal is eitherTRUE or FALSE. These keywords
are not case sensitive.

Input Parameters

An input parameter is designated by a question mark (?) followed by an inte
For example, the first input parameter is?1, the second is?2, and so forth.
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The following rules apply to input parameters:

• They can be used only in aWHERE clause.

• Their use is restricted to a single-valued path expression within a co
tional expression.

• They must be numbered, starting with the integer 1.

• The number of input parameters in theWHERE clause must not exceed the
number of input parameters in the corresponding finder or select met

• The type of an input parameter in theWHERE clause must match the type o
the corresponding argument in the finder or select method.

Conditional Expressions

A WHERE clause consists of a conditional expression, which is evaluated from
to right within a precedence level. You may change the order of evaluation w
parentheses.

Here is the syntax of a conditional expression:

conditional_expression ::= conditional_term |
    conditional_expression OR conditional_term

conditional_term ::= conditional_factor |
    conditional_term AND conditional_factor

conditional_factor ::= [ NOT ] conditional_test

conditional_test :: = conditional_primary

conditional_primary ::=
    simple_cond_expression | (conditional_expression)

simple_cond_expression ::=
    comparison_expression |
    between_expression |
    like_expression |
    in_expression |
    null_comparison_expression |
    empty_collection_comparison_expression |
    collection_member_expression
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Operators and Their Precedence

Table 10 lists the EJB QL operators in order of decreasing precedence.

BETWEEN Expressions

A BETWEEN expression determines whether an arithmetic expression falls wi
a range of values. The syntax of theBETWEEN expression follows:

between_expression ::=
    arithmetic_expression [NOT] BETWEEN
    arithmetic_expression AND arithmetic_expression

These two expressions are equivalent:

p.age BETWEEN 15 AND 19
p.age >= 15 AND p.age <= 19

The following two expressions are also equivalent:

p.age NOT BETWEEN 15 AND 19
p.age < 15 OR p.age > 19

Table 10 EJB QL Operator Precedence

 Type Precedence Order

Navigation . (a period)

Arithmetic
+ - (unary)
 * / (multiplication and division)
 + - (addition and subtraction)

Comparison

=
>
>=
<
<=
<> (not equal)

Logical
NOT
AND
OR
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If an arithmetic expression has aNULL value, then the value of theBETWEEN
expression is unknown.

IN Expressions

An IN expression determines whether or not a string belongs to a set of strin
erals. Here is the syntax of theIN expression:

in_expression ::=
    single_valued_path_expression
    [NOT] IN (string_literal [, string_literal]* )

The single-valued path expression must have aString value. If the single-val-
ued path expression has aNULL value, then the value of theIN expression is
unknown.

In the following example, if the country is‘UK’ the expression isTRUE. If the
country is‘Peru’ it is FALSE.

o.country IN (‘UK’, ‘US’, ‘France’)

LIKE Expressions

A LIKE expression determines whether a wildcard pattern matches a string.
is the syntax:

like_expression ::=
    single_valued_path_expression
    [NOT] LIKE pattern_value [ESCAPE escape-character]

The single-valued path expression must have aString value. If this value is
NULL, then the value of theLIKE expression is unknown. The pattern value is
string literal that may contain wildcard characters. The underscore (_) wildc
character represents any single character. The percent (%) wildcard char
represents zero or more characters. TheESCAPE clause specifies an escape-cha
acter for the wildcard characters in the pattern value.
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Table 11 shows some sampleLIKE expressions. TheTRUE andFALSE columns
indicate the value of theLIKE expression for a single-valued path expression.

NULL Comparison Expressions

A NULL comparison expression tests whether a single-valued path expressio
a NULL value. Usually, this expression is used to test whether or not a single-
ued relationship has been set. If a path expression contains aNULL value during
evaluation, it returns aNULL value. Here is the syntax of aNULL comparison
expression:

null_comparison_expression ::=
    single_valued_path_expression IS [NOT] NULL

Empty Collection Comparison Expressions

An empty collection comparison expression tests whether a collection-va
path expression has no elements. In other words, it tests whether or not a co
tion-valued relationship has been set. Here is the syntax:

empty_collection_comparison_expression ::=

    collection_valued_path_expression IS [NOT] EMPTY

If the collection-valued path expression isNULL, then the empty collection com-
parison expression has aNULL value.

Table 11 LIKE Expression Examples

 Expression TRUE FALSE

address.phone LIKE ‘12%3’
‘123’
‘12993’

‘1234’

asentence.word LIKE ‘l_se’ ‘lose’ ‘loose’

aword.underscored LIKE ‘_%’ ESCAPE ‘\’ ‘_foo’ ‘bar’

address.phone NOT LIKE ‘12%3’ 1234
‘123’
‘12993’
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Collection Member Expressions

The collection member expression determines whether a value is a membe
collection. The value and the collection members must have the same type
expression syntax follows:

collection_member_expression ::=
    {single_valued_navigation | identification_variable |
    input_parameter}
    [NOT] MEMBER [OF] collection_valued_path_expression

If the collection-valued path expression is unknown, then the collection mem
expression is unknown. If the collection-valued path expression designate
empty collection, then the collection member expression isFALSE.

Functional Expressions

EJB QL includes several string and arithmetic functions, which are listed in
following tables. In Table 12, thestart andlength arguments are of typeint.
They designate positions in theString argument. In Table 13, thenumber argu-
ment may be either anint, afloat, or adouble.

Table 12 String Expressions

Function Syntax Return Type

CONCAT(String, String) String

SUBSTRING(String, start, length) String

LOCATE(String, String [, start]) int

LENGTH(String) int

Table 13 Arithmetic Expressions

Function Syntax Return Type

ABS(number) int, float, or double

SQRT(double) double
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NULL Values

If the target of a reference is not in the persistent store, then the target isNULL.
For conditional expressions containingNULL, EJB QL uses the semantics define
by SQL92. Briefly, these semantics are as follows:

• If a comparison or arithmetic operation has an unknown value, it yield
NULL value.

• If a path expression contains aNULL value during evaluation, it returns a
NULL value.

• The IS NULL test converts aNULL persistent field or a single-valued rela
tionship field toTRUE. TheIS NOT NULL test converts them toFALSE.

• Boolean operators and conditional tests use the three-valued logic de
by the following tables.

Table 14 AND Operator Logic

AND T F U

T T F U

F F F F

U U F U

Table 15 OR Operator Logic

OR T F U

T T T T

F T F U

U T U U

Table 16 NOT Operator Logic

NOT

T F
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Equality Semantics

In EJB QL, only values of the same type can be compared. However, this
has one exception: Exact and approximate numeric values can be compare
such a comparison, the required type conversion adheres to the rules of
numeric promotion.

EJB QL treats compared values as if they were Java types, not as if they re
sented types in the underlying data store. For example, if a persistent field c
be either an integer or aNULL, then it must be designated as anInteger object,
not as anint primitive. This designation is required because a Java object ca
NULL but a primitive cannot.

Two strings are equal only if they contain the same sequence of characters.
ing blanks are significant; for example, the strings‘abc’ and‘abc ‘ are not
equal.

Two entity beans of the same abstract schema type are equal only if their prim
keys have the same value.

F T

U U

Table 17 Conditional Test

Conditional Test T F U

expression IS TRUE T F F

expression IS FALSE F T F

expression IS UNKNOWN F F T

Table 16 NOT Operator Logic (Continued)

NOT
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SELECT Clause
The SELECT clause defines the types of the objects or values returned by
query. TheSELECT clause has the following syntax:

select_clause ::= SELECT [DISTINCT]
    {single_valued_path_expression |

OBJECT(identification_variable)}

Return Types

The return type defined by theSELECT clause must match that of the finder o
select method for which the query is defined.

For finder method queries, the return type of theSELECT clause is the abstract
schema type of the entity bean that defines the finder method. This abs
schema type maps to the type of the interface (or a collection thereof) that sp
fies the finder method. If the bean’s remote home interface defines the fi
method, then the return type is the remote interface (or a collection of rem
interfaces). Likewise, if the local home interface defines the finder method,
return type is the local home interface (or a collection). For example,
LocalPlayerHome interface of thePlayerEJB entity bean defines thefindall
method:

public Collection findAll() throws FinderException;

The EJB QL query of thefindall method returns a collection ofLocalPlayer-
Home interface types:

SELECT OBJECT(p)
FROM Player p

For select method queries, the return type of theSELECT clause may be one of the
following:

• The abstract schema of the entity bean that contains the select metho

• The abstract schema of a related entity bean

(By default, each of these abstract schema types map to the local home
face of the entity bean. Although uncommon, in the deployment descrip
you may override the default mapping by specifying a remote home in
face.)

• A persistent field
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The PlayerEJB entity bean, for example, implements theejbSelectSports
method, which returns a collection ofString objects forsport. Thesport is a
persistent field of theLeagueEJB entity bean. See Example 11 (page 194).

A SELECT clause cannot specify a collection-valued expression. For example
SELECT clausep.teams is invalid becauseteams is a collection. However, the
SELECT clause in the following query is valid because thet is a single element of
theteams collection:

SELECT t
FROM Player p, IN (p.teams) AS t

DISTINCT and OBJECT Keywords

TheDISTINCT keyword eliminates duplicate return values. If the method of t
query returns ajava.util.Collection—which allows duplicates—to elimi-
nate duplicates you must specify theDISTINCT keyword. However, if the method
returns a java.util.Set, the DISTINCT keyword is redundant because
java.util.Set may not contain duplicates.

The OBJECT keyword must precede a stand-alone identification variable, bu
must not precede a single-valued path expression. If an identification variab
part of a single-valued path expression, it is not stand-alone.

EJB QL Restrictions
EJB QL has a few restrictions:

• Comments are not allowed.

• Date and time values are in milliseconds and use a Javalong. A date or
time literal should be an integer literal. To generate a millisecond val
you may use thejava.util.Calendar class.

• Currently, container-managed persistence does not support inherita
For this reason, two entity beans of different types cannot be compar
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Web Components
by Stephanie Bodoff

WHEN a web-based client such as a browser communicates with a J
application, it does so through server-side objects called web components. T
are two types of web components: Java™ Servlets and JavaServer Pa
(JSP™) pages. Servlets are Java programming language classes that dynam
process requests and construct responses. JSP pages are text-based doc
that execute as servlets, but allow a more natural approach to creating static
tent. While servlets and JSP pages can be used interchangeably, each h
strengths. Servlets are best suited to managing the control functions of an a
cation, such as dispatching requests, and handling non-textual data. JSP
are more appropriate for generating text-based markup such as HTML, S
WML, and XML.

This chapter describes the packaging, configuration, and deployment proce
common to servlets and JSP pages. Subsequent chapters,Java Servlet
Technology (page 229) andJavaServer Pages™Technology (page 265), cover
how to develop the web components. Many features of JSP technology are d
mined by Java Servlet technology so you should familiarize yourself with t
material, even if you do not intend to write servlets.

Most web-based J2EE clients use the HTTP protocol and support for HTTP
major aspect of web components. For a brief summary of HTTP protocol
tures seeHTTP Overview (page 451).

Web Component Life Cycle 212
Packaging Web Components 214

Creating a WAR 215
Adding a WAR to a J2EE Application 215
Adding a Web Component to a WAR 216
215

Bios.html
http://www.w3.org/MarkUp
http://www.w3.org/TR/SVG
http://www.oasis-open.org/cover/wap-wml.html
http://www.w3.org/TR/REC-xml
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Configuring Web Components 217
Application-Level Configuration 217
WAR-Level Configuration 218
Component-Level Configuration 220

Deploying Web Components 221
Executing Web Components 221
Updating Web Components 222

Web Component Life Cycle
The J2EE platform provides many supporting services that enhance the cap
ties of web components and make them easier to develop. However, beca
must take into account these services, the process for creating and running
component is different than that of traditional stand-alone Java classes.

Web components run within an environment called aweb container. The web
container provides services such as request dispatching, security, concurr
and life cycle management. It also gives web components access to the
platform APIs such as naming, transactions, and email. Before it can be
cuted, a web component must be installed (ordeployed) into a web container.

Certain aspects of web component behavior can be configured when it is p
aged and deployed. The configuration information is maintained in a text fil
XML format called aweb application deployment descriptor. When you pack-
age and deploy web components using the J2EE SDKdeploytool, it automati-
cally generates or updates the deployment descriptor based on data tha
enter indeploytool wizards and inspectors. You can also manually create
deployment descriptor according to the schema described in the Java Se
specification.

The process for creating, deploying, and executing a web component ca
summarized as follows:

1. Develop the web component code (including possibly a deploym
descriptor).

2. Package the web component along with any static resources (for exam
images) referenced by the component.

3. Deploy the application.

4. Access a URL that references the web component.

http://java.sun.com/products/servlet/download.html#specs
http://java.sun.com/products/servlet/download.html#specs
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These steps are expanded on in the following sections and are illustrated w
Hello, World style application. This application allows a user to enter a na
into an HTML form:

Figure 20 Greeting Form

and then displays a greeting after the name is submitted:

Figure 21 Response

The Hello application contains two web components that generate the gree
and the response. This tutorial has two versions of this application: a servlet
sion calledHello1App in which the components are implemented by two serv
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classes,GreetingServlet.java andResponseServlet.java and a JSP version
calledHello2App in which the components are implemented by two JSP pag
greeting.jsp and response.jsp. The two versions are used to illustrate th
tasks involved in packaging and deploying a J2EE application that contains
components.

Packaging Web Components
You add web components to a J2EE application in a package called aweb appli-
cation archive(WAR), which is a JAR similar to the package used for Java cla
libraries. A WAR usually contains other resources besides web compone
including:

• Server-side utility classes (database beans, shopping carts, and so o

• Static web resources (HTML, image, and sound files, and so on)

• Client-side classes (applets and utility classes)

A WAR has a specific hierarchical directory structure. The top-level directory
a WAR is thedocument rootof the application. The document root is where JS
pages, client-side classes and archives, and static web resources are store

The document root contains a subdirectory calledWEB-INF, which contains the
following files and directories:

• web.xml - the web application deployment descriptor

• Tag library descriptor files (seeTag Library Descriptors (page 310)).

• classes - a directory that contains server-side classes: servlet, uti
classes, and JavaBeans components.

• lib - a directory that contains JAR archives of libraries (tag libraries a
any utility libraries called by server-side classes).

You can also create application-specific subdirectories (that is , package dir
ries) in either the document root or theWEB-INF/classes directory.

Note: When you add classes and archives to a WAR,deploytool automatically
packages them in theWEB-INF subdirectory. This is correct for web components
and server-side utility classes, but incorrect for client-side classes such as apple
and any archives accessed by applets. To put client-side classes and archives in
correct location you must “drag” them to the document root after you have adde
them to the archive.

../examples/src/web/hello1/GreetingServlet.java
../examples/src/web/hello1/ResponseServlet.java
../examples/src/web/hello2/greeting.txt
../examples/src/web/hello2/response.txt


PACKAGING WEB COMPONENTS 219

ion

a-
, it
red
c-

ate a

an

ick
Creating a WAR
When you add the first web component to a J2EE application,deploytool auto-
matically creates a new WAR to contain the component. A later sect
describes how to add a web component.

You can also manually create a WAR in three ways:

• With the packager tool distributed with the J2EE SDK. This tool is
described inPackager (page 459).

• With thewar task of theant portable build tool.Ant is used to build the
J2EE Tutorial examples. The example application described inTheExam-
ple JSP Pages (page 269) uses ant to create the WAR.

• With the JAR tool distributed with the J2SE. If you arrange your applic
tion development directory in the structure required by the WAR format
is straightforward to create a web application archive file in the requi
format. You simply execute the following command in the top-level dire
tory of the application:

jar cvf archiveName.war .

Note that in order to use any of these methods, you must also manually cre
deployment descriptor in the correct format.

Adding a WAR to a J2EE Application
If you manually create a WAR or you obtain a WAR from another party, you c
add it to an existing J2EE application as follows:

1. Select a J2EE application.

2. Select File->Add->Web WAR.

3. Navigate to the directory containing the WAR, select the WAR, and cl
Add Web WAR.

SeeThe Example JSP Pages (page 269) for an example.

You can also add a WAR to a J2EE application using thepackager tool. The
Duke’s Bank application described inBuilding, Deploying, and Running the
Application (page 438) usespackager.
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Adding a Web Component to a WAR
The following procedure describes how to create and add the web compone
the Hello1App application to a WAR. Although the web component wizar
solicits WAR and component-level configuration information when you add
component, this chapter describes how to add the component and provide co
uration information at a later time using application, WAR, and web compon
inspectors:

1. Go toj2eetutorial/examples/src and build the example by running
ant hello1. For detailed instructions, seeAbout the
Examples (page xxii)).

2. Create a J2EE application calledHello1App.

a. Select File->New->Application.

b. Click Browse.

c. In the file chooser, navigate to j2eetutorial/exam-

ples/src/web/hello1.

d. In the File Name field, enterHello1App .

e. Click New Application.

f. Click OK.

3. Create the WAR and add theGreetingServlet web component and all the
of theHello1App application content.

a. Invoke the web component wizard by selecting File->New->Web Co
ponent.

b. In the combo box labelled Create New WAR File in Application sele
Hello1App. EnterHello1WAR in the field labeled WAR Display Name.

c. Click Edit to add the content files.

d. In the Edit Contents dialog, navigate toj2eetutorial/exam-
ples/build/web/hello1. Select GreetingServlet.class, Respon
eServlet.class, and duke.waving.gif, and click Add. Click OK.

e. Click Next.

f. Select the servlet radio button.

g. Click Next.

h. Select GreetingServlet from the Servlet Class combo box.

i. Click Finish.
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4. Add theResponseServlet web component.

a. Invoke the web component wizard by selecting File->New->Web Co
ponent.

b. In the combo box labelled Add to Existing WAR File selec
Hello1WAR.

c. Click Next.

d. Select the servlet radio button.

e. Click Next.

f. Select ResponseServlet from the Servlet Class combo box.

g. Click Finish.

Note: You can add JSP pages to a WAR without creating a new web component fo
each page. You simply select the WAR, click Edit to edit the contents of the WAR
and add the pages. The JSP version of the Hello, World application, described
UpdatingWebComponents(page 226), shows how to do this. If you choose this
method, you will not be able to specify alias paths (described inSpecifyingan
Alias Path(page 224)) for the pages.

Configuring Web Components
The following sections describe the web component configuration parame
that you will usually want to specify. Configuration parameters are specifie
three levels: application, WAR, and component. A number of security para
ters can be applied at the WAR and component levels. For information on s
rity parameters, seeSecurity (page 353).

Application-Level Configuration

Context Root

A context rootis a path that gets mapped to the document root of a J2EE app
tion. If the entry URL of an application is the same as the base of the w
server’s URL namespace (for examplehttp://<host>:8000), the context root
is an empty string. If your application’s context root iscatalog, then a request
URL such ashttp://<host>:8000/catalog/index.html will retrieve the file
index.html from the application’s document root.
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To specify the context root for theHello1App application indeploytool,

1. Select Hello1App.

2. Select the Web Context tab

3. Enterhello1 in the Context Root field.

WAR-Level Configuration
The following sections give generic procedures for specifying WAR-level co
figuration information. For some specific examples, seeThe Example
Servlets (page 231).

Context Parameters

The web components in a WAR share an object that represents their web co
(seeAccessingtheWebContext (page 257)). To specify initialization parameter
that are passed to the context,

1. Select the WAR.

2. Select the Context tab.

3. Click Add.

References to Environment Entries, Enterprise Beans, Resource
Environment Entries, or Resources

If your web components reference environment entries, enterprise be
resource environment entries, or resources such as databases, you must d
the references as follows:

1. Select the WAR.

2. Select the Environment, Enterprise Bean Refs, Resource Env. Ref
Resource Refs tab.

3. Click Add in the panel to add a new reference.
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Event Listeners

To add an event listener class (described inHandling Servlet Life Cycle
Events (page 236)),

1. Select the WAR.

2. Select the Event Listeners tab.

3. Click Add.

4. Select the listener class from the new field in the Event Listener Clas
panel.

Error Mapping

You can specify a mapping between the status code returned in an H
response or a Java programming language exception returned by any web
ponent and another web component or resource (seeHandling
Errors (page 238)). To set up the mapping,

1. Select the WAR.

2. Select the File Refs tab.

3. Click Add in the Error Mapping panel.

4. Enter the HTTP status code (seeHTTP Responses (page 452)) or fully
qualified class name of an exception in the Error/Exception field.

5. Enter the name of a resource to be invoked when the status code or e
tion is returned. The name should have a leading ‘/’.

Note: You can also define error pages for a JSP page contained in a WAR. If erro
pages are defined for both the WAR and a JSP page, the JSP page’s error page ta
precedence.

Filter Mapping

A web container uses filter mapping declarations to decide which filters to ap
to a request, and in what order (seeFiltering Requests and
Responses (page 247)). The container matches the request URI to a serv
described inSpecifyingan Alias Path (page 224). To determine which filters t
apply, it matches filter mapping declarations by servlet name or URL patt
The order in which filters are invoked is the order in which filter mapping dec
rations that match a request URI for a servlet appear in the filter mapping lis
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You specify a filter mapping in thedeploytool as follows:

1. Select the WAR.

2. Select the Filter Mapping tab.

3. Add a filter

a. Click Edit Filter List.

b. Click Add.

c. Select the filter class.

d. Enter a filter name.

e. Add any filter initialization parameters.

f. Click OK.

4. Map the filter

a. Click Add.

b. Select the filter name.

c. Select the target type. A filter can be mapped to a specific servlet o
all servlets that match a given URL pattern.

d. Specify the target. If the target is a servlet, select the servlet from
drop-down list. If the target is a URL pattern, enter the pattern.

Component-Level Configuration

Initialization Parameters

To specify parameters that are passed to the web component when it is in
ized,

1. Select the web component.

2. Select the Init. Parameters tab.

3. Click Add to add a new parameter and value.

Specifying an Alias Path

When a request is received by a web container it must determine which
component should handle the request. It does so by mapping the URL path
tained in the request to a web component. A URL path contains the context
(described inContext Root (page 221)) and analias path:

http://<host>:8000/context root/alias path
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Before a servlet can be accessed, the web container must have least one
path for the component. The alias path must start with a ‘/’ and end with a string
or a wildcard expression with an extension (*.jsp for example). Since Web con-
tainers automatically map an alias path that ends with*.jsp, you do not have to
specify an alias path for a JSP page unless you wish to refer to the page
name other than its file name. In the example discussed inUpdating Web
Components (page 226), the pagegreeting.jsp has an alias,/greeting, but
the pageresponse.jsp is referenced by its file name withingreeting.jsp.

You set up the mappings for the servlet version of the Hello application using
web component inspector as follows:

1. Select the GreetingServlet web component.

2. Select the Aliases tab.

3. Click Add to add a new mapping.

4. Type/greeting in the aliases list.

5. Select the ResponseServlet web component.

6. Click Add.

7. Type/response in the aliases list.

Deploying Web Components
The next step after you have created, packaged, and configured a J2EE ap
tion containing web components is to deploy the application. To deploy
Hello1App application,

1. Select Hello1App.

2. Select Tools->Deploy.

3. Select a Target Server.

4. Click Finish.

Executing Web Components
A web component is executed when a web browser is pointed at a URL th
mapped to the component. Once you have deployed theHello1App application,
you can run it by pointing a browser at:

http://<host>:8000/hello1/greeting
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Replace<host> with the name of the host running the J2EE server. If yo
browser is running on the same host as the J2EE server, you may replace<host>

with localhost.

Updating Web Components
During development, you will often need to make changes to web compone
To update a servlet you modify the source file, recompile the servlet cl
update the component in the WAR, and redeploy the application. Except for
compilation step, you update a JSP page in the same way.

To try this feature, first build, package, and deploy the JSP version of the H
application:

1. Go toj2eetutorial/examples/src and build the example by running
ant hello2.

2. Create a J2EE application calledHello2App.

a. Select File->New->Application.

b. In the file chooser, navigate to j2eetutorial/exam-

ples/src/web/hello2.

c. In the File Name field, enterHello2App .

d. Click New Application.

e. Click OK.

3. Create the WAR and add thegreeting web component and all of the
Hello2App application content.

a. Invoke the web component wizard by selecting File->New->Web Co
ponent.

b. In the combo box labelled Create New WAR File in Application sele
Hello2App. EnterHello2WAR in the field labeled WAR Display Name.

c. Click Edit to add the content files.

d. In the Edit Contents dialog, navigate toexamples/build/web/hello2.
Select greeting.jsp, response.jsp, and duke.waving.gif, and click A
Click OK.

e. Click Next.

f. Select the JSP radio button.

g. Click Next.

h. Select greeting.jsp from the JSP Filename combo box.



UPDATING WEB COMPONENTS 227

at

ts of

has

fore

ede-
i. Click Finish.

4. Add the alias/greeting for thegreeting web component.

5. Specify the context roothello2.

6. Deploy Hello2App.

7. Execute the application by pointing a web browser
http://<host>:8000/hello2/greeting. Replace<host> with the name
of the host running the J2EE server.

Now modify one of the JSP files. For example, you could replace the conten
response.jsp with:

<h2><font color="red">Hello, <%=username%>!</font></h2>

Thus, to update the file in the WAR and redeploy the application:

1. Editresponse.jsp

2. Executeant hello2 to copy the modified file to the build directory.

3. Select Hello2App.

4. In the deploytool, select Tools->Update Files.

5. A dialog appears reporting the changed file.Verify that response.jsp
been changed and dismiss the dialog.

6. Select Tools->Deploy. Make sure the checkbox labeled Save object be
deploying is checked.

You can also perform steps 4. through 6. by selecting Tools->Update and R
ploy. Thedeploytool replaces the old JSP file inHello2App.ear with the new
one and then redeploys the application.
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When you execute the application, the color of the response should be red:

Figure 22 Red Response
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Java Servlet
Technology

by Stephanie Bodoff

AS soon as the web began to be used for delivering services, service prov
recognized the need for dynamic content. Applets, one of the earliest atte
towards this goal, focused on using the client platform to deliver dynamic u
experiences. At the same time, developers also investigated using the serve
form for this purpose. Initially, CGI scripts were the main technology used
generate dynamic content. Though widely used, CGI scripting technology h
number of shortcomings including platform-dependence and lack of scalab
To address these limitations, Java Servlet technology was created as a po
way to provide dynamic, user-oriented content.
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What is a Servlet?
A servlet is a Java programming language class used to extend the capabilit
servers that host applications accessed via a request-response program
model. Although servlets can respond to any type of request, they are comm
used to extend the applications hosted by web servers. For such applica
Java Servlet technology defines HTTP-specific servlet classes.

Thejavax.servlet andjavax.servlet.http packages provide interfaces an
classes for writing servlets. All servlets must implement theServlet interface,
which defines life cycle methods.

When implementing a generic service, you can use or extend theGenericServ-

let class provided with the Java Servlet API. TheHttpServlet class provides
methods, such asdoGet anddoPost, for handling HTTP-specific services.

This chapter focuses on writing servlets that generate responses to H
requests. Some knowledge of the HTTP protocol is assumed; if you are unfa
iar with this protocol, you can get a brief introduction to HTTP inHTTP
Overview (page 451).

http://java.sun.com/j2ee/tutorial/api/javax/servlet/package-summary.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/package-summary.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/Servlet.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/GenericServlet.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/GenericServlet.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpServlet.html
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The Example Servlets
This chapter uses the Duke’s Bookstore application to illustrate the ta
involved in programming servlets. Table 18 lists the servlets that handle e
bookstore function. Each programming task is illustrated by one or more s
lets. For example,BookDetailsServlet illustrates how to handle HTTP GET
requests,BookDetailsServlet and CatalogServlet show how to construct
responses, andCatalogServlet shows you how to track session information.

The data for the bookstore application is maintained in a Cloudscape data
and is accessed through the helper classdatabase.BookDB. Thedatabase pack-
age also contains the classBookDetails which represents a book. The shoppin
cart and shopping cart items are represented by the classescart.ShoppingCart

andcart.ShoppingCartItem.

The source for the bookstore application is located in thej2eetutorial/exam-

ples/src/web/bookstore1 directory created when you unzip the tutorial bun

Table 18 Duke’s Bookstore Example Servlets

Function Servlet

Enter the bookstore BookStoreServlet

Create the bookstore banner BannerServlet

Browse the bookstore catalog CatalogServlet

Put a book in a shopping cart
CatalogServlet,
BookDetailsServlet

Get detailed information on a specific book BookDetailsServlet

Display the shopping cart ShowCartServlet

Remove one or more books from the shopping cartShowCartServlet

Buy the books in the shopping cart CashierServlet

Receive an acknowledgement for the purchase ReceiptServlet



232 JAVA SERVLET TECHNOLOGY

e

.

ct

o

ass,
, and
d
es-
dle (seeDownloadingthe Examples (page xxii)). To build, deploy, and run th
example:

1. Go toj2eetutorial/examples/src and build the example by running
ant bookstore1 (SeeHow to Build and Run the Examples (page xxiii))

2. Start thej2ee server.

3. Startdeploytool.

4. Start the Cloudscape database server by runningcloudscape -start.

5. Load the bookstore data into the database by runningant create-web-

db.

6. Create a J2EE application calledBookstore1App.

a. Select File->New->Application.

b. In the file chooser, navigate to j2eetutorial/exam-

ples/src/web/bookstore1.

c. In the File Name field, enterBookstore1App .

d. Click New Application.

e. Click OK.

7. Create the WAR and add theBannerServletweb component and all of the
Duke’s Bookstore content to theBookstore1App application.

a. Select File->New->Web Component.

b. Click the Create New WAR File in Application radio button and sele
Bookstore1App from the combo box. EnterBookstore1WAR in the field
labeled WAR Display Name.

c. Click Edit to add the content files.

d. In the Edit Archive Contents dialog box, navigate t
j2eetutorial/examples/build/web/bookstore1. Select Ban-
nerServlet.class, BookStoreServlet.class, BookDetailsServlet.cl
CatalogServlet.class, ShowCartServlet.class, CashierServlet.class
ReceiptServlet.class. Click Add. Add errorpage.html an
duke.books.gif. Add the cart, database, exception, filters, listeners, m
sages, and util packages. Click OK.

e. Click Next.

f. Select the servlet radio button.

g. Click Next.

h. Select BannerServlet from the Servlet Class combo box.

i. Click Next twice.
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alias field.

k. Click Finish.

8. Add each of the web components listed in Table 19. For each servlet, c
the Add to Existing WAR File radio button and select Bookstore1WA
from the combo box. Since the WAR contains all of the servlet classes,
do not have to add any more content.

9. Add a resource reference for the Cloudscape database.

a. Select Bookstore1WAR.

b. Select the Resource Refs tab.

c. Click Add.

d. Select javax.sql.DataSource from the Type column

e. Enterjdbc/BookDB in the Coded Name field.

f. Enterjdbc/Cloudscape in the JNDI Name field.

10.Add the listener classlisteners.ContextListener (described inHan-
dling Servlet Life Cycle Events (page 236).

a. Select the Event Listeners tab.

b. Click Add.

c. Select the listeners.ContextListener class from drop down field in
Event Listener Classes panel.

Table 19 Duke’s Bookstore Web Components

Web Component Name Servlet Class Component Alias

BookStoreServlet BookStoreServlet /enter

CatalogServlet CatalogServlet /catalog

BookDetailsServlet BookDetailsServlet /bookdetails

ShowCartServlet ShowCartServlet /showcart

CashierServlet CashierServlet /cashier

ReceiptServlet ReceiptServlet /receipt
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11.Add an error page (described inHandling Errors (page 238)).

a. Select the File Refs tab.

b. Click Add in the Error Mapping panel.

c. Enter exception.BookNotFoundException in the Error/Exception
field.

d. Enter/errorpage.html in the Resource to be Called field.

e. Repeat forexception.BooksNotFoundException and javax.serv-

let.UnavailableException.

12.Add the filtersfilters.HitCounterFilter andfilters.OrderFilter
(described inFiltering Requests and Responses (page 247)).

a. Select the Filter Mapping tab.

b. Click Edit Filter List.

c. Click Add.

d. Select filters.HitCounterFilter from the Filter Class column.

e. SelectHitCounterFilter from the Display Name column.

f. Click Add.

g. Select filters.OrderFilter from the Filter Class column.

h. Select OrderFilter from the Display Name column.

i. Click OK.

j. Click Add.

k. Select HitCounterFilter from the Filter Name column.

l. Select Servlet from the Target Type column.

m.Select BookStoreServlet from the Target column.

n. Repeat for OrderFilter. The target type is Servlet and the targe
ReceiptServlet.

13.Enter the context root.

a. SelectBookstore1App.

b. Select the Web Context tab.

c. Enter bookstore1.

14.Deploy the application.

a. Select Tools->Deploy.

b. Click Finish.

15.Open the bookstore URLhttp://<host>:8000/bookstore1/enter.
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Troubleshooting
Common Problemsand Their Solutions (page 66) (in particularWeb Client
RuntimeErrors (page 70)) lists some reasons why a web application can fai
addition, Duke’s Bookstore returns the following exceptions:

• BookNotFoundException - if a book can’t be located in the bookstore
database. This will occur if you haven’t loaded the bookstore database
data by runningant create-web-db or if the Cloudscape server hasn’
been started or it has crashed.

• BooksNotFoundException - if the bookstore data can’t be retrieved. Thi
will occur if you haven’t loaded the bookstore database with data by r
ning ant create-web-db or if the Cloudscape server hasn’t been start
or it has crashed.

• UnavailableException - if a servlet can’t retrieve the web contex
attribute representing the bookstore. This will occur if you haven’t add
the listener class to the application.

Since we have specified an error page, you will see the messageThe applica-

tion is unavailable. Please try later. If you don’t specify an error page,
the web container generates a default page containing the messageA Servlet

Exception Has Occurred and a stack trace that can help diagnose the caus
the exception. If you use theerrorpage.html, you will have to look in the web
container’s log to determine the cause of the exception. Web log files resid
the directory:

$J2EE_HOME/<logs>/<host>/web

and are namedcatalina.<date>.log.

The<logs> element is the directory specified by thelog.directory entry in the
default.properties file. The default value islogs. The<host> element is the
name of the computer. See theConfiguration Guideprovided with the J2EE
SDK for more information about J2EE SDK log files.
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Servlet Life Cycle
The life cycle of a servlet is controlled by the container in which the servlet h
been deployed. When a request is mapped to a servlet, the container per
the following steps:

1. If an instance of the servlet does not exist, the container:

a. Loads the servlet class

b. Instantiates an instance of the servlet class

c. Initializes the servlet instance by calling theinit method. Initialization
is covered inInitializing a Servlet (page 241).

2. Invokes theservice method, passing a request and response object. S
vice methods are discussed inWriting Service Methods (page 242).

If the container needs to remove the servlet, it finalizes the servlet by calling
servlet’s destroy method. Finalization is discussed inFinalizing a
Servlet (page 261).

Handling Servlet Life Cycle Events
You can monitor and react to events in a servlet’s life cycle by defining liste
objects whose methods get invoked when life cycle events occur. To use t
listener objects you must

• Define the listener class

• Specify the listener class

Defining The Listener Class

You define a listener class as an implementation of a listener interface. Tab
lists the events that can be monitored and the corresponding interface that
be implemented. When a listener method is invoked it is passed an event
contains information appropriate to the event. For example, the methods in
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HttpSessionListener interface are passed anHttpSessionEvent, which con-
tains anHttpSession.

The listeners.ContextListener class creates and removes the databa
helper and counter objects used in the Duke’s Bookstore application. The m
ods retrieve the web context object fromServletContextEvent and then store
(and remove) the objects as servlet context attributes.

import database.BookDB;
import javax.servlet.*;
import util.Counter;

public final class ContextListener
implements ServletContextListener {
private ServletContext context = null;
public void contextInitialized(ServletContextEvent event) {

context = event.getServletContext();
try {

BookDB bookDB = new BookDB();
context.setAttribute("bookDB", bookDB);

} catch (Exception ex) {
System.out.println(

"Couldn't create database: "
+ ex.getMessage());

Table 20 Servlet Life Cycle Events

Object Event Listener Interface and Event Class

Web context
(SeeAccessing
the Web
Context (page 257
))

Initialization
and destruction

javax.servlet.
ServletContextListener and
ServletContextEvent

Attribute added,
removed, or
replaced

javax.servlet.
ServletContextAttributesListener and
ServletContextAttributeEvent

Session
(SeeMaintaining
Client
State(page 258))

Creation,
invalidation,and
timeout

javax.servlet.http.
HttpSessionListener and
HttpSessionEvent

Attribute added,
removed, or
replaced

javax.servlet.http.
HttpSessionAttributesListener and
HttpSessionBindingEvent

http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextEvent.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextAttributesListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextAttributesListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextAttributeEvent.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionEvent.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionAttributesListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionAttributesListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionBindingEvent.html
../examples/src/web/bookstore1/listeners/ContextListener.java
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}
Counter counter = new Counter();
context.setAttribute("hitCounter", counter);
context.log("Created hitCounter"

+ counter.getCounter());
counter = new Counter();
context.setAttribute("orderCounter", counter);
context.log("Created orderCounter"

 + counter.getCounter());
}

public void contextDestroyed(ServletContextEvent event) {
context = event.getServletContext();
BookDB bookDB = context.getAttribute(

"bookDB");
bookDB.remove();
context.removeAttribute("bookDB");
context.removeAttribute("hitCounter");
context.removeAttribute("orderCounter");

}
}

Specifying Event Listener Classes

You specify a listener class for a WAR in thedeploytool Event Listeners
inspector (seeEvent Listeners (page 223)).

Handling Errors
Any number of exceptions can occur when a servlet is executed. The web
tainer will generate a default page containing the messageA Servlet Excep-

tion Has Occurred when an exception occurs, but you can also specify that
container should return a specific error page for a given exception. You spe
error pages for a WAR in thedeploytool File Refs inspector (Error
Mapping (page 223)).

Sharing Information
Web components, like most objects, usually work with other objects to acc
plish their tasks. There are several ways they can do this. They can use pr
helper objects (for example, JavaBeans components), they can share objec
are attributes of a public scope, and they can invoke other web resources
Java Servlet technology mechanisms that allow a web component to invoke o
web resources are described inInvoking Other Web Resources (page 254).
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Collaborating web components share information via objects maintained
attributes of four scope objects. These attributes are accessed with
[get|set]Attribute methods of the class representing the scope. Table 21
the scope objects.

Table 21  Scope Objects

Scope
Object Class Accessible From

web context
javax.servlet.
ServletContext

Web components within a Web context. See
Accessing the Web Context (page 257).

session
javax.servlet.
http.HttpSession

Web components handling a request that belongs to
the session. SeeMaintaining Client
State(page 258).

request
subtype of
javax.servlet.
ServletRequest

Web components handling the request.

page
javax.servlet.
jsp.PageContext

The JSP page that creates the object. See
JavaServer Pages™ Technology(page 265).

http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSession.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContext.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletRequest.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/PageContext.html
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Figure 23shows the scoped attributes maintained by the Duke’s Bookstore ap
cation.

Figure 23 Duke’s Bookstore Scoped Attributes

Controlling Concurrent Access to Shared Resources
In a multithreaded server, it is possible for shared resources to be accessed
currently. Besides scope object attributes, shared resources include in-me
data such as instance or class variables and external objects such as files
base connections, and network connections. Concurrent access can arise i
eral situations:

• Multiple web components accessing objects stored in the web contex

• Multiple web components accessing objects stored in a session

• Multiple threads within a web component accessing instance variable
web container will typically create a thread to handle each request. If
want to ensure that a servlet instance handles only one request at a ti
servlet can implement theSingleThreadModel interface. If a servlet
implements this interface, you are guaranteed that no two threads will e
cute concurrently in the servlet’s service method. A web container
implement this guarantee by synchronizing access to a single instanc
the servlet, or by maintaining a pool of web component instances and
patching each new request to a free instance. This interface does not

  hitCounter
  bookDB
  orderCounter
  

Web context
attributes

  Session
  attribute
cart

BookStoreServlet

ShowCartServlet

ReceiptServlet

CatalogServlet

CashierServlet

BookDetailsServlet

orderFilter

hitCounterFilter

  Session
  attribute
currency

http://java.sun.com/j2ee/tutorial/api/javax/servlet/SingleThreadModel.html
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shared resources such as static class variables or external objects.

When resources can be accessed concurrently, they can be used in an inc
tent fashion. To prevent this, you must control the access using the synchro
tion techniques described in the Threads lesson in the Java Tutorial.

In the previous section we showed five scoped attributes shared by more
one servlet:bookDB, cart, currency, hitCounter, andorderCounter. It is not
necessary to control access to thebookDB attribute because it is only set during
application startup. However, the cart, currency, and counters can be set and
by multiple multithreaded servlets. To prevent these objects from being u
inconsistently, access is controlled by synchronized methods. For example,
is theutil.Counter class:

public class Counter {
private int counter;
public Counter() {

counter = 0;
}
public synchronized int getCounter() {

return counter;
}
public synchronized int setCounter(int c) {

counter = c;
return counter;

}
public synchronized int incCounter() {

return(++counter);
}

}

Initializing a Servlet
After the web container loads and instantiates the servlet class and befo
delivers requests from clients, the web container initializes the servlet. You
customize this process to allow the servlet to read persistent configuration
initialize resources, and perform any other one-time activities by overriding
init method of theServlet interface. A servlet that cannot complete its initia
ization process should throwUnavailableException.

All the servlets that access the bookstore database (BookStoreServlet, Cata-
logServlet, BookDetailsServlet, andShowCartServlet) initialize a variable

http://java.sun.com/docs/books/tutorial/essential/threads/index.html
http://java.sun.com/docs/books/tutorial
../examples/src/web/bookstore1/BookStoreServlet.java
../examples/src/web/bookstore1/CatalogServlet.java
../examples/src/web/bookstore1/CatalogServlet.java
../examples/src/web/bookstore1/BookDetailsServlet.java
../examples/src/web/bookstore1/ShowCartServlet.java
http://java.sun.com/j2ee/tutorial/api/javax/servlet/Servlet.html
../examples/src/web/bookstore1/util/Counter.java
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in theirinit method that points to the database helper object created by the
context listener:

public class CatalogServlet extends HttpServlet {
private BookDB bookDB;
public void init() throws ServletException {

bookDB = (BookDB)getServletContext().
getAttribute("bookDB");

if (bookDB == null) throw new
UnavailableException("Couldn't get database.");

}
}

Writing Service Methods
The service provided by a servlet is implemented in theservice method of a
GenericServlet, thedoMethod methods (whereMethod can take the valueGet,
Delete, Options, Post, Put, Trace) of anHttpServlet, or any other protocol-
specific methods defined by a class that implements theServlet interface. In the
rest of this chapter, the term “service method” will be used for any method
servlet class that provides a service to a client.

The general pattern for a service method is to extract information from
request, access external resources, and then populate the response based
information.

For HTTP servlets, the correct procedure for populating the response is to
fill in the response headers, then retrieve an output stream from the response
finally write any body content to the output stream. Response headers
always be set before aPrintWriter or ServletOutputStream is retrieved
because the HTTP protocol expects to receive all headers before body con
The next two sections describe how to get information from requests and ge
ate responses.
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Getting Information From Requests
A request contains data passed between a client and the servlet. All req
implement theServletRequest interface. This interface defines methods fo
accessing the following information:

• Parameters, which are typically used to convey information between
ents and servlets

• Object-valued attributes, which are typically used to pass informat
between the servlet container and a servlet or between collaborating s
lets

• Information about the protocol used to communicate the request and
client and server involved in the request

• Information relevant to localization

For example, inCatalogServlet the identifier of the book that a custome
wishes to purchase is included as a parameter to the request. The following
fragment illustrates how to use thegetParameter method to extract the identi-
fier:

String bookId = request.getParameter("Add");
if (bookId != null) {

BookDetails book = bookDB.getBookDetails(bookId);

You can also retrieve an input stream from the request and manually pars
data. To read character data, use theBufferedReader object returned by the
request’sgetReader method. To read binary data, use theServletInputStream

returned bygetInputStream.

HTTP servlets are passed an HTTP request object,HttpServletRequest, which
contains the request URL, HTTP headers, query string, and so on.

An HTTP request URL contains the following parts:

http://[host]:[port][request path]?[query string]

The request path is further composed of the following elements:

• Context path: A concatenation of’/’with the context root of the servlet’s
J2EE application.

• Servlet path: The path section that corresponds to the component a
that activated this request. This path starts with a’/’.

../examples/src/web/bookstore1/CatalogServlet.java
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletRequest.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpServletRequest.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletInputStream.html
http://java.sun.com/j2se/1.3/docs/api/java/io/BufferedReader.html
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• Path info: The part of the request path that is not part of the context p
or the servlet path.

Table 23 gives some examples of how the URL will be broken down if the c
text path is/catalog, and the aliases are as listed in Table 22:

Query strings are composed of a set of parameters and values. Individual pa
eters are retrieved from a request with thegetParameter method. There are two
ways to generate query strings:

• A query string can explicitly appear in a web page. For example, an HTM
page generated by theCatalogServlet could contain the link<a
href="/bookstore1/catalog?Add=101">Add To Cart</a>. Cata-

logServlet extracts the parameter namedAdd as follows:

String bookId = request.getParameter("Add");

• A query string is appended to a URL when a form with aGET HTTP
method is submitted. In the Duke’s Bookstore application,CashierServ-

let generates a form, a user name input to the form is appended to
URL that maps toReceiptServlet, andReceiptServlet extracts the
user name using thegetParameter method.

Table 22 Aliases

Pattern Servlet

/lawn/* LawnServlet

/*.jsp JSPServlet

Table 23 Request Path Elements

Request Path Servlet Path Path Info

/catalog/lawn/index.html /lawn /index.html

/catalog/help/feedback.jsp /help/feedback.jsp null

../examples/src/web/bookstore1/ReceiptServlet.java
../examples/src/web/bookstore1/CashierServlet.java
../examples/src/web/bookstore1/CashierServlet.java
../examples/src/web/bookstore1/CatalogServlet.java
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Constructing Responses
A response contains data passed between a server and the client. All resp
implement theServletResponse interface. This interface defines methods th
allow you to:

• Retrieve an output stream to use to send data to the client. To send ch
ter data, use thePrintWriter returned by the response’sgetWriter
method. To send binary data in a MIME body response, use theServ-

letOutputStream returned bygetOutputStream. To mix binary and text
data, for example, to create a multipart response, use aServletOutput-

Stream and manage the character sections manually.

• Indicate the content type (for example,text/html), being returned by the
response. A registry of content type names is kept by IANA at:

ftp://ftp.isi.edu/in-notes/iana/assignments/media-types

• Indicate whether to buffer output. By default, any content written to t
output stream is immediately sent to the client. Buffering allows conten
be written before anything is actually sent back to the client, thus provid
the servlet with more time to set appropriate status codes and heade
forward to another web resource.

• Set localization information.

HTTP response objects,HttpServletResponse, also have fields representing
HTTP headers such as

• Status codes, which are used to indicate the reason of a request is no
isfied.

• Cookies, which are used to store application-specific information at the
ent. Sometimes cookies are used to maintain an identifier for trackin
user’s session (seeMaintaining Client State (page 258)).

In Duke’s Bookstore,BookDetailsServlet generates an HTML page that dis
plays information about a book which the servlet retrieves from a database.
servlet first sets response headers: the content type of the response and the
size. The servlet buffers the page content because the database access can
ate an exception that would cause forwarding to an error page. By buffering
response, the client will not see a concatenation of part of a Duke’s Books
page with the error page should an error occur. ThedoGet method then retrieves
aPrintWriter from the response.

ftp://ftp.isi.edu/in-notes/iana/assignments/media-types
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletResponse.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpServletResponse.html
../examples/src/web/bookstore1/BookDetailsServlet.java
http://java.sun.com/j2se/1.3/docs/api/java/io/PrintWriter.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletOutputStream.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletOutputStream.html
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For filling in the response, the servlet first dispatches the request toBannerServ-

let, which generates a common banner for all the servlets in the applicat
This process is discussed inIncluding the Contentof AnotherResourcein the
Response (page 254). Then the servlet retrieves the book identifier fro
request parameter and uses the identifier to retrieve information about the
from the bookstore database. Finally the servlet generates HTML markup
describes the book information and commits the response to the client by ca
theclose method on thePrintWriter.

public class BookDetailsServlet extends HttpServlet {
 public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// set headers before accessing the Writer
response.setContentType("text/html");
response.setBufferSize(8192);
PrintWriter out = response.getWriter();

// then write the response
out.println("<html>" +
"<head><title>+
messages.getString("TitleBookDescription")
+</title></head>");

// Get the dispatcher; it gets the banner to the user
RequestDispatcher dispatcher =

getServletContext().
getRequestDispatcher("/banner");

if (dispatcher != null)
dispatcher.include(request, response);

//Get the identifier of the book to display
String bookId = request.getParameter("bookId");
if (bookId != null) {

// and the information about the book
try {

BookDetails bd =
bookDB.getBookDetails(bookId);

...
//Print out the information obtained
out.println("<h2>" + bd.getTitle() + "</h2>" +
...

} catch (BookNotFoundException ex) {
response.resetBuffer();
throw new ServletException(ex);

}
}
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out.println("</body></html>");
out.close();

}
}

BookDetailsServlet generates a page that looks like:

Figure 24 Book Details

Filtering Requests and Responses
A filter is an object that can transform the header and/or content of a reque
response. Filters differ from web components in that they usually do not th
selves create a response. Instead, a filter provides functionality that ca
“attached” to any kind of web resource. As a consequence, a filter should
have any dependencies on a web resource for which it is acting as a filter so
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it can be composable with more than one type of web resource. The main t
that a filter can perform are:

• Query the request and act accordingly

• Block the request and response pair from passing any further.

• Modify the request headers and data. You do this by providing a cust
ized version of the request.

• Modify the response headers and data. You do this by providing a cust
ized version of the response.

• Interact with external resources

Applications of filters include authentication, logging, image conversion, d
compression, encryption, tokenizing streams, XML transformations, and so

You can configure a web component to be filtered by a chain of zero, one
more filters in a specific order. This chain is specified when the web applica
containing the component is deployed and instantiated when a web conta
loads the component.

In summary, the tasks involved in using filters include:

• Programming the filter

• Programming customized requests and responses

• Specifying the filter chain for each servlet

Programming Filters
The filtering API is defined by theFilter, FilterChain, andFilterConfig

interfaces in thejavax.servlet package. You define a filter by implementin
theFilter interface. The most important method in this interface is thedoFil-

ter method, which is passed request, response, and filter chain objects.
method can perform the following actions:

• Examine the request headers

• Customize the request object if it wishes to modify request headers or

• Customize the response object if it wishes to modify response heade
data

• Invoke the next entity in the filter chain. If the current filter is the last filt
in the chain that ends with the target web component or static resource
next entity is the resource at the end of the chain; otherwise, it is the n
filter that was configured in the WAR. It invokes the next entity by callin
the doFilter method on the chain object (passing in the request a

http://java.sun.com/j2ee/tutorial/api/javax/servlet/Filter.html
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response it was called with, or the wrapped versions it may have crea
Alternatively, it can choose to block the request by not making the cal
invoke the next entity. In the latter case, the filter is responsible for filli
out the response.

• Examine response headers after it has invoked the next filter in the ch

• Throw an exception to indicate an error in processing

In addition todoFilter, you must implement theinit anddestroy methods.
The init method is called by the container when the filter is instantiated. If y
wish to pass initialization parameters to the filter you retrieve them from
FilterConfig object passed toinit.

The Duke’s Bookstore application uses the filtersHitCounterFilter and
OrderFilter to increment and log the value of a counter when the entry a
receipt servlets are accessed.

In the doFilter method, both filters retrieve the servlet context from the filt
configuration object so that they can access the counters stored as co
attributes. After the filters have completed application-specific processing,
invoke doFilter on the filter chain object passed into the originaldoFilter

method. The elided code is discussed in the next section.

public final class HitCounterFilter implements Filter {
private FilterConfig filterConfig = null;

public void init(FilterConfig filterConfig)
throws ServletException {
this.filterConfig = filterConfig;

}
public void destroy() {

this.filterConfig = null;
}
public void doFilter(ServletRequest request,

ServletResponse response, FilterChain chain)
throws IOException, ServletException {
if (filterConfig == null)

return;
StringWriter sw = new StringWriter();
PrintWriter writer = new PrintWriter(sw);
Counter counter = (Counter)filterConfig.

getServletContext().
getAttribute("hitCounter");

writer.println();
writer.println("===============");
writer.println("The number of hits is: " +

counter.incCounter());

../examples/src/web/bookstore1/filters/OrderFilter.java
../examples/src/web/bookstore1/filters/HitCounterFilter.java
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writer.println("===============");
// Log the resulting string
writer.flush();
filterConfig.getServletContext().

log(sw.getBuffer().toString());
...
chain.doFilter(request, wrapper);
...

}
}

Programming Customized Requests and Responses
There are many ways for a filter to modify a request or response. For examp
filter could add an attribute to the request or insert data in the response. In
Duke’s Bookstore example,HitCounterFilter inserts the value of the counte
into the response.

A filter that modifies a response must usually capture the response before
returned to the client. The way to do this is to pass the servlet that generate
response a stand-in stream. The stand-in stream prevents the servlet from c
the original response stream when it completes and allows the filter to mo
the servlet’s response.

In order to pass this stand-in stream to the servlet, the filter creates a resp
“wrapper” that overrides thegetWriter or getOutputStream method to return
this stand-in stream. The wrapper is passed to thedoFilter method of the filter
chain. Wrapper methods default to calling through to the wrapped reques
response object. This approach follows the well-known Wrapper or Decor
pattern described inDesign Patterns, Elements of Reusable Object-Orien
Software. The following sections describe how the hit counter filter describ
earlier and other types of filters use wrappers.

To override request methods, you wrap the request in an object that ext
ServletRequestWrapper or HttpServletRequestWrapper. To override
response methods, you wrap the response in an object that ext
ServletResponseWrapper or HttpServletResponseWrapper.

HitCounterFilter wraps the response in aCharResponseWrapper. The
wrapped response is passed to the next object in the filter chain, which isBook-

StoreServlet. BookStoreServlet writes its response into the stream create
by CharResponseWrapper. Whenchain.doFilter returns,HitCounterFilter
retrieves the servlet’s response fromPrintWriter and writes it to a buffer. The
filter inserts the value of the counter into the buffer, resets the content len

../examples/src/web/bookstore1/filters/CharResponseWrapper.java
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletRequestWrapper.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpServletRequestWrapper.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletResponseWrapper.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpServletResponseWrapper.html
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the
header of the response, and finally writes the contents of the buffer to
response stream.

PrintWriter out = response.getWriter();
CharResponseWrapper wrapper = new CharResponseWrapper(

(HttpServletResponse)response);
chain.doFilter(request, wrapper);
CharArrayWriter caw = new CharArrayWriter();
caw.write(wrapper.toString().substring(0,

wrapper.toString().indexOf("</body>")-1));
caw.write("<p>\n<center><center>" +

messages.getString("Visitor") + "<font color='red'>" +
counter.getCounter() + "</font><center>");

caw.write("\n</body></html>");
response.setContentLength(caw.toString().length());
out.write(caw.toString());
out.close();

public class CharResponseWrapper extends
HttpServletResponseWrapper {
private CharArrayWriter output;
public String toString() {

return output.toString();
}
public CharResponseWrapper(HttpServletResponse response){

super(response);
output = new CharArrayWriter();

}
public PrintWriter getWriter(){

return new PrintWriter(output);
}

}
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Figure 25 shows the entry page for Duke’s Bookstore with the hit counter.

Figure 25 Duke’s Bookstore

Specifying Filter Mappings
A web container uses filter mappings to decide how to apply filters to w
resources. A filter mapping matches a filter to a web component by name o
web components and static resources by URL pattern. The filters are invoke
the order that filter mappings appear in the filter mapping list of a WAR. Y
specify a filter mapping list for a WAR in thedeploytool Filter Mapping
inspector (seeFilter Mapping (page 223)).
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Table 24 contains the filter mapping list for the Duke’s Bookstore applicati
The filters are matched by servlet name and each filter chain contains only
filter.

You can map a filter to one or more web resource and you can map more
one filter to a web resource. This is illustrated in Figure 26, where filter F1
mapped to web resources W1, W2, and W3, filter F2 is mapped to W2, and fi
F3 is mapped to W1 and W2.

Figure 26 Filter to Servlet Mapping

Recall that a filter chain is one of the objects passed to thedoFilter method of a
filter. This chain is formed indirectly via filter mappings. The order of the filte
in the chain is the same as the order that filter mappings appear in the web a
cation deployment descriptor.

Table 24 Duke’s Bookstore Filter Mapping List

Servlet Name Filter

BookStoreServlet HitCounterFilter

ReceiptServlet OrderFilter

F1

S1

F3

F2

S3

S2
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When a URL is mapped to web resource W1, the web container invokes
doFilter method of F1. ThedoFilter method of each filter in W1’s filter chain
is invoked by the preceding filter in the chain via thechain.doFilter method.
Since W1’s filter chain contains filters F1 and F3, F1’s call tochain.doFilter

invokes thedoFilter method of filter F3. When F3’sdoFilter method com-
pletes, control returns to F1’sdoFilter method.

Invoking Other Web Resources
Web components can invoke other web resources in two ways: indirect
direct.

A web component indirectly invokes another web resource when it embed
URL that points to another web component in content returned to a client. In
Duke’s Bookstore application, most web components contain embedded U
that point to other web components. For example,ReceiptServlet indirectly
invokes theCatalogServlet through the embedded URL/bookstore1/cata-
log.

A web component can also directly invoke another resource while it is execut
There are two possibilities: it can include the content of another resource,
can forward a request to another resource.

To invoke a resource available on the server that is running a web compon
you must first obtain aRequestDispatcher using the getRequestDis-

patcher("URL") method.

You can get aRequestDispatcher from either a request or the web contex
however, the two methods have slightly different behavior. The method takes
path to the requested resource as an argument. A request can take a relativ
(that is, one that does not begin with a’/’), but the web context requires an
absolute path. If the resource is not available, or if the server has not im
mented aRequestDispatcher object for that type of resource,getRequestDis-
patcher will return null. Your servlet should be prepared to deal with th
condition.

Including the Content of Another Resource in the
Response
It is often useful to include content of another resource, for example, banner
tent or copyright information, in the response returned from a web compon

http://java.sun.com/j2ee/tutorial/api/javax/servlet/RequestDispatcher.html
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To include the content of another resource, invoke theinclude method of a
RequestDispatcher:

include(request, response);

If the resource is static, theinclude method enables programmatic server-sid
includes. If the resource is a web component, the effect of the method is to
the request to the included web component, execute the web component
then include the result of the execution in the response from the containing s
let. An included web component has access to the request object, but it is lim
in what it can do with the response object:

• It can write to the body of and commit a response.

• It cannot set headers or call any method (for example,setCookie) that
affects the headers of the response.

The banner for the Duke’s Bookstore application is generated byBannerServ-

let. Note that bothdoGet anddoPost methods are implemented becauseBan-

nerServlet can be dispatched from either method in a calling servlet.

public class BannerServlet extends HttpServlet {
public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

PrintWriter out = response.getWriter();
out.println("<body bgcolor=\"#ffffff\">" +
"<center>" + "<hr> <br> &nbsp;" + "<h1>" +
"<font size=\"+3\" color=\"#CC0066\">Duke's </font>" +
<img src=\"" + request.getContextPath() +
"/duke.books.gif\">" +
"<font size=\"+3\" color=\"black\">Bookstore</font>" +
"</h1>" + "</center>" + "<br> &nbsp; <hr> <br> ");

}
public void doPost (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

PrintWriter out = response.getWriter();
out.println("<body bgcolor=\"#ffffff\">" +
"<center>" + "<hr> <br> &nbsp;" + "<h1>" +
"<font size=\"+3\" color=\"#CC0066\">Duke's </font>" +
<img src=\"" + request.getContextPath() +
"/duke.books.gif\">" +

../examples/src/web/bookstore1/BannerServlet.java
../examples/src/web/bookstore1/BannerServlet.java
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"<font size=\"+3\" color=\"black\">Bookstore</font>" +
"</h1>" + "</center>" + "<br> &nbsp; <hr> <br> ");

}
}

Each servlet in the Duke’s Bookstore application includes the result fromBan-

nerServlet with the following code:

RequestDispatcher dispatcher =
getServletContext().getRequestDispatcher("/banner");

if (dispatcher != null)
dispatcher.include(request, response);

}

Transferring a Control to Another Web Component
In some applications you might want to have one web component do prelimin
processing of a request and another component generate the response. For
ple, you might want to partially process a request and then transfer to ano
component depending on the nature of the request.

To transfer control to another web component, you invoke theforward method
of aRequestDispatcher. When a request is forwarded, the request URL is set
the path of the forwarded page. If the original URL is required for any proce
ing you can save it as a request attribute. TheDispatcher servlet, used by a ver-
sion of the Duke’s Bookstore application described inA Template Tag
Library (page 328), saves the path information from the original URL, retrie
aRequestDispatcher from the request, and then forwards to the JSP pagetem-

plate.jsp.

public class Dispatcher extends HttpServlet {
public void doGet(HttpServletRequest request,

HttpServletResponse response) {
request.setAttribute("selectedScreen",

request.getServletPath());
RequestDispatcher dispatcher = request.

getRequestDispatcher("/template.jsp");
if (dispatcher != null)

dispatcher.forward(request, response);
}
public void doPost(HttpServletRequest request,
...

}

../examples/src/web/bookstore3/Dispatcher.java
../examples/src/web/bookstore3/template.txt
../examples/src/web/bookstore3/template.txt
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Theforward method should be used to give another resource responsibility
replying to the user. If you have already accessed aServletOutputStream or
PrintWriter object within the servlet, you cannot use this method; it throws
IllegalStateException.

Accessing the Web Context
The context in which web components execute is an object that implements
ServletContext interface. You retrieve the web context with thegetServlet-
Context method. The web context provides methods for accessing:

• Initialization parameters

• Resources associated with the web context

• Object-valued attributes

• Logging capabilities

The web context is used by the Duke’s Bookstore filtersfilters.HitCounter-

Filter and OrderFilter discussed in Filtering Requests and
Responses (page 247). The filters store a counter as a context attribute. R
from Controlling ConcurrentAccessto SharedResources (page 240) that th
counter’s access methods are synchronized to prevent incompatible opera
by servlets that are running concurrently. A filter retrieves the counter ob
with the context’sgetAttribute method. The incremented value of the count
is recorded with the context’slog method.

public final class HitCounterFilter implements Filter {
private FilterConfig filterConfig = null;
public void doFilter(ServletRequest request,

ServletResponse response, FilterChain chain)
throws IOException, ServletException {
...
StringWriter sw = new StringWriter();
PrintWriter writer = new PrintWriter(sw);
ServletContext context = filterConfig.

getServletContext();
Counter counter = (Counter)context.

getAttribute("hitCounter");
...
writer.println("The number of hits is: " +

counter.incCounter());
...

http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContext.html
../examples/src/web/bookstore1/filters/HitCounterFilter.java
../examples/src/web/bookstore1/filters/HitCounterFilter.java
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context.log(sw.getBuffer().toString());
...

}
}

Maintaining Client State
Many applications require a series of requests from a client to be associated
one another. For example, the Duke’s Bookstore application saves the state
user’s shopping cart across requests. Web-based applications are responsi
maintaining such state, called asession, because the HTTP protocol is stateles
To support applications that need to maintain state, Java Servlet technology
vides an API for managing sessions and allows several mechanisms for im
menting sessions.

Accessing a Session
Sessions are represented by anHttpSession object. You access a session b
calling thegetSession method of a request object. This method returns the c
rent session associated with this request, or, if the request does not have
sion, creates one. SincegetSession may modify the response header (if cookie
are the session tracking mechanism), it needs to be called before you retri
PrintWriter or ServletOutputStream.

Associating Attributes with a Session
You can associate object-valued attributes with a session by name. S
attributes are accessible by any web component that belongs to the same
contextand is handling a request that is part of the same session.

The Duke’s Bookstore application stores a customer’s shopping cart as a se
attribute. This allows the shopping cart to be saved between requests and
allows cooperating servlets to access the cart.CatalogServlet adds items to the
cart, ShowCartServlet displays, deletes items from, and clears the cart, a
CashierServlet retrieves the total cost of the books in the cart.

public class CashierServlet extends HttpServlet {
public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// Get the user's session and shopping cart

http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContextListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSession.html
../examples/src/web/bookstore1/CatalogServlet.java
../examples/src/web/bookstore1/ShowCartServlet.java
../examples/src/web/bookstore1/CashierServlet.java
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HttpSession session = request.getSession();
ShoppingCart cart =

(ShoppingCart)session.
getAttribute("cart");

...
// Determine the total price of the user's books
double total = cart.getTotal();

Notifying Objects That Are Added To a Session

Recall that your application can notify web context and session listener obj
of servlet life cycle events (HandlingServletLife CycleEvents (page 236)). You
can also notify objects of certain events related to their association with a
sion:

• When the object is added to or removed from a session. To receive
notification, your object must implement thejavax.http.HttpSession-
BindingListener interface.

• When the session to which the object is attached will be passivated an
activated. A session will be passivated and activated when it is mo
between VMs or saved to and restored from persistent storage. To receive
this notification, your object must implement thejavax.http.HttpSes-
sionActivationListener interface.

Session Management
Since there is no way for an HTTP client to signal that it no longer needs a
sion, each session has an associated time-out so that its resources c
reclaimed. The time-out period can be accessed with a session’s[get|set]Max-

InactiveInterval methods. You can also set the time-out period indeploy-

tool:

1. Select the WAR.

2. Select the General tab.

3. Enter the time-out period in the Advanced box.

To ensure that an active session is not timed-out, you should periodically ac
the session in service methods because this resets the session’s time-t
counter.

When a particular client interaction is finished, you use the session’sinvali-

date method to delete a session on the server side. The session data is rem
and when a new request is made to the servlet, a new session will be creat

http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionBindingListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionBindingListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionActivationListener.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSessionActivationListener.html
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The bookstore application’sReceiptServlet is the last servlet to access a cli
ent’s session, so it has responsibility for invalidating the session:

public class ReceiptServlet extends HttpServlet {
public void doPost(HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// Get the user's session and shopping cart
HttpSession session = request.getSession();
// Payment received -- invalidate the session
session.invalidate();
...

Session Tracking
A web container can use several methods to associate a session with a user
which involve passing an identifier between the client and server. The m
methods require the client to accept cookies or the web component to rewrite
URL that is returned to the client.

If your application makes use of session objects, you must ensure that se
tracking is enabled by allowing the application to rewrite a URL whenever
client turns off cookies. You do this by calling the response’sencodeURL(URL)

method on all URLs returned by a servlet. This method includes the sessio
in the URL only if cookies are disabled; otherwise it returns the UR
unchanged.

ThedoGet method ofShowCartServlet encodes the three URLs at the bottom
of the shopping cart display page as follows:

out.println("<p> &nbsp; <p><strong><a href=\"" +
response.encodeURL(request.getContextPath() + "/catalog") +

"\">" + messages.getString("ContinueShopping") +
"</a> &nbsp; &nbsp; &nbsp;" +
"<a href=\"" +

response.encodeURL(request.getContextPath() + "/cashier") +
"\">" + messages.getString("Checkout") +
"</a> &nbsp; &nbsp; &nbsp;" +
"<a href=\"" +

response.encodeURL(request.getContextPath() +
"/showcart?Clear=clear") +
"\">" + messages.getString("ClearCart") +
"</a></strong>");

../examples/src/web/bookstore1/ReceiptServlet.java
../examples/src/web/bookstore1/ShowCartServlet.java


FINALIZING A SERVLET 261

fol-

ser-
, or

e any
re-

is

cific

ques

n

the
ized
If cookies are turned off, the session is encoded in the Check Out URL as
lows:

http://localhost:8080/bookstore1/cashier;
jsessionid=c0o7fszeb1

If cookies are turned on, the URL is simply:

http://localhost:8080/bookstore1/cashier

Finalizing a Servlet
When a servlet container determines that a servlet should be removed from
vice (for example, when a container wants to reclaim memory resources
when it is being shut down) it calls thedestroy method of theServlet inter-
face. In this method you release any resources the servlet is using and sav
persistent state. The followingdestroy method releases the database object c
ated in theinit method described inInitializing a Servlet (page 241):

public void destroy() {
bookDB = null;

}

All of a servlet’s service methods should be complete when a servlet
removed. The server tries to ensure this completion by calling thedestroy

method only after all service requests have returned or after a server-spe
grace period, whichever comes first.

If your servlet has potentially long-running service requests, use the techni
described below to:

• Keep track of how many threads are currently running theservice method

• Provide a clean shutdown by having thedestroy method notify long-run-
ning threads of the shutdown and wait for them to complete

• Have the long-running methods poll periodically to check for shutdow
and, if necessary, stop working, clean up, and return

Tracking Service Requests
To track service requests, include in your servlet class a field that counts
number of service methods that are running. The field should have synchron
access methods to increment, decrement, and return its value.
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public ShutdownExample extends HttpServlet {
private int serviceCounter = 0;
...
//Access methods for serviceCounter
protected synchronized void enteringServiceMethod() {

serviceCounter++;
}
protected synchronized void leavingServiceMethod() {

serviceCounter--;
}
protected synchronized int numServices() {

return serviceCounter;
}

}

Theservice method should increment the service counter each time the met
is entered and should decrement the counter each time the method returns
is one of the few times that yourHttpServlet subclass should override theser-
vice method. The new method should callsuper.service to preserve all of the
originalservice method’s functionality.

protected void service(HttpServletRequest req,
HttpServletResponse resp)
throws ServletException,IOException {

enteringServiceMethod();
try {

super.service(req, resp);
} finally {

leavingServiceMethod();
}

}

Providing a Clean Shutdown
To ensure a clean shutdown, yourdestroy method should not release any share
resources until all of the service requests have completed. One part of doing
is to check the service counter. Another part is to notify the long-running me
ods that it is time to shut down. For this notification another field is required. T
field should have the usual access methods.

public ShutdownExample extends HttpServlet {
private boolean shuttingDown;
...
//Access methods for shuttingDown
protected setShuttingDown(boolean flag) {

shuttingDown = flag;
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protected boolean isShuttingDown() {

return shuttingDown;
}

}

An example of thedestroy method using these fields to provide a clean shu
down follows:

public void destroy() {
/* Check to see whether there are still service methods /*
/* running, and if there are, tell them to stop. */
if (numServices() > 0) {

setShuttingDown(true);
}

/* Wait for the service methods to stop. */
while(numServices() > 0) {

try {
Thread.sleep(interval);

} catch (InterruptedException e) {
}

}
}

Creating Polite Long-Running Methods
The final step to provide a clean shutdown is to make any long-running meth
behave politely. Methods that might run for a long time should check the va
of the field that notifies them of shutdowns and should interrupt their work
necessary.

public void doPost(...) {
...
for(i = 0; ((i < lotsOfStuffToDo) &&

!isShuttingDown()); i++) {
try {

partOfLongRunningOperation(i);
} catch (InterruptedException e) {

...
}

}
}
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Technology

by Stephanie Bodoff

JAVA SERVER Pages™ (JSP™) technology allows you to easily create w
content that has both static and dynamic components. JSP technology pro
all the dynamic capabilities of Java Servlet technology but provides a more n
ral approach to creating static content. The main features of JSP technolog

• A language for developing JSP pages, which are text-based document
describe how to process a request and construct a response

• Constructs for accessing server-side objects

• Mechanisms for defining extensions to the JSP language

JSP technology also contains API that is used by developers of web contai
but this API is not covered in this chapter.

What is a JSP Page? 200
The Example JSP Pages 203
The Life Cycle of a JSP Page 206

Translation and Compilation 206
Execution 207

Initializing and Finalizing a JSP Page 209
Creating Static Content 210
Creating Dynamic Content 210

Using Objects Within JSP Pages 210
JSP Scripting Elements 213

Including Content in a JSP Page 216
265

Bios.html


266 JAVASERVER PAGES™ TECHNOLOGY

tem-
ML,
. A

ays

L
bably
Transferring Control to Another Web Component 217
Param Element 217

Including an Applet 218
Extending the JSP Language 220

What is a JSP Page?
A JSP page is a text-based document that contains two types of text: static
plate data, which can be expressed in any text-based format such as HT
SVG, WML, and XML, and JSP elements, which construct dynamic content
syntax card and reference for the JSP elements is available at:

http://java.sun.com/products/jsp/technical.html#syntax

The following web page is a form that allows you to select a locale and displ
the date in a manner appropriate to the locale.

Figure 27 Localized Date Form

The source for this example is in thej2eetutorial/examples/src/web/date
directory created when you unzip the tutorial bundle. The JSP pageindex.jsp

used to create the form appears below; it is a typical mixture of static HTM
markup and JSP elements. If you have developed web pages, you are pro
familiar with the HTML document structure statements (<head>, <body>, and so
on) and the HTML statements that create a form<form> and a menu<select>.

../examples/src/web/date/index.txt
http://www.w3.org/MarkUp
http://www.w3.org/TR/SVG
http://www.oasis-open.org/cover/wap-wml.html
http://www.w3.org/TR/REC-xml
http://java.sun.com/products/jsp/technical.html#syntax
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The highlighted lines in the example contain the following types of JSP c
structs:

• Directives (<@page ... %>) import classes in thejava.util package and
theMyLocales class, and set the content type returned by the page.

• The jsp:useBean element creates an object containing a collection
locales and initializes a variable that point to that object.

• Scriptlets (<% ... %> ) retrieve the value of thelocale request parameter,
iterate over a collection of locale names, and conditionally insert HTM
text into the output.

• Expressions (<%= ... %>) insert the value of the locale name into th
response.

• Thejsp:include element sends a request to another page (date.jsp) and
includes the response in the response from the calling page.

<%@ page import="java.util.*,MyLocales" %>
<%@ page contentType="text/html; charset=ISO-8859-5" %>
<html>
<head><title>Localized Dates</title></head>
<body bgcolor="white">
<jsp:useBean id="locales" scope="application"

class="MyLocales"/>
<form name="localeForm" action="index.jsp" method="post">
<b>Locale:</b>
<select name=locale>
<%

String selectedLocale = request.getParameter("locale");
Iterator i = locales.getLocaleNames().iterator();
while (i.hasNext()) {

String locale = (String)i.next();
if (selectedLocale != null &&

selectedLocale.equals(locale)) {
%>

<option selected><%=locale%></option>
<%

} else {
%>

<option><%=locale%></option>
<%

}
}

%>
</select>
<input type="submit" name="Submit" value="Get Date">



268 JAVASERVER PAGES™ TECHNOLOGY

bo

dd,
</form>
<jsp:include page="date.jsp"/>
</body>
</html>

To build, deploy, and execute this JSP page:

1. Go toj2eetutorial/examples/src and build the example by executing
ant date (seeHow to Build and Run the Examples (page xxiii)).

2. Create a J2EE application calledDateApp.

a. Select File->New->Application.

b. In the file chooser, navigate toj2eetutorial/examples/src/web/
date.

c. In the File Name field, enterDateApp .

d. Click New Application.

e. Click OK.

3. Create the WAR and add the web components to theDateApp application.

a. Select File->New->Web Component.

b. Select DateApp from the Create new WAR File in Application com
box.

c. EnterDateWAR in the WAR Display Name field.

d. Click Edit.

e. Navigate to j2eetutorial/examples/build/web/date. Select
index.jsp, date.jsp, MyDate.class and MyLocales.class and click A
then click Finish.

f. Click Next.

g. Click JSP in the Web Component radio box, then click Next.

h. Select index.jsp from the JSP Filename combo box. Click Finish.

4. Enter the context root.

a. Select DateApp.

b. Select the Web Context tab.

c. Enterdate.

5. Deploy the application.

a. Select Tools->Deploy.

b. Click Finish.
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6. Invoke the URLhttp://<host>:8000/date in a browser.

You will see a combo box whose entries are locales. Select a locale and click
Date. You will see the date expressed in a manner appropriate for that loca

The Example JSP Pages
To illustrate JSP technology, this chapter rewrites each servlet in the Du
Bookstore application introduced inThe ExampleServlets (page 231) as a JS
page:

The data for the bookstore application is still maintained in a Cloudscape d
base. However, two changes are made to the database helper objectdata-

base.BookDB:

• The database helper object is rewritten to conform to JavaBeans com
nent design patterns as described inJavaBeans™Componentsin JSP™
Pages (page 289). This change is made so that JSP pages can acce
helper object using JSP language elements specific to JavaBeans co
nents.

Table 25 Duke’s Bookstore Example JSP Pages

Function JSP Pages

Enter the bookstore bookstore.jsp

Create the bookstore banner banner.jsp

Browse the books offered for sale catalog.jsp

Put a book in a shopping cart catalog.jsp andbookdetails.jsp

Get detailed information on a specific book bookdetails.jsp

Display the shopping cart showcart.jsp

Remove one or more books from the shopping cartshowcart.jsp

Buy the books in the shopping cart cashier.jsp

Receive an acknowledgement for the purchase receipt.jsp

../examples/src/web/bookstore2/database/BookDB.java
../examples/src/web/bookstore2/database/BookDB.java
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• Instead of accessing the bookstore database directly, the helper object
through an enterprise bean. The advantage of using an enterprise be
that the helper object is no longer responsible for connecting to the d
base; this job is taken over by the enterprise bean. Furthermore, bec
the EJB container maintains the pool of database connections, an e
prise bean can get a connection quicker than the helper object. The rele
interfaces and classes for the enterprise bean are thedatabase.BookDBE-

JBHome home interface,database.BookDBEJB remote interface, and the
database.BookDBEJB implementation class, which contains all the JDB
calls to the database.

The implementation of the database helper object follows. The bean has
instance variables: the current book and a reference to the database ente
bean.

public class BookDB {
private String bookId = "0";
private BookDBEJB database = null;

public BookDB () throws Exception {
}
public void setBookId(String bookId) {

this.bookId = bookId;
}
public void setDatabase(BookDBEJB database) {

this.database = database;
}
public BookDetails getBookDetails()

throws Exception {
try {

return (BookDetails)database.
getBookDetails(bookId);

} catch (BookNotFoundException ex) {
throw ex;

}
}
...

}

Finally, this version of the example uses an applet to generate a dynamic d
clock in the banner. SeeIncludinganApplet (page 285) for a description of the
JSP element that generates HTML for downloading the applet.
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The source for the application is located in thej2eetutorial/examples/src/

web/bookstore2 directory created when you unzip the tutorial bundle (s
Downloading the Examples (page xxii)). To build, deploy, and run the examp

1. Go toj2eetutorial/examples/src and build the example by running
ant bookstore2.

2. Start thej2ee server.

3. Startdeploytool.

4. Start the Cloudscape database by executingcloudscape -start.

5. If you have not already created the bookstore database, runant cre-

ate-web-db.

6. Create a J2EE application calledBookstore2App.

a. Select File->New->Application.

b. In the file chooser, navigate toj2eetutorial/examples/src/web/
bookstore2.

c. In the File Name field, enterBookstore2App .

d. Click New Application.

e. Click OK.

7. AddBookstore2WAR WAR to theBookstore2App application.

a. Select File->Add->Web WAR.

b. In the Add Web WAR dialog, navigate toj2eetutorial/examples/
build/web/bookstore2. Select bookstore2.war. Click Add Web WAR

8. Add theBookDBEJB enterprise bean to the application.

a. Select File->New Enterprise Bean or the New Enterprise Bean but

b. Select Bookstore2App from Create New JAR File in Applicatio
combo box.

c. TypeBookDBJAR in the JAR Display Name field.

d. Click Edit to add the content files.

e. In the Edit Archive Contents dialog box, navigate to th
j2eetutorial/examples/build/web/ejb directory and add the data-
base and exception packages. Click Next.

f. Chose Session and Stateless for the Bean Type.

g. Select database.BookDBEJBImpl for Enterprise Bean Class.

h. In the Remote Interfaces box, select database.BookDBEJBHome
Remote Home Interface and database.BookDBEJB for Remote In
face.



272 JAVASERVER PAGES™ TECHNOLOGY
i. Enter BookDBEJB for Enterprise Bean Name.

j. Click Next and then click Finish.

9. Add a resource reference for the Cloudscape database to theBookDBEJB.

a. Select the BookDBEJB enterprise bean.

b. Select the Resource Refs tab.

c. Click Add.

d. Select javax.sql.DataSource from the Type column

e. Enterjdbc/BookDB in the Coded Name field.

f. Enterjdbc/Cloudscape in the JNDI Name field.

10.Save BookDBJAR.

a. Select BookDBJAR.

b. Select File-Save As.

c. Navigate to the directoryexamples/build/web/ejb.

d. EnterbookDB.jar in the File name field.

e. Click Save EJB JAR As.

11.Add a reference to the enterprise beanBookDBEJB.

a. Select Bookstore2WAR.

b. Select the EJB Refs tab.

c. Click Add.

d. Enterejb/BookDBEJB in the Coded Name column.

e. Enter Session in the Type column.

f. Select Remote in the Interfaces column.

g. Enter database.BookDBEJBHome in the Home Interface column.

h. Enter database.BookDBEJB in the Local/Remote Interface column.

12.Specify the JNDI Names

a. Select Bookstore2App.

b. In the Application table, locate the EJB component and enterBookD-

BEJB in the JNDI Name column.

c. In the References table, locate the EJB Ref, and enterBookDBEJB in the
JNDI Name column.

d. In the References table, locate the Resource component and enterjdbc/

Cloudscape in the JNDI Name column.
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13.Enter the context root.

a. Select the Web Context tab.

b. Enter bookstore2.

14.Deploy the application.

a. Select Tools->Deploy.

b. Click Finish.

15.Open the bookstore URLhttp://<host>:8000/bookstore2/enter.

SeeTroubleshooting (page 235) for help with diagnosing common problems

The Life Cycle of a JSP Page
A JSP page services requests as a servlet. Thus, the life cycle and many
capabilities of JSP pages (in particular the dynamic aspects) are determine
Java Servlet technology and much of the discussion in this chapter refers to f
tions described inJava Servlet Technology (page 229).

When a request is mapped to a JSP page, it is handled by a special servle
first checks whether the JSP page’s servlet is older than the JSP page. If it
translates the JSP page into a servlet class and compiles the class. During
opment, one of the advantages of JSP pages over servlets is that the “build”
cess is performed automatically.

Translation and Compilation
During the translation phase each type of data in a JSP page is treated differ
Template data is transformed into code that will emit the data into the stream
returns data to the client. JSP elements are treated as follows:

• Directives are used to control how the web container translates and
cutes the JSP page.

• Scripting elements are inserted into the JSP page’s servlet class. SeJSP
Scripting Elements (page 280) for details.

• Elements of the form<jsp:XXX ... /> are converted into method calls to
JavaBeans components or invocations of the Java Servlet API.

For a JSP page namedpageName, the source for a JSP page’s servlet is kept
the file:

J2EE_HOME/repository/host/web/context root/_0002fpageName_jsp.java
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For example, the source for the index page (namedindex.jsp) for the date

localization example discussed at the beginning the chapter would be name

J2EE_HOME/repository/host/web/date/_0002findex_jsp.java

Both the translation and compilation phases can yield errors that are
observed when the page is requested for the first time. If an error occurs w
the page is being translated (for example, if the translator encounters a
formed JSP element), the server will return aParseException and the servlet
class source file will be empty or incomplete. The last incomplete line will giv
pointer to the incorrect JSP element.

If an error occurs while the JSP page is being compiled (for example, due
syntax error in a scriptlet), the server will return aJasperException and a mes-
sage that includes the name of the JSP page’s servlet and the line where the
occurred.

Once the page has been translated and compiled, the JSP page’s servlet f
most part follows the servlet life cycle described inServlet Life
Cycle (page 236):

1. If an instance of the JSP page’s servlet does not exist, the container:

a. Loads the JSP page’s servlet class

b. Instantiates an instance of the servlet class

c. Initializes the servlet instance by calling thejspInit method

2. Invokes the_jspService method, passing a request and response obje

If the container needs to remove the JSP page’s servlet, it calls thejspDestroy

method.

Execution
You can control various JSP page execution parameters usingpage directives.
The directives that pertain to buffering output and handling errors are discu
here. Other directives are covered in the context of specific page authoring
throughout the chapter.

Buffering

When a JSP page is executed, output written to the response object is auto
cally buffered. You can adjust the size of the buffer with the following pa
directive:
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<%@ page buffer="none|xxxkb" %>

A larger buffer allows more content to be written before anything is actually s
back to the client, thus providing the JSP page with more time to set approp
status codes and headers or forward to another web resource. A smaller b
decreases server memory load and allows the client to start receiving data
quickly.

Handling Errors

Any number of exceptions can arise when a JSP page is executed. To specif
the web container should forward control to an error page if an exception occ
include the followingpage directive at the beginning of your JSP page:

<%@ page errorPage="file_name" %>

The Duke’s Bookstore application pageinitdestroy.jsp contains the directive

<%@ page errorPage="errorpage.jsp"%>

The beginning oferrorpage.jsp indicates that it is serving as an error pag
with the following page directive:

<%@ page isErrorPage="true|false" %>

This directive makes the exception object (of typejavax.servlet.jsp.JspEx-

ception) available to the error page, so that you can retrieve, interpret, and
sibly display information about the cause of the exception in the error page.

Note: You can also define error pages for the WAR that contains a JSP page. If erro
pages are defined for both the WAR and a JSP page, the JSP page’s error page ta
precedence.

Initializing and Finalizing a JSP Page
You can customize the initialization process to allow the JSP page to read pe
tent configuration data, initialize resources, and perform any other one-t
activities by overriding thejspInit method of theJspPage interface. You
release resources using thejspDestroy method. The methods are defined usin
JSP declarations, discussed inDeclarations (page 280).

../examples/src/web/bookstore2/initdestroy.txt
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/JspException.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/JspException.html
../examples/src/web/bookstore2/errorpage.txt


276 JAVASERVER PAGES™ TECHNOLOGY
The bookstore example pageinitdestroy.jsp defines thejspInit method to
retrieve or create an enterprise beandatabase.BookDBEJB that accesses the
bookstore database and store a reference to the bean inbookDBEJB. The enter-
prise bean is created using the techniques described inGettingStarted (page 47).

private BookDBEJB bookDBEJB;
public void jspInit() {

bookDBEJB =
(BookDB)getServletContext().

getAttribute("bookDBEJB");
if (bookDBEJB == null) {

try {
InitialContext ic = new InitialContext();
Object objRef = ic.lookup(

"java:comp/env/ejb/BookDBEJB");
BookDBEJBHome home =

(BookDBEJBHome)PortableRemoteObject.
narrow(objRef,
database.BookDBEJBHome.class);

bookDBEJB = home.create();
getServletContext().setAttribute("bookDBEJB",
bookDBEJB);

} catch (RemoteException ex) {
System.out.println(

"Couldn’t create database bean." +
ex.getMessage());

} catch (CreateException ex) {
System.out.println(

"Couldn’t create database bean." +
ex.getMessage());

} catch (NamingException ex) {
System.out.println(

"Unable to lookup home: " +
"java:comp/env/ejb/BookDBEJB."+
ex.getMessage());

}
}

}

When the JSP page is removed from service, thejspDestroy method releases
theBookDBEJB variable.

public void jspDestroy() {
bookDBEJB = null;

}

../examples/src/web/bookstore2/initdestroy.txt
../examples/src/web/bookstore2/database/BookDB.java
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Since the enterprise bean is shared between all the JSP pages, it should be
ized when the application is started, instead of in each JSP page. Java S
technology provides application life cycle events and listener classes for this
pose. As an exercise, you can move the code that manages the creation
enterprise bean to a context listener class. SeeHandling Servlet Life Cycle
Events (page 236) for the context listener that initializes the Java Servlet ver
of the bookstore application.

Creating Static Content
You create static content in a JSP page by simply writing it as if you were cr
ing a page that consists only of that content. Static content can be express
any text-based format such as HTML, WML, and XML. The default format
HTML. If you want to use a format other than HTML you include apage direc-
tive with thecontentType attribute set to the format type at the beginning o
your JSP page. For example, if you want a page to contain data expressed
wireless markup language (WML), you need to include the following directiv

<%@ page contentType="text/vnd.wap.wml"%>

A registry of content type names is kept by IANA at:

ftp://ftp.isi.edu/in-notes/iana/assignments/media-types

Creating Dynamic Content
You create dynamic content by accessing Java programming language ob
from within scripting elements.

Using Objects Within JSP Pages
You can access a variety of objects, including enterprise beans and JavaB
components, within a JSP page. JSP technology automatically makes s
objects available and you can also create and access application-specific o

Implicit Objects

Implicit objects are created by the web container and contain information rela
to a particular request, page, or application. Many of the objects are define
the Java Servlet technology underlying JSP technology and are discuss

ftp://ftp.isi.edu/in-notes/iana/assignments/media-types
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length inJava ServletTechnology (page 229). Table 26 summarizes the impli
objects.

Application-Specific Objects

When possible, application behavior should be encapsulated in objects so
page designers can focus on presentation issues. Objects can be created by

Table 26 Implicit Objects

Variable Class Description

application
javax.servlet.
ServletContext

The context for the JSP page’s servlet and any web
components contained in the same application. See
Accessing the Web Context (page 257).

config
javax.servlet.
ServletConfig

Initialization information for the JSP page’s servlet.

exception
java.lang.
Throwable

Accessible only from an error page. SeeHan-
dling Errors(page 275).

out
javax.servlet.
jsp.JspWriter

The output stream.

page
java.lang.
Object

The instance of the JSP page’s servlet processing
the current request. Not typically used by JSP page
authors.

pageContext
javax.servlet.
jsp.PageContext

The context for the JSP page. Provides a single AP
to manage the various scoped attributes described
in Sharing Information(page 238).
This API is used extensively when implementing
tag handlers (seeTag Handlers(page 309)).

request
subtype of
javax.servlet.
ServletRequest

The request triggering the execution of the JSP
page. SeeGetting Information From
Requests(page 243).

response
subtype of
javax.servlet.
ServletResponse

The response to be returned to the client. Not typi-
cally used by JSP page authors.

session
javax.servlet.
http.HttpSession

The session object for the client. SeeAccessing
the Web Context (page 257).

http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletContext.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletConfig.html
http://java.sun.com/products/jdk/1.2/docs/api/java/lang/Throwable.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/JspWriter.html
http://java.sun.com/products/jdk/1.2/docs/api/java/lang/Object.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/PageContext.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletRequest.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/ServletResponse.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/HttpSession.html
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opers who are proficient in the Java programming language and accessing
bases and other services. There are four ways to create and use objects w
JSP page:

• Instance and class variables of the JSP page’s servlet class are crea
declarations and accessed inscriptlets andexpressions.

• Local variables of the JSP page’s servlet class are created and us
scriptlets andexpressions.

• Attributes of scope objects (seeScopeObjects (page 239)) are created an
used inscriptlets andexpressions.

• JavaBeans components can be created and accessed using streamlin
elements. These elements are discussed in the chapterJavaBeans™Com-
ponentsin JSP™Pages (page 289). You can also create a JavaBeans c
ponent in a declaration or scriptlet and invoke the methods of a JavaBe
component in a scriptlet or expression.

Declarations, scriptlets, and expressions are described inJSP Scripting
Elements (page 280).

Shared Objects

The conditions affecting concurrent access to shared objects described inShar-
ing Information (page 238) apply to objects accessed from JSP pages that r
multithreaded servlets. You can indicate how a web container should disp
multiple client requests with the followingpage directive:

<%@ page isThreadSafe="true|false" %>

WhenisThreadSafe is set totrue, the web container may choose to dispatc
multiple concurrent client requests to the JSP page. This is thedefaultsetting. If
usingtrue, you must ensure that you properly synchronize access to any sh
objects defined at the page level. This includes objects created within dec
tions, JavaBeans components with page scope, and attributes of thepage scope
object.

If isThreadSafe is set tofalse, requests are dispatched one at a time, in t
order they were received and access to page level objects does not have
controlled. However, you still must ensure that access to attributes of theappli-

cation or session scope objects and JavaBeans components with applicatio
session scope is properly synchronized.
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JSP Scripting Elements
JSP scripting elements are used to create and access objects, define metho
manage the flow of control. Since one of the goals of JSP technology is to s
rate static template data from the code needed to dynamically generate co
very sparing use of JSP scripting is recommended. Much of the work
requires the use of scripts can be eliminated by using custom tags, describ
Extending the JSP Language (page 287).

JSP technology allows a container to support any scripting language that can
Java objects. If you wish to use a scripting language other than the default,java,
you must specify it in apage directive at the beginning of a JSP page:

<%@ page language="scripting language" %>

Since scripting elements are converted to programming language stateme
the JSP page’s servlet class, you must import any classes and packages use
JSP page. If the page language isjava, you import a class or package with th
page directive:

<%@ page import="packagename.*, fully_qualified_classname" %>

For example, bookstore example pageshowcart.jsp imports the classes neede
to implement the shopping cart with the following directive:

<%@ page import="java.util.*, cart.*" %>

Declarations

A declaration is used to declare variables and methods in a page’s scripting
guage. The syntax for a declaration is:

<%! scripting language declaration %>

When the scripting language is the Java programming language, variables
methods in JSP declarations become declarations in the JSP page’s servle

The bookstore example pageinitdestroy.jsp defines an instance variable
namedbookDBEJB and the initialization and finalization methodsjspInit and
jspDestroy discussed earlier in a declaration:

<%!
private BookDBEJB bookDBEJB;

public void jspInit() {

../examples/src/web/bookstore2/showcart.txt
../examples/src/web/bookstore2/initdestroy.txt
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}
public void jspDestroy() {

...
}

%>

Scriptlets

A scriptlet is used to contain any code fragment that is valid for the scripting l
guage used in a page. The syntax for a scriptlet is:

<%
scripting language statements

%>

When the scripting language is set tojava, a scriptlet is transformed into a Jav
programming language statement fragment and is inserted into the se
method of the JSP page’s servlet. A programming language variable cre
within a scriptlet is accessible from anywhere within the JSP page.

The JSP pageshowcart.jsp contains a scriptlet that retrieves an iterator fro
the collection of items maintained by a shopping cart and sets up a constru
loop through all the items in the cart. Inside the loop, the JSP page extracts p
erties of the book objects and formats them using HTML markup. Since
while loop opens a block, the HTML markup is followed by a scriptlet th
closes the block.

<%
Iterator i = cart.getItems().iterator();
while (i.hasNext()) {

ShoppingCartItem item =
(ShoppingCartItem)i.next();

BookDetails bd = (BookDetails)item.getItem();
%>

<tr>
<td align="right" bgcolor="#ffffff">
<%=item.getQuantity()%>
</td>
<td bgcolor="#ffffaa">
<strong><a href="
<%=request.getContextPath()%>/bookdetails?bookId=
<%=bd.getBookId()%>"><%=bd.getTitle()%></a></strong>
</td>
...

../examples/src/web/bookstore2/showcart.txt
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<%
// End of while
}

%>

The output appears below:

Figure 28 Duke’s Bookstore Shopping Cart

Expressions

A JSP expression is used to insert the value of a scripting language expres
converted into a string, into the data stream returned to the client. When
scripting language is the Java programming language, an expression is t
formed into a statement that converts the value of the expression into aString

object and inserts it into the implicitout object.

The syntax for an expression is:

<%= scripting language expression %>

Note that a semicolon is not allowed within a JSP expression, even if the s
expression has a semicolon when you use it within a scriptlet.

The following scriptlet retrieves the number of items in a shopping cart:
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<%
// Print a summary of the shopping cart
int num = cart.getNumberOfItems();
if (num > 0) {

%>

Expressions are then used to insert the value ofnum into the output stream and
determine the appropriate string to include after the number:

<font size="+2">
<%=messages.getString("CartContents")%> <%=num%>
<%=(num==1 ? <%=messages.getString("CartItem")%> :
<%=messages.getString("CartItems")%>)%></font>

Including Content in a JSP Page
There are two mechanisms for including content from another source in a
page: theinclude directive and the jsp:include element.

Theinclude directive is processed when the JSP page istranslatedinto a servlet
class. The effect of the directive to the insert the text contained in another
either static content or another JSP page, in the including JSP page. You w
probably use theinclude directive to include banner content, copyright infor
mation, or any chunk of content that you might want to reuse in another pa
The syntax for theinclude directive is:

<%@ include file="filename" %>

For example, all the bookstore application pages include the filebanner.jsp

containing the banner content with the following directive:

<%@ include file="banner.jsp" %>

In addition, the pagesbookstore.jsp, bookdetails.jsp, catalog.jsp, and
showcart.jsp include JSP elements that create and destroy a database
with the element:

<%@ include file="initdestroy.jsp" %>

Because you must statically put aninclude directive in each file that reuses the
resource referenced by the directive, this approach has its limitations. For a m
flexible approach to building pages out of content chunks, seeA TemplateTag
Library (page 328).

../examples/src/web/bookstore2/banner.txt
../examples/src/web/bookstore2/bookstore.txt
../examples/src/web/bookstore2/bookdetails.txt
../examples/src/web/bookstore2/catalog.txt
../examples/src/web/bookstore2/showcart.txt
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The include element is processed when a JSP page isexecuted. Theinclude

action allows you to include either a static or dynamic file in a JSP file. T
results of including static and dynamic files are quite different. If the file is sta
its content is inserted into the calling JSP file. If the file is dynamic, the reque
sent to the included JSP page, the included page is executed, and then the
is included in the response from the calling JSP page. The syntax for
jsp:include element is:

<jsp:include page="includedPage" />

The date application introduced at the beginning of this chapter includes
page that generates the display of the localized date with the following elem

<jsp:include page="date.jsp"/>

Transferring Control to Another Web
Component

The mechanism for transferring control to another web component from a
page uses the functionality provided by the Java Servlet API as describe
Transferringa Control to AnotherWeb Component (page 256). You access th
functionality from a JSP page with thejsp:forward element:

<jsp:forward page="/main.jsp" />

Note that if any data has already been returned to a client, thejsp:forward ele-
ment will fail with anIllegalStateException.

Param Element
When aninclude or forward element is invoked, the original request object
provided to the target page. If you wish to provide additional data to that pa
you can append parameters to the request object with theparam element:

<jsp:include page="..." >
<jsp:param name=”param1” value="value1"/>

</jsp:include>
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Including an Applet
You can include an applet or JavaBeans component in a JSP page usin
jsp:plugin element. This element generates HTML that contains the appro
ate client browser dependent constructs (<object> or <embed>) that will result in
the download of the Java Plugin software (if required) and client-side compo
and subsequent execution of an client-side component. The syntax for
jsp:plugin element follows:

<jsp:plugin
type="bean|applet"
code="objectCode"
codebase="objectCodebase"
{ align="alignment" }
{ archive="archiveList" }
{ height="height" }
{ hspace="hspace" }
{ jreversion="jreversion" }
{ name="componentName" }
{ vspace="vspace" }
{ width="width" }
{ nspluginurl="url" }
{ iepluginurl="url" } >
{ <jsp:params>

{ <jsp:param name="paramName" value= paramValue" /> }+
</jsp:params> }
{ <jsp:fallback> arbitrary_text </jsp:fallback> }

</jsp:plugin>

Thejsp:plugin tag is replaced by either an<object> or <embed> tag, as appro-
priate for the requesting client. The attributes of the jsp:plugin tag provide c
figuration data for the presentation of the element as well as the version o
plugin required. Thenspluginurl andiepluginurl attributes specify the URL
where the plugin can be downloaded.

Thejsp:param elements indicate parameters to the applet or JavaBeans com
nent. Thejsp:fallback element indicates the content to be used by the clie
browser if the plugin cannot be started (either because<object> or <embed> is
not supported by the client or due to some other problem).

If the plugin can start but the applet or JavaBeans component cannot be fou
started, a plugin-specific message will be presented to the user, most like
popup window reporting aClassNotFoundException.
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a
The Duke’s Bookstore pagebanner.jsp that creates the banner displays
dynamic digital clock generated byDigitalClock:

Figure 29 Duke’s Bookstore with Applet

Thejsp:plugin element used to download the applet follows:

<jsp:plugin
type="applet"
code="DigitalClock.class"
codebase="/bookstore2"
jreversion="1.3"
align="center" height="25" width="300"
nspluginurl="http://java.sun.com/products/plugin/1.3.0_01

/plugin-install.html"
iepluginurl="http://java.sun.com/products/plugin/1.3.0_01

/jinstall-130_01-win32.cab#Version=1,3,0,1" >
<jsp:params>

../examples/src/web/bookstore2/banner.txt
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<jsp:param name="language"
value="<%=request.getLocale().getLanguage()%>" />

<jsp:param name="country"
value="<%=request.getLocale().getCountry()%>" />

<jsp:param name="bgcolor" value="FFFFFF" />
<jsp:param name="fgcolor" value="CC0066" />

</jsp:params>
<jsp:fallback>
<p>Unable to start plugin.</p>

</jsp:fallback>
</jsp:plugin>

Extending the JSP Language
You can perform a wide variety of dynamic processing tasks including acces
databases, using enterprise services such as email and directories, and flow
trol with JavaBeans components in conjunction with scriptlets. One of the dr
backs of scriptlets however, is that they tend to make JSP pages more difficu
maintain. Alternatively, JSP technology provides a mechanism, calledcustom
tags, that allows you to encapsulate dynamic functionality in objects that
accessed through extensions to the JSP language. Custom tags bring the b
of another level of componentization to JSP pages.

For example, recall the scriptlet used to loop through and display the conten
the Duke’s Bookstore shopping cart:

<%
Iterator i = cart.getItems().iterator();
while (i.hasNext()) {

ShoppingCartItem item =
(ShoppingCartItem)i.next();

...
%>

<tr>
<td align="right" bgcolor="#ffffff">
<%=item.getQuantity()%>
</td>
...

<%
}

%>

An iterate custom tag eliminates the code logic and manages the scrip
variableitem that references elements in the shopping cart:
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<logic:iterate id="item"
collection="<%=cart.getItems()%>"
<tr>
<td align="right" bgcolor="#ffffff">
<%=item.getQuantity()%>
</td>
...

</logic:iterate>

Custom tags are packaged and distributed in a unit called atag library. The
syntax of custom tags is the same as that used for the JSP elements, n
<prefix:tag>, but for custom tags, the prefix is defined by theuserof the tag
library and the tag is defined by thetag developer. Custom Tags in JSP™
Pages (page 299) explains how to use and develop custom tags.



com-
con-

nents
d get
tion
g Java-
ava-
JavaBeans™
Components in JSP™

Pages
by Stephanie Bodoff

JAVA BEANS components are Java classes that can be easily reused and
posed together into applications. Any Java class that follows certain design
ventions can be a JavaBeans component.

JavaServer Pages™ technology directly supports using JavaBeans compo
with JSP language elements. You can easily create and initialize beans an
and set the values of their properties. This chapter provides basic informa
about JavaBeans components and the JSP language elements for accessin
Beans components in your JSP pages. For further information about the J
Beans component model seehttp://java.sun.com/products/javabeans.

JavaBeans Component Design Conventions 224
Why Use a JavaBeans Component? 225
Creating and Using a JavaBeans Component 226
Setting JavaBeans Component Properties 226
Retrieving JavaBeans Component Properties 229
289

http://java.sun.com/products/javabeans
Bios.html
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JavaBeans Component Design
Conventions

JavaBeans component design conventions govern the properties of the clas
the public methods that give access to the properties.

A JavaBeans component property can be:

• Read/write, read-only, or write-only.

• Simple, which means it contains a single value, or indexed, which me
it represents an array of values.

There is no requirement that a property be implemented by an instance vari
the property must simply be accessible using public methods that conform
certain conventions:

• For each readable property, the bean must have a method of the f
PropertyClass getProperty() { ... }

• For each writable property, the bean must have a method of the form
setProperty(PropertyClass pc) { ... }

In addition to the property methods, a JavaBeans component must define a
structor that takes no parameters.

The Duke’s Bookstore application JSP pagesenter.jsp, bookdetails.jsp,
catalog.jsp, showcart.jsp use thedatabase.BookDB and database.Book-

Details JavaBeans components.BookDB provides a JavaBeans component fro
end to the enterprise beanBookDBEJB. Both beans are used extensively by bea
oriented custom tags (seeTagsThatDefineScriptingVariables (page 318)). The
JSP pagesshowcart.jsp andcashier.jsp usecart.ShoppingCart to repre-
sent a user’s shopping cart.

The JSP pagescatalog.jsp, showcart.jsp, and cashier.jsp use the
util.Currency JavaBeans component to format currency in a locale-sensi
manner. The bean has two writable properties,locale andamount, and one read-
able property,format. Theformat property does not correspond to any instan
variable, but returns a function of thelocale andamount properties.

public class Currency {
private Locale locale;
private double amount;
public Currency() {

locale = null;
amount = 0.0;

../examples/src/web/bookstore2/database/BookDB.java
../examples/src/ejb/database/BookDetails.java
../examples/src/ejb/database/BookDetails.java
../examples/src/web/bookstore2/cart/ShoppingCart.java
../examples/src/web/bookstore2/util/Currency.java
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public void setLocale(Locale l) {

locale = l;
}
public void setAmount(double a) {

amount = a;
}
public String getFormat() {

NumberFormat nf =
NumberFormat.getCurrencyInstance(locale);

return nf.format(amount);
}

}

Why Use a JavaBeans Component?
A JSP page can create and use any type of Java programming language
within a declaration or scriptlet. The following scriptlet creates the bookst
shopping cart and stores it as a session attribute:

<%
ShoppingCart cart = (ShoppingCart)session.

getAttribute("cart");
// If the user has no cart, create a new one
if (cart == null) {

cart = new ShoppingCart();
session.setAttribute("cart", cart);

}
%>

If the shopping cart object conforms to JavaBeans conventions, JSP page
use JSP elements to create and access the object. For example, theDuke’s

Bookstore pagesbookdetails.jsp, catalog.jsp, andshowcart.jsp replace
the scriptlet with the much more concise JSPuseBean element:

<jsp:useBean id="cart" class="cart.ShoppingCart"
scope="session"/>
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Creating and Using a JavaBeans
Component

You declare that your JSP page will use a JavaBeans component using eithe
of the following formats:

<jsp:useBean id="beanName"
class="fully_qualified_classname" scope="scope"/>

or

<jsp:useBean id="beanName"
class="fully_qualified_classname" scope="scope">
<jsp:setProperty .../>

</jsp:useBean>

The second format is used when you want to includejsp:setProperty state-
ments, described in the next section, for initializing bean properties.

The jsp:useBean element declares that the page will use a bean that is sto
within and accessible from the specified scope, which can beapplication,
session, request or page. If no such bean exists, the statement creates the b
and stores it as an attribute of the scope object (seeScopeObjects (page 239)).
The value of theid attribute determines thenameof the bean in the scope and
the identifier used to reference the bean in other JSP elements and scriptlets

Note: In JSPScriptingElements(page 280) we mentioned that you mustyou
must import any classes and packages used by a JSP page. This rule
slightly altered if the class is only referenced byuseBean elements. In these
cases, you must only import the class ifthe class is in the unnamed package. For
example, inWhat is a JSPPage?(page 266), the pageindex.jsp imports the
MyLocales class. However, in the Duke’s Bookstore example, all classes are con
tained in packages, and so are not explicitly imported.

The following element creates an instance ofCurrency if none exists, stores it as
an attribute of thesession object, and makes the bean available throughout
session by the identifiercurrency:

<jsp:useBean id="currency" class="util.Currency"
scope="session"/>
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Setting JavaBeans Component Properties
There are two ways to set JavaBeans component properties in a JSP page

• With thejsp:setProperty element

• With a scriptlet:<%= beanName.setPropName(value) %>

The syntax of thejsp:setProperty element depends on the source of the pro
erty value. Table 27 summarizes the various ways to set a property of a J
Beans component using thejsp:setProperty element:

A property set from a constant or request parameter must have a type liste
Table 28. Since both a constant and request parameter are strings, the web
tainer automatically converts the value to the property’s type; the convers
applied is shown in the table.String values can be used to assign values to
property that has aPropertyEditor class. When that is the case, thesetAs-
Text(String) method is used. A conversion failure arises if the method thro

Table 27 Setting JavaBeans Component Properties

Value Source Element Syntax

String constant
<jsp:setProperty name="beanName"

property="propName" value="string constant"/>

Request parameter
<jsp:setProperty name="beanName"

property="propName" param="paramName"/>

Request parameter
name matches bean
property

<jsp:setProperty name="beanName"
property="propName"/>

<jsp:setProperty name="beanName"
property="*"/>

Expression
<jsp:setProperty name="beanName"

property="propName"
value="<%= expression %>"/>

1.beanName must be the same as that specified for theid attribute in auseBean element.
2. There must be asetPropName method in the JavaBeans component.
3.paramName must be a request parameter name.
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an IllegalArgumentException. The value assigned to an indexed proper
must be an array, and the rules just described apply to the elements.

You would use a runtime expression to set the value of a property whose ty
a compound Java programming language type. Recall fr
Expressions (page 282) that a JSP expression is used to insert the value
scripting language expression, converted into aString, into the stream returned
to the client. When used within asetProperty element, an expression simply
returns its value;no automatic conversion is performed. As a consequence,
type returned from an expression must match or be castable to the type o
property.

TheDuke’s Bookstore application demonstrates how to use thesetProperty

element and a scriptlet to set the current book for the database helper bean
example,bookstore3/bookdetails.jsp uses the form:

<jsp:setProperty name="bookDB" property="bookId"/>

Table 28 Valid Value Assignments

Property Type Conversion on String Value

Bean Property Uses setAsText(string-literal)

boolean or Bool-
ean

As indicated in java.lang.Boolean.valueOf(String)

byte or Byte As indicated in java.lang.Byte.valueOf(String)

char or Character As indicated in java.lang.String.charAt(0)

double or Double As indicated in java.lang.Double.valueOf(String)

int or Integer As indicated in java.lang.Integer.valueOf(String)

float or Float As indicated in java.lang.Float.valueOf(String)

long or Long As indicated in java.lang.Long.valueOf(String)

short or Short As indicated in Short.valueOf(String)

Object new String(string-literal)

../examples/src/web/bookstore3/bookdetails.txt
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while bookstore2/bookdetails.jsp uses the form:

<% bookDB.setBookId(bookId) %>

The following fragments from the pagebookstore3/showcart.jsp illustrate
how to initialize a currency bean with aLocale object and amount determined
by evaluating request-time expressions. Because the first initialization is ne
in auseBean element, it is only executed when the bean is created.

<jsp:useBean id="currency" class="util.Currency"
scope="session">
<jsp:setProperty name="currency" property="locale"

value="<%= request.getLocale() %>"/>
</jsp:useBean>

<jsp:setProperty name="currency" property="amount"
value="<%=cart.getTotal()%>"/>

Retrieving JavaBeans Component
Properties

There are several ways to retrieve JavaBeans component properties. Two
methods convert the value of the property into aString and insert the value into
the current implicitout object: thejsp:getProperty element and an expres-
sion:

• <jsp:getProperty name="beanName" property="propName"/>

• <%= beanName.getPropName() %>

For both methods,beanName must be the same as that specified for theid

attribute in auseBean element and there must be agetPropName method in the
JavaBeans component.

If you need to retrieve the value of a property without converting it and insert
it into the out object, you must use a scriptlet:

<% Object o = beanName.getPropName(); %>

Note the differences between the expression and the scriptlet; the expressio
an ‘=’ after the opening ‘%’ and does not terminate with a semicolon, as does
scriptlet.

../examples/src/web/bookstore2/bookdetails.txt
../examples/src/web/bookstore3/showcart.txt
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The Duke’s Bookstore application demonstrates how to use both forms
retrieve the formatted currency from the currency bean and insert it into
page. For example,bookstore3/showcart.jsp uses the form:

<jsp:getProperty name="currency" property="format"/>

while bookstore2/showcart.jsp uses the form:

<%= currency.getFormat() %>

The Duke’s Bookstore application pagebookstore2/showcart.jsp uses the
following scriptlet to retrieve the number of books from the shopping cart be
and open a conditional insertion of text into the output stream:

<%
// Print a summary of the shopping cart
int num = cart.getNumberOfItems();
if (num > 0) {

%>

Although scriptlets are very useful for dynamic processing, using custom
(seeCustomTagsin JSP™Pages (page 299)) to access object properties a
perform flow control is considered to be a better approach. For exam
bookstore3/showcart.jsp replaces the scriptlet with the following custom
tags:

<bean:define id="num" name="cart" property="numberOfItems" />
<logic:greaterThan name="num" value="0" >

Figure 30 summarizes where various types of objects are stored and how
objects can be accessed from a JSP page. Objects created by thejsp:useBean

tag are stored as attributes of the scope objects and can be access
jsp:[get|set]Property tags and in scriptlets and expressions. Objects crea

../examples/src/web/bookstore3/showcart.txt
../examples/src/web/bookstore2/showcart.txt
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in declarations and scriptlets are stored as variables of the JSP page’s s
class and can be accessed in scriptlets and expressions.

Figure 30 Accessing Objects From a JSP Page

Session
  attribute1
  attribute2

Web context
  attribute1
  attribute2

Request
  attribute1
  attribute2

Page context
  attribute1
  attribute2

jsp:useBean
jsp:getProperty
jsp:setProperty

JSP page
servlet class
  object1
  object2

<%! declaration %>
<% scriptlet %>
<%= expression %>
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Custom Tags in JSP™
Pages

by Stephanie Bodoff

THE standard JSP tags for invoking operations on JavaBeans™ compon
and performing request dispatching simplify JSP page development and ma
nance. JSP technology also provides a mechanism for encapsulating other
of dynamic functionality incustom tags, which are extensions to the JSP lan
guage. Custom tags are usually distributed in the form of atag library, which
defines a set of related custom tags and contains the objects that impleme
tags.

Some examples of tasks that can be performed by custom tags include opera
on implicit objects, form processing, accessing databases and other ente
services such as email and directories, and flow control. JSP tag libraries are
ated by developers who are proficient at the Java programming language
expert in accessing data and other services and used by web application de
ers who can focus on presentation issues rather than being concerned with
to access enterprise services. As well as encouraging division of labor betw
library developers and library users, custom tags increase productivity by en
sulating recurring tasks so that they can be reused across more than one ap
tion.

Tag libraries are receiving a great deal of attention in the JSP technology c
munity. For more information about tag libraries and pointers to some free
available libraries seehttp://java.sun.com/products/jsp/taglibrar-
ies.html.

What is a Custom Tag? 232
299

http://java.sun.com/products/jsp/taglibraries.html
http://java.sun.com/products/jsp/taglibraries.html
Bios.html
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The Example Tags 232
Using Tags 236

Declaring Tag Libraries 236
Types of Tags 237

Defining Tags 240
Tag Handlers 241
Tag Library Descriptors 242
Simple Tags 244
Tags With Attributes 245
Tags With Bodies 248
Tags That Define Scripting Variables 250
Cooperating Tags 254

Examples 256
An Iteration Tag 256
A Template Tag Library 259

How Is a Tag Handler Invoked? 265

What is a Custom Tag?
A custom tag is a user-defined JSP language element. When a JSP page co
ing a custom tag is translated into a servlet, the tag is converted to operation
an object called atag handler. The web container then invokes those operatio
when the JSP page’s servlet is executed.

Custom tags have a rich set of features. They can

• Be customized via attributes passed from the calling page.

• Access all the objects available to JSP pages.

• Modify the response generated by the calling page.

• Communicate with each other. You can create and initialize a JavaBe
component, create a variable that refers to that bean in one tag, and
use the bean in another tag.

• Be nested within one another, allowing for complex interactions within
JSP page.

The Example JSP Pages
This chapter describes the tasks involved in using and defining tags. The ch
illustrates the tasks with excerpts from the JSP version of the Duke’s Books
application discussed inJavaServer Pages™Technology (page 265) rewritten to
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take advantage of two tag libraries: Struts and tutorial-template. The third
tion in the chapter,Examples (page 324), describes two tags in detail: theiter-

ate tag from Struts and the set of tags in the tutorial-template tag library.

The Struts tag library provides a framework for building internationalized w
applications that implement the Model-View-Controller design pattern. Str
includes a comprehensive set of utility custom tags for handling:

• HTML forms

• Templates

• JavaBeans components

• Logic processing

The Duke’s Bookstore application uses tags from the Strutsbean and logic

sublibraries.

The tutorial-template tag library defines a set of tags for creating an applica
template. The template is a JSP page, with place holders for the parts that ne
change with each screen. Each of these place holders is referred to as a pa
ter of the template. For example, a simple template could include a title para
ter for the top of the generated screen and a body parameter to refer to a
page for the custom content of the screen. The template is created with a s
nested tags—definition, screen, and parameter—that are used to build a
table of screen definitions for Duke’s Bookstore and aninsert tag to insert
parameters from the table into the screen.

Figure 31 shows the flow of a request through the Duke’s Bookstore web com
nents:

• template.jsp which determines the structure of each screen. It uses
insert tag to compose a screen from subcomponents.

• screendefinitions.jsp which defines the subcomponents used by ea
screen. All screens have the same banner, but different title and body
tent (specified by the JSP Pages column in Table 25).

• Dispatcher, a servlet, processes requests and forwards totemplate.jsp.

http://jakarta.apache.org/struts
../examples/src/web/bookstore3/template.txt
../examples/src/web/bookstore3/screendefinitions.txt
../examples/src/web/bookstore3/Dispatcher.java
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Figure 31 Request Flow Through Duke’s Bookstore Components

The source for the Duke’s Bookstore application is located in t
j2eetutorial/examples/src/web/bookstore3 directory created when you
unzip the tutorial bundle (seeDownloadingtheExamples (page xxii)). To build,
deploy, and run the example:

1. Go toj2eetutorial/examples/src and build the application by execut-
ing ant bookstore3 (see How to Build and Run the
Examples (page xxiii)).

2. Download and unpack Struts version 1.0 from

http://jakarta.apache.org/builds/jakarta-struts/release/v1.0/

Copy struts-bean.tld, struts-logic.tld, and struts.jar from
jakarta-struts-1.0/lib to examples/build/web/bookstore3.

3. Start thej2ee server.
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4. Startdeploytool

5. Start the Cloudscape database by executingcloudscape -start.

6. If you have not already created the bookstore database, runant create-

web-db.

7. Create a J2EE application calledBookstore3App.

a. Select File->New Application.

b. In the file chooser, navigate to j2eetutorial/exam-

ples/src/web/bookstore3.

c. In the File Name field, enterBookstore3App .

d. Click New Application.

e. Click OK.

8. Create the WAR and add theDispatcherServlet web component and all
of the Duke’s Bookstore content toBookstore3App.

a. Select File->New->Web Component.

b. Click the Create New WAR File in Application radio button and sele
Bookstore3App from the combo box. EnterBookstore3WAR in the field
labeled WAR Display Name.

c. Click Edit to add the content files. In the Edit Contents dialog, navig
to j2eetutorial/examples/build/web/bookstore3. Select Dis-
patcher.class and click Add. Add the JSP pages banner.jsp, bo
store.jsp, bookdetails.jsp, catalog.jsp, showcart.jsp, cashier.
receipt.jsp, initdestroy.jsp, template.jsp, screendefinitions.jsp,
errorpage.jsp. Add duke.books.gif, struts-bean.tld, struts-logic.tld, tu
rial-template.tld, and struts.jar. Add the cart, database, messages, ta
and util packages. Click OK.

d. Click Next.

e. Select the servlet radio button.

f. Click Next.

g. Select Dispatcher from the Servlet class combo box.

h. Click Next twice.

i. In the Component Aliases panel click Add and then type/enter in the
alias field. Repeat to add the aliases/catalog, /bookdetails, /show-
cart, /cashier, and/receipt.

j. Click Finish.
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9. Add the BookDBEJB enterprise bean that you created inTheExampleJSP
Pages (page 269).

a. Select File->Add->EJB JAR.

b. Navigate to the directoryexamples/build/web/ejb.

c. SelectbookDB.jar.

d. Click Add EJB JAR.

10.Add a reference to the enterprise beanBookDBEJB.

a. Select Bookstore3WAR.

b. Select the EJB Refs tab.

c. Click Add.

d. Enterejb/BookDBEJB in the Coded Name column.

e. Enter Session in the Type column.

f. Select Remote in the Interfaces column.

g. Enter database.BookDBEJBHome in the Home Interface column.

h. Enter database.BookDBEJB in the Local/Remote Interface column.

11.Add the tag library URI to location mappings (seeDeclaring Tag
Libraries (page 305)):

a. Select the File Refs tab

b. Click the Add button in the JSP Tag Libraries subpanel.

c. Enter the relative URI/tutorial-template in the Coded Reference
field.

d. Enter the absolute location/WEB-INF/tutorial-template.tld in the
Tag Library field.

e. Repeat for /struts-bean to /WEB-INF/struts-bean.tld and
/struts-logic to /WEB-INF/struts-logic.tld.

12.Specify the JNDI Names

a. Select Bookstore3App.

b. In the Application table, locate the EJB component and enterBookD-

BEJB in the JNDI Name column.

c. In the References table, locate the EJB Ref, and enterBookDBEJB in the
JNDI Name column.

d. In the References table, locate the Resource component and
jdbc/Cloudscape in the JNDI Name column.
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13.Enter the context root.

a. Select the Web Context tab.

b. Enter bookstore3.

14.Deploy the application.

a. Select Tools->Deploy.

b. Click Finish.

15.Open the bookstore URLhttp://<host>:8000/bookstore3/enter.

SeeTroubleshooting (page 235) for help with diagnosing common problems

Using Tags
This section describes how a page author specifies that a JSP page is using
library and introduces the different types of tags.

Declaring Tag Libraries
You declare that a JSP page will use tags defined in a tag library by includin
taglib directive in the page before any custom tag is used:

<%@ taglib uri="/WEB-INF/tutorial-template.tld" prefix="tt" %>

Theuri attribute refers to a URI that uniquely identifies the TLD, described
TagLibrary Descriptors (page 310). This URI can be direct or indirect. Thepre-

fix attribute defines the prefix that distinguishes tags defined by a given
library from those provided by other tag libraries.

Tag library descriptor filenames must have the extension.tld. TLD files are
stored in theWEB-INF directory of the WAR or in a subdirectory ofWEB-INF. You
can reference a TLD directly and indirectly.

The followingtaglib directive directly references a TLD filename:

<%@ taglib uri="/WEB-INF/tutorial-template.tld" prefix="tt" %>

Thistaglib directive uses a short logical name to indirectly reference the TL

<%@ taglib uri="/tutorial-template" prefix="tt" %>

1. A logical name must be mapped to an absolute location in the web ap
cation deployment descriptor. To map the logical name/tutorial-tem-
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plate to the absolute location/WEB-INF/tutorial-template.tld,Select
Bookstore3WAR.

2. Select the File Refs tab

3. Click the Add button in the JSP Tag Libraries subpanel.

4. Enter the relative URI/tutorial-template in the Coded Reference
field.

5. Enter the absolute location/WEB-INF/tutorial-template.tld in the
Tag Library field.

Types of Tags
JSP custom tags are written using XML syntax. They have a start tag and
tag, and possibly a body:

<tt:tag>
body

</tt:tag>

A custom tag with no body is expressed as follows:

<tt:tag />

Simple Tags

A simple tag contains no body and no attributes:

<tt:simple />

Tags With Attributes

A custom tag can have attributes. Attributes are listed in the start tag and
the syntaxattr="value". Attribute values serve to customize the behavior of
custom tag just as parameters are used to customize the behavior of a met

You specify the types of a tag’s attributes in a tag library descriptor, (seeTag
Library Descriptors (page 310)).

You can set an attribute value from aString constant or a runtime expression
The conversion process between the constants and runtime expression
attribute types follows the rules described for JavaBeans component prope
in Setting JavaBeans Component Properties (page 293).
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The attributes of the Strutslogic:present tag determine whether the body o
the tag is evaluated. In the following example, an attribute specifies a req
parameter namedClear:

<logic:present parameter="Clear">

The Duke’s Bookstore application pagecatalog.jsp uses a runtime expression
to set the value of the attribute that determines the collection of books o
which the Strutslogic:iterate tag iterates:

<logic:iterate collection="<%=bookDB.getBooks()%>"
id="book" type="database.BookDetails">

Tags With Bodies

A custom tag can contain custom and core tags, scripting elements, HTML
and tag-dependent body content between the start and end tag.

In the following example, the Duke’s Bookstore application pageshowcart.jsp

uses the Strutslogic:present tag to clear the shopping cart and print a messa
if the request contains a parameter namedClear:

<logic:present parameter="Clear">
<% cart.clear(); %>
<font color="#ff0000" size="+2"><strong>
You just cleared your shopping cart!
</strong><br>&nbsp;<br></font>

</logic:present>

Choosing Between Passing Information as Attributes or Body

As shown in the last two sections, it is possible to pass a given piece of data
attribute of the tag or to the tag’s body. Generally speaking, any data that
simple string or can be generated by evaluating a simple expression is
passed as an attribute.

Tags That Define Scripting Variables

A tag can define a variable that can be used in scripts within a page. The fol
ing example illustrates how to define and use a scripting variable that contain
object returned from a JNDI lookup. Examples of such objects include enterp
beans, transactions, databases, environment entries, and so on:

../examples/src/web/bookstore3/showcart.txt
../examples/src/web/bookstore3/catalog.txt
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<tt:lookup id="tx" type="UserTransaction"
name="java:comp/UserTransaction" />

<% tx.begin(); %>

In the Duke’s Bookstore application, several pages use bean-oriented tags
Struts to define scripting variables. For example,bookdetails.jsp uses the
bean:parameter tag to create thebookId scripting variable and set it to value o
the bookId request parameter. Thejsp:setProperty statement also sets the
bookId property of thebookDB object to the value of thebookId request parame-
ter. Thebean:define tag retrieves the value of the bookstore database prope
bookDetails and defines the result as the scripting variablebook:

<bean:parameter id="bookId" name="bookId" />
<jsp:setProperty name="bookDB" property="bookId"/>
<bean:define id="book" name="bookDB" property="bookDetails"

type="database.BookDetails"/>
<h2><jsp:getProperty name="book" property="title"></h2>

Cooperating Tags

Tags can cooperate with each other through shared objects.

In the following example,tag1 creates an object calledobj1, which is then
reused bytag2.

<tt:tag1 attr1="obj1" value1="value" />
<tt:tag2 attr1="obj1" />

In the next example, an object created by the enclosing tag of a group of ne
tags is available to all inner tags. Since the object is not named, the potentia
naming conflicts is reduced. The following example illustrates how a set
cooperating nested tags would appear in a JSP page.

<tt:outerTag>
<tt:innerTag />

</tt:outerTag>

The Duke’s Bookstore pagetemplate.jsp uses a set of cooperating tags t
define the screens of the application. These tags are described inA TemplateTag
Library (page 328).

../examples/src/web/bookstore3/bookdetails.txt
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Defining Tags
To define a tag, you need to:

• Develop a tag handler and helper classes for the tag

• Declare the tag in a tag library descriptor (TLD)

This section describes the properties of tag handlers and TLDs and explains
to develop tag handlers and library descriptor elements for each type of tag i
duced in the previous section.

Tag Handlers
A tag handleris an object invoked by a web container to evaluate a custom
during the execution of the JSP page that references the tag. Tag handlers
implement either theTag or BodyTag interface. Interfaces can be used to take
existing Java object and make it a tag handler. For newly created handlers
can use theTagSupport and BodyTagSupport classes as base classes. The
classes and interfaces are contained in thejavax.servlet.jsp.tagext pack-
age.

Tag handler methods defined by theTag andBodyTag interfaces are called by the
JSP page’s servlet at various points during the evaluation of the tag. When
start tag of a custom tag is encountered, the JSP page’s servlet calls metho
initialize the appropriate handler and then invokes the handler’sdoStartTag

method. When the end tag of a custom tag is encountered, the handler’sdoEnd-

Tag method is invoked. Additional methods are invoked in between when a
handler needs to interact with the body of the tag. For further information,
How Is a Tag HandlerInvoked? (page 333). In order to provide a tag handl
implementation, you must implement the methods, summarized in Table 29,
are invoked at various stages of processing the tag.

Table 29 Tag Handler Methods

Tag Handler Type Methods

Simple doStartTag, doEndTag, release

Attributes
doStartTag, doEndTag, set/getAttribute1...N,
release

http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/tagext/Tag.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/tagext/BodyTag.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/tagext/TagSupport.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/tagext/BodyTagSupport.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/tagext/package-summary.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/http/package-summary.html
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A tag handler has access to an API that allows it to communicate with the
page. The entry point to the API is the page context object (javax.serv-

let.jsp.PageContext) through which a tag handler can retrieve all the oth
implicit objects (request, session, and application) accessible from a JSP pa

Implicit objects can have named attributes associated with them. Such attrib
are accessed using[set|get]Attribute methods.

If the tag is nested, a tag handler also has access to the handler (called thepar-
ent) associated with the enclosing tag.

A set of related tag handler classes (a tag library) is usually packaged
deployed as a JAR archive.

Tag Library Descriptors
A tag library descriptor(TLD) is an XML document that describes a tag library
A TLD contains information about a library as a whole and about each tag c
tained in the library. TLDs are used by a web container to validate the tags
by JSP page development tools.

TLD filenames must have the extension.tld. TLD files are stored in theWEB-
INF directory of the WAR file or a subdirectory ofWEB-INF. When you add a
TLD to a WAR using deploytool,

A TLD must begin with an XML document prolog that specifies the version
XML and the document type definition (DTD):

Body, Evaluation and
No Interaction

doStartTag, doEndTag, release

Body, Iterative Evalua-
tion

doStartTag, doAfterBody, doEndTag, release

Body, Interaction
doStartTag, doEndTag, release, doInitBody,
doAfterBody, release

Table 29 Tag Handler Methods (Continued)

Tag Handler Type Methods

http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/PageContext.html
http://java.sun.com/j2ee/tutorial/api/javax/servlet/jsp/PageContext.html
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<?xml version="1.0" encoding="ISO-8859-1" ?>
<!DOCTYPE taglib PUBLIC "-//Sun Microsystems, Inc.//DTD JSP Tag
Library 1.2//EN"
"http://java.sun.com/dtd/web-jsptaglibrary_1_2.dtd">

The J2EE SDK version 1.3 can understand 1.1 and 1.2 version DTDs. Howe
this chapter documents the 1.2 version because you should use the newer v
in any tag libraries that you develop. The template library TLD,tutorial-tem-

plate.tld, conforms to the 1.2 version. The Struts library TLDs conform to t
1.1 version of the DTD, which has fewer elements and uses slightly differ
names for some of the elements.

The root of a TLD is thetaglib element. The subelements oftaglib are listed
in Table 30:

Listener Element

A tag library can specify some classes that are event listeners (seeHandling
ServletLife Cycle Events (page 236)). The listeners are listed in the TLD
listener elements and the web container will instantiate the listener classes

Table 30 taglib Subelements

Element Description

tlib-version The tag library’s version.

jsp-version The JSP specification version the tag library requires.

short-name Optional name that could be used by a JSP page authoring tool to crea
names with a mnemonic value.

uri A URI that uniquely identifies the tag library.

display-name Optional name intended to be displayed by tools.

small-icon Optional small-icon that can be used by tools.

large-icon Optional large-icon that can be used by tools.

description Optional tag-specific information.

listener SeeListener Element(page 311).

tag SeeTag Element(page 312).

../examples/src/web/bookstore3/tutorial-template.tld
../examples/src/web/bookstore3/tutorial-template.tld
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register them in a way analogous to listeners defined at the WAR level. Un
WAR-level listeners, the order in which the tag library listeners are registere
undefined. The only subelement of thelistener element is thelistener-
class element, which must contain the fully-qualified name of the listener cla

Tag Element

Each tag in the library is described by giving its name and the class of its
handler, information on the scripting variables created by the tag, and infor
tion on the tag’s attributes. Scripting variable information can be given direc
in the TLD or through a tag extra info class (seeTagsThat Define Scripting
Variables (page 318)). Each attribute declaration contains an indication
whether the attribute is required or not, whether its value can be determine
request-time expressions, and the type of the attribute (seeTags With
Attributes (page 314)).

A tag is specified in a TLD in atag element. The subelements of tag are listed
Table 31:

Table 31 tag Subelements

Element Description

name The unique tag name.

tag-class The fully-qualified name of the tag handler class.

tei-class Optional subclass ofjavax.servlet.jsp.tagext.TagExtraInfo.
SeeTagExtraInfo Class(page 321).

body-content The body content type. SeeBody-content Element(page 313) and
Body-content Element(page 318).

display-name Optional name intended to be displayed by tools.

small-icon Optional small-icon that can be used by tools.

large-icon Optional large-icon that can be used by tools.

description Optional tag-specific information.

variable Optional scripting variable information. SeeVariable
Element(page 320).

attribute Tag attribute information. SeeAttribute Element(page 314).
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The following sections will describe the methods and TLD elements that y
need to develop for each type of tag introduced inUsing Tags (page 305).

Simple Tags

Tag Handlers

The handler for a simple tag must implement thedoStartTag and doEndTag

methods of theTag interface. ThedoStartTag method is invoked when the star
tag is encountered. This method returnsSKIP_BODY because a simple tag has n
body. ThedoEndTag method is invoked when the end tag is encountered. T
doEndTag method needs to returnEVAL_PAGE if the rest of the page needs to b
evaluated; otherwise it should returnSKIP_PAGE.

The simple tag discussed in the first section:

<tt:simple />

would be implemented by the following tag handler:

public SimpleTag extends TagSupport {
public int doStartTag() throws JspException {

try {
pageContext.getOut().print("Hello.");

} catch (Exception ex) {
throw new JspTagException("SimpleTag: " +

ex.getMessage());
}
return SKIP_BODY;

}
public int doEndTag() {

return EVAL_PAGE;
}

}

Body-content Element

Tags without bodies must declare that their body content is empty using
body-content element:

<body-content>empty</body-content>
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Tags With Attributes

Defining Attributes in a Tag Handler

For each tag attribute, you must define a property and get and set method
conform to the JavaBeans architecture conventions in the tag handler. For e
ple, the tag handler for the Strutslogic:present tag

<logic:present parameter="Clear">

contains the following declaration and methods:

protected String parameter = null;
public String getParameter() {

return (this.parameter);
}
public void setParameter(String parameter) {

this.parameter = parameter;
}

Note that if your attribute is namedid, and your tag handler inherits from the
TagSupport class, you do not need to define the property and set and get m
ods as these are already defined byTagSupport.

A tag attribute whose value is aString can name an attribute of one of the
implicit objects available to tag handlers. An implicit object attribute would
accessed by passing the tag attribute value to the [set|get]Attribute method
of the implicit object. This is a good way to pass scripting variable names t
tag handler where they are associated with objects stored in the page co
(SeeTags That Define Scripting Variables (page 318)).

Attribute Element

For each tag attribute you must specify whether the attribute is required, whe
the value can be determined by an expression, and optionally, the type o
attribute. For static values the type is alwaysjava.lang.String. If the rtex-

prvalue element istrue or yes, then thetype element defines the return type
expected from any expression specified as the value of the attribute.

<attribute>
<name>attr1</name>
<required>true|false|yes|no</required>
<rtexprvalue>true|false|yes|no</rtexprvalue>
<type>fully-qualified_type</type>

</attribute>
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If a tag attribute is not required, a tag handler should provide a default value

Thetag element for thelogic:present tag declares thatparameter attribute is
not required (because the tag can also test for the presence of other entities
as bean properties), and that its value can be set by a runtime expression.

<tag>
<name>present</name>
<tag-class>org.apache.struts.taglib.

logic.PresentTag</tag-class>
<body-content>JSP</body-content>
...
<attribute>

<name>parameter</name>
<required>false</required>
<rtexprvalue>true</rtexprvalue>

</attribute>
...

</tag>

Attribute Validation

The documentation for a tag library should describe valid values for
attributes. When a JSP page is translated, a web container will enforce any
straints contained in the TLD element for each attribute.

The attributes passed to a tag can also be validated at translation time wit
isValid method of a class derived fromTagExtraInfo. This class is also used
to provide information about scripting variables defined by the tag (seeTags
That Define Scripting Variables (page 318)).

The isValid method is passed the attribute information in aTagData object,
which contains attribute-value tuples for each of the tag’s attributes. Since
validation occurs at translation time, the value of an attribute that is compute
request time will be set toTagData.REQUEST_TIME_VALUE.

The tag<tt:twa attr1="value1"/> has the following TLDattribute ele-
ment:

<attribute>
<name>attr1</name>
<required>true</required>
<rtexprvalue>true</a>

</attribute

This declaration indicates that the value ofattr1 can be determined at runtime.
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The followingisValid method checks that the value ofattr1 is a valid boolean
value. Note that since the value ofattr1 can be computed at runtime,isValid
must check whether the tag user has chosen to provide a runtime value.

public class TwaTEI extends TagExtraInfo {
public boolean isValid(Tagdata data) {

Object o = data.getAttribute("attr1");
if (o != null && o != TagData.REQUEST_TIME_VALUE) {

if (o.toLowerCase().equals("true") ||
o.toLowerCase().equals("false") )
return true;

else
return false;

}
else

return true;
}

}

Tags With Bodies

Tag Handlers

A tag handler for a tag with a body is implemented differently depending
whether the tag handler needs to interact with the body or not. By interact
mean that the tag handler reads or modifies the contents of the body.

Tag Handler Does Not Interact With the Body. If the tag handler does
not need to interact with the body, the tag handler should implement theTag

interface (or be derived fromTagSupport). If the body of the tag needs to be
evaluated, thedoStartTag method needs to returnEVAL_BODY_INCLUDE; other-
wise it should returnSKIP_BODY.

If a tag handler needs to iteratively evaluate the body it should implement
IterationTag interface or be derived fromTagSupport. It should return
EVAL_BODY_AGAIN from thedoStartTag anddoAfterBody methods if it deter-
mines that the body needs to be evaluated again.

Tag Handler Interacts With the Body. If the tag handler needs to interac
with the body, the tag handler must implementBodyTag (or be derived from
BodyTagSupport). Such handlers typically implement thedoInitBody and the
doAfterBody methods. These methods interact with body content passed to
tag handler by the JSP page’s servlet.
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A body content supports several methods to read and write its contents. A
handler can use the body content’sgetString or getReader methods to extract
information from the body and thewriteOut(out) method to write the body
contents to an out stream. The writer supplied to thewriteOut method is
obtained using the tag handler’sgetPreviousOut method. This method is used
to ensure that a tag handler’s results are available to an enclosing tag hand

If the body of the tag needs to be evaluated, thedoStartTag method needs to
returnEVAL_BODY_BUFFERED; otherwise it should returnSKIP_BODY.

doInitBody Method

The doInitBody method is called after the body content is set but before it
evaluated. You generally use this method to perform any initialization t
depends on the body content.

doAfterBody Method

ThedoAfterBody method is calledafter the body content is evaluated.

Like the doStartTag method, doAfterBody must return an indication of
whether to continue evaluating the body. Thus, if the body should be evalu
again, as would be the case if you were implementing an iteration tag,doAfter-

Body should returnEVAL_BODY_BUFFERED; otherwisedoAfterBody should return
SKIP_BODY.

release Method

A tag handler should reset its state and release any private resources i
release method.

The following example reads the content of the body (which contains an S
query) and passes it to a object that executes the query. Since the body do
need to be reevaluated,doAfterBody returnsSKIP_BODY.

public class QueryTag extends BodyTagSupport {
public int doAfterBody() throws JspTagException {

BodyContent bc = getBodyContent();
// get the bc as string
String query = bc.getString();
// clean up
bc.clearBody();
try {

Statement stmt = connection.createStatement();
result = stmt.executeQuery(query);

} catch (SQLException e) {
throw new JspTagException("QueryTag: " +
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 e.getMessage());
}
return SKIP_BODY;

}
}

Body-content Element

For tags that have a body, you must specify the type of the body content:

<body-content>JSP|tagdependent</body-content>

Body content containing custom and core tags, scripting elements, and HT
text is categorized asJSP. This is the value declared for the Strut
logic:present tag. All other types of body content, for example, SQL stat
ments passed to the query tag, would be labeledtagdependent.

Note that the value of thebody-content element does not affect the interpreta
tion of the body by the tag handler; the element is only intended to be used b
authoring tool for rendering the body content.

Tags That Define Scripting Variables

Tag Handlers

A tag handler is responsible for creating and setting the object referred to by
scripting variable into a context accessible from the page. It does this by u
the pageContext.setAttribute(name, value, scope) or pageCon-

text.setAttribute(name, value) methods. Typically an attribute passed t
the custom tag specifies thename of the scripting variable object; this name ca
be retrieved by invoking the attribute’s get method described inDefining
Attributes in a Tag Handler (page 314).

If the value of the scripting variable is dependent on an object present in the
handler’s context it can retrieve the object using thepageContext.getAt-

tribute(name, scope) method.

The usual procedure is that the tag handler retrieves a scripting variable,
forms some processing on the object, and then sets the scripting variable’s
using thepageContext.setAttribute(name, object) method.
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The scope that an object can have is summarized in Table 32. The scope
strains the accessibility and lifetime of the object.

Providing Information About the Scripting Variable

The example described inTags That Define Scripting Variables (page 307)
defines a scripting variablebook that is used for accessing book information:

<bean:define id="book" name="bookDB" property="bookDetails"
type="database.BookDetails"/>

<font color="red" size="+2">
<%=messages.getString("CartRemoved")%>
<strong><jsp:getProperty name="book"

property="title"/></strong>
<br>&nbsp;<br>
</font>

When the JSP page containing this tag is translated, the web container gen
code to synchronize the scripting variable with the object referenced by the v
able. In order to do the code generation, the web container requires certain i
mation about the scripting variable:

• Variable name

• Variable class

• Whether the variable refers to a new or existing object.

Table 32 Scope of Objects

Name Accessible From Lifetime

page Current page
Until the response has been sent back
to the user or the request is passed to
a new page

request
Current page and any included or
forwarded pages

Until the response has been sent back
to the user

session
Current request and any subsequent
request from the same browser
(subject to session lifetime).

The life of the user’s session

application
Current and any future request from
the same web application

The life of the application
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• The availability of the variable.

There are two ways to provide this information: by specifying thevariable

TLD subelement or by defining a tag extra info class and including thetei-

class element in the TLD. Using thevariable element is simpler, but slightly
less flexible.

Variable Element. Thevariable element has the following subelements:

• name-given - The variable name as a constant

• name-from-attribute The name of an attribute whose translation-tim
value will give the name of the variable.

One ofname-given or name-from-attribute is required. The following sub-
elements are optional:

• variable-class Fully-qualified name of the class of the variable
java.lang.String is the default.

• declare - Whether the variable refers to a new object.True is the default.

• scope - The scope of the scripting variable defined.NESTED is default.
Table 33 describes the availability of the scripting variable and the me
ods where the value of the variable must be set or reset.

The implementation of the Strutsbean:define tag conforms to the JSP specifi
cation version 1.1, which requires you to define a tag extra info class. The
specification version 1.2 adds thevariable element. You could define the fol-
lowing variable element for thebean:define tag:

Table 33 Scripting Variable Availability

Value Availability Methods

NESTED
Between the start
tag and the end tag.

In doInitBody anddoAfterBody for a tag handler
implementingBodyTag; otherwise indoStartTag.

AT_BEGIN
From the start tag
until the end of the
page.

In doInitBody, doAfterBody, anddoEndTag for a
tag handler implementingBodyTag; otherwise in
doStartTag anddoEndTag.

AT_END
After the end tag
until the end of the
page.

In doEndTag.
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<tag>
<variable>

<name-from-attribute>id</name-from-attribute>
<variable-class>database.BookDetails</variable-class>
<declare>true</declare>
<scope>AT_BEGIN</scope>

</variable>
</tag>

TagExtraInfo Class. You define a tag extra info class by extending the cla
javax.servlet.jsp.TagExtraInfo. A TagExtraInfo must implement the
getVariableInfo method to return an array ofVariableInfo objects contain-
ing the following information:

• Variable name

• Variable class

• Whether the variable refers to a new object

• The availability of the variable

The web container passes a parameter calleddata to the getVariableInfo

method that contains attribute-value tuples for each of the tag’s attributes. T
attributes can be used to provide theVariableInfo object with a scripting vari-
able’s name and class.

The Struts tag library provides information about the scripting variable crea
by thebean:define tag in theDefineTei tag extra info class. Since the nam
(book) and class (database.BookDetails) of the scripting variable are passe
in as tag attributes, they can be retrieved with thedata.getAttributeString

method and used to fill in theVariableInfo constructor. To allow the scripting
variablebook to be used in the rest of the page, the scope ofbook is set to be
AT_BEGIN.

public class DefineTei extends TagExtraInfo {
public VariableInfo[] getVariableInfo(TagData data) {
String type = data.getAttributeString("type");

if (type == null)
type = "java.lang.Object";

return new VariableInfo[] {
new VariableInfo(data.getAttributeString("id"),

type,
true,
VariableInfo.AT_BEGIN)

};
}

}
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The fully-qualified name of the tag extra info class defined for a scripting va
able must be declared in the TLD in thetei-class subelement of thetag ele-
ment. Thus, thetei-class element forDefineTei would be:

<tei-class>org.apache.struts.taglib.bean.DefineTagTei
</tei-class>

Cooperating Tags
Tags cooperate by sharing objects. JSP technology supports two styles of o
sharing.

The first style requires that a shared object be named and stored in the page
text (one of the implicit objects accessible to both JSP pages and tag hand
To access objects created and named by another tag, a tag handler uses thepage-

Context.getAttribute(name, scope) method.

In the second style of object sharing, an object created by the enclosing tag
dler of a group of nested tags is available to all inner tag handlers. This form
object sharing has the advantage that it uses a private namespace for the o
thus reducing the potential for naming conflicts.

To access an object created by an enclosing tag, a tag handler must first obt
enclosing tag with the static methodTagSupport.findAncestorWith-
Class(from, class) or the TagSupport.getParent method. The former
method should be used when a specific nesting of tag handlers cannot be gu
teed. Once the ancestor has been retrieved, a tag handler can access any st
or dynamically created objects. Statically created objects are members o
parent. Private objects can also be created dynamically created. Such objec
be stored in a tag handler with thesetValue method and retrieved with the
getValue method.

The following example illustrates a tag handler that supports both the named
private object approaches to sharing objects. In the example, the handler
query tag checks whether an attribute namedconnection has been set in the
doStartTag method. If the connection attribute has been set, the hand
retrieves the connection object from the page context. Otherwise, the tag ha
first retrieves the tag handler for the enclosing tag, and then retrieves the con
tion object from that handler.

public class QueryTag extends BodyTagSupport {
private String connectionId;
public int doStartTag() throws JspException {

String cid = getConnection();
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if (cid != null) {
// there is a connection id, use it

connection =(Connection)pageContext.
getAttribute(cid);

} else {
ConnectionTag ancestorTag =

(ConnectionTag)findAncestorWithClass(this,
ConnectionTag.class);

if (ancestorTag == null) {
throw new JspTagException("A query without

a connection attribute must be nested
within a connection tag.");

}
connection = ancestorTag.getConnection();

}
}

}

The query tag implemented by this tag handler could be used in either of the
lowing ways:

<tt:connection id="con01" ....> ... </tt:connection>
<tt:query id="balances" connection="con01">

SELECT account, balance FROM acct_table
where customer_number = <%= request.getCustno()%>

</tt:query>

<tt:connection ...>
<x:query id="balances">

SELECT account, balance FROM acct_table
where customer_number = <%= request.getCustno()%>

</x:query>
</tt:connection>

The TLD for the tag handler must indicate that the connection attribute
optional with the following declaration:

<tag>
...
<attribute>

<name>connection</name>
<required>false</required>

</attribute>
</tag>
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Examples
The custom tags described in this section demonstrate solutions to two recu
problems in developing JSP applications: minimizing the amount of Java p
gramming in JSP pages and ensuring a common look and feel across ap
tions. In doing so, they illustrate many of the styles of tags discussed in the
section.

An Iteration Tag
Constructing page content that is dependent on dynamically generated data
requires the use of flow control scripting statements. By moving the flow con
logic to tag handlers, flow control tags reduce the amount of scripting neede
JSP pages.

The Struts logic:iterate tag retrieves objects from a collection stored in a Jav
Beans component and assigns them to a scripting variable. The body of th
retrieves information from the scripting variable. While elements remain in
collection, theiterate tag causes the body to be reevaluated.

JSP Page

Two Duke’s Bookstore application pages,catalog.jsp andshowcart.jsp, use
the logic:iterate tag to iterate over collections of objects. An excerpt fro
catalog.jsp is shown below. The JSP page initializes theiterate tag with a
collection (named by theproperty attribute) of thebookDB bean. Theiterate
tag sets thebook scripting variable on each iteration over the collection. Th
bookId property of thebook variable is exposed as another scripting variab
Properties of both variables are used to dynamically generate a table conta
links to other pages and book catalog information.

<logic:iterate name="bookDB" property="books"
id="book" type="database.BookDetails">
<bean:define id="bookId" name="book" property="bookId"

type="java.lang.String"/>

<tr>
<td bgcolor="#ffffaa">
<a href="<%=request.getContextPath()%>

/bookdetails?bookId=<%=bookId%>">
<strong><jsp:getProperty name="book"
property="title"/>&nbsp;</strong></a></td>

<td bgcolor="#ffffaa" rowspan=2>

../examples/src/web/bookstore3/catalog.txt
../examples/src/web/bookstore3/showcart.txt
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<jsp:setProperty name="currency" property="amount"
value="<%=book.getPrice()%>"/>

<jsp:getProperty name="currency" property="format"/>
&nbsp;</td>

<td bgcolor="#ffffaa" rowspan=2>
<a href="<%=request.getContextPath()%>

/catalog?Add=<%=bookId%>">
&nbsp;<%=messages.getString("CartAdd")%>
&nbsp;</a></td></tr>

<tr>
<td bgcolor="#ffffff">
&nbsp;&nbsp;<%=messages.getString("By")%> <em>

<jsp:getProperty name="book"
property="firstName"/>&nbsp;

<jsp:getProperty name="book"
property="surname"/></em></td></tr>

</logic:iterate>

Tag Handler

The implementation of the Strutslogic:iterate tag conforms to JSP version
1.1 specification capabilities, which requires you to extend theBodyTagSupport

class. The JSP version 1.2 specification adds features (described inTagHandler
DoesNot InteractWith the Body (page 316)) that simplify programming tag
that iteratively evaluate their body. The following discussion is based on
implementation that uses these features.

The logic:iterate tag supports initializing the collection in a several way
from a collection provided as a tag attribute or from a collection that is a bea
a property of a bean. Our example uses the latter method. Most of the cod
doStartTag is concerned with constructing an iterator over the collection obje
The method first checks if the handler’s collection property is set and if not, p
ceeds to checking the bean and property attributes. If thebean andproperty

attributes are both set, thedoStartTag calls a utility method that uses JavaBean
introspection methods to retrieve the collection. Once the collection objec
determined, the method constructs the iterator.

If the iterator contains more elements,doStartTag sets the value of the scripting
variable to the next element and then indicates that the body should be evalu
otherwise it ends the iteration by returningSKIP_BODY.

After the body has been evaluated, thedoAfterBody method retrieves the body
content and writes it to the out stream. The body content object is then clear
preparation for another body evaluation. If the iterator contains more eleme
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doAfterBody again sets the value of the scripting variable to the next elem
and returnsEVAL_BODY_AGAIN to indicate that the body should be evaluate
again. This causes the re-execution ofdoAfterBody. When there are no remain-
ing elements,doAfterBody terminates the process by returningSKIP_BODY.

public class IterateTag extends TagSupport {
protected Iterator iterator = null;
protected Object collection = null;
protected String id = null;
protected String name = null;
protected String property = null;
protected String type = null;
public int doStartTag() throws JspException {

Object collection = this.collection;
if (collection == null) {

try {
Object bean = pageContext.findAttribute(name);
if (bean == null) {

... throw an exception
}
if (property == null)

collection = bean;
else

collection =
PropertyUtils.

getProperty(bean, property);
if (collection == null) {

... throw an exception
}

} catch
... catch exceptions thrown

by PropertyUtils.getProperty
}

}
// Construct an iterator for this collection
if (collection instanceof Collection)

iterator = ((Collection) collection).iterator();
else if (collection instanceof Iterator)

iterator = (Iterator) collection;
...

}
// Store the first value and evaluate,
// or skip the body if none
if (iterator.hasNext()) {

Object element = iterator.next();
pageContext.setAttribute(id, element);
return (EVAL_BODY_AGAIN);
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} else
return (SKIP_BODY);

}
public int doAfterBody() throws JspException {

if (bodyContent != null) {
try {

JspWriter out = getPreviousOut();
out.print(bodyContent.getString());
bodyContent.clearBody();

} catch (IOException e) {
...

}
}
if (iterator.hasNext()) {

Object element = iterator.next();
pageContext.setAttribute(id, element);
return (EVAL_BODY_AGAIN);

} else
return (SKIP_BODY);

}
}

}

Tag Extra Info Class

Information about the scripting variable is provided in theIterateTei tag extra
info class. The name and class of the scripting variable are passed in a
attributes and used to fill in theVariableInfo constructor.

public class IterateTei extends TagExtraInfo {
public VariableInfo[] getVariableInfo(TagData data) {
String type = data.getAttributeString("type");
if (type == null)

type = "java.lang.Object";

return new VariableInfo[] {
new VariableInfo(data.getAttributeString("id"),

type,
true,
VariableInfo.AT_BEGIN)

};
}

}
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A Template Tag Library
A template provides a way to separate the common elements that are part of
screen from the elements that change with each screen of an application. P
all the common elements together into one file makes it easier to maintain
enforce a consistent look and feel in all the screens. It also makes develop
of individual screens easier since the designer can focus on portions of a sc
that are specific to that screen while the template takes care of the common
tions.

The template is a JSP page, with place holders for the parts that need to ch
with each screen. Each of these place holders is referred to as a parameter
template. For example, a simple template could include a title parameter fo
top of the generated screen and a body parameter to refer to a JSP page f
custom content of the screen.

The template uses a set of nested tags—definition, screen, andparameter—
to define a table of screen definition for an application screen and aninsert tag
to insert parameters from a screen definition into the application screen.

JSP Page

The template for the Duke’s Bookstore example,template.jsp, is shown
below. This page includes a JSP page that creates the screen definition an
uses theinsert tag to insert parameters from the definition into the applicati
screen.

<%@ taglib uri="/tutorial-template.tld" prefix="tt" %>
<%@ page errorPage="errorpage.jsp" %>
<%@ include file="screendefinitions.jsp" %><html>

<head>
<title>

<tt:insert definition="bookstore"
parameter="title"/>

</title>
</head>

<tt:insert definition="bookstore"
parameter="banner"/>

<tt:insert definition="bookstore"
parameter="body"/>

</body>
</html>

screendefinitions.jsp creates a screen definition based on a request attrib
selectedScreen:

../examples/src/web/bookstore3/template.txt
../examples/src/web/bookstore3/screendefinitions.txt
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<tt:definition name="bookstore"
screen="<%= (String)request.

getAttribute(\"selectedScreen\") %>">
<tt:screen id="/enter">

<tt:parameter name="title"
value="Duke’s Bookstore" direct="true"/>

<tt:parameter name="banner"
value="/banner.jsp" direct="false"/>

<tt:parameter name="body"
value="/bookstore.jsp" direct="false"/>

</tt:screen>
<tt:screen id="/catalog">

<tt:parameter name="title"
value="<%=messages.getString("TitleBookCatalog")%>"
direct="true"/>
...

</tt:definition>

The template is instantiated by theDispatcher servlet.Dispatcher first gets the
requested screen and stores as an attribute of the request. This is nec
because when the request is forwarded totemplate.jsp, the request URL
doesn’t contain the original request (for example,/bookstore3/catalog), but
instead reflects the path (/bookstore3/template.jsp) of the forwarded page.
Finally the servlet dispatches the request totemplate.jsp:

public class Dispatcher extends HttpServlet {
public void doGet(HttpServletRequest request,

HttpServletResponse response) {
request.setAttribute("selectedScreen",

request.getServletPath());
RequestDispatcher dispatcher =

request.getRequestDispatcher("/template.jsp");
if (dispatcher != null)

dispatcher.forward(request, response);
}
public void doPost(HttpServletRequest request,

HttpServletResponse response) {
request.setAttribute("selectedScreen",

request.getServletPath());
RequestDispatcher dispatcher =

request.getRequestDispatcher("/template.jsp");
if (dispatcher != null)

dispatcher.forward(request, response);
}

}

../examples/src/web/bookstore3/Dispatcher.java
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Tag Handlers

The template tag library contains four tag handlers—DefinitionTag,
ScreenTag, ParameterTag, andInsertTag—that demonstrate the use of coop
erating tags.DefinitionTag, ScreenTag, andParameterTag comprise a set of
nested tag handlers that share public and private objects.DefinitionTag creates
a public named object calleddefinition that is used byInsertTag.

In doStartTag, DefinitionTag creates a public object namedscreens that
contains a hash table of screen definitions. A screen definition consists
screen identifier and a set of parameters associated with the screen.

public int doStartTag() {
HashMap screens = null;
screens = (HashMap) pageContext.getAttribute("screens");
if (screens == null)

pageContext.setAttribute("screens", new HashMap(),
pageContext.APPLICATION_SCOPE);

return EVAL_BODY_INCLUDE;
}

The table of screen definitions is filled in byScreenTag andParameterTag from
text provided as attributes to these tags. Table 34 shows the contents o
screen definitions hash table for the Duke’s Bookstore application.

In doEndTag, DefinitionTag creates a public object of classDefinition,
selects a screen definition from thescreens object based on the URL passed i
the request, and uses it to initialize theDefinition object.

Table 34 Screen Definitions

Screen Id Title Banner Body

/enter Duke’s Bookstore /banner.jsp /bookstore.jsp

/catalog Book Catalog /banner.jsp /catalog.jsp

/bookdetails Book Description /banner.jsp /bookdetails.jsp

/showcart Your Shopping Cart /banner.jsp /showcart.jsp

/cashier Cashier /banner.jsp /cashier.jsp

/receipt Receipt /banner.jsp /receipt.jsp

../examples/src/web/bookstore3/taglib/DefinitionTag.java
../examples/src/web/bookstore3/taglib/Definition.java
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public int doEndTag()throws JspTagException {
try {

Definition definition = new Definition();
Hashtable screens = null;
ArrayList params = null;
TagSupport screen = null;
screens = (HashMap)

pageContext.getAttribute("screens",
pageContext.APPLICATION_SCOPE);

if (screens != null)
params = (ArrayList) screens.get(screenId);

else
...

if (params == null)
...

Iterator ir = null;
if (params != null)

ir = params.iterator();
while ((ir != null) && ir.hasNext())

definition.setParam((Parameter) ir.next());
// put the definition in the page context

pageContext.setAttribute(
definitionName, definition);

} catch (Exception ex) {
ex.printStackTrace();

}
return EVAL_PAGE;

}

If the URL passed in the request is /enter, theDefinition contains the items
from the first row of Table 34:

The definition for the URL/enter is shown in Table 35. The definition specifie
that the value of theTitle parameter, Duke’s Bookstore, should be insert

Title Banner Body

Duke’s Bookstore /banner.jsp /bookstore.jsp
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directly into the output stream, but the values ofBanner and Body should be
dynamically included.

InsertTag uses theDefinition to insert parameters of the screen definition in
the response. In thedoStartTag method it retrieves the definition object from
the page context.

public int doStartTag() {
// get the definition from the page context
definition = (Definition) pageContext.

getAttribute(definitionName);
// get the parameter
if (parameterName != null && definition != null)

parameter = (Parameter)definition.
getParam(parameterName);

if (parameter != null)
directInclude = parameter.isDirect();

return SKIP_BODY;
}

ThedoEndTag method inserts the parameter value. If the parameter is direct,
directly inserted into the response; otherwise the request is sent to the para
and the response is dynamically included into the overall response.

public int doEndTag()throws JspTagException {
try {

if (directInclude && parameter != null)
pageContext.getOut().print(parameter.getValue());

else {
if ((parameter != null) &&

(parameter.getValue() != null))
pageContext.include(parameter.getValue());

Table 35 Screen Definition for URL/enter

Parameter
Name Parameter Value isDirect

title Duke’s Bookstore true

banner /banner.jsp false

body /bookstore.jsp false

../examples/src/web/bookstore3/taglib/InsertTag.java
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}
} catch (Exception ex) {

throw new JspTagException(ex.getMessage());
}
return EVAL_PAGE;

}

How Is a Tag Handler Invoked?
The Tag interface defines the basic protocol between a tag handler and
page’s servlet. It defines the life cycle and the methods to be invoked when
start and end tags are encountered.

The JSP page’s servlet invokes thesetPageContext, setParent, and attribute
setting methods before callingdoStartTag. The JSP page’s servlet also guara
tees thatrelease will be invoked on the tag handler before the end of the pag

Here is a typical tag handler method invocation sequence:

ATag t = new ATag();
t.setPageContext(...);
t.setParent(...);
t.setAttribute1(value1);
t.setAttribute2(value2);
t.doStartTag();
t.doEndTag();
t.release();

TheBodyTag interface extendsTag by defining additional methods that let a ta
handler access its body. The interface provides three new methods:

setBodyContent - creates body content and adds to tag handler

doInitBody - called before evaluation of tag body

doAfterBody - called after evaluation of tag body

A typical invocation sequence is:

t.doStartTag();
out = pageContext.pushBody();
t.setBodyContent(out);
// perform any initialization needed after body content is set
t.doInitBody();
t.doAfterBody();
// while doAfterBody returns EVAL_BODY_BUFFERED we
// iterate body evaluation
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...
t.doAfterBody();
t.doEndTag();
t.pageContext.popBody();
t.release();
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Transactions
by Dale Green

A  typical enterprise application accesses and stores information
one or more databases. Because this information is critical for busin
operations, it must be accurate, current, and reliable. Data integrit
would be lost if multiple programs were allowed to simultaneously u
date the same information. Also, it would be lost if a system that faile
while processing a business transaction were to leave the affected
only partially updated. By preventing both of these scenarios, softw
transactions ensure data integrity. Transactions control the concur
access of data by multiple programs. In the event of a system failu
transactions make sure that after recovery the data will be in a con
tent state.
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What is a Transaction?
To emulate a business transaction, a program may need to perform several
A financial program, for example, might transfer funds from a checking acco
to a savings account with the steps listed in the following pseudo-code.

begin transaction
   debit checking account
   credit savings account
   update history log
commit transaction

Either all three of these steps must complete, or none of them at all. Otherw
data integrity is lost. Because the steps within a transaction are a unified who
transaction is often defined as an indivisible unit of work.

A transaction can end in two ways: with a commit or a rollback. When a trans
tion commits, the data modifications made by its statements are saved. If a s
ment within a transaction fails, the transaction rolls back, undoing the effect
all statements in the transaction. In the pseudo-code, for example, if a disk d
crashed during thecredit step, the transaction rolls back and undoes the d
modifications made by thedebit statement. Although the transaction failed
data integrity is intact because the accounts still balance.

In the preceding pseudo-code, thebegin and commit statements mark the
boundaries of the transaction. When designing an enterprise bean, you dete
how the boundaries are set by specifying either container-managed or bean-
aged transactions.

Container-Managed Transactions
In an enterprise bean with container-managed transactions, the EJB™ cont
sets the boundaries of the transactions. You can use container-managed tra
tions with any type of enterprise bean: session, entity, or message-driven.
tainer-managed transactions simplify development because the enterprise
code does not explicitly mark the transaction’s boundaries. The code does
include statements that begin and end the transaction.

Typically, the container begins a transaction immediately before an enterp
bean method starts. It commits the transaction just before the method exits.
method can be associated with a single transaction. Nested or multiple tran
tions are not allowed within a method.
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Container-managed transactions do not require all methods to be associated
transactions. When deploying a bean, you specify which of the bean’s meth
are associated with transactions by setting the transaction attributes.

Transaction Attributes
A transaction attribute controls the scope of a transaction. Figure 32 illustr
why controlling the scope is important. In the diagram, method-A begins a tra
action and then invokes method-B of Bean-2. When method-B executes, do
run within the scope of the transaction started by method-A or does it exe
with a new transaction? The answer depends on the transaction attribu
method-B.

Figure 32 Transaction Scope

Transaction Attribute Values

A transaction attribute may have one of the following values:

• Required

• RequiresNew

• Mandatory

• NotSupported

• Supports

• Never

Required

If the client is running within a transaction and it invokes the enterprise bea
method, the method executes within the client’s transaction. If the client is

. 

. 

. 
method-A() { 
    . 
    . 
    . 
    bean-2.method-B() 
}

Bean-1

. 

. 

. 
method-B() { 
    . 
    . 
    . 
}

Bean-2

TX1
TX?
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associated with a transaction, the container starts a new transaction before
ning the method.

The Required attribute will work for most transactions. Therefore, you may w
to use it as a default, at least in the early phases of development. Because
action attributes are declarative, you can easily change them at a later time

RequiresNew

If the client is running within a transaction and it invokes the enterprise bea
method, the container takes the following steps:

1. Suspends the client’s transaction

2. Starts a new transaction

3. Delegates the call to the method

4. Resumes the client’s transaction after the method completes

If the client is not associated with a transaction, the container starts a new tr
action before running the method.

You should use the RequiresNew attribute when you want to ensure tha
method always runs within a new transaction.

Mandatory

If the client is running within a transaction and it invokes the enterprise bea
method, the method executes within the client’s transaction. If the client is
associated with a transaction, the container throws theTransactionRequire-

dException.

Use the Mandatory attribute if the enterprise bean’s method must use the tra
tion of the client.

NotSupported

If the client is running within a transaction and it invokes the enterprise bea
method, the container suspends the client’s transaction before invoking
method. After the method has completed, the container resumes the cli
transaction.

If the client is not associated with a transaction, the container does not st
new transaction before running the method.

Use the NotSupported attribute for methods that don’t need transactions. S
transactions involve overhead, this attribute may improve performance.



CONTAINER-MANAGED TRANSACTIONS 339

n’s
not
ction

e the

n’s

ning

d T2
with
nt is

efore

not
base
ager
Supports

If the client is running within a transaction and it invokes the enterprise bea
method, the method executes within the client’s transaction. If the client is
associated with a transaction, the container does not start a new transa
before running the method.

Because the transactional behavior of the method may vary, you should us
Supports attribute with caution.

Never

If the client is running within a transaction and it invokes the enterprise bea
method, the container throws aRemoteException. If the client is not associated
with a transaction, the container does not start a new transaction before run
the method.

Summary of Transaction Attributes

Table 36 summarizes the effects of the transaction attributes. Both the T1 an
transactions are controlled by the container. A T1 transaction is associated
the client that calls a method in the enterprise bean. In most cases, the clie
another enterprise bean. A T2 transaction is started by the container just b
the method executes.

In the last column, the word “none” means that the business method does
execute within a transaction controlled by the container. However, the data
calls in such a business method might be controlled by the transaction man
of the DBMS.

Table 36 Transaction Attributes and Scope

Transaction
Attribute

Client’s
Transaction

Business Method’s
Transaction

Required
none T2

T1 T1

RequiresNew
none T2

T1 T2
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Setting Transaction Attributes

Because transaction attributes are stored in the deployment descriptor, the
be changed during several phases of J2EE™ application development: ente
bean creation, application assembly, and deployment. However, as an ente
bean developer, it is your responsibility to specify the attributes when crea
the bean. The attributes should be modified only by an application develo
who is assembling components into larger applications. Do not expect the pe
who is deploying the J2EE™ application to specify the transaction attributes

You can specify the transaction attributes for the entire enterprise bean o
individual methods. If you’ve specified one attribute for a method and anot
for the bean, the attribute for the method takes precedence. When speci
attributes for individual methods, the requirements differ with the type of be
Session beans need the attributes defined for business methods, but do not
them for the create methods. Entity beans require transaction attributes fo
business,create, remove, and finder methods. Message-driven beans requ
transaction attributes (either Required or NotSupported) for theonMessage

method.

Mandatory
none error

T1 T1

NotSupported
none none

T1 none

Supports
none none

T1 T1

Never
none none

T1 error

Table 36 Transaction Attributes and Scope (Continued)

Transaction
Attribute

Client’s
Transaction

Business Method’s
Transaction
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Rolling Back a Container-Managed Transaction
There are two ways to roll back a container-managed transaction. First, if a
tem exception is thrown, the container will automatically roll back the trans
tion. Second, by invoking thesetRollbackOnly method of theEJBContext
interface, the bean method instructs the container to roll back the transactio
the bean throws an application exception, the roll back is not automatic, but
be initiated by a call tosetRollbackOnly. for For a description of system and
application exceptions, seeHandling Exceptions (page 142).

Source Code. The source code for the following example is in th
j2eetutorial/examples/src/ejb/bank directory. To compile the code, go to
the j2eetutorial/examples/src directory and typeant bank. To create the
database tables, typeant create-bank-table. A sampleBankApp.ear file is in
the j2eetutorial/examples/ears directory.

The transferToSaving method of theBankEJB example illustrates theset-
RollbackOnly method. If a negative checking balance occurs,transferToSav-

ing invokes setRollBackOnly and throws an application exception
(InsufficientBalanceException). The updateChecking and updateSaving

methods update database tables. If the updates fail, these methods thr
SQLException and thetransferToSaving method throws anEJBException.
Because theEJBException is a system exception, it causes the container to au
matically roll back the transaction. Here is the code for thetransferToSaving

method:

public void transferToSaving(double amount) throws
   InsufficientBalanceException  {

   checkingBalance -= amount;
   savingBalance += amount;

   try {
      updateChecking(checkingBalance);
      if (checkingBalance < 0.00) {
         context.setRollbackOnly();
         throw new InsufficientBalanceException();
      }
      updateSaving(savingBalance);
   } catch (SQLException ex) {
       throw new EJBException
          (“Transaction failed due to SQLException: “
          + ex.getMessage());
   }
}
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When the container rolls back a transaction, it always undoes the changes to
made by SQL calls within the transaction. However, only in entity beans will
container undo changes made to instance variables. (It does so by automat
invoking the entity bean’sejbLoad method, which loads the instance variable
from the database.) When a rollback occurs, a session bean must explicitly
any instance variables changed within the transaction. The easiest way to re
session bean’s instance variables is by implementing theSessionSynchroniza-

tion interface.

Synchronizing a Session Bean’s Instance Variables
TheSessionSynchronization interface, which is optional, allows you to syn
chronize the instance variables with their corresponding values in the datab
The container invokes theSessionSynchronization methods—afterBegin,
beforeCompletion, and afterCompletion—at each of the main stages of a
transaction.

TheafterBegin method informs the instance that a new transaction has beg
The container invokesafterBegin immediately before it invokes the busines
method. TheafterBegin method is a good place to load the instance variab
from the database. TheBankBean class, for example, loads thecheckingBal-
ance andsavingBalance variables in theafterBegin method:

public void afterBegin() {

   System.out.println(“afterBegin()”);
   try {
      checkingBalance = selectChecking();
      savingBalance = selectSaving();
   } catch (SQLException ex) {
       throw new EJBException(“afterBegin Exception: “ +
           ex.getMessage());
   }
}

The container invokes thebeforeCompletion method after the business metho
has finished, but just before the transaction commits. ThebeforeCompletion

method is the last opportunity for the session bean to roll back the transac
(by callingsetRollbackOnly). If it hasn’t already updated the database with th
values of the instance variables, the session bean may do so in thebeforeCom-

pletion method.

The afterCompletion method indicates that the transaction has completed
has a singleboolean parameter, whose value istrue if the transaction was com-
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mitted andfalse if it was rolled back. If a rollback occurred, the session be
can refresh its instance variables from the database in theafterCompletion

method:

public void afterCompletion(boolean committed) {

   System.out.println(“afterCompletion: “ + committed);
   if (committed == false) {
      try {
         checkingBalance = selectChecking();
         savingBalance = selectSaving();
      } catch (SQLException ex) {

throw new EJBException(“afterCompletion SQLException:
“ + ex.getMessage());

      }
   }
}

Methods Not Allowed in Container-Managed
Transactions
You should not invoke any method that might interfere with the transact
boundaries set by the container. The list of prohibited methods follows:

• Thecommit, setAutoCommit, androllback methods ofjava.sql.Con-
nection

• ThegetUserTransaction method ofjavax.ejb.EJBContext

• Any method ofjavax.transaction.UserTransaction

You may, however, use these methods to set boundaries in bean-managed
actions.

Bean-Managed Transactions
In a bean-managed transaction, the code in the session or message-driven
explicitly marks the boundaries of the transaction. An entity bean may not h
bean-managed transactions; it must use container-managed transactions in
Although beans with container-managed transactions require less coding,
have one limitation: When a method is executing, it can be associated with e
a single transaction or no transaction at all. If this limitation will make codi
your bean difficult, you should consider using bean-managed transactions.
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The following pseudo-code illustrates the kind of fine-grained control you c
obtain with bean-managed transactions. By checking various conditions,
pseudo-code decides whether to start and stop different transactions withi
business method.

begin transaction
...
update table-a
...
if (condition-x)
   commit transaction
else if (condition-y)
   update table-b
   commit transaction
else
   rollback transaction
   begin transaction
   update table-c
   commit transaction

When coding a bean-managed transaction for a session bean, you must d
whether to use JDBC or JTA transactions. For a message-driven bean with b
managed transactions, you may use only JTA transactions. The sections tha
low discuss both types of transactions.

JDBC Transactions
A JDBC transactionis controlled by the transaction manager of the DBMS. Yo
may want to use JDBC transactions when wrapping legacy code inside a se
bean. To code a JDBC transaction, you invoke thecommit androllback meth-
ods of thejava.sql.Connection interface. The beginning of a transaction i
implicit. A transaction begins with the first SQL statement that follows the m
recentcommit, rollback, or connect statement. (This rule is generally true, bu
may vary with DBMS vendor.)

Source Code. The source code for the following example is in th
j2eetutorial/examples/src/ejb/warehouse directory. To compile the code,
go to thej2eetutorial/examples/src directory and typeant bank. To create
the database tables, typeant create-warehouse-table. A sample Ware-

houserApp.ear file is in the j2eetutorial/examples/ears directory.

The following code is from theWarehouseEJB example, a session bean that us
theConnection interface’s methods to delimit bean-managed transactions.
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ship method starts by invokingsetAutoCommit on the Connection object
namedcon. This invocation tells the DBMS not to automatically commit eve
SQL statement. Next, theship method calls routines that update th
order_item andinventory database tables. If the updates succeed, the tran
tion is committed. But if an exception is thrown, the transaction is rolled bac

public void ship (String productId, String orderId, int
quantity) {

   try {
      con.setAutoCommit(false);
      updateOrderItem(productId, orderId);
      updateInventory(productId, quantity);
      con.commit();
   } catch (Exception ex) {
       try {
          con.rollback();
          throw new EJBException(“Transaction failed: “ +
             ex.getMessage());
       } catch (SQLException sqx) {
           throw new EJBException(“Rollback failed: “ +
              sqx.getMessage());
       }
   }
}

JTA Transactions
JTA is the abbreviation for the Java™ Transaction API. This API allows you
demarcate transactions in a manner that is independent of the transaction
ager implementation. The J2EE SDK implements the transaction manager
the Java Transaction Service (JTS). But your code doesn’t call the JTS met
directly. Instead, it invokes the JTA methods, which then call the lower-level J
routines.

A JTA transactionis controlled by the J2EE transaction manager. You may w
to use a JTA transaction because it can span updates to multiple databases
different vendors. A particular DBMS’s transaction manager may not work w
heterogeneous databases. However, the J2EE transaction manager does ha
limitation—it does not support nested transactions. In other words, it cannot
a transaction for an instance until the previous transaction has ended.

Source Code. The source code for the following example is in th
j2eetutorial/examples/src/ejb/teller directory. To compile the code, go
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to thej2eetutorial/examples/src directory and typeant teller. To create
the database tables, typeant create-bank-teller. A sampleTellerApp.ear
file is in the j2eetutorial/examples/ears directory.

To demarcate a JTA transaction, you invoke thebegin, commit, androllback
methods of thejavax.transaction.UserTransaction interface. The follow-
ing code, taken from theTellerBean class, demonstrates theUserTransaction
methods. Thebegin andcommit invocations delimit the updates to the databas
If the updates fail, the code invokes therollback method and throws anEJBEx-
ception.

public void withdrawCash(double amount) {

   UserTransaction ut = context.getUserTransaction();

   try {
      ut.begin();
      updateChecking(amount);
      machineBalance -= amount;
      insertMachine(machineBalance);
      ut.commit();
   } catch (Exception ex) {
       try {
          ut.rollback();
       } catch (SystemException syex) {
           throw new EJBException
              (“Rollback failed: “ + syex.getMessage());
       }
       throw new EJBException
          (“Transaction failed: “ + ex.getMessage());
    }
}

Returning Without Committing
In a stateless session bean with bean-managed transactions, a business m
must commit or roll back a transaction before returning. However, a stateful
sion bean does not have this restriction.

In a stateful session bean with a JTA transaction, the association betwee
bean instance and the transaction is retained across multiple client calls. Ev
each business method called by the client opens and closes the database c
tion, the association is retained until the instance completes the transaction
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In a stateful session bean with a JDBC transaction, the JDBC connection re
the association between the bean instance and the transaction across m
calls. If the connection is closed, the association is not retained.

Methods Not Allowed in Bean-Managed
Transactions
Do not invoke thegetRollbackOnly and setRollbackOnly methods of the
EJBContext interface. These methods should be used only in container-mana
transactions. For bean-managed transactions you invoke thegetStatus and
rollback methods of theUserTransaction interface.

Summary of Transaction Options for
Enterprise Beans

If you’re unsure about how to set up transactions in an enterprise bean, her
tip: In the bean’s deployment descriptor, specify container-managed tran
tions. Then, set the Required transaction attribute for the entire bean.
approach will work most of the time.

Table 37 lists the types of transactions that are allowed for the different type
enterprise beans. An entity bean must use container-managed transactions
container-managed transactions, you specify the transaction attributes in
deployment descriptor and you roll back a transaction with thesetRollback-

Only method of theEJBContext interface.

A session bean may have either container-managed or bean-managed tra
tions. There are two types of bean-managed transactions: JDBC and JTA t
actions. You delimit JDBC transactions with thecommit androllback methods
of the Connection interface. To demarcate JTA transactions, you invoke t
begin, commit, androllback methods of theUserTransaction interface.

In a session bean with bean-managed transactions, it is possible to mix J
and JTA transactions. This practice is not recommended, however, becau
could make your code difficult to debug and maintain.
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A message-driven bean may have either container-managed or bean-ma
JTA transactions. (JDBC transactions are not applicable (N/A) to mess
driven beans because queues and topics are not databases.)

Transaction Timeouts
For container-managed transactions, you control the transaction timeout int
by setting the value of thetransaction.timeout property in the
default.properties file, which is in theconfig directory of your J2EE SDK
installation. For example, you would set the timeout value to 5 seconds as
lows:

transaction.timeout=5

With this setting, if the transaction has not completed within 5 seconds, the
container manager rolls it back.

When the J2EE SDK is first installed, the timeout value is set to 0:

transaction.timeout=0

If the value is 0, the transaction will not time out.

Only enterprise beans with container-managed transactions are affected b
transaction.timeout property. For enterprise beans with bean-managed, J
transactions, you invoke thesetTransactionTimeout method of theUser-
Transaction interface.

Table 37 Allowed Transaction Types for Enterprise Beans

Bean Type ContainerManaged

Bean-Managed

JTA JDBC

entity Y N Y

session Y Y Y

message-driven Y Y N/A
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Isolation Levels
Transactions not only ensure the full completion (or rollback) of the stateme
that they enclose, they also isolate the data modified by the statements. Thiso-
lation level describes the degree to which the data being updated is visibl
other transactions.

Suppose that a transaction in one program updates a customer’s phone nu
but before the transaction commits another program reads the same phone
ber. Will the second program read the updated and uncommitted phone nu
or will it read the old one? The answer depends on the isolation level of
transaction. If the transaction allows other programs to read uncommitted d
performance may improve because the other programs don’t have to wait
the transaction ends. But there’s a tradeoff—if the transaction rolls back, ano
program might read the wrong data.

You cannot modify the isolation level of entity beans with container-manag
persistence. These beans use the default isolation level of the DBMS, whi
usuallyREAD_COMMITTED.

For entity beans with bean-managed persistence and for all session beans
can set the isolation level programmatically with the API provided by the und
lying DBMS. A DBMS, for example, might allow you to permit uncommitte
reads by invoking thesetTransactionIsolation method:

Connection con;
...
con.setTransactionIsolation(TRANSACTION_READ_UNCOMMITTED);

Do not change the isolation level in the middle of a transaction. Usually, suc
change causes the DBMS software to issue an implicit commit. Because the
lation levels offered by DBMS vendors may vary, you should check the DBM
documentation for more information. Isolation levels are not standardized for
J2EE platform.

Updating Multiple Databases
The J2EE transaction manager controls all enterprise bean transactions e
for bean-managed JDBC transactions. The J2EE transaction manager allo
enterprise bean to update multiple databases within a transaction. The fig
that follow show two scenarios for updating multiple databases in a single tra
action.
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In Figure 33, the client invokes a business method in Bean-A. The busin
method begins a transaction, updates Database-X, updates Database-Y
invokes a business method in Bean-B. The second business method up
Database-Z and returns control to the business method in Bean-A, which c
mits the transaction. All three database updates occur in the same transact

Figure 33 Updating Multiple Databases

In Figure 34, the client calls a business method in Bean-A, which begins a tr
action and updates Database-X. Then, Bean-A invokes a method in Bea
which resides in a remote J2EE server. The method in Bean-B updates Data
Y. The transaction managers of the J2EE servers ensure that both databas
updated in the same transaction.

Client

J2EE Server

Databases

Bean-A Bean-B

X Y Z
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Figure 34 Updating Multiple Databases Across J2EE Servers

Transactions for Web Components
You may demarcate a transaction in a web component with either
java.sql.Connection or javax.transaction.UserTransaction interface.
These are the same interfaces that a session bean with bean-managed tr
tions may use. In theBean-ManagedTransactions section of this chapter, tran
actions demarcated with theConnection interface are discussed inJDBC
Transactions (page 344) and those with theUserTransaction interface inJTA
Transactions (page 345).

Client

Databases

J2EE Server

Bean-A

X

J2EE Server

Bean-B

Y
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Security
by Eric Jendrock

The J2EE application programming model insulates developers from mec
nism-specific implementation details of application security. J2EE provides
insulation in a way that enhances the portability of applications, allowing th
to be deployed in diverse security environments.

Some of the material in this chapter assumes that you have an understand
basic security concepts. To learn more about these concepts, we highly re
mend that you explore the Security trail in the Java Tutorial (s
http://java.sun.com/docs/books/tutorial/security1.2/index.html)
before you begin this chapter.

Overview 354
Declaring Roles 355

Declaring and Linking Role References 355
Web-Tier Security 357

Protecting Web-Tier Resources 357
Authenticating Users 358
Using Programmatic Security in the Web Tier 359
Unprotected Web-Tier Resources 360

EJB-Tier Security 360
Declaring Method Permissions 360
Mapping Roles to J2EE Users and Groups 361
Using Programmatic Security in the EJB Tier 361
Unprotected EJB-Tier Resources 362

Application-Client-Tier Security 362
Specifying the Application Client’s CallbackHandler 363
353

Bios.html
http://java.sun.com/docs/books/tutorial/security1.2/index.html
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EIS-Tier Security 363
Configuring Sign-On 364
Container-Managed Sign-On 364
Component-Managed Sign-On 365
Configuring Resource Adapter Security 365

Propagating Security Identity 366
Configuring an Enterprise Bean to Use Propagated Security Identities
Configuring Client Authentication 367

J2EE Users, Realms, and Groups 368
Managing J2EE Users and Groups 369

Setting Up a Server Certificate 370
Configuring J2SE Security Policy Files 372

Overview
The J2EE platform defines declarative contracts between those who develo
assemble application components and those who configure applications in
ational environments. In the context of application security, application prov
ers are required to declare the security requirements of their applications in
a way that these requirements can be satisfied during application configura
The declarative securitymechanisms used in an application are expressed i
declarative syntax in a document called a deployment descriptor. An applica
deployer then employs container-specific tools to map the application requ
ments that are in a deployment descriptor to security mechanisms that are im
mented by J2EE containers. The J2EE SDK provides this functionality w
deploytool.

Programmatic securityrefers to security decisions that are made by securi
aware applications. Programmatic security is useful when declarative sec
alone is not sufficient to express the security model of an application. For ex
ple, an application might make authorization decisions based on the time of
the parameters of a call, or the internal state of an enterprise bean or web co
nent. Another application might restrict access based on user information st
in a database.

J2EE applications are made up of components that can be deployed into diff
containers. These components are used to build a multi-tier enterprise app
tion. The goal of the J2EE security architecture is to achieve end-to-end sec
by securing each tier.

The tiers can contain both protected and unprotected resources. Often, you
to protect resources to ensure that only authorized users have access.Authoriza-
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tion provides controlled access to protected resources. However, authorizati
based onidentification and authentication. Identification is a process tha
enables recognition of an entity by a system, while authentication is a pro
that verifies the identity of a user, device, or other entity in a computer syst
usually as a prerequisite to allowing access to resources in a system.

Authorization is not required to access unprotected resources. Because au
zation is built upon authentication, authentication is also not needed to ac
unprotected resources. Accessing a resource without authentication is refer
asunauthenticated or anonymous access.

Declaring Roles
When you design an enterprise bean or web component, you should always
about the kinds of users who will access the component. For example
Account enterprise bean might be accessed by customers, bank tellers
branch managers. Each of these user categories is called asecurity role, an
abstract logical grouping of users that is defined by the person who assem
the application. When an application is deployed, the deployer will map the ro
to security identities in the operational environment.

A J2EE group also represents a category of users, but it has a different s
than a role. A J2EE group is designated for the entire J2EE server, whereas
covers only a specific application in a J2EE server.

To create a role for an application, you declare it for the EJB JAR file or for
web component WAR file that is contained in the application. For example,
could use the following procedure to create a role.

1. In deploytool, select the enterprise bean’s EJB JAR file or the web co
ponent’s WAR file in the tree view.

2. In the Roles tabbed pane, click Add.

3. In the table, enter values for the Name and Description fields.

Declaring and Linking Role References
A security role referenceallows an enterprise bean or web component to ref
ence an existing security role. A security role is an application-specific log
grouping of users, classified by common traits such as customer profile or
title. When an application is deployed, roles are mapped to security identi
such asprincipals (identities assigned to users as a result of authentication
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groups, in the operational environment. Based on this, a user with a certain s
rity role has associated access rights to a J2EE application. The link is the a
name of the security role that is being referenced.

During application assembly, the assembler creates security roles for the app
tion and associates these roles with available security mechanisms. The a
bler then resolves the security role references in individual servlets and JSP
linking them to roles defined for the application.

The security role reference defines a mapping between the name of a role t
called from a web component usingisUserInRole(String name) or an EJB
component usingisCallerInRole(String name) and the name of a security
role that has been defined for the application. For example, to map the sec
role reference “cust” to the security role with rolename “bankCustomer” y
would do the following:

1. Select the enterprise bean or web component in the tree view.

2. Select the Security tabbed pane.

3. If the “cust” entry does not appear in the Role Names Referenced in C
pane, click the Add button.

4. Enter the name of the security role reference “cust” in the Coded Na
column.

5. From the drop-down menu in the Role Name column, select the secu
role name “bankCustomer” that maps to the coded name.

If the security role name to which you want to map the security role ref
ence is not listed in the Role Name column, click Edit Roles and add
role (seeDeclaring Roles (page 355)).

6. Click on the folded paper icon to add a description for the “cust” role r
erence.

7. In the Description dialog box, enter a description.

8. Click OK to accept the description or Cancel to cancel it.

In this example,isUserInRole(“bankCustomer”) andisUserInRole(“cust”)
will both return true for the methods indicated in the Method permissions pan

Because a coded name is linked to a role name, you can change the role na
a later time without having to change the coded name. For example, if you w
to change the role name from “bankCustomer” to something else, you woul
need to change the “cust” name in the code. However, you would need to re
the “cust” coded name to the new role name.
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Web-Tier Security
The following sections address authenticating users and protecting resourc
the web tier.

Protecting Web-Tier Resources
You can protect web resources by specifying a security constraint. A secu
constraint determines who is authorized to access aweb resource collection, a
list of URL patterns and HTTP methods that describe a set of resources t
protected. Security constraints can be defined usingdeploytool, as described in
Controlling Access to Web Resources (page 357).

If you try to access a protected web resource as an unauthenticated user, th
container will try to authenticate you. The container will only accept the requ
after you have proven your identity to the container and have been granted
mission to access the resource.

Controlling Access to Web Resources

Use the following procedure to specify a security constraint to control access
web resource.

1. In deploytool, select the web component in the tree view.

2. Select the Security tabbed pane.

3. Click the Add button in the Security Constraints section of the screen

4. Click the Edit button adjacent to the Web Resource Collection field to a
a web resource collection to the security constraint. The web resource
lection describes a URL pattern and HTTP method pair that refer to
resources that need to be protected.

5. Click the Edit button adjacent to the Authorized Roles field to add one
more roles to the security constraint. You are specifying the set of roles
are allowed to access the web resource collection.
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Authenticating Users
When you try to access a protected web-tier resource, the web container
vates the authentication mechanism that has been configured for that reso
You can configure the following authentication mechanisms for a resource:

• HTTP basic authentication

• Form-based authentication

• Client-certificate authentication

Basic Authentication

If you specifyHTTP basic authentication,the web server will authenticate a use
by using the user name and password obtained from the web client.

Form-Based Authentication

If you specify form-based authentication, you can customize the login scree
and error pages that are presented to the end user by an HTTP browser.

Neither HTTP basic authentication nor form-based authentication is sec
since the content of the user dialog is sent as plain text, and the target ser
not authenticated.

Client-Certificate Authentication

Client-certificate authenticationis a more secure method of authentication tha
either basic or form-based authentication. It uses HTTP over SSL, in which
server and, optionally, the client authenticate each other with Public Key Cer
cates.Secure Sockets Layer(SSL) provides data encryption, server authentic
tion, message integrity, and optional client authentication for a TCP
connection. You can think of apublic key certificateas the digital equivalent of a
passport. It is issued by a trusted organization, which is called acertificate

authority (CA), and provides identification for the bearer. If you specify clien
certificate authentication, the web server will authenticate the client using
X.509 certificate, a public key certificate that conforms to a standard that
defined by X.509 Public Key Infrastructure (PKI).

Configuring A Web Resource’s Authentication Mechanism

To configure the authentication mechanism that a web resource will use:

1. Select the web component in the tree view. The Web Component inspe
will be displayed.



WEB-TIER SECURITY 359

ser

and
ngs
d in.

nter

sed
tion
tent is

ctor

have

ll-

ative
ion.
2. Select the Security tab.

3. Choose one of the following authentication mechanisms from the U
Authentication Method pulldown menu:

• None

• Basic

• Client-Certificate

• Form Based

a. If you choose form-based authentication, you must select Settings
fill in the Realm Name, Login Page, and Error Page fields in the Setti
dialog. The error page is displayed when the user cannot be logge

b. If you choose basic authentication, you must select Settings and e
“Default” in the Realm name field in the settings dialog.

Using SSL to Enhance the Confidentiality of HTTP Basic and Form-
Based Authentication

Passwords are not protected for confidentiality with HTTP basic or form-ba
authentication. To overcome this limitation, you can run these authentica
protocols over an SSL-protected session and ensure that all message con
protected for confidentiality.

To configure HTTP basic or form-based authentication over SSL:

1. Select the web component in the tree view. The Web Component inspe
will be displayed.

2. From the Security tabbed pane, make sure that Basic or Form Based
been selected in the User Authentication Method menu pulldown.

3. Click on the Add button in the Security constraint section.

4. Click on the Security constraint that was added.

5. Select CONFIDENTIAL in the Network Security Requirement menu pu
down.

Using Programmatic Security in the Web Tier
Programmatic security is used by security-aware applications when declar
security alone is not sufficient to express the security model of the applicat
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Programmatic security consists of the following methods of theHttpServle-

tRequest interface:

• getRemoteUser

• isUserInRole

• getUserPrincipal

You can use thegetRemoteUser method to determine the user name with whic
the client authenticated. TheisUserInRole method is used to determine if a
user is in a specific security role. ThegetUserPrincipal method returns a
java.security.Principal object.

These APIs allow servlets to make business logic decisions based on the lo
role of the remote user. They also allow the servlet to determine the princ
name of the current user.

Unprotected Web-Tier Resources
Many applications feature unprotected web-tier content, which any caller
access without authentication. In the web tier, unrestricted access is prov
simply by not configuring an authentication mechanism.

EJB-Tier Security
The following sections describe declarative and programmatic security me
nisms that can be used to protect resources in the EJB tier. The prote
resources include methods of enterprise beans that are called from the ap
tion clients, web components, or other enterprise beans.

You can protect EJB-tier resources by doing the following:

• Declaring method permissions

• Mapping roles to J2EE users and groups

Declaring Method Permissions
After you’ve defined the roles, you can define the method permissions o
enterprise bean. Method permissions indicate which roles are allowed to inv
which methods.
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Use the following procedure to specify method permissions by mapping role
methods.

1. In deploytool, select the enterprise bean in the tree view.

2. Select the Security tabbed pane.

3. In the Method Permissions table, select Sel Roles in the Availability c
umn.

4. Then select a role’s checkbox if that role should be allowed to invok
method.

Mapping Roles to J2EE Users and Groups
When you are developing a J2EE application, you should know the roles of y
users, but you probably won’t know exactly who the users will be. That’s p
fectly all right, because after your bean has been deployed, the administrat
the J2EE server will map the roles to the J2EE users (or groups) of the de
realm. In the Account bean example, the administrator might assign the
Sally to the Manager role, and the users Bob, Ted, and Clara to the Teller ro

An administrator can map roles to J2EE users and groups by using the follow
procedure.

1. In deploytool, select the J2EE application in the tree view.

2. In the Security tabbed pane, select the appropriate role from the R
Name list.

3. Click Add.

4. In the Users dialog box, select the users and groups that should belo
the role. (SeeManagingJ2EEUsersandGroups (page 369) for informa-
tion about creating users and groups withdeploytool.)

Using Programmatic Security in the EJB Tier
Programmatic security in the EJB-tier consists of thegetCallerPrincipal and
theisCallerInRole methods. You can use thegetCallerPrincipal method to
determine the caller of the enterprise bean and theisCallerInRole method to
determine the caller’s role.

Determining the Caller of the Enterprise Bean

The getCallerPrincipal method of theEJBContext interface returns the
java.security.Principal object that identifies the caller of the enterpris
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bean. (In this case, a principal is the same as a user.) In the following exam
thegetUser method of an enterprise bean returns the name of the J2EE user
invoked it:

public String getUser() {
   return context.getCallerPrincipal().getName();
}

Determining the Caller’s Role

You can determine whether an enterprise bean’s caller belongs to a parti
role by invoking theisCallerInRole method:

boolean result = context.isCallerInRole("Customer");

Unprotected EJB-Tier Resources
By default, the J2EE SDK assigns the ANYONE role to a method. Theguest

user, which is anonymous and unauthenticated, belongs to the ANYONE
Therefore, if you do not map the roles, any user may invoke the methods o
enterprise bean.

Application-Client-Tier Security
Authentication requirements for J2EE application clients are the same as
requirements for other J2EE components. Access to protected resources in
the EJB tier or the web tier requires user authentication, while access to un
tected resources does not.

An application client can use the Java Authentication and Authorization Ser
(JAAS) for authentication. JAAS implements a Java version of the stand
Pluggable Authentication Module (PAM) framework, which permits applic
tions to remain independent from underlying authentication technologies.
can plug new or updated authentication technologies under an application w
out making any modifications to the application itself. Applications enable
authentication process by instantiating aLoginContext object which, in turn,
references a configuration to determine the authentication technologies or
modules that will be used to perform the authentication.

A typical login module could prompt for and verify a username and passwo
Other modules could read and verify a voice or fingerprint sample.
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In some cases, a login module needs to communicate with the user to o
authentication information. Login modules use ajavax.security.auth.call-

back.CallbackHandler for this purpose. Applications implement theCall-
backHandler interface and pass it to the login context which forwards it direc
to the underlying login modules. A login module uses the callback handler b
to gather input (such as a password or smart card pin number) from users
supply information (such as status information) to users. By allowing the ap
cation to specify the callback handler, underlying login module can remain in
pendent of the different ways applications interact with users.

For example, the implementation of a callback handler for a GUI applicat
might display a window to solicit user input. Or, the implementation of a ca
back handler for a command line tool might simply prompt the user for inp
directly from the command line.

The login module passes an array of appropriate callbacks to the callback
dler’s handle method (for example, aNameCallback for the user name and a
PasswordCallback for the password) and the callback handler performs t
requested user interaction and sets appropriate values in the callbacks. For e
ple, to process aNameCallback, theCallbackHandler may prompt for a name,
retrieve the value from the user, and call thesetName method of theNameCall-
back to store the name.

Specifying the Application Client’s CallbackHandler
Use the following procedure to specify aCallbackHandler for an application
client.

1. In deploytool, select the application client JAR file in the tree view.

2. Select the General tab.

3. From the CallbackHandler Class menu, select theCallbackHandler class
that will be used as an interface to gather user authentication data.

EIS-Tier Security
In the EIS tier, an application component requests a connection to an
resource. As part of this connection, the EIS may require a sign-on to
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resource. The application component provider has two choices for the desig
the EIS sign-on. The two sign-on approaches are:

1. With the container-managed sign-on approach, the application compo
lets the container take the responsibility of configuring and managing
EIS sign-on. The container determines the username and passwor
establishing a connection to an EIS instance.

2. With the component-managed sign-on approach, the application com
nent code manages EIS sign-on by including code that performs the s
on process to an EIS.

The component provider can usedeploytool to choose the type of sign-on.

Configuring Sign-On
Use the following procedure to configure the type of sign-on.

1.  Indeploytool, select the component from the tree.

2.  Select the Resource Refs tab.

3.  Click Add.

4.  In the Authentication combo box, select one of the following:

a.  Container—for container-managed sign-on

b.  Application—for component-managed sign-on

Container-Managed Sign-On
With container-managed sign-on, an application component does not hav
pass any security information for signing on to the resource to thegetConnec-

tion() method. The security information is supplied by the container, as sho
in the example below.

// Business Method in an application component
Context initctx = new InitialContext();

// perform JNDI lookup to obtain a connection factory
javax.resource.cci.ConnectionFactory cxf =
     (javax.resource.cci.ConnectionFactory)initctx.lookup(
      “java:comp/env/eis/MainframeCxFactory”);
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// Invoke factory to obtain a connection. The security
// information is not passed in the getConnection method
javax.resource.cci.Connection cx = cxf.getConnection();
...

Component-Managed Sign-On
With component-managed sign-on, an application component is responsibl
passing the security information that is needed for signing on to the resourc
the getConnection() method. Security information could be username a
password, for example, as shown in the example below.

// Method in an application component
Context initctx = new InitialContext();

// perform JNDI lookup to obtain a connection factory
javax.resource.cci.ConnectionFactory cxf =
     (javax.resource.cci.ConnectionFactory)initctx.lookup(
       “java:comp/env/eis/MainframeCxFactory”);

// Invoke factory to obtain a connection
com.myeis.ConnectionSpecImpl properties = //..

// get a new ConnectionSpec
properties.setUserName(“...”);
properties.setPassword(“...”);
javax.resource.cci.Connection cx =
  cxf.getConnection(properties);
...

Configuring Resource Adapter Security
In addition to configuring the sign-on, you must also configure the resou
adapter security.

To add security to a resource adapter, complete the following steps:

1. Locate the resource adapter RAR file in the tree view.

2. Select the Security tabbed pane. In the Authentication Mechanisms p
select the authentication mechanisms that this resource adapter supp

• Password: A user and password is required to connect to an EIS.

• Kerberos Version 5.0: The resource adapter supports the Kerb
authentication mechanism. See RFC-1510,The Kerberos Network
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Authentication Service (V5)for details. This specification can be foun
athttp://www.ietf.org/rfc/rfc1510.txt.

You can select no mechanism, one mechanism, or multiple mechani
If you do not select a mechanism, no security authentication will be s
ported.

3. Select Reauthentication Supported if the resource adapter supports
forming reauthentication on an existing physical connection. Reauthe
cation will be performed when an application server calls t
getConnection() method with a security context that is different from th
one that was used to establish the connection.

4. In the Security Permissions panel, click the Add button to add a secu
permission that your resource adapter needs to access system resour
your operational environment. Specify only permissions that are
included in the default set, which are listed in Table 2 of Section 11.2
theJ2EE™ Connector Architecture Specification 1.0.

5. For each security permission, click the rightmost column labelled wit
folded paper to enter a description for the permission.

To delete a security permission, select the permission in the table and
Delete.

Propagating Security Identity
When you design an enterprise bean, you can specify a security identity tha
be used when methods on another enterprise bean are invoked from withi
first bean, as shown in Figure 35.

Figure 35 Security Identity Propagation

initiating
client

intermediate target

application client
or web client

EJB or web
container EJB container

J2EE security identity propagated
security identity
(J2EE)

http://www.ietf.org/rfc/rfc1510.txt
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You can choose one of the following:

• Use the caller identity (J2EE) of the intermediate component to call
methods on the target bean. This technique is used when the target
tainer trusts the intermediate container.

• Use a specific identity to call the methods on the second bean. This t
nique is used when target container expects access via a specific ide

You can usedeploytool to select the type of security identity that is propagate

Configuring an Enterprise Bean to Use Propagated
Security Identities
You can also force an enterprise bean to use a security identity other than
with which the first bean is running.

1. In deploytool, select the target enterprise bean in the tree view.

2. Select the Security tabbed pane.

3. In the Security Identity pane, select the Run As Specified Role option

4. Use the drop-down menu to select the role with which to run.

5. After you select the role, you can select a user from that role. To do t
select Deployment Settings.

6. From Run as Specified User, select the user name that the client will u
invoke the enterprise bean's methods.

7. Click OK when you are done.

You can force an enterprise bean to use the security identity with which the
bean is running.

1. In deploytool, select the target enterprise bean in the tree view.

2. Select the Security tabbed pane.

3. In the Security Identity pane, select the Use Caller ID radio button.

Configuring Client Authentication
If an application component in an application client container accesses a
tected method on a bean, use client authentication.

Use the following procedure to configure client authentication:

1. In deploytool, select the target enterprise bean in the tree view.

2. Select the Security tabbed pane.
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3. Select Deployment Settings to display the Security Deployment Sett
dialog.

4. Select the SSL Required checkbox to enable SSL.

5. In the Client Authentication pane, select Certificate as the method
which the server expects the client to authenticate itself to the server.

6. Click OK when you are done.

Trust Between Containers

When an enterprise bean is designed so that either the original caller identity
designated identity is used to call a target bean, the target bean will receive
propagated identity only; it willnot receive any authentication data.

There is no way for the target container to authenticate the propagated sec
identity. However, since the security identity is used in authorization checks
example, method permissions or with theisCallerInRole() method), it is
vitally important that the security identity be authentic. Since there is no auth
tication data available to authenticate the propagated identity, the target
trust that the calling container has propagated an authenticated security ide

By default, the J2EE SDK server is configured to trust identities that are pro
gated from different containers. Therefore, there are no special steps tha
need to take to set up a trust relationship.

J2EE Users, Realms, and Groups
A J2EE user is similar to an operating system user. Typically, both types of u
represent people. However, these two types of users are not the same. The
authentication service has no knowledge of the user and password you pro
when you log on to the operating system. The J2EE authentication service i
connected to the security mechanism of the operating system. The two sec
services manage users that belong to different realms.

A realm is a collection of users that are controlled by the same authentica
policy. The J2EE authentication service governs users in two realms: certifi
and default.

Certificates are used with the HTTPS protocol to authenticate web browser
ents. To verify the identity of a user in the certificate realm, the authentica
service verifies an X509 certificate. For step-by-step instructions, seeSettingUp
a Server Certificate (page 370). The common name field of the X509 certific
is used as the principal name.
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In most cases, the J2EE authentication service verifies user identity by chec
the default realm. This realm is used for the authentication of all clients exc
for web browser clients that use the HTTPS protocol and certificates.

A J2EE user of the default realm may belong to a J2EE group. (A user in the
tificate realm may not.) Agroup is a category of users, classified by commo
traits such as job title or customer profile. For example, most customers of a
commerce application might belong to theCUSTOMER group, but the big spenders
would belong to thePREFERRED group. Categorizing users into groups makes
easier to control the access of large numbers of users.EJB-Tier
Security (page 360), explains how to control user access to enterprise bean

Managing J2EE Users and Groups
This section shows how to usedeploytool to do the following:

• Display all users in the default realm

• Add a user to the default realm

• Add a user to the certificate realm

• Remove a user

• Add a group to the default realm (you cannot add a group to the certific
realm)

• Remove a group from the default realm

Use the following procedure to display all users in the default or certific
realm.

1. In the tree view, click on the server to which you want to add users and
groups.

2. From the Tools menu, select Server Configuration to display the Confi
ration Installation screen.

3. Under J2EE Server in the tree view, select Users.

4. Select the realm (Default or Certificate).

Use the following procedure to add a user to the default realm.

1. Click Add User.

2. Enter a username and a password in the appropriate fields.

3. In the Group Membership panel, select the group (from Available grou
to which the user you are adding will belong. To select multiple grou
repeat this step.
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4. Click Add to move your selection(s) to Groups.

5. Click OK when done.

 Use the following procedure to add a new group to the default realm.

1. Click Edit Groups.

2. From the Groups window, click Add.

3. Select the line you just added and enter the name of the group to add

4. Press OK when done.

 Use the following procedure to add remove a group from the default realm.

1. Click Edit Groups.

2. From the Groups window, select the group to remove.

3. Press Delete.

4. Press Yes when prompted.

5. Press OK when done.

Use the following procedure to add a new user to the certificate realm.

1. Select the Certificate realm.

2. Click Add User.

3. Select the directory where the certificate is located.

4. Select the certificate filename.

5. Press OK when done.

When you have finished these modifications, you must stop and restart the
server.

Setting Up a Server Certificate
Certificates are used with the HTTPS protocol to authenticate web browser
ents. The HTTPS service of the J2EE server will not run unless a server ce
cate has been installed. Use the following procedure to set up a J2EE s
certificate.

1. Generate a key pair and a self-signed certificate.

The keytool utility enables you to create the certificate. Thekeytool

utility that ships with the J2EE SDK has the same syntax as the one
ships with the J2SE software. However, the J2EE SDK version progra
matically adds a Java Cryptographic Extension provider that has im
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mentations of RSA algorithms. This provider enables you to import RS
signed certificates.

To generate the certificate, run thekeytool utility as follows, substituting
<certificate-alias> with the alias of your certificate and<keystore-
filename> with the name of your keystore file:

   keytool -genkey -keyalg RSA -alias <certificate-alias>
    -keystore <keystore-filename>

2. Thekeytool utility prompts you for the following information:

a. Keystore password—Enter a password. (You may want to
“changeit” to be consistent with the default password of the J2EE SD
keystore.)

b. First and last name—Enter the fully-qualified name of your server. T
fully-qualified name includes the host name and the domain name.

c. Organizational unit—Enter the appropriate value.

d. Organization—Enter the appropriate value.

e. City or locality—Enter the appropriate value.

f. State or province—Enter the unabbreviated name.

g. Two-letter country code—For the USA, the two-letter country code
US.

h. Key password for alias—Do not enter a password. Press Return.

3. Import the certificate.

If your certificate will be signed by a Certification Authority (CA) othe
than Verisign, you must import the CA certificate. Otherwise, you m
skip this step. (Even if your certificate will be signed by Verisign Test C
you must import it.)

To import the certificate, perform these tasks:

a. Request the CA certificate from your CA. Store the certificate in a 

b. To install the CA certificate in the Java 2 Platform, Standard Edition,
thekeytool utility as follows. (You must have the required permission
to modify the$JAVA_HOME/jre/lib/security/cacerts file.)

     keytool -import -trustcacerts -alias <ca-cert-alias>
      -file <ca-cert-filename>
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4. If you want to have your certificate digitally signed by a CA, do the follow
ing:

a. Generate a Certificate Signing Request (CSR).

     keytool -certreq -sigalg MD5withRSA -alias <cert-alias>
      -file <csr-filename>

b. Send the contents of the<csr-filename> for signing.

If you are using Verisign CA, go tohttp://digitalid.veri-
sign.com/. Verisign will send the signed certificate in email. Store th
certificate in a file.

c. Import the signed certificate that you received in email into the serv

     keytool -import -alias <cert-alias> -file
      <signed-cert-file>

Configuring J2SE Security Policy Files
Security policy files are used to grant permissions. Theserver.policy file in
the $J2EE_HOME/lib/security directory is the J2EE server policy file. The
J2EE application client policy file,client.policy, resides in the same direc
tory.

For more information on setting up security policy files, see the Security trai
the Java Tutorial.

http://digitalid.verisign.com
http://digitalid.verisign.com
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BOTH enterprise beans and web components can access a wide varie
resources, including databases, mail sessions, Java™ Message Service o
and URLs. The J2EE™ platform provides mechanisms that allow you to ac
all of these resources in a similar manner. This chapter describes how to get
nections to several types of resources. Although the code samples in this ch
are from enterprise beans, they will also work in web components.
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Mail Session Connections 332
Running the ConfirmerEJB Example 333

URL Connections 334
Running the HTMLReaderEJB Example 336

JNDI Names and Resource References
First, let’s define these terms.

JNDI is the acronym for the Java™ Naming and Directory Interface API. J2
components locate objects by invoking the JNDIlookup method.
373
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A JNDI nameis a people-friendly name for an object. These names are boun
their objects by the naming and directory service that is provided by the J2
server. Because J2EE components access this service through the JNDI AP
usually refer to an object’s people-friendly name as its JNDI name.

A connection factory is an object that produces connection objects that ena
a J2EE component to access to a resource.

A resource referenceis an element in a deployment descriptor that identifies t
component’s coded name for the resource. More specifically, the coded n
identifies a connection factory for the resource.

Although both the coded and the JNDI name identify the same connection
tory, they are different. This approach to naming requires that you map the
names before deployment, but it also decouples components from resou
Because of this decoupling, if at a later time the component needs to access
ferent resource, you don’t have to change the name in the code. This flexib
also makes it easier for you to assemble J2EE applications from pre-exis
components.

Deploytool Tips for Resource References
The instructions that follow refer to the entity bean described in the section,The
SavingsAccountEJBExample (page 110). TheSavingsAccountEJB code is in
the j2eetutorial/examples/src/ejb/savingsaccount directory. A sample
SavingsAccountApp.ear file is in the j2eetutorial/examples/ears directory.

Specifying a Resource Reference

1. In thedeploytool, select theSavingsAccountEJB from the tree.

2. Select the Resource Refs tab.

3. Click Add.

4. In the Coded Name field, enterjdbc/SavingsAccountDB.

TheSavingsAccountBean code refers to the database as follows:

private String dbName = “java:comp/env/jdbc/SavingsAccountDB”;

The java:comp/env prefix is the JNDI subcontext for the componen
Because this subcontext is implicit in the Coded Name field, you don’t n
to include it there.

5. In the Type combo box, select javax.sql.DataSource. ADataSource object
is a factory for database connections.
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6. In the Authentication combo box, select Container.

7. If you want other enterprise beans to share the connections acquired
theDataSource, select the Sharable checkbox.

Mapping a Resource Reference to a JNDI Name

1. Select the J2EE application from the tree.

2. Select the JNDI Names tab.

3. In the References table, select the row containing the resource refere
For theSavingsAccountEJB example, the resource reference isjdbc/

SavingsAccountDB, the name you entered in the Coded Name field of t
Resource Refs tab.

4. In the row you just selected, enter the JNDI name. For theSavingsAc-

countEJB example, you would enterjdbc/Cloudscape in the JNDI Name
field.

When it starts up, the J2EE server reads information from a configura
file and adds JNDI database names such asjdbc/Cloudscape to the name
space. To edit the configuration file, select Tools->Server Configuration
go to the Data Sources node. For information about configuring JDBC d
ers, see theConfiguration Guide of the J2EE SDK.

Database Connections for Enterprise Beans
The persistence type of an enterprise bean determines whether or not you
the connection routine. You must code the connection for enterprise beans
access a database and do not have container-managed persistence. Such
include entity beans with bean-managed persistence and session bean
entity beans with container-managed persistence, thedeploytool generates the
connect routines for you.

Coded Connections

How to Connect

The code examples in this section are from theSavingsAccountBean class,
which connects to the database with the following steps:

1. Specify the database name.

private String dbName = “java:comp/env/jdbc/SavingsAccountDB”;
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2. Obtain theDataSource associated with the logical name.

InitialContext ic = new InitialContext();
DataSource ds = (DataSource) ic.lookup(dbName);

3. Get theConnection from theDataSource.

Connection con =  ds.getConnection();

When To Connect

When coding an enterprise bean, you must decide how long it will retain
connection. Generally you have two choices: either hold the connection for
lifetime of the bean, or only during each database call. Your choice determ
the method (or methods) in which your bean connects to a database.

Longterm Connections. You can design an enterprise bean that holds a da
base connection for its entire lifetime. Because the bean connects and dis
nects just once, its code is slightly easier to write. But there’s a tradeoff—o
components may not acquire the connection. Session and entity beans iss
lifelong connections in different methods.

Session Beans:

The EJB™ container invokes theejbCreate method at the beginning of a ses
sion bean’s life cycle and invokes theejbRemove method at the end. To retain a
connection for the lifetime of a session bean, you connect to the database inejb-

Create and disconnect inejbRemove. If the session bean is stateful, you mus
also connect inejbActivate and disconnect inejbPassivate. A stateful ses-
sion bean requires these additional calls because the EJB container may
vate the bean during its lifetime. During passivation, a stateful session bea
saved in secondary storage, but a database connection may not be saved
manner. Because a stateless session bean cannot be passivated, it do
require the additional calls inejbActivate andejbPassivate. For more infor-
mation on activation and passivation, seeThe Stateful SessionBean Life
Cycle (page 90). For an example of a stateful session bean with a longterm
nection, see theTellerBean.java code in thej2eetutorial/examples/ejb/
teller directory.

Entity Beans With Container-Managed Persistence:

After instantiating an entity bean and moving it to the pooled stage, the EJB c
tainer invokes thesetEntityContext method. Conversely, the EJB containe
invokes theunsetEntityContext method when the entity bean leaves th
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pooled stage and becomes eligible for garbage collection. To retain a data
connection for its entire life span, an entity bean connects in thesetEntityCon-

text method and disconnects in theunsetEntityContext method. To see a dia-
gram of the life cycle see Figure 12 in the section,The Entity Bean Life
Cycle (page 92). For an example of an entity bean with a longterm connec
see theSavingsAccountBean.java code in thej2eetutorial/examples/ejb/
savingsaccount directory.

Shortterm Connections. Briefly held connections allow many component
to share the same connection. Because the EJB container manages a p
database connections, enterprise beans can quickly obtain and release th
nections. For example, a business method might connect to a database, in
row, and then disconnect.

In a session bean, a business method that connects to a database should b
actional. The transaction will help maintain data integrity.

Deploytool Tips for Specifying Database Users and Passwords

The instructions in this section do not apply to entity beans with container-m
aged persistence. For those entity beans, see the instructions inSpecifyingthe
Database JNDI Name, User Name, and Password (page 173).

To connect to the Cloudscape database bundled with this release, you d
specify a database user and password; authentication is performed by a se
service. For more information about authentication, see the chapter
Security (page 353).

However, some types of databases do require a user and password during
nection. For these databases, if thegetConnection call has no parameters, you
must specify the database user and password with thedeploytool. To specify
these values, perform these steps:

1. Select the enterprise bean in the tree view.

2. Select the Resource Refs tabbed pane.

3. Select the appropriate row in the table labelled, “Resource Factories
erenced in Code,” and enter the database user name and password
fields at the bottom.

If you wish to obtain the database user and password programmatically, yo
not need to specify them with thedeploytool. In this case, you include the data
base user and password in the arguments of thegetConnection method:

con = dataSource.getConnection(dbUser, dbPassword);
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Connection Pooling
The EJB container maintains the pool of database connections. This po
transparent to the enterprise beans. When an enterprise bean requests a c
tion, the container fetches one from the pool and assigns it to the bean. Bec
the time-consuming connection has already been made, the bean quickly g
connection. The bean may release the connection after each database call
it can rapidly get another connection. And because such a bean holds the co
tion for a short time, the same connection may be shared sequentially by m
beans.

Mail Session Connections
If you’ve ever ordered a product from a web site, you’ve probably received
email confirming your order. TheConfirmerBean class demonstrates how to
send email from an enterprise bean.

Source Code. The source code for this example is in thej2eetutorial/
examples/src/ejb/confirmer directory. To compile the code, go to the
j2eetutorial/examples/src directory and typeant confirmer. A sample
ConfirmerApp.ear file is in the j2eetutorial/examples/ears directory.

In the sendNotice method of theConfirmerBean class, thelookup method
returns aSession object, which represents a mail session. Like a database c
nection, a mail session is a resource. As with any resource, you must link
coded name (TheMailSession) with a JNDI name. Using theSession object as
an argument, thesendNotice method creates an emptyMessage object. After
calling severalset methods on theMessage object, sendNotice invokes the
send method of theTransport class to send the message on its way. The sou
code for thesendNotice method follows:

public void sendNotice(String recipient) {

   try {
       Context initial = new InitialContext();
       Session session =
         (Session) initial.lookup(
         “java:comp/env/TheMailSession”);

       Message msg = new MimeMessage(session);
       msg.setFrom();

       msg.setRecipients(Message.RecipientType.TO,
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r the
          InternetAddress.parse(recipient, false));

       msg.setSubject(“Test Message from ConfirmerBean”);

       DateFormat dateFormatter =
         DateFormat.getDateTimeInstance(
         DateFormat.LONG, DateFormat.SHORT);

       Date timeStamp = new Date();

String messageText = “Thank you for your order.” + `\n’ +
          “We received your order on “ +
          dateFormatter.format(timeStamp) + “.”;

       msg.setText(messageText);
       msg.setHeader(“X-Mailer”, mailer);
       msg.setSentDate(timeStamp);

       Transport.send(msg);

   } catch(Exception e) {
       throw new EJBException(e.getMessage());
   }
}

Running the ConfirmerEJB Example

Deploying the Application

1. In thedeploytool open thej2eetutorial/examples/ears/Confirmer-
App.ear file (File->Open).

2. In the Resource Refs tab of the bean, specify the resource reference fo
mail session with the values in the following table.

Table 38 ResourceRefs for theConfirmerEJB Example

Field Name Value

Coded Name TheMailSession

Type javax.mail.Session

Authentication Application

From (your email address)
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3. Deploy the SavingsAccountApp application (Tools->Deploy). In the
Introduction dialog box, make sure that you select the Return Client J
checkbox.

Running the Client

1. In a terminal window, go to thej2eetutorial/examples/ears directory.

2. Set theAPPCPATH environment variable to ConfirmerAppClient.jar.

3. Type the following command on a single line, replacing<recipient> with
the email address of the person who will receive the message.

runclient -client ConfirmerApp.ear -name ConfirmerAppClient
-textauth <recipient>

4. At the login prompts, enterguest for the user name andguest123 for the
password.

Trouble-Shooting

If the application cannot connect to the mail server it will generate this exc
tion:

javax.mail.MessagingException: Could not connect to SMTP host

To fix this problem, make sure that the mail server is running and that you
entered the correct name for the mail server host in the Resource Refs tab o
deploytool.

URL Connections
A Uniform Resource Locator (URL) specifies the location of a resource on
Web. TheHTMLReaderBean class shows how to connect to a URL from within a
enterprise bean.

Host (mail server host)

User Name (your UNIX or Windows user name)

Table 38 ResourceRefs for theConfirmerEJB Example

Field Name Value
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Source Code. The source code for this example is in thej2eetutorial/
examples/src/ejb/htmlreader directory. To compile the code, go to the
j2eetutorial/examples/src directory and typeant htmlreader. A sample
HTMLReaderApp.ear file is in the j2eetutorial/examples/ears directory.

The getContents method of theHTMLReaderBean class returns aString that
contains the contents of an HTML file. This method looks up thejava.net.URL

object associated with a coded name (url/MyURL), opens a connection to it, and
then reads its contents from anInputStream. Before deploying the application,
you must map the coded name (url/MyURL) to a JNDI name (a URL string).
Here is the source code for thegetContents method:

public StringBuffer getContents() throws HTTPResponseException
{

   Context context;
   URL url;
   StringBuffer buffer;
   String line;
   int responseCode;
   HttpURLConnection connection;
   InputStream input;
   DataInputStream dataInput;

   try {
      context = new InitialContext();
      url = (URL)context.lookup(“java:comp/env/url/MyURL”);
      connection = (HttpURLConnection)url.openConnection();
      responseCode = connection.getResponseCode();
   } catch (Exception ex) {
       throw new EJBException(ex.getMessage());
   }

   if (responseCode != HttpURLConnection.HTTP_OK) {
throw new HTTPResponseException(“HTTP response code: “ +

         String.valueOf(responseCode));
   }

   try {
      buffer = new StringBuffer();
      input = connection.getInputStream();
      dataInput = new DataInputStream(input);
      while ((line = dataInput.readLine()) != null) {
         buffer.append(line);
         buffer.append(`\n’);
      }
   } catch (Exception ex) {
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       throw new EJBException(ex.getMessage());
   }

   return buffer;
}

Running the HTMLReaderEJB Example

Deploying the Application

1. In thedeploytool open thej2eetutorial/examples/ears/HTMLRead-
erApp.ear file (File->Open).

2. Deploy theHTMLReaderApp application (Tools->Deploy). In the Introduc-
tion dialog box, make sure that you select the Return Client JAR checkb

Running the Client

1. In a terminal window, go to thej2eetutorial/examples/ears directory.

2. Set theAPPCPATH environment variable to HTMLReaderAppClient.jar.

3. Type the following command on a single line:

runclient -client HTMLReaderApp.ear -name
HTMLReaderClient -textauth

4. At the login prompts, enterguest for the user name andguest123 for the
password.

5. The client displays the contents of theindex.html file that resides in the
public_html directory of your J2EE SDK installation.

Connecting Beyond the Firewall

To connect to a URL outside of your firewall, you must perform these tasks:

1. Stop the J2EE server.

2. In thebin/j2ee script, add the following options to the PROPS enviro
ment variable. The<port> is the proxy’s port number and<host> is the
name of your proxy host.

-Dhttp.proxyPort=<port> -Dhttp.proxyHost=<host>

3. In thelib/security/Server.policy file, find the following line:

permission java.net.SocketPermission “*:0-65535”, “connect”;
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Edit the line so that it appears as follows:

permission java.net.SocketPermission “*”, “connect”;

4. Start the J2EE server.
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J2EE™Connector
Technology

by Dale Green and Beth Stearns

THE other chapters in this book are intended for business application deve
ers, but this chapter is for advanced users such as system integrators and
developers. The examples in this chapter demonstrate the J2EE™ Conn
Technology by accessing relational databases. However, this technology is
substitute for the JDBC API. Business application developers should continu
use the JDBC™ API to access relational databases.

The J2EE Connector Technology enables J2EE components such as ente
beans to interact with enterprise information systems (EIS). EIS softw
includes various types of systems: enterprise resource planning (ERP), m
frame transaction processing, non-relational database, among others. The
Connector Technology simplifies the integration of diverse EIS systems. E
EIS requires just one implementation of the J2EE Connector Technolo
Because an implementation adheres to theJ2EE Connector Specification, it is
portable across all compliant J2EE servers.
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About Resource Adapters
A resource adapter is a J2EE component that implements the J2EE Conn
Technology for a specific EIS. It is through the resource adapter that a J
application communicates with an EIS. (See Figure 36.)

Stored in a RAR (Resource adapter ARchive) file, a resource adapter ma
deployed on any J2EE server, much like the EAR file of a J2EE application
RAR file may be contained in an EAR file or it may exist as a separate file.

A resource adapter is analogous to a JDBC driver. Both provide a standard
through which an application can access a resource that is outside of the
server. For a resource adapter, the outside resource is an EIS; for a JDBC d
it is a DBMS. Resource adapters and JDBC drivers are rarely created by app
tion developers. In most cases, both types of software are built by vendors
sell products such as tools, servers, or integration software.

Resource Adapter Contracts
Figure 36 shows the two types of contracts implemented by a resource ada
The application contract defines the API through which a J2EE component s
as an enterprise bean accesses the EIS. This API is the only view that the co
nent has of the EIS. The resource adapter itself and its system contracts are
parent to the J2EE component.

The system contracts link the resource adapter to important services—con
tion, transaction, and security—that are managed by the J2EE server.

The connection management contract supports connection pooling, a tech
that enhances application performance and scalability. Connection poolin
transparent to the application, which simply obtains a connection to the EIS
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Because of the transaction management contract, calls to the EIS ma
enclosed in a XA transactions. XA transactions are global—they may con
calls to multiple EISs, databases, and enterprise bean business met
Although often appropriate, XA transactions are not mandatory. Instead
application may use local transactions, which are managed by the indivi
EIS, or it may use no transactions at all.

To protect the information in an EIS, the security management contract prov
these mechanisms: authentication, authorization, and secure communic
between the J2EE server and the EIS.

Figure 36 Accessing an EIS Through a Resource Adapter

Administering Resource Adapters
Installing a resource adapter is a two-step process:

1. Deploy the RAR file containing the resource adapter onto a server.

J2EE Server

Enterprise 
Bean

EISResource 
Adapter

Web  
Component

Transaction 
Connection 
Security

Managers:
System 
Contracts

Application 
Contract

Application 
Contract
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The following command, for example, deploys a sample black box resou
adapter onto the local host. (For Windows, in the following commands o
the backslash character, change$J2EE_HOME to %J2EE_HOME%, and enter the
entire command on a single line.)

deploytool -deployConnector \
$J2EE_HOME/lib/connector/cciblackbox-tx.rar \
localhost

2. Add a connection factory for the resource adapter.

Suppose that you wanted to add a connection factory for the reso
adapter in thecciblackbox-tx.rar file. The JNDI name of the connection
factory will beeis/MyCciBlackBoxTx. To override the default value of the
property namedConnnectionURL, you specify the URL of a database. (A
property is a name-value pair used to configure a connection factory.) To
the connection factory, you might enter the followingj2eeadmin command:

j2eeadmin -addConnectorFactory \
eis/MyCciBlackBoxTx \
cciblackbox-tx.rar \
-props \
ConnectionURL=jdbc:oracle:thin:@myhost:1521:ACCTDB

For the full syntax of thedeploytool andj2eeadmin commands, seeJ2EE™
SDK Tools (page 453). These commands also list and remove resource ada
and connection factories.

To list the resource adapters that have been deployed:

deploytool -listConnectors localhost

To list the connection factories that have been added:

j2eeadmin -listConnectorFactory

To uninstall the resource adapter deployed in step 1:

deploytool -undeployConnector cciblackbox-tx.rar localhost

To remove the connection factory added in step 2:

j2eeadmin -removeConnectorFactory eis/MyCciBlackBoxTx
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The Black Box Resource Adapters
The J2EE SDK includes several black box resource adapters for performing
to-end and compatibility testing. The underlying EIS of these adapters is a r
tional DBMS. The client API is the JDBC 2.0 API and thejavax.sql.Data-
Source interface. Underneath, the black box adapters use JDBC drivers
communicate with relational databases. For more information, seeConfiguring
JDBC™ Drivers (page 391).

Note: Although the black box adapters use JDBC, resource adapters are not mea
to replace JDBC for accessing relational databases. The black box adapters are
testing purposes only. Because they use JDBC, they can be plugged into existi
tests that also use JDBC.

Transaction Levels
The black box resource adapters reside in the$J2EE_HOME/lib/connector

(Unix) or %J2EE_HOME%\lib\connector (Windows) subdirectory. The follow-
ing table lists the blackbox RAR files and the different transaction levels t
they support:

For theXA_TRANSACTION level, the underlying JDBC driver must support the XA
requirements as defined by the JDBC 2.0 API.

Table 39 Black Box Transaction Levels

File Transaction Level

blackbox-notx.rar NO_TRANSACTION

blackbox-tx.rar LOCAL_TRANSACTION

blackbox-xa.rar XA_TRANSACTION

cciblackbox-tx.rar LOCAL_TRANSACTION

cciblackbox-xa.rar XA_TRANSACTION
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Properties
A resource adapter may contain properties, name-value pairs containing i
mation specific to the resource adapter and its underlying EIS. These prope
are defined in the deployment descriptor of each blackbox RAR file. Because
EIS of a blackbox adapter is a relational database, the properties contain i
mation required for connecting to a database. Table 40 lists the properties o
black box adapter files. Table 41 shows the default values for the black box p
erties.

To override a default property value, you set the value when adding a conne
factory with thej2eeadmin command. See the section,AdministeringResource
Adapters (page 387).

Table 40 Black Box Properties

File Property Name Description

blackbox-notx.rar ConnectionURL URL of database

blackbox-tx.rar ConnectionURL URL of database

blackbox-xa.rar XADataSourceName JNDI name ofXADataSource

cciblackbox-tx.rar ConnectionURL URL of database

cciblackbox-xa.rar XADataSourceName JNDI name ofXADataSource

Table 41 Default Values for Black Box Properties

Property Name Description

ConnectionURL jdbc:cloudscape:rmi:CloudscapeDB;create=true

XADataSourceName jdbc/XACloudscape_xa
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Configuring JDBC™ Drivers
If you are running the black box adapters against a Cloudscape database
may skip this section. If you are using a database other than Cloudscape
should perform the steps that follow.

The Non-XA Black Box Adapters

1. Set the JDBC driver class. Use thej2eeadmin tool with the -addJdb-

cDriver option and specify the driver class name. The syntax for t
option is:

j2eeadmin -addJdbcDriver <class name>

2. Edit the bin/userconfig.sh (UNIX) or bin\userconfig.bat (Win-
dows) file, setting the J2EE_CLASSPTH variable to the location of t
JDBC driver classes.

3. Restart the J2EE server.

The XA Black Box Adapters

1. Set theXADatasource property. With thej2eeadmin tool and the-addJd-
bcXADatasource option, specify the JNDI name and class name for t
XADatasource property. Optionally, you may specify the XA user nam
and password and you may override the default property value. The sy
follows:

j2eeadmin -addJdbcXADatasource <jndi name> <class name>
[<xa user name> <xa password>]
[-props (<name>=<value>)+]

The preceding command results in two data sources. One is aDataSource

object with the specified JNDI name from which the J2EE application g
aConnection instance. The other is anXADatasource object whose JNDI
name is the<jndi-name> parameter appended with two underscores a
xa (<jndi-name>__xa). Behind the scenes, theDataSource uses the
XADataSource to create connections.

2. Restart the J2EE server.
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Resource Adapter Tutorial
This tutorial shows you how to deploy the black box resource adapter store
the blackbox-tx.rar file. To test the resource adapter, you will modify th
examples/src/ejb/savingsaccount/SavingsAccountBean.java file so that
it accesses the Cloudscape database through the resource adapter. TheSav-

ingsAccountBean.java file is also used in another example; seeRunningthe
SavingsAccountEJB Example (page 123)

Setting Up
1. Start the J2EE server.

j2ee -verbose

2. Follow the instructions in the section,SettingUp theDatabase (page 123).

Deploying the Resource Adapter
1. Deploy a black box resource adapter that is packaged in theblackbox-

tx.rar file.

UNIX:

deploytool -deployConnector \
$J2EE_HOME/lib/connector/blackbox-tx.rar localhost

Windows:

(Enter the following command on a single line.)

deploytool -deployConnector
%J2EE_HOME%\lib\connector\blackbox-tx.rar localhost

2. Add a connection factory for the resource adapter. The JNDI name for
connection factory iseis/MyBlackBoxTx.

UNIX:

j2eeadmin -addConnectorFactory \
eis/MyBlackBoxTx blackbox-tx.rar

Windows:

(Enter the following command on a single line.)
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j2eeadmin -addConnectorFactory
eis/MyBlackBoxTx blackbox-tx.rar

3. Verify that the resource adapter has been deployed.

deploytool -listConnectors localhost

Thedeploytool displays these lines:

Installed connector(s):
Connector Name: blackbox-tx.rar

Installed connection factories:
Connection Factory JNDI Name: eis/MyBlackBoxTx

Testing the Resource Adapter
1. If you are new to the J2EE SDK, you should first read the instructions

Getting Started (page 47).

2. Locate theSavingsAccountBean.java source code, which resides in th
j2eetutorial/examples/src/ejb/savingsaccount directory.

3. Edit the SavingsAccountBean.java source code, changing the valu
assigned to thedbName variable as follows:

private String dbName = “java:comp/env/MyEIS”;

4. Compile the source code in thesavingsaccount directory:

a. Go toj2eetutorial/examples/src.

b. Typeant savingsaccount.

5. Replace the newSavingsAccountBean.class file in the existingSav-
ingsAccountApp.ear file.

a. In the GUI deploytool, open thej2eetutorial/examples/ears/Sav-
ingsAccountApp.ear file.

b. On the General tabbed pane of the SavingsAccountJAR, click Edit

c. In the Available Files field, locate thej2eetutorial/exam-
ples/build/ejb/SavingsAccountBean.class file.

d. Drag and drop theSavingnsAccountBean.class file from the Avail-
able Files field to the Contents field.

e. Click OK.
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6. Change the resource factory reference.

a. Select the Resource Refs tabbed pane of the SavingsAccountEJB

b. Select the item whose Coded Name entry isjdbc/SavingsAccountDB.

c. Click Delete.

d. Click Add.

e. Enter the values specified in the following table.

Theeis/MyBlackBoxTx JNDI name matches the name of the connecti
factory that you added in step 2 ofDeploying the Resource
Adapter (page 392). The MyEIS value of the Coded Name field cor
sponds to this line in theSavingsAccountBean.java source code:

private String dbName = “java:comp/env/MyEIS”;

Although it is included in the source code, thejava:comp/env/ subcon-
text is implicit in the Coded Name field of the Resource Refs tabbed pa

7. Save the SavingsAccountApp (File->Save).

8. Deploy the SavingsAccountApp.

a. Select Tools->Deploy.

b. In the Introduction dialog box, select Return Client Jar.

Table 42 Resource References Values

Field Value

Coded Name MyEIS

Type javax.sql.DataSource

Authentication Container

JNDI Name eis/MyBlackBoxTx
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c. In the JNDI Names dialog box, verify that the JNDI names in the fo
lowing table have been specified.

9. To run the application, follow the directions inRunning the
Client (page 124).

Common Client Interface (CCI)
This section describes how components use the Connector architecture Com
Client Interface (CCI) API and a resource adapter to access data from an E

Overview of the CCI
Defined by the J2EE Connector Specification, the CCI defines a set of interf
and classes whose methods allow a client to perform typical data access o

Table 43 JNDI Names

Component or Reference Name JNDI Name

SavingsAccountEJB MySavingsAccount

MyEIS eis/MyBlackBoxTx

ejb/SimpleSavingsAccount MySavingsAccount
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tions. Our exampleCoffeeEJB session bean includes methods that illustrate h
to use the CCI, in particular, the following CCI interfaces and classes:

• ConnectionFactory: Provides an application component with aConnec-

tion instance to an EIS.

• Connection- Represents the connection to the underlying EIS.

• ConnectionSpec: Provides a means for an application component to pa
connection request-specific properties to theConnectionFactory when
making a connection request.

• Interaction: Provides a means for an application component to exec
EIS functions, such as database stored procedures.

• InteractionSpec: Holds properties pertaining to an application comp
nent’s Interaction with an EIS.

• Record: The superclass for the different kinds of record instances. Rec
instances may beMappedRecord, IndexedRecord, or ResultSet

instances, which all inherit from the Recordinterface.

• RecordFactory: Provides an application component with aRecord
instance.

• IndexedRecord: Represents an ordered collection ofRecord instances
based on thejava.util.List interface.

A client or application component that uses the CCI to interact with an unde
ing EIS does so in a prescribed manner. The component must establish a co
tion to the EIS’s resource manager, and it does so using theConnectionFactory.
TheConnection object represents the actual connection to the EIS and it is u
for subsequent interactions with the EIS.

The component performs its interactions with the EIS, such as accessing
from a specific table, using anInteraction object. The application componen
defines theInteraction object using anInteractionSpec object. When the
application component reads data from the EIS (such as from database tabl
writes to those tables, it does so using a particular type ofRecord instance, either
a MappedRecord, IndexedRecord, or ResultSet instance. Just as theConnec-
tionFactory createsConnection instances, aRecordFactory createsRecord
instances.

Our example shows how a session bean uses a resource adapter to add an
records in a relational database. The example shows how to invoke stored p
dures, which are business logic functions stored in a database and specific
enterprise’s operation. Stored procedures consist of SQL code to perform o
tions related to the business needs of an organization. They are kept in the
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base and can be invoked when needed, just as you might invoke a Ja
method. In addition to showing how to use the CCI to invoke stored procedu
we’ll also explain how to pass parameters to stored procedures and how to
the parameter data types from SQL to those of the Java programming langu

Programming with the CCI
The code for the following example is in theexamples/src/connector/cci
directory.

To illustrate how to use a CCI resource adapter, we’ve written a session bean
a client of that bean. These pieces of code illustrate how clients invoke the di
ent CCI methods that resource adapters built on CCI might make available.
example uses the two sample CCI-specific resource adapt
cciblackbox_tx.rar and cciblackbox_xa.rar.

The Coffee session bean is much like any other session bean. It has a h
interface (CoffeeHome), a remote interface (Coffee), and an implementation
class (CoffeeEJB). To keep things simple, we’ve called the clientCoffeeCli-

ent.

Let’s start with the session bean interfaces and classes. The home interfaceCof-

feeHome, is like any other session bean home interface. It extendsEJBHome and
defines acreate method to return a reference to theCoffee remote interface.

TheCoffee remote interface defines the bean’s two methods that may be ca
by a client.

public void insertCoffee(String name, int quantity)
throws RemoteException;
public int getCoffeeCount() throws RemoteException;

Now let’s examine theCoffeeEJB session bean implementation class to see h
it uses the CCI.

To begin with, notice thatCoffeeEJB imports thejavax.resource CCI inter-
faces and classes, along with thejavax.resource.ResourceException, and
the samplecciblackbox classes.

import javax.resource.cci.*;
import javax.resource.ResourceException;
import com.sun.connector.cciblackbox.*;
Obtaining a Database Connection
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Prior to obtaining a database connection, the session bean does some set u
in its setSessionContext method. (See the following code example.) Speci
cally, thesetSessionContext method sets the user and password values, a
instantiates aConnectionFactory. These values and objects remain available
the other session bean methods.

(In this and subsequent code examples, the numbers in the left margin c
spond to the explanation that follows the code.)

   public void setSessionContext(SessionContext sc) {
        try {
            this.sc = sc;
1           Context ic = new InitialContext();
2           user = (String) ic.lookup(“java:comp/env/user”);
            password = (String) ic.lookup
               (“java:comp/env/password”);
3           cf = (ConnectionFactory) ic.lookup
               (“java:comp/env/CCIEIS”);
        } catch (NamingException ex) {
            ex.printStackTrace();
        }
    }

1. Establish a JNDIInitialContext.

2. Use the JNDIInitialContext.lookup method to find the user and pass
word values.

3. Use thelookup method to locate theConnectionFactory for the CCI
black box resource adapter and obtain a reference to it.

CoffeeEJB uses its private methodgetCCIConnection method to establish a
connection to the underlying resource manager or database. A client of theCof-

fee session bean cannot invoke this method directly. Rather, the session
uses this method internally to establish a connection to the database. The fo
ing code uses the CCI to establish a database connection.

    private Connection getCCIConnection() {
        Connection con = null;
        try {
1           ConnectionSpec spec =
                new CciConnectionSpec(user, password);
2           con = cf.getConnection(spec);
        } catch (ResourceException ex) {
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            ex.printStackTrace();
        }
        return con;
    }

1. Instantiate a newCciConnectionSpec object with the user and password
values obtained by thesetSessionContext method. TheCciConnec-
tionSpec class is the implementation of theConnectionSpec interface.

2. Call theConnectionFactory.getConnection method to obtain a connec-
tion to the database. (The reference to theConnectionFactory was
obtained in thesetSessionContext method.) Use theCciConnection-
Spec object to pass the required properties to theConnectionFactory.
ThegetConnection method returns aConnection object.

The CoffeeEJB bean also includes a private method,closeCCIConnection, to
close a connection. The method invokes theConnection object’sclose method
from within a try/catch block. Like thegetCCIConnection method, this is a
private method intended to be called from within the session bean.

private void closeCCIConnection(Connection con) {
    try {
        con.close();
    } catch (ResourceException ex) {
        ex.printStackTrace();
    }
}

Database Stored Procedures

The sample CCI black box adapters call database stored procedures. It is im
tant to understand stored procedures before delving into how to read or w
data using the sample CCI black box adapters. The methods of these sampl
adapters do not actually read data from a database or update database
Instead, these sample CCI adapters enable you to invoke database stored
dures, and it is the stored procedures that actually read or write to the datab

A stored procedure is a business logic method or function that is stored in a d
base and is specific for the enterprise’s business. Typically, stored proced
consist of SQL code, though in certain cases (such as with Cloudscape) they
consist of code written in the Java™ programming language. Stored proced
perform operations related to the business needs of an organization. The
kept in the database and applications can invoke them when needed.
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Stored procedures are typically SQL statements. Our example calls two st
procedures:COUNTCOFFEE and INSERTCOFFEE. The COUNTCOFFEE procedure
merely counts the number of coffee records in theCoffee table, as follows:

SELECT COUNT(*) FROM COFFEE

TheINSERTCOFFFEE procedure adds a record with two values, passed to the p
cedure as parameters, to the sameCoffee table, as follows:

INSERT INTO COFFEE VALUES (?,?)

Mapping to Stored Procedure Parameters

When you invoke a stored procedure from your application component you m
have to pass argument values to the procedure. For example, when you in
theINSERTCOFFEE procedure, you pass it two values for theCoffee record ele-
ments. Likewise, you must be prepared to receive values that a stored proce
returns.

The stored procedure, in turn, passes its set of parameters to the database
agement system (DBMS) to carry out its operation and may receive values
from the DBMS. Database stored procedures specify, for each of their para
ters, the SQL type of the parameter value and the mode of the parameter. M
can be input (IN), output (OUT), or both input and output (INOUT). An input
parameter only passes data in to the DBMS while an output parameter
receives data back from the DBMS. AINOUT parameter accepts both input an
output data.

When you use the CCIexecute method to invoke a database stored procedu
you also create an instance of anInputRecord, provided that you’re passing a
parameter to the stored procedure and the stored procedure you’re exec
returns data (possibly anOutputRecord instance). TheInputRecord andOut-
putRecord are instances of the supportedRecord types: IndexedRecord,
MappedRecord, or ResultSet. In our example, we instantiate anInputRecord
and anOutputRecord that are bothIndexedRecord instances.

Note: The CCI black box adapters only supportIndexedRecord types.

The InputRecord maps theIN andINOUT parameters for the stored procedur
while theOutputRecord maps theOUT andINOUT parameters. Each element o
an input or output record corresponds to a stored procedure parameter. Th
there is an entry in theInputRecord for eachIN andINOUT parameter declared
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in the stored procedure. Not only does theInputRecord have the same number
of elements as the procedure’s input parameters, they are declared in the
order as in the procedure’s parameter list. The same holds true for theOutpu-

tRecord, though its list of elements matches only theOUT andINOUT parameters.

For example, suppose you have a stored procedureX that declares three parame
ters. The first parameter is anIN parameter, the second is anOUT parameter, and
the third is anINOUT parameter. The following figure shows how the elements
anInputRecord and anOutputRecord map to this stored procedure.

Figure 37 Mapping Stored Procedure Parameters to CCI Record Elements

When you use the CCI black box adapter, you designate the parameter typ
mode in the same way, though the underlying Oracle or Cloudscape DB
declare the mode differently. Oracle designates the parameter’s mode in
stored procedure declaration, along with the parameter’s type declaration
example, an OracleINSERTCOFFEE procedure declares its twoIN parameters as
follows:

procedure INSERTCOFFEE (name IN VARCHAR2, qty IN INTEGER)

An OracleCOUNTCOFFEE procedure declares its parameterN as anOUT parameter:

procedure COUNTCOFFEE (N OUT INTEGER)

Cloudscape, which declares stored procedures using standard a Java meth
nature, indicates anIN parameter using a single value and anINOUT parameter as
an array. The method’s return value is theOUT parameter. For example, Cloud

InputRecord iRec

Stored_procedure X ( IN,   OUT,   INOUT 

OutputRecord oRec

e1 e2

e1 e2
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scape declares theIN parameters (name andqty) for insertCoffee and theOUT
parameter (the method’s return value) forcountCoffee as follows:

public static void insertCoffee(String name, int qty)
public int countCoffee()

If qty were anINOUT parameter, then Cloudscape would declares it as:

public static void insertCoffee(String name, int[] qty)

Oracle would declare it as:

procedure INSERTCOFFEE (name IN VARCHAR2, qty INOUT INTEGER)

You must also map the SQL type of each value to its corresponding Java t
Thus, if the SQL type is integer, then theInputRecord or OutputRecord ele-
ment must be defined as aInteger object. If the SQL type is aVARCHAR, then the
Java type must be aString object. Thus, when you add the element to th
Record, you declare it to be an object of the proper type. For example, add
integer and a string element to anInputRecord as follows:

iRec.add (new Integer (intval));
iRec.add (new String (“Mocha Java”));

Note: TheJDBC Specification defines the SQL to Java type mapping.

Reading Database Records

The getCoffeeCount method ofCoffeeEJB illustrates how to use the CCI to
read records from a database table. This method does not directly read the
base records itself; instead, it invokes a procedure stored in the database
COUNTCOFFEE. It is the stored procedure that actually reads the records in
database table.

The CCI provides interfaces for three types of records:IndexedRecord, Mappe-
dRecord, andResultSet. These three record types inherit from the base int
face,Record. They differ only in how they map the record elements within th
record. Our example usesIndexedRecord, which is the only record type cur-
rently supported.IndexedRecord holds its record elements in an ordered
indexed collection based onjava.util.List. As a result, we use anIterator
object to access the individual elements in the list.
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Let’s begin by looking at how thegetCoffeeCount method uses the CCI to
invoke a database stored procedure. Again, note that the numbers in the m
to the left of the code correspond to the explanation after the code example

    public int getCoffeeCount() {
        int count = -1;
        try {
1           Connection con = getCCIConnection();
2           Interaction ix = con.createInteraction();
3           CciInteractionSpec iSpec =
               new CciInteractionSpec();
4           iSpec.setSchema(user);
            iSpec.setCatalog(null);
            iSpec.setFunctionName(“COUNTCOFFEE”);
5           RecordFactory rf = cf.getRecordFactory();
6           IndexedRecord iRec =
               rf.createIndexedRecord(“InputRecord”);
7           Record oRec = ix.execute(iSpec, iRec);
8           Iterator iterator =
               ((IndexedRecord)oRec).iterator();
9           while(iterator.hasNext()) {
                Object obj = iterator.next();
                if(obj instanceof Integer) {
                    count = ((Integer)obj).intValue();
                }
                else if(obj instanceof BigDecimal) {
                    count = ((BigDecimal)obj).intValue();
                }
            }
10          closeCCIConnection(con);
        }catch(ResourceException ex) {
            ex.printStackTrace();
        }
        return count;
    }

1. Obtain a connection to the database.

2. Create a newInteraction instance. ThegetCoffeeCount method creates
a newInteraction instance because it is this object that enables the s
sion bean to execute EIS functions such as invoking stored procedure

3. Instantiate aCciInteractionSpec object. The session bean must pass ce
tain properties to theInteraction object, such as schema name, catalo
name, and the name of the stored procedure. It does this by instantiat
CciInteractionSpec object. TheCciInteractionSpec is the implemen-
tation class for theInteractionSpec interface, and it holds properties
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required by theInteraction object to interact with an EIS instance. (Not
that our example uses a Cloudscape database, which does not require
alog name.)

4. Set values for theCciInteractionSpec instance’s fields. The session bea
uses theCciInteractionSpec methodssetSchema, setCatalog, and
setFunctionName to set the required values into the instance’s fields.O
example passesCOUNTCOFFEE to setFunctionName because this is the
name of the stored procedure it intends to invoke.

5. ThegetCoffeeCount method uses theConnectionFactory to obtain a
reference to aRecordFactory so that it can create anIndexedRecord
instance. We obtain anIndexedRecord (or aMappedRecord or aResult-
Set) using aRecordFactory.

6. Invoke the createIndexedRecord method of RecordFactory. This
method creates a newIndexedRecord using the nameInputRecord,
which is passed to it as an argument.

7. ThegetCoffeeCount method has completed the required set-up work a
it can invoke the stored procedureCOUNTCOFFEE. It does this using the
Interaction instance’sexecute method. Notice that it passes two objec
to theexecute method: theInteractionSpec object, whose properties
reference theCOUNTCOFFEE stored procedure, and theIndexedRecord
object, which the method expects to be an inputRecord. The execute

method returns an outputRecord object.

8. ThegetCoffeeCount method uses anIterator to retrieve the individual
elements from the returnedIndexedRecord. It casts the outputRecord
object to anIndexedRecord. IndexedRecord contains an iterator method
that it inherits fromjava.util.List.

9. Retrieve each element in the returned record object using theitera-

tor.hasNext method. Each extracted element is anObject, and the bean
evaluates whether it is an integer or decimal value and processes it acc
ingly.

10.Close the connection to the database.

Inserting Database Records

TheCoffeeEJB session bean implements theinsertCoffee method to add new
records into theCoffee database table. This method invokes theINSERTCOFFEE

stored procedure, which inserts a record with the values (name andqty) passed
to it as arguments.
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TheinsertCoffee method shown here illustrates how to use the CCI to invok
stored procedure that expects to be passed argument values. This example
the code for theinsertCoffee method and is followed by an explanation.

    public void insertCoffee(String name, int qty) {
        try {
1           Connection con = getCCIConnection();
2           Interaction ix = con.createInteraction();
3           CciInteractionSpec iSpec =
               new CciInteractionSpec();
4           iSpec.setFunctionName(“INSERTCOFFEE”);
            iSpec.setSchema(user);
            iSpec.setCatalog(null);
5           RecordFactory rf = cf.getRecordFactory();
6           IndexedRecord iRec =
               rf.createIndexedRecord(“InputRecord”);
7           boolean flag = iRec.add(name);
            flag = iRec.add(new Integer(qty));
8           ix.execute(iSpec, iRec);
9           closeCCIConnection(con);
        }catch(ResourceException ex) {
            ex.printStackTrace();
        }
    }

1. Establish a connection to the database.

2. Create a newInteraction instance for the connection so that the bean c
execute the database’s stored procedures.

3. Instantiate aCciInteractionSpec object so that the bean can pass th
necessary properties—schema name, catalog name, stored proc
name—to theInteraction object. The CciInteractionSpec class
implements theInteractionSpec interface and it holds properties that th
Interaction object requires to communicate with the database instan

4. Set the required values into the newCciInteractionSpec instance’s
fields, using the instance’ssetSchema, setCatalog, andsetFunction-
Name methods. Our example passesINSERTCOFFEE to setFunctionName

and theuser to setSchema.

5. Obtain a reference to aRecordFactory using theConnectionFactory
objects’sgetRecordFactory method.

6. Invoke theRecordFactory object’screateIndexedRecordmethod to cre-
ate a newIndexedRecord with the nameInputRecord.

7. Use theIndexedRecord add method to set the values for the two elemen
in the new record. Call theadd method once for each element. Our exam
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ple sets the first record element to thename value and the second elemen
to theqty value. Notice thatqty is set to anInteger object when passed
to theadd method. TheCoffeeEJB session bean is now ready to add th
new record to the database.

8. Call theInteraction instance’s execute method to invoke the stored pr
cedureINSERTCOFFEE. Just as we did when invoking theCOUNTCOFFEE
procedure, we pass two objects to the execute method: theInteraction-

Spec object with the correctly set properties for theINSERTCOFFEE stored
procedure and theIndexedRecord object representing an inputRecord.
Theexecute method is not expected to return anything in this case.

9. Close the connection to the database.

Writing a CCI Client
A client application that relies on a CCI resource adapter is very much like
other J2EE client that uses enterprise bean methods. OurCoffeeClient applica-
tion uses the methods of theCoffeeEJB session bean to access theCoffee table
in the underlying database.CoffeeClient invokes theCoffee.getCoffeeCount
method to read theCoffee table records and theCoffee.insertCoffee method
to add records to the table.

CCI Tutorial
This tutorial shows you how to deploy and test the sample CCI black box ada
with the code described in the preceding sections. This code has been pac
into a J2EE application EAR file namedCoffeeApp.ear, which is located in the
j2eetutorial/examples/ears directory. The source code is in
j2eetutorial/examples/src/connector/cci. To compile the source code, go
to thej2eetutorial/examples/src directory and typeant cci.

Deploying the Resource Adapter

1. Use thedeploytool utility to deploy the CCI black box resource adapte
Specify the name of the resource adapter’s RAR file (cciblackbox-

tx.rar), plus the name of the server (localhost).

UNIX:

deploytool -deployConnector \
$J2EE_HOME/lib/connector/cciblackbox-tx.rar localhost

Windows:
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(Note that this command and all subsequent Windows commands mu
entered on a single line.)

deploytool -deployConnector
%J2EE_HOME%\lib\connector\cciblackbox-tx.rar localhost

2. Next, add a connection factory for the deployed CCI adapter. The con
tion factory supplies a data source connection for the adapter.
j2eeadmin to create the connection factory, specifying the adapter’s JN
name plus the server name. Here, we add a connection factory for our
adapter whose JNDI name iseis/CciBlackBoxTx on the serverlocal-
host.

UNIX:

j2eeadmin -addConnectorFactory \
eis/CciBlackBoxTx cciblackbox-tx.rar

Windows:

j2eeadmin -addConnectorFactory
eis/CciBlackBoxTx cciblackbox-tx.rar

3. Verify that the resource adapter has been deployed.

deploytool -listConnectors localhost

Thedeploytool utility displays these lines:

Installed connector(s):
Connector Name: cciblackbox-tx.rar

Installed connection factories:
Connection Factory JNDI name: eis/CciBlackBoxTx

Setting Up the Database

Cloudscape:

1. Create the stored procedure.

a. To compile the stored procedure, go to thej2eetutorial/exam-
ples/src directory and typeant procs. This command will put the
Procs.class file in the j2eetutorial/examples/build/connec-

tor/procs directory.

b. Locate thebin/userconfig.sh (UNIX) or bin\userconfig.bat

(Windows) file in your J2EE SDK installation. Edit the file so that th
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J2EE_CLASSPATH variable points to the directory that contains th
Procs.class file.

c. Restart the Cloudscape server.

d. Go to thej2eetutorial/examples/src directory and typeant cre-

ate-procs-alias. This command creates aliases for the methods
Procs.class. Cloudscape uses method aliases to simulate stored
cedures.

2. To create theCoffee table, go to the j2eetutorial/examples/src directory
and typeant create-coffee-table.

Oracle:

1. Start the database server.

2. Run the j2eetutorial/examples/src/connector/sql/oracle.sql
script, which creates both the stored procedures and theCoffee table.

Browsing the CoffeeApp Application

1. In the GUIdeploytool, open thej2eetutorial/examples/ears/Cof-
feeApp.ear file.

2. Select the Resource Refs tabbed pane of the CoffeeBean componen
note the following:

• The Coded Name ofCCIEIS corresponds to the following line in the
CoffeeEJB.java source code:

cf = (ConnectionFactory) ic.lookup(“java:comp/env/CCIEIS”);

• The JNDI Name ofeis/CciBlackBoxTx matches the name of the con
nection factory you added in step 2 ofDeploying the Resource
Adapter (page 406).

• The User Name and Password fields contain dummy values (XXX), since
this EAR file was tested with a Cloudscape database. For other type
databases, you may be required to insert actual values in these fi
For these databases, you should also insert actual values on the
Entries tabbed pane of the CoffeeBean.

3. Select the JNDI Names tabbed pane of the CoffeeApp. Note that
CCIEIS value in the Reference Name field has been mapped to the eis
BlackBoxTx value in the JNDI Name field.
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Deploying and Running the CoffeeApp Application

1. Deploy the application.

a. In the GUIdeploytool, select Tools->Deploy.

b. In the Introduction dialog box, select Return Client Jar.

2. In a terminal window, go to thej2eetutorial/examples/ears directory.

3. Set theAPPCPATH environment variable to the name of the stub client JA
file: CoffeeAppClient.jar.

4. Run the client.

runclient -client CoffeeApp.ear -name CoffeeClient
-textauth

5. At the login prompts, enterguest as the user name andguest123 as the
password.

6. The client should display the following lines:

Coffee count = 0
Inserting 3 coffee entries...
Coffee count = 3
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The Duke’s Bank
Application

by Stephanie Bodoff, Dale Green
and Monica Pawlan

THIS chapter describes the Duke’s Bank application, an online banking ap
cation with two clients: a J2EE application client used by administrators to m
age customers and accounts; and a web client used by customers to a
account histories and perform transactions. The clients access the cust
account, and transaction information maintained in a database through ente
beans. The Duke’s Bank application demonstrates how all the component
nologies—enterprise beans, application clients, and web components—
sented in this tutorial are put together to provide a simple but functio
application. Figure 38 gives a high-level view of the how the components in
act.

The rest of this chapter looks at each of the component types in detail and
cludes with a discussion of how to build, deploy, and run the application.
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Figure 38 Duke’s Bank Application

Enterprise Beans
Figure 39 takes a closer look at the access paths between the clients, ente
beans, and database tables. As you can see, the end-user clients (web and
application components) may access only the session beans. Within the e
prise bean tier, the session beans are clients of the entity beans. On the bac
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Figure 39 Enterprise Beans in the Duke’s Bank Application

Source Code. The source code for these enterprise beans is in
j2eetutorial/bank/src/com/sun/ebank/ejb subdirectory.

Session Beans
The Duke’s Bank application has three session beans:AccountControllerEJB,
CustomerControllerEJB, andTxControllerEJB. (“Tx” stands for a business
“transaction” such as transferring funds.) These session beans provide a cl
view of the application’s business logic. Hidden from the clients are the ser
side routines that implement the business logic, access databases, manag
tionships, and perform error checking.

AccountControllerEJB

The business methods of theAccountControllerEJB session bean perform
tasks that fall into the following categories.
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Methods that Create and Remove Entity Beans.

• createAccount

• removeAccount

The createAccount and removeAccount methods of theAccountControl-
lerEJB session bean call thecreate andremove methods of theAccountEJB
entity bean. ThecreateAccount andremoveAccount methods throw application
exceptions to indicate invalid method arguments. ThecreateAccount method
throws aIllegalAccountTypeException if the type argument is neitherCheck-
ing, Savings, Credit, nor Money Market. The createAccount method also
verifies that the specified customer exists by invoking thefindByPrimaryKey of
the CustomerEJB entity bean. If the result of this verification is false, thecre-

ateAccount method throws aCustomerNotFoundException.

Methods that Manage the Account-Customer Relationship.

• addCustomerToAccount

• removeCustomerFromAccount

TheAccountEJB andCustomerEJB entity beans have a many-to-many relation
ship. A bank account may be jointly held by more than one customer, and a
tomer may have multiple accounts. Because the entity beans use bean-ma
persistence, there are several ways to manage this relationship. For more
mation, see Mapping Table Relationships For Bean-Managed
Persistence (page 125).

In the Duke’s Bank application, theaddCustomerToAccount and removeCus-

tomerFromAccount methods of the AccountControllerEJB manage the
account-customer relationship. TheaddCustomerToAccount method, for exam-
ple, starts by verifying that the customer exists. To create the relationship
addCustomerToAccount method inserts a row into thecustomer_account_xref
database table. In this cross reference table, each row contains thecustomerId

andaccountId of the related entities. To remove a relationship, theremoveCus-

tomerFromAccount method deletes a row from thecustomer_account_xref
table. If a client calls theremoveAccount method, then all rows for the specified
accountId are removed from thecustomer_account_xref table.

Methods that Get the Account Information.

• getAccountsOfCustomer

• getDetails
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TheAccountControllerEJB session bean has two getter methods. ThegetAc-

countsOfCustomer method returns all of the accounts of a given customer
invoking thefindByCustomer method of theAccountEJB entity bean. Instead of
implementing a getter method for every instance variable, theAccountControl-

lerEJB has agetDetails method that returns an object (AccountDetails) that
encapsulates the entire state of anAccountEJB. Because it can invoke a single
method to retrieve the entire state, the client avoids the overhead associated
multiple remote calls.

CustomerControllerEJB
Because it is theAccountControllerEJB that manages the customer-accou
relationship, theCustomerControllerEJB is the simpler of these two session
beans. A client creates aCustomerEJB entity bean by invoking thecreateCus-
tomer method of theCustomerControllerEJB session bean. To remove a cus
tomer, the client calls theremoveCustomer method, which not only invokes the
remove method of CustomerEJB, but also deletes from the
customer_account_xref table all rows that identify the customer.

TheCustomerControllerEJB has two methods that return multiple customer
getCustomersOfAccount and getCustomersOfLastName. These methods call
the corresponding finder methods—findbyAccountId andfindByLastName—
of CustomerEJB.

TxControllerEJB
TheTxControllerEJB session bean handles bank transactions. In addition to
getter methods,getTxsOfAccount andgetDetails, theTxControllerEJB has
several methods that change the balances of the bank accounts:

• withdraw

• deposit

• makeCharge

• makePayment

• transferFunds

These methods access anAccountEJB entity bean to verify the account type an
to set the new balance. Thewithdraw anddeposit methods are for non-credit
accounts, whereas themakeCharge and makePayment methods are for credit
accounts. If thetype method argument does not match the account, these m
ods throw anIllegalAccountTypeException. If a withdrawal were to result in
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a negative balance, then thewithdraw method throws andInsufficientFund-
sException. If a credit charge attempts to exceed the account’s credit line,
makeCharge method throws anInsufficientCreditException.

The transferFunds method also checks the account type and new balance
necessary, it throws the same exceptions as thewithdraw andmakeCharge meth-
ods. ThetransferFunds method subtracts from the balance of oneAccountEJB

instance and adds the same amount to another instance. Because both o
steps must complete, thetransferFunds method has aRequired transaction
attribute. If either step fails, the entire operation is rolled back and the balan
remain unchanged.

Entity Beans
For each business entity represented in our simple bank, the Duke’s Bank a
cation has a matching entity bean:

• AccountEJB

• CustomerEJB

• TxEJB

The purpose of these beans is to provide an object view of these database t
account, customer, andtx. For each column in a table, the corresponding ent
bean has an instance variable. Because they use bean-managed persisten
entity beans contain the SQL statements that access the tables. For examp
create method of theCustomerEJB entity bean calls the SQLinsert command.

Unlike the session beans, the entity beans do not validate method param
(except for the primary key parameter ofejbCreate). During the design phase,
we decided that the session beans would check the parameters and thro
application exceptions, such asCustomerNotInAccountException andIllega-
lAccountTypeException. Consequently, if some other application were
include these entity beans, its session beans would also have to validat
method parameters.

Helper Classes
The EJB JAR files include several helper classes that are used by the ente
beans. The source code for these classes is in
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j2eetutorial/bank/src/com/sun/ebank/util subdirectory. The following
table briefly describes the helper classes.

Database Tables
A database table of the Duke’s Bank application may be categorized by its
pose:

• Representing business entities

• Holding the next primary key

Table 44 Helper Classes for the Application’s Enterprise Beans

Class Name Description

AccountDetails
Encapsulates the state of anAccountEJB instance. Returned by the
getDetails methods ofAccountControllerEJB and
AccountEJB.

CodedNames
Defines the strings that are the logical names in the calls of the looku
method. (For example:java:comp/env/ejb/account) TheEJB-
Getter class references these strings.

CustomerDetails
Encapsulates the state of anCustomerEJB instance. Returned by the
getDetails methods ofCustomerControllerEJB andCustomerEJB.

DBHelper
Provides methods that generate the next primary keys. (For example
getNextAccountId).

Debug
Has simple methods for printing a debugging message from an enter
prise bean. These messages appear on the stdout of the J2EE serve
it’s run with the-verbose option.

DomainUtil
Contains validation methods:
getAccountTypes, checkAccountType, isCreditAccount.

EJBGetter
Has methods that locate (by invoking lookup) and return home inter-
faces. (For example:getAccountControllerHome)

TxDetails
Encapsulates the state of anTxEJB instance. Returned by thegetDe-
tails methods ofTxControllerEJB andTxEJB.
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Tables Representing Business Entities

Figure 40 shows relationships between the database tables. Thecustomer and
account tables have a many-to-many relationship: A customer may have sev
bank accounts and each account may be owned by more than one custome
many-to-many relationship is implemented by the cross reference table na
customer_account_xref. Theaccount andtx tables have a one-to-many rela
tionship: A bank account may have many transactions, but each transa
refers to a single account.

Figure 40 makes use of several abbreviations. PK stands for “primary key,”
value that uniquely identifies a row in a table. FK is an abbreviation for “forei
key,” which is the primary key of the related table. Tx is short for “transactio
such as a deposit or withdrawal.

Figure 40 Database Tables in the Duke’s Bank Application

Tables that Hold the Next Primary Key

These tables have the following names:

• next_account_id

• next_customer_id

• next_tx_id

Customer_Account_Xref

customer_id (FK) 
account_id (FK)

account_id (PK) 
type 
description 
balance 
credit_line 
begin_balance 
begin_balance_ 
  time_stamp

AccountCustomer

customer_id (PK) 
last_name 
first_name 
middle_initial 
street 
city 
state 
zip 
phone 
email

tx_id (PK) 
account_id (FK) 
time_stamp 
amount 
balance 
description

Tx

1

1 1

N

NN
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Each of these tables has a single column namedid. The value of theid is the
next primary key that is passed to thecreate method of an entity bean. For
example, before it creates a newAccountEJB entity bean, theAccountControl-
lerEJB session bean must obtain a unique key by invoking thegetNextAccoun-

tId method of theDBHelper class. ThegetNextAccountId method reads theid
from thenext_account_id table, increments theid value in the table, and then
returns theid.

Securing the Enterprise Beans
In the J2EE platform, you can protect an enterprise bean by specifying the s
rity roles that can access its methods (seeEJB-Tier Security (page 360)). In the
Duke’s Bank application, two roles are defined—BankCustomer and BankAd-

min—because two categories of operations are defined by the enterprise be

A user in theBankAdmin role is allowed to perform administrative functions
such as creating or removing an account, adding a customer to or removi
customer from an account, setting a credit line, setting an initial balance, et
user in theBankCustomer role is allowed to deposit, withdraw, transfer funds
make charges and payments, list transactions that have occurred in the acc
etc. Notice that there is no overlap in functions that users in either role can
form.

Access to these functions was restricted to the appropriate role by setting me
permissions on selected methods of theCustomerControllerEJB, AccountCon-
trollerEJB, andTxControllerEJB enterprise beans. For example, by allowin
users in theBankAdmin role only to access the createAccount method in t
AccountControllerEJB enterprise bean, you have denied users in the BankC
tomer role or any other role permission to create bank accounts. To see
method permissions that have been set, start the deploytool utility and locat
CustomerControllerEJB, AccountControllerEJB, and TxControllerEJB

enterprise beans in the tree view. Then select the Security tabbed pane and
ine the method permissions that have been set for each bean’s methods.

Application Client
Sometimes, enterprise applications use a standalone client application for
dling tasks such as system or application administration. For example,
Duke’s Bank application uses an application client to manually administer c
tomers and accounts. This capability is useful in the event the site becomes
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A J2EE application client is a standalone program launched from the comm
line or desktop, and accesses enterprise beans running on the J2EE appli
server.

The application client shown in Figure 41 handles basic customer and acc
administration for the banking application through a Swing user interface.

Figure 41 Application Client

The bank administrator can perform any of the following functions by maki
menu selections.

Customer administration:

• View customer information

• Add a new customer to the database

• Update customer information

• Find customer ID

Account administration:

• Create a new account

• Add a new customer to an existing account

• View account information

• Remove an account from the database
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Error and informational messages appear in the left panel underApplication

Message Watch: and data is entered and displayed in the right panel.

The Classes and their Relationships
The J2EE application client is divided into the following three classes. Th
relationship is depicted in Figure 42.

• BankAdmin builds the initial user interface, creates theEventHandle
object, and provides methods for theEventHandle andDataModel objects
to call to update the user interface.

• EventHandle listens for button clicks by the user, takes action based
which button the user clicks, creates theDataModel object, calls methods
in theDataModel object to write data to and read data from the underlyin
database, and calls methods in theBankAdmin object to update the user
interface when actions complete.

• DataModel retrieves data from the user interface, performs data chec
writes valid data to and reads stored data from the underlying database
calls methods in theBankAdmin object to update the user interface base
on the success of the database read or write operation.
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Figure 42 Relationships among Classes

BankAdmin Class
TheBankAdmin class, which creates the user interface, is the class with themain

method, and providesprotected methods for the otherBankAdmin application
classes to call.

Main Method

Themain method creates instances of theBankAdmin andEventHandle classes.
The application client is internationalized and so thecurrentLocale an variable
passed to theBankAdmin constructor contains the language and country codes
the Java virtual machine. In the event the Java virtual machine is localized
United States English, the language code isen, meaning English and the coun
try code isUS, meaning United States. In other words, mean the Java virt
machine is localized for United States English as opposed to Australian
United Kingdom English.

BankAdmin 
 

Creates user interface 
Creates DataModel and EventHandle 
Provides methods to update user interface: 
    Clears display 
    Creates customer information labels 
    Creates read-only fields to view data 
    Creates editable fields to add or update data

DataModel 
 

Retrieves user interface data 
Checks user interface data 
Reads data from and writes 
  data to DB 
Calls BankApp methods

Database

EventHandle 
 

Responds to button presses 
Calls DataModel methods 
Calls BankApp methods 

../bank/src/com/sun/ebank/appclient/BankAdmin.java
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Themain method lets you display the application client in another language.
you have to do is add a properties file to the application with the translations
the language you want to use, update and redeploy the application, and invo
with the appropriate language and country codes. For example, the applic
client is distributed with a resource bundle namedAdminMessages_es.proper-

ties that contains Spanish translations. To use this bundle, invoke the app
tion like this:

runclient -client BankApp.ear -name BankAdmin es

SeeRunningthe J2EEApplication Client (page 448) above for more informa
tion on therunclient command, andInternationalization (page 425) for more
information on internationalization.

public static void main(String args[]) {
String language, country;
if(args.length == 1) {

language = new String(args[0]);
currentLocale = new Locale(language, "");

} else if(args.length == 2) {
language = new String(args[0]);
country = new String(args[1]);
currentLocale = new Locale(language, country);

} else
currentLocale = Locale.getDefault();

frame = new BankAdmin(currentLocale);
frame.setTitle(messages.getString("CustAndAccountAdmin"));
WindowListener l = new WindowAdapter() {

public void windowClosing(WindowEvent e) {
System.exit(0);

}
};
frame.addWindowListener(l);
frame.pack();
frame.setVisible(true);
ehandle = new EventHandle(frame, messages);
System.exit(0);
}

}

Constructor

TheBankAdmin constructor creates the initial user interface, which consists o
menu bar and two panels. The menu bar contains the customer and ac
menus, the left panel contains a message area, and the right panel is a da
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play or update area. The internationalization code creates aResourceBundle

from thecurrentLocale.

//Constructor
public BankAdmin(Locale currentLocale) {

//Internationalization setup
messages = ResourceBundle.getBundle("AdminMessages",
currentLocale);

Internationalization

In an internationalized program, strings are read from a properties file that
tains translations for the language in use in the form of key and value pairs.
instead of creating strings directly in your code, you create aResourceBundle

that indicates the file where the translations are, and read the translations
ues) from that file using the corresponding key. To give you an idea how the
and value pairs are constructed in the properties file, here are the first few
from theMessagesBundle.properties file for the example.

ViewCust=View Customer Information
CreateCust=Create New Customer
UpdateCust=Update Customer Information

Instead of creating the View Customer Information menu item in your code
this:

view = new JButton(“View Customer Information”)

You do it like this:

view = new JButton(messages.getString(“ViewCust”))

In this example,ViewCust is the key in theAdminMessages.properties file
with a corresponding value ofView Customer Information. This approach
makes it easy to localize application text to the language spoken by the maj
of its users.
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Class Methods

TheBankAdmin class provides methods that other objects call when they nee
update the user interface. These methods are as follows:

• clearMessages clears the application messages that appear in the
panel

• resetPanelTwo resets the right panel when the user selects OK to sig
the end of a data view or update operation.

• createPanelTwoActLabels creates labels for account fields whe
account information is either viewed or updated.

• createActFields creates account fields when account information
either viewed or updated.

• createPanelTwoCustLabels creates labels for customer fields when cu
tomer information is either viewed or updated.

• createCustFields creates customer fields when account information
either viewed or updated.

• addCustToActFields creates labels and fields for when an add custom
to account operation is invoked.

• makeRadioButtons makes radio buttons for selecting the account ty
when a new account is created.

• getDescription makes the radio button labels that describe each av
able account type.

EventHandle Class
The EventHandle class implements theActionListener interface, which pro-
vides a method interface for handling action events. Like all other interface
the Java programming language,ActionListener defines a set of methods, bu
does not implement their behavior. Instead, you provide the implementat
because they take application-specific actions.

Constructor

The constructor receives an instance of theResourceBundle and BankAdmin

classes and assigns them to its private instance variable so theEventHandle

object has access to the application client’s localized text and can update the

../bank/src/com/sun/ebank/appclient/EventHandle.java
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interface as needed. Lastly, the constructor calls thehookupEvents method to
create the inner classes to listen for and handle action events.

public EventHandle(BankAdmin frame, ResourceBundle messages) {
 this.frame = frame;
 this.messages = messages;
 this.dataModel = new DataModel(frame, messages);
 //Hook up action events
 hookupEvents();

}

actionPerformed Method

The ActionListener interface has only one method, theactionPerformed
method. This method handles action events generated by theBankAdmin user
interface when users create a new account. Specifically, it sets the acc
description when a bank administrator selects an account type radio button
sets the current balance to the beginning balance for new accounts when a
administrator presses the Return key in the beginning balance field.

hookupEvents Method

The EventHandle class uses inner classes to handle menu and button p
events. An inner class is a class nested or defined inside another class. U
inner classes in this way modularizes the code making it easier to read and m
tain. EventHandle inner classes manage the following application client ope
tions:

• View Customer Information

• Create New Customer

• Update Customer Information

• Find Customer ID by Last Name

• View Account Information

• Create New Account

• Add Customer to Account

• Remove Account

• Clear data on cancel button press

• Process data on OK button press
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DataModel Class
TheDataModel class provides methods for reading data from the database, w
ing data to the database, retrieving data from the user interface, and chec
that data before it is written to the database.

Constructor

The constructor receives an instance of theBankAdmin class and assigns it to its
private instance variable so theDataModel object can display error messages i
the user interface when itscheckActData, checkCustData, or writeData

method detects errors. It also receives an instance of theResourceBundle class
and assigns it to its private instance variable so theDataModel object has access
to the application client’s localized text.

Because theDataModel class interacts with the database, the constructor also
the code to establish connections with the remote interfaces for theCustomer-

Controller andAccountController enterprise beans, and to use their remo
interfaces to create an instance of theCustomerController andAccountCon-
troller enterprise beans.

//Constructor
public DataModel(BankAdmin frame, ResourceBundle messages) {

this.frame = frame;
this.messages = messages;

//Look up and create CustomerController bean
 try {

CustomerControllerHome customerControllerHome =
EJBGetter.
getCustomerControllerHome();

customer = customerControllerHome.create();
 } catch (Exception NamingException) {

NamingException.printStackTrace();
 }

//Look up and create AccountController bean
 try {

AccountControllerHome accountControllerHome =
EJBGetter.getAccountControllerHome();

account = accountControllerHome.create();
 } catch (Exception NamingException) {

NamingException.printStackTrace();
 }

}

../bank/src/com/sun/ebank/appclient/DataModel.java


APPLICATION CLIENT 429

ses
and

mid-
two

ction

and

lds
Methods

The getData method retrieves data from the user interface text fields and u
theString.trim method to remove extra control characters such as spaces
returns. Its one parameter is aJTextfield so any instance of theJTextfield
class can be passed in for processing.

private String getData(JTextField component) {
 String text, trimmed;
 if(component.getText().length() > 0) {

text = component.getText();
trimmed = text.trim();
return trimmed;

 } else {
text = null;
return text;

 }
}

The checkCustData method stores customer data retrieved by thegetData

method, but first checks the data to be sure all required fields have data, the
dle initial is no longer than one character, and the state is no longer than
characters. If everything checks out, thewriteData method is called. If there are
errors, they are printed to the user interface in theBankAdmin object. Thecheck-
ActData method uses a similar model to check and store account data.

ThecreateCustInf andcreateActInf methods are called by theEventHandle
class to refresh the Panel 2 display in the event of a view, update, or add a
event.

• Create Customer Information

• For a view or update event, thecreateCustInf method gets the cus-
tomer information for the specified customer from the database
passes it to thecreateCustFields method in theBankAdmin class. A
Boolean variable is used to determine whether thecreateCustFields

method should create read-only fields for a view event or writable fie
for an update event.

• For create event, thecreateCustInf method calls thecreateCust-
Fields method in theBankAdmin class with null data and a Boolean
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variable to create empty editable fields for the user to enter custo
data.

• Create Account Information

• For a view or update event, thecreateActInf method gets the accoun
information for the specified account from the database and passes
thecreateActFields method in theBankAdmin class. A Boolean vari-
able is used to determine whether thecreateActFields method should
create read-only fields for a view event or writable fields for an upd
event.

• For a create event, thecreateActInf method calls thecreateAct-
Fields method in theBankAdmin class with null data and a Boolean
variable to create empty editable fields for the user to enter custo
data.

• Adding a customer to an account or removing an account events ope
directly on the database without creating any user interface compone

Web Client
The web client is used by customers to access account information and per
operations on accounts. Table 45 lists the functions the client supports, the U
used to access the functions, and the components that implement the funct

Table 45 Web Client

Function URL Aliases JSP Pages
JavaBeans
Component

Home page /main main.jsp

Log on/off the
application

/logon
/logonError
/logoff

logon.jsp
logonError.jsp
logoff.jsp

List account /accountList accountList.jsp

List the history of
an account

/accountHist accountHist.jsp
AccountHistory-
Bean

Transfer funds
between accounts

/transferFunds
/transferAck
/transferError

transferFunds.jsp
transferAck.jsp
transferError.jsp

TransferBean
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Figure 43 shows an example account history screen.

Figure 43 Account History

Withdraw and
deposit funds

/atm
/atmAck

atm.jsp
atmAck.jsp

ATMBean

Table 45 Web Client (Continued)

Function URL Aliases JSP Pages
JavaBeans
Component
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Design Strategies
The main job of the JSP pages in the Duke’s Bank application is presentatio
strategy for developing maintainable JSP pages is to minimize the amoun
scripting embedded in the pages. In order to achieve this, most dynamic pro
ing tasks are delegated to enterprise beans, custom tags, and JavaBeans c
nents.

In the Duke’s Bank application, the JSP pages use enterprise beans to h
interactions with the database. In addition, the JSP pages rely heavily on J
Beans components for interactions with the enterprise beans. In the Du
Bookstore application presented in the chapters on web components, theBookDB

JavaBeans component acted as a front end to a database or a facade to the
face provided by an enterprise bean. In the Duke’s Bank application,Transfer-

Bean plays the same role. However, the other JavaBeans components have
richer functionality.ATMBean invokes enterprise bean methods and sets ackno
edgement strings according to customer input andAccountHistoryBean mas-
sages the data returned from the enterprise beans in order to present the v
the data required by the customer.

The web client uses a template mechanism implemented by custom tags
cussed inA TemplateTag Library (page 328)) to maintain a common loo
across all the JSP pages. The template mechanism consists of three comp

• template.jsp determines the structure of each screen. It uses theinsert

tag to compose a screen from subcomponents.

• screendefinitions.jsp defines the subcomponents used by each scre
All screens have the same banner, but different title and body con
(specified by the JSP Pages column in Table 45).

• Dispatcher, a servlet, processes requests and forwards totemplate.jsp.

Finally, the web client uses three logic tags—iterate, equal, andnotEqual—
from the Struts tag library discussed inThe ExampleJSPPages (page 300) to
perform flow control.

Web Client Life Cycle

Initializing the Client Components

Responsibility for managing the enterprise beans used by the web client
with the BeanManager class. It creates customer, account, and transaction c
troller enterprise beans and provides methods for retrieving the beans.

../bank/src/com/sun/ebank/web/TransferBean.java
../bank/src/com/sun/ebank/web/TransferBean.java
../bank/src/com/sun/ebank/web/ATMBean.java
../bank/src/com/sun/ebank/web/AccountHistoryBean.java
../bank/src/web/template.txt
../bank/src/web/screendefinitions.txt
../bank/src/com/sun/ebank/web/Dispatcher.java
../bank/src/com/sun/ebank/web/BeanManager.java
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When instantiated,BeanManager retrieves the home interface for each bean fro
the helper classEJBGetter and creates an instance by calling thecreate method
of the home interface. Because this is an application-level function,BeanMan-

ager itself is created and stored as an context attribute by aContextListener

(seeHandlingServletLife CycleEvents (page 236)) when the client is first ini
tialized.

public class BeanManager {
private CustomerController custctl;
private AccountController acctctl;
private TxController txctl;
public BeanManager() {

if (custctl == null) {
try {

CustomerControllerHome home =
EJBGetter.getCustomerControllerHome();

custctl = home.create();
} catch (RemoteException ex) {

System.out.println("...”);
} catch (CreateException ex) {

System.out.println();
} catch (NamingException ex) {

System.out.println();
}

}
public CustomerController getCustomerController() {

return custctl;
}
...

}

public final class ContextListener
implements ServletContextListener {
private ServletContext context = null;
...
public void contextInitialized(ServletContextEvent event) {

this.context = event.getServletContext();
context.setAttribute("beanManager", new

BeanManager());
context.log("contextInitialized()");

}
...

}

../bank/src/com/sun/ebank/util/EJBGetter.java
../bank/src/com/sun/ebank/web/ContextListener.java


434 THE DUKE’S BANK APPLICATION
Request Processing

All requests for the URLs listed in Table 45 are mapped to thedispatcher web
component, which is implemented by theDispatcher servlet:

public class Dispatcher extends HttpServlet {
public void doPost(HttpServletRequest request,

HttpServletResponse response) {
...
String selectedScreen = request.getServletPath();

request.setAttribute("selectedScreen", selectedScreen);
BeanManager beanManager = getServletContext().getAttribute(

"beanManager");
...
if (selectedScreen.equals("/accountHist")) {

...
} else if (selectedScreen.equals("/transferAck")) {

String fromAccountId =
request.getParameter("fromAccountId");

String toAccountId =
request.getParameter("toAccountId");

if ( (fromAccountId == null) || (toAccountId == null) ){
request.setAttribute(

"selectedScreen", "/transferError");
} else {

TransferBean transferBean = new TransferBean();
request.setAttribute("transferBean",

transferBean);
transferBean.setFromAccountId(fromAccountId);
transferBean.setToAccountId(toAccountId);
try {

transferBean.
setTransferAmount((Double.valueOf(

request.getParameter("transferAmount"))).
doubleValue());

} catch (NumberFormatException e) {
}
transferBean.setBeanManager(beanManager);
transferBean.populate();

}
...
try {
request.getRequestDispatcher("/template.jsp").

forward(request, response);
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} catch(Exception e) {
}

}
}

When a request is delivered toDispatcher it:

1. Retrieves and saves the incoming request URL in the request attri
selectedScreen. This is because the URL will be modified when th
request is later forwarded to the application’s template page.

2. Creates a JavaBeans component and store the bean as a request at

3. Parses and validate the request parameters. If a parameter is invalid,Dis-

patcher may reset the request alias to an error page. Otherwise it init
izes the JavaBeans component.

4. Calls thepopulate method of the JavaBeans component. This meth
retrieves data from the enterprise beans and processes the data acc
to options specified by the customer.

5. Forwards the request totemplate.jsp.

As mentioned earlier,template.jsp generates the response by including th
responses from subcomponents. If the request is a GET, the body subcomp
usually retrieves data from the enterprise bean directly; otherwise it retrie
data from the JavaBeans component initialized byDispatcher.
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Figure 44 summarizes the interaction between these components:

Figure 44 Web Component Interaction

Securing the Web Client
In the J2EE platform, a web component is protected from anonymous acces
specifying which security roles can access the component (seeControlling
Accessto Web Resources (page 357)). This is known as an authorization c
straint. The web container guarantees that only certain users can access the
ponent. In order for the web container to enforce the authorization constraint
application must also specify a means for users to identify themselves (desc
in AuthenticatingUsers (page 358)) and the web container must support m
ping a role to a user.

In the Duke’s Bank web client, all of the URLs listed in Table 45 are restricted
the security roleBankCustomer. The application requires users to identify them
selves via the form-based login mechanism. When a customer tries to acc
web client URL, and has not been authenticated, the web container display
form-based login URL/logon, which is mapped to the JSP pagelogon.jsp.
This page contains a form that requires a customer to enter an identifier
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password. The web container retrieves this information, maps it to a secu
role, and verifies that the role matches that specified in the authorization
straint. Note that in order for the web container to check the validity of t
authentication information, and perform the mapping, you must perform th
two steps when you deploy the application:

• Add the customer’s group, ID, and password to the default realm of
container (seeJ2EE Users, Realms, and Groups (page 368)).

• Map theBankCustomer role to the customeror customer’s group (see
Mapping Roles to J2EE Users and Groups (page 361)).

Once the customer has been authenticated, the identifier provided by the
tomer is used as a key to identify the customer’s accounts. The identifie
retrieved from the request as follows:

<% ArrayList accounts =
beanManager.getAccountController().getAccountsOfCustomer(

request.getUserPrincipal().getName()); %>

Internationalization
Like the application client, the web client uses resource bundles to map dis
keys to locale-specific strings.Dispatcher retrieves the locale (set by a browse
language preference) from the request and then opens the appropriate res
bundle:

ResourceBundle messages = (ResourceBundle)session.
getAttribute("messages");
if (messages == null) {

Locale locale=request.getLocale();
messages = ResourceBundle.getBundle("WebMessages",

locale);
session.setAttribute("messages", messages);

}

Each JSP page first retrieves the resource bundle from the session:

<% ResourceBundle messages =
(ResourceBundle)session.getAttribute("messages"); %>
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and then looks up any string that it needs in the bundle. For example, here is
accountHist.jsp generates the headings for the transactions table:

<td><b><%=messages.getString("TxDate")%></b></td>
<td><b><%=messages.getString("TxDescription")%></b></td>
<td><b><%=messages.getString("TxAmount")%></b></td>
<td><b><%=messages.getString("TxRunningBalance")%></b></td>

Building, Deploying, and Running the
Application

To build the Duke’s Bank application, you must have downloaded and unzip
the tutorial bundle as described inDownloadingtheExamples (page xxii). When
you install the bundle, the Duke’s Bank application files are placed in the follo
ing directory structure of thej2eetutorial directory:

/bank
/dd - deployment descriptors

account-ejb.xml
app-client.xml
customer-ejb.xml
runtime-ac.xml
runtime-app.xml
tx-ejb.xml
web.xml

/src
/com - component classes

/sun/ebank/appclient
/sun/ebank/ejb
/sun/ebank/web

/web - JSP pages, images
/sql - database scripts

create-table.sql
insert.sql

To simplify the packaging and deployment of the Duke’s Bank application,
tutorial bundle includes deployment descriptors, source code, and abuild.xml

file that contains the automatedant tasks. If you haven’t runant yet, please see
How to Build and Run the Examples (page xxiii).

After you compile the source code, the resulting class files will reside in
j2eetutorial/bank/build subdirectory. When you package the componen

../bank/src/web/accountHist.txt
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and the application, the resulting archive files are placed in
j2eetutorial/bank/jar subdirectory.

Adding Groups and Users to the Realm
In order to run the application and web clients you must add groups and use
the default security realm. To create theCustomer andAdmin groups, add the
user200 to theCustomer group, and add the useradmin to theAdmin group in
deploytool:

1. Select Tools->Server Configuration

2. In the tree, select the Users node.

3. Make sure that Default is selected in the Realm combo box.

4. Click Add User.

5. Click Edit Groups.

6. Click Add.

7. EnterCustomer.

8. Click Add.

9. EnterAdmin.

10.Click OK.

11.Enter200 for User Name: andj2ee for Password:

12.Select theCustomer group from the Available Groups list.

13.Click Add.

14.Click Apply.

15.Enteradmin for User Name andj2ee for Password.

16.Select the Admin Group from the Available Groups list.

17.Click Add.

18.Click OK.

You can also use therealmtool command line utility:

1.realmtool -addGroup Customer

2. realmtool -add 200 j2ee Customer

3. realmtool -addGroup Admin
4.realmtool -add admin j2ee Admin
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Starting the J2EE Server, Deploy Tool, and Database

J2EE Server

1. If the J2EE server is running, stop it:

j2ee -stop

2. Restart the server:

j2ee -verbose

Deploytool

After the J2EE server reports “startup complete,” run thedeploytool:

1. If thedeploytool is already running, reconnect to the J2EE server:

a. File->Add Server

b. In the Add Server dialog box, enterlocalhost in the Server Name field.

c. Click OK.

2. If thedeploytool is not running, launch it from the command line:

deploytool

Cloudscape

Start the Cloudscape database server:

cloudscape -start

Compiling the Enterprise Beans
In a different window, go to thej2eetutorial/bank subdirectory of the tutorial
distribution and execute

ant compile-ejb

Packaging the Enterprise Beans
To package the enterprise beans execute

ant package-ejb
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This command packages the class files and the deployment descriptors into
EJB JAR file:

account-ejb.jar
customer-ejb.jar
tx-ejb.jar

The JAR files are in the j2eetutorial/bank/jar subdirectory.

(When packaging a component in this chapter, ant may report that it cannot
a file (such asaccount-ejb.jar) to delete. You may ignore these messages.)

Compiling the Web Client
To compile the web client, go to thej2eetutorial/bank directory of the tuto-
rial distribution and execute

ant compile-web

Packaging the Web Client
The web client uses the Struts tag library discussed inThe Example JSP
Pages (page 300). Before you can package the web client you must down
and install Struts version 1.0 from

http://jakarta.apache.org/builds/jakarta-struts/release/v1.0/

Copy struts-logic.tld andstruts.jar from jakarta-struts-1.0/lib to
j2eetutorial/bank/jar. Then change to thej2eetutorial/bank directory
and execute

ant package-web

This command packages the servlet class, JSP pages, JavaBeans com
classes, tag libraries and the web application deployment descriptor intoweb-

client.war and puts this file inj2eetutorial/bank/jar.

Compiling the J2EE Application Client
To compile the application client, go to thej2eetutorial/bank subdirectory
and execute

ant compile-ac

http://jakarta.apache.org/builds/jakarta-struts/release/v1.0
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Packaging the J2EE Application Client
From thej2eetutorial/bank directory, execute these commands:

1. ant package-ac. This command createsapp-client.jar in
j2eetutorial/bank/jar.

2. ant setruntime-ac. This command adds a runtime deployment descr
tor (j2eetutorial/bank/dd/runtime-ac.xml) to app-client.jar.

Packaging the EAR
You create the Duke’s Bank enterprise archive file by going to t
j2eetutorial/bank directory and running the following commands:

1. ant assemble-app. This command createsDukesBankApp.ear in
j2eetutorial/bank/jar.

2. ant setruntime-app. This command adds a runtime deployment descr
tor (j2eetutorial/bank/dd/runtime-app.xml) to DukesBankApp.ear.

Opening the EAR
In deploytool, open the EAR as follows:

1. Select File ->Open.

2. Go to thej2eetutorial/bank/jar subdirectory.

3. SelectDukesBankApp.ear.

4. Click Open Object.
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You should see the following in deploytool:

Figure 45 Duke’s Bank Application Archives and Components
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Reviewing JNDI Names
With DukesBankApp selected, click the JNDI Names tab. The JNDI Name co
umn is shown in Figure 46. The order may be a little different on your own d
play. An explanation of these mappings immediately follows.

Figure 46 JNDI Names
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A JNDI name is the name the J2EE server uses to look up enterprise bean
resources. When you look up an enterprise bean, you supply statements s
to those shown below. The actual lookup takes place three lines down wher
getCustomerControllerHome method of com.sun.ebank.utilEJBGetter is
called. EJBGetter is a utility class that retrieves a coded JNDI name fro
com.sun.ebank.util.CodedNames.

In this example, the application client is looking up the coded name for theCus-

tomerController remote interface:

try {
customerControllerHome =

EJBGetter.getCustomerControllerHome();
customer = customerControllerHome.create();

} catch (Exception NamingException) {
NamingException.printStackTrace();

}

public static CustomerHome getCustomerHome() throws
NamingException {

InitialContext initial = new InitialContext();
Object objref = initial.lookup(

CodedNames.CUSTOMER_EJBHOME);

BankAdmin (the display name for the main class for the application client) ref
encesejb/customerController, which is the coded name defined inCoded-
Names for theCustomerController remote interface.

The JNDI name is stored in the J2EE application deployment descriptor and
J2EE server uses it to look up theCustomerControllerEJB. In Figure 46 you
see thatCustomerControllerEJB is mapped to the same JNDI name as
ejb/customerController. It does not matter what the JNDI name is, as long
it is the same name for the remote interface lookup as you use for its corresp
ing bean. So, looking at the table, you can say that the application cl
(BankAdmin) looks up theCustomerController remote interface, which uses
the JNDI name ofMyCustomerController, and the J2EE server uses theMyCus-

tomerController JNDI name to find the correspondingCustomerControl-
lerEJB object.

The other rows in the table have the mappings for the other enterprise bean
of these beans are stored in the JAR files you added to the J2EE application
ing assembly. Their implementations have coded names for looking up e
other enterprise beans or the database driver.
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The JNDI name for the database driver isjdbc/Cloudscape. This name is the
default coded name supplied in a configuration file of your J2EE SDK insta
tion. For more information, see theConfiguration Guide of the J2EE SDK.

Mapping the Security Roles to Groups
To map theBankAdmin role to theAdmin group and theBankCustomer role to the
Customer group:

1. In deploytool, select DukesBankApp.

2. In the Security tabbed pane, select theBankAdmin role from the Role Name
list.

3. Click Add.

4. In the Users dialog box, select theAdmin group in the Group Name list.

5. Click OK.

6. In the Security tabbed pane, select theBankCustomer role from the Role
Name list.

7. Click Add.

8. In the Users dialog box, select theCustomer group in the Group Name list.

9. Click OK.

10.From the main menu, select File->Save.

Figure 47 shows theBankCustomer role selected and theCustomer group to
which it is mapped.
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Figure 47 BankCustomer Role Mapped to Customer Group

Deploying the J2EE Application
To deploy the application:

1. Select the DukesBankApp application.

2. Select Tools->Deploy.

3. Select the checkbox labeled Return Client Jar. By default, the directory
the returned jar file is the that same as where the EAR file is stored.
default name of the client JAR file is the application name withCli-

ent.jar appended:DukesBankAppClient.jar.

4. Click Finish.

Creating the Bank Database
You have to create and enter data into the appropriate tables so that the ente
beans have something to read from and write to the database. To create and
ulate the database tables, in a terminal window go to thej2eetutorial/bank

directory and type the following commands:

1. ant db-create-table
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2. ant db-insert

Running the J2EE Application Client
To launch and test the application client:

1. In a terminal window, go toj2eetutorial/bank/jar.

2. Set theAPPCPATH environment variable toDukesBankAppClient.jar.

3. To run the English version of the client, execute the following comma

runclient -client DukesBankApp.ear -name BankAdmin

4. To run the Spanish version, include thees language code:

runclient -client DukesBankApp.ear -name BankAdmin es

TheDukesBankApp.ear parameter is the name of the J2EE application EA
file, and theBankAdmin parameter is the display name of the application c
ent.

5. At the login prompts, type inadmin for the user name andj2ee for the
password. The next thing you should see is the application shown in Fig
48.

Figure 48 BankAdmin J2EE Application Client



BUILDING , DEPLOYING, AND RUNNING THE APPLICATION449

ser,
i-

or
tory

n
ate
Running the Web Client
To run the web client:

1. Open the bank URLhttp://<host>:8000/bank/main in a web browser.
If your J2EE server is running on the same host as your web brow
replace<host> with localhost. To see the Spanish version of the appl
cation, set your browser language preference to any Spanish dialect.

2. The application will display the login page. Enter200 for the customer ID
andj2ee for the password. Click Submit.

3. Select an application function: Account List, Transfer Funds, ATM,
Logoff. Once you have a list of accounts, you can get an account his
by selecting an account link.

Note: The first time you select a new page, particularly a complicated page like a
account history, it takes some time to display because the J2EE server must transl
the page into a servlet class and compile and load the class.

If you select Account List, you will see the screen shown in Figure 49.

Figure 49 Account List
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HTTP Overview
by Stephanie Bodoff

Most web-based J2EE clients use the HTTP protocol to communicate wi
J2EE server. HTTP defines the requests that a client can send to a serve
responses that the server can send in reply. Each request contains a URL,
is a string that identifies a web component or a static object such as an HT
page or image file.

The J2EE server converts an HTTP request to an HTTP request object and d
ers it to the web component identified by the request URL. The web compo
fills in an HTTP response object, which the server converts to an HTTP resp
and sends to the client.

This appendix provides some introductory material on the HTTP protocol.
further information on this protocol, see the Internet RFCs: HTTP/1.0 - R
1945, HTTP/1.1 - RFC 2616, which can be downloaded from

http://www.rfc-editor.org/rfc.html

HTTP Requests
An HTTP request consists of a request method, a request URL, header fi
and a body. HTTP 1.1 defines the following request methods:

• GET - retrieves the resource identified by the request URL.

• HEAD - returns the headers identified by the request URL.

• POST - sends data of unlimited length to the web server.

• PUT - stores a resource under the request URL.

• DELETE - removes the resource identified by the request URL.
451

ftp://ftp.isi.edu/in-notes/rfc1945.txt
ftp://ftp.isi.edu/in-notes/rfc1945.txt
http://www.rfc-editor.org/rfc.html
ftp://ftp.isi.edu/in-notes/rfc2616.txt
Bios.html
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• OPTIONS - returns the HTTP methods the server supports.

• TRACE - returns the header fields sent with the TRACE request.

HTTP 1.0 includes only the GET, HEAD, and POST methods. Although J2
servers are only required to support HTTP 1.0, in practice many servers, inc
ing the J2EE SDK, support HTTP 1.1.

HTTP Responses
An HTTP response contains a result code, header fields, and a body.

The HTTP protocol expects the result code and all header fields to be retu
before any body content.

Some commonly used status codes include:

• 404 - indicates that the requested resource is not available.

• 401 - indicates that the request requires HTTP authentication.

• 500 - indicates an error inside the HTTP server which prevented it fr
fulfilling the request.

• 503 - indicates that the HTTP server is temporarily overloaded, and un
to handle the request.
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J2EE Administration Tool
The j2eeadmin tool is a command-line script that enables you to add a
remove these resources: JDBC™ drivers and data sources, JMS destination
connection factories, and resource adapter connection factories.

Table 46 j2eeadmintool Options

Option Description

-addConnectorFactory
<jndi-name>
[<app-name>:]
<rar-filename>
[<xa-user-name>
<xa-password>]
[-props (<name>=<value>)+]

Adds a connection factory with the specified
<jndi-name>. The connection factory is contained in
the RAR file specified by<rar-filename>. The
<rar-filename> must be the base name of the file; it
cannot include any prefix ending in / (Unix) or \ (Win-
dows). If the RAR file is contained in an EAR file, then
the name of the J2EE application name must be specified
by <app-name>, followed by a colon. Optionally, a user
name and password for the factory may be specified.
Also optional is the-props flag, followed by one or
more name-value pairs that specify properties for this
factory. To prevent the shell from interpreting characters
in the values, enclose the values in single or double
quotes.

-addJdbcDriver
<class-name>

Adds the JDBC driver specified by its fully-qualified
<class-name>. You must also update the
J2EE_CLASSPATH environment variable in the file
bin\userconfig.bat. Then you must restart the J2EE
server.

-addJdbcDatasource
<jndi-name> <url>

Adds the JDBCDataSource with the specified
<jndi-name> and<url>.

-addJdbcXADatasource
<jndi-name>
<class-name>
[<xa-user-name>
<xa-password>]
[-props (<name>=<value>)+]

Adds the JDBCXADataSource with the specified
<jndi-name> and fully-qualified <class-name>.
Optionally, a user name and password for theData-
Source may be specified. Also optional is the-props
flag, followed by one or more name-value pairs that
specify properties for thisDataSource.

-addJmsDestination
<jndi-name>
(queue|topic)

Adds a JMS destination with the specified
<jndi-name> and declares the destination as either a
queue or topic.
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Cleanup Tool
The cleanup tool is a command-line script that removes all deployed applic
tions from your J2EE server. It will not delete the component files (JAR, WA
EAR).

Note: Use this utility with care!

Cloudscape Server
The enterprise code examples in this manual have been tested with the C
scape DBMS, which is included in the J2EE SDK.

Starting Cloudscape
Before your enterprise beans can access a Cloudscape database, you mu
the Cloudscape server from the command line:

-addJmsFactory
<jndi-name>
(queue|topic)
[-props (<name>=<value>)+]

Adds a JMS connection factory with the specified
<jndi-name> and destination type, either queue or
topic. Optionally, one or more properties may be speci-
fied with name-value pairs.

-list<resource-type> Lists resources of the specified<resource-type>,
either:ConnectorFactory, JdbcDriver, JdbcData-
source, JdbcXADatasource, JmsDestination, or
JmsFactory. There is no space between-list and
<resource-type>.

-remove<resource-type>
<jndi-name>

Removes the resource of the specified
<resource-type> and<jndi-name>. (See the
description of-list for the allowed
<resource-type> elements.)

-removeAll<resource-type> Removes all resources of the specified
<resource-type>. (See the description of-list for
the allowed<resource-type> elements.)

Table 46 j2eeadmintool Options (Continued)

Option Description
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cloudscape -start

You should see output similar to the following:

Mon Aug 09 11:50:30 PDT 1999: [RmiJdbc]
COM.cloudscape.core.JDBCDriver registered in DriverManager
Mon Aug 09 11:50:30 PDT 1999: [RmiJdbc] Binding . . ..
Mon Aug 09 11:50:30 PDT 1999: [RmiJdbc] No installation of
RMI Security Manager...
Mon Aug 09 11:50:31 PDT 1999: [RmiJdbc] RmiJdbcServer
bound in rmi registry

Stopping Cloudscape
To stop the server type the following command:

cloudscape -stop

You should see output similar to the following:

Attempting to shutdown RmiJdbc server
RmiJdbc Server RmiAddr is: //buzz/RmiJdbcServer
WARNING: Shutdown was successful!

Note: If you stop the server with Control-c, files will not be closed properly. When
the server is started the next time, it must perform recovery by rolling back
non-committed transactions and possibly applying the forward log.

Running the Interactive SQL Tool
The Cloudscape product includes a text-based, interactive tool calledij. (This
tool is not supported by Sun Microsystems, Inc.) You can run theij tool by typ-
ing this command:

cloudscape -isql

Within the tool, each command you type must end in a semicolon. The c
mands in the next example display all rows from theorders table, execute a
SQL script namedmyscript.sql, and end the tool session:

ij> select * from orders;
ij> run ‘myscript.sql’;
ij> exit;
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The following example runs a SQL script from the command line:

cloudscape -isql < myscript.sql

This command lists the names of all user tables in the database:

ij> select tablename from sys.systables
    where tabletype = ‘T’;

The next example displays the column names of the orders table:

ij> select columnname from sys.syscolumns
    where referenceid =
          (select tableid from sys.systables
           where tablename = ’orders’);

Before you deploy an entity bean with container-managed persistence, you
thedeploytool to generate the bean’s SQL statements. Because the table n
in these SQL statements are case-sensitive, you must enclose them in d
quotes:

ij> select * from “TeamBeanTable”;

For more information on theij tool, please refer to the online documentation o
the Cloudscape web site:

http://www.cloudscape.com

Cloudscape Server Configuration
The default database used by the Cloudscape server is namedCloudscapeDB.
This database will reside in thecloudscape directory of your J2EE SDK instal-
lation. TheCloudscapeDB database will be created automatically the first time
is accessed. The driver for the Cloudscape server is already configured in
config/default.properties file. No further changes by you are necessary.

Deployment Tool
Thedeploytool utility has two versions: GUI and command-line.

The GUI version enables you to package components and to deploy applicat
If you run thedeploytool script with no options, the GUI version is launched
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The GUI version includes online help information that is context sensitive.
access a help topic for a particular dialog box or tabbed pane, press f1.

The command-line version of the tool enables you to deploy and undeploy ap
cations. To package components from the command line, use thepackager tool.

Table 47 deploytool Options

Option Description

-deploy <ear-filename>
<server-name>
[<client-stub-jar>]

Deploys the J2EE application contained in the EAR
file specified by<ear-filenamme> onto the J2EE
server running on the machine specified by
<server-name>. Optionally, a JAR file for a
stand-alone Java application client may be created by
specifying<client-stub-jar>.

-deployConnector
<rar-filename> <server-name>

Deploys the resource adapter contained in the RAR
file specified by<rar-filename> onto the J2EE
server running on the machine specified by
<server-name>.

-listApps <server-name> Lists the J2EE applications that are deployed on the
J2EE server running on the machine specified by
<server-name>.

-listConnectors <server-name> Lists the resource adapters that are deployed on the
J2EE server running on the machine specified by
<server-name>.

-undeployConnector
<rar-filename>
<server-name>

Undeploys the resource adapter contained in the file
specified by<rar-filename> from the J2EE server
running on the machine specified by
<server-name>.

-uninstall <app-name>
<server-name>

Undeploys the J2EE application whose name is
<app-name> from the J2EE server running on the
machine specified by<server-name>.

-help Displays options.

-ui Runs GUI version (default).
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J2EE Server
To launch the J2EE server, run thej2ee script from the command-line prompt.

To run the HTTPS service of the J2EE server, you must install a server ce
cate. For instructions, see the Security chapter.

Key Tool
The keytool utility creates public and private keys and generates X5
self-signed certificates. The J2EE SDK version of thekeytool utility has the
same options as the version distributed with the J2SE SDK. However, the J
version programmatically adds a Java Cryptographic Extension provider tha
implementations of RSA algorithms (licensed from RSA Data Security). F
more information, see the Security chapter.

Packager
The packager tool is a command-line script that enables you to package J2
components. This tool is for advanced users who do not want to use thedeploy-

tool to package J2EE components. With thepackager, you can create the fol-
lowing component packages:

• EJB JAR file

• Web Application WAR file

• Application Client JAR file

• J2EE Application EAR file

Table 48 j2ee Options

Option Description

-verbose Redirects all logging output to the current shell.

-version Displays the version number.

-stop Stops the J2EE server.



460 J2EE™ SDK TOOLS

ion

s
s.

o the
• Resource Adapter RAR file

Thepackager tool also enables you to set the runtime deployment informat
of an application EAR file.

Note: To make them easier to read, the examples that follow contain line break
within the commands. When typing these commands, do not include the line break

EJB JAR File

Syntax

packager -ejbJar <root-directory> <file-list>
<ejb-dd> <ejb-jar>

Example

The following command packages the threeHello classes, and the
hello-jar.xml deployment descriptor into theHelloEJB.jar file:

packager -ejbJar /home/duke/classes/
HelloHome.class:HelloEJB.class:HelloRemote.class
hello-jar.xml HelloEJB.jar

Web Application WAR File

Syntax

packager -webArchive
[-classpath <root-directory> [-classFiles <file-list>]]
<content-root> [-contentFiles <file-list>] <web-dd> <web-war>

Example

The following command packages helper classes and JSP™ pages int
bookstore2.war file:

packager -webArchive -classpath .
-classFiles
   cart\ShoppingCart.class:cart\ShoppingCartItem.class:
   database\BookDB.class:util\Currency.class
.
-contentFiles
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   banner.jsp:bookdetails.jsp:bookstore.jsp:cashier.jsp:
   catalog.jsp:DigitalClock.class:duke.books.gif:
   errorpage.jsp:initdestroy.jsp:receipt.jsp:showcart.jsp
web.xml bookstore2.war

Application Client JAR File

Syntax

packager -applicationClient <root-directory> <file-list>
<main-class> <appclient-dd> <appclient-jar>

Example

The following command creates theappClient.jar file:

packager  -applicationClient classes
hola:hello/HelloUtil.class
package.Main client.xml appClient.jar

J2EE Application EAR File

Syntax

packager -enterpriseArchive <file-only-list>
[-alternativeDescriptorEntries <file-only-list>]
[-libraryJars <file-list>] <app-name> <app-ear>

Example

In the following command, the optional-alternativeDescriptorEntries flag
allows you to specify the external descriptor entry name of each componen
you wish it to appear in the EAR file:

packager -enterpriseArchive
myWeb.war:myEJB.jar:appClient.ear
-alternativeDescriptorEntries
myWeb/web.xml:myEjb/myEjb.xml:client/client.xml
myAppName myApp.ear

Specifying the Runtime Deployment Descriptor
The preceding example specified the-enterpriseArchive flag to create a por-
table J2EE application EAR file. This file is portable because you can impo
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into any J2EE environment that conforms to theJ2EE Specification. Although
you can import the file into thedeploytool, you cannot deploy it on the J2EE
server until it contains a runtime deployment descriptor. This deploym
descriptor is an XML file that contains information such as the JNDI names
the application’s enterprise beans.

Syntax

-setRuntime <app-ear>|<appclient-jar> <runtime.xml>
[-o <output-file>]

Example

In the following command, the-setRuntime flag instructs the packager to inser
the runtime deployment descriptor (sun-j2ee-ri.xml) into themyApp.ear file:

packager -setRuntime MyApp.ear sun-j2ee-ri.xml

The next command copiesMyApp.ear to OtherApp.ear, inserts the deployment
descriptor intoOtherApp.ear file, and leavesMyApp.ear unchanged.

packager -setRuntime MyApp.ear sun-j2ee-ri.xml -o OtherApp.ear

To obtain an example of the runtime deployment descriptor, extract it from
EAR file that you’ve already deployed:

jar -xvf SomeApp.ear

The DTD of the runtime deployment descriptor is in thelib/dtds/
sun-j2ee-ri-dtd file of your J2EE SDK installation.

Note: The runtime deployment descriptor (sun-j2ee-ri.xml) is not required by
theJ2EE Specification. This descriptor is unique to the J2EE SDK and may change
in future releases.

Resource Adapter RAR File

Syntax

packager -connector <root-directory> file1:file2
ra.xml myConnector.rar
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Example

In this example, thejar command packages the files under thecom directory into
myfiles.jar. The packager command creates a RAR file namedtheConnec-

tor.rar that containsmyfiles.jar and themyra.xml deployment descriptor:

jar -cvf myadapter.jar com
packager -connector . myadapter.jar myra.xml theConnector.rar

Realm Tool
The realmtool utility is a command-line script that enables you to add a
remove J2EE users and to import certificate files.

Examples
To display all users in the default realm, type this command:

realmtool -list default

Table 49 realmtool Options

Option Description

-show Lists the realm names.

-list <realm-name> Lists the users in the specified realm. This release
has two realms:default andcertificate.

-add <username password
group[,group]>

Adds the specified user to thedefault realm.

-addGroup <group> Adds a group to thedefault realm.

-import <certificate-file>
-alias <alias>

Adds a user to thecertificate realm by import-
ing a file containing an X509 certificate.

-remove <realm-name username> Removes a user from the specified realm.

-removeGroup <group> Removes a group.
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To add a user to the default realm you specify the-add flag. The following com-
mand will add a user named robin who is protected by the password red, and
include robin in the bird and wing groups:

realmtool -add robin red bird,wing

To add a user to the certificate realm, you import a file containing the X509
tificate that identifies the user:

realmtool -import certificate-file

To remove a user you specify the-remove flag. For example, to remove a use
named sparrow from the default realm, you would type the following comma

realmtool -remove default sparrow

To add a group to the default realm you specify the-addGroup flag. The follow-
ing command adds the wing group:

realmtool -addGroup wing

(You cannot add a group to the certificate realm.)

To remove a group from the default realm, you specify the-removeGroup flag:

realmtool -removeGroup wing
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Runclient Script
To run a J2EE application client, you execute therunclient script from a com-
mand-line prompt.

Syntax

runclient -client <appjar> [-name <name>] [-textauth]
[-Dj2eelogin.name=guest -Dj2eelogin.password=guest123]
[app-args]

Example
Before executing therunclient command, you must set theAPPCPATH environ-
ment variable to the name of the client JAR stub file that is generated du
deployment. The following example shows how to setAPPCPATH on a Windows
machine. Therunclient command that follows launches a client namedFabu-

lousClient. The J2EE application of this client resides in theFabulou-
sApp.ear file.

set APPCPATH=FabulousAppClient.jar
runclient -client FabulousApp.ear -name FabulousClient

Table 50 runclient Options

Option Description

-client <appjar> The J2EE application EAR file.

-name <name>
The display name of the J2EE application client
component.

-textauth
Causes the client container to prompt for the user
name and password are from the command line, no
from a pop-up window.

-Dj2eelogin.name=guest
-Dj2eelogin.password=guest123

Prevents the client container from prompting for the
user name and password.

<app-args> Any arguments required by the J2EE application.
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Remote Access
If the J2EE application client will reside on a different machine than the J2
server, before executingrunclient you must do the following:

• Copy the EAR file to the remote client’s machine.

• Copy the client JAR stub file to the remote client’s machine.

• Set theAPPCPATH environment variable to the name of the client JAR stu
file.

• Set theVMARGS environment variable to the following value:

-Dorg.omg.CORBA.ORBInitialHost=<remote-host>

For example, if the remote host were namedmurphy you would set the
VMARGS variable on a Windows machine as follows:

set VMARGS=-Dorg.omg.CORBA.ORBInitialHost=murphy

Verifier
Theverifier tool validates J2EE archive files (EAR, WAR, JAR).

You can runverifier three ways:

• From within thedeploytool GUI

• As a command-line utility

• As a stand-alone GUI utility

To run verifier from within the deploytool GUI, choose Verifier from the
Tools menu. The following sections explain how to run the verifier the other t
ways.

Command-Line Verifier
The command-line verifier has the following syntax:

verifier [options] <filename>
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The filename argument is the name of a J2EE component file. The followi
table lists the options.

Stand-Alone GUI Verifier
To run the stand-alone GUI verifier, follow these steps:

1. From the command-line prompt, type:

verifier -u

2. To select a file for verification, click Add.

3. Select the radio button to indicate the report level:

• All Results

• Failures Only

• Failures and Warnings Only

4. Click OK.

5. The verifier lists the details in the lower portion of the screen.

Table 51 verifier Options

Syntax Description

-v Displays a verbose version of output.

-o <output-file> Writes the results to the specified<output-file>, overriding the
defaultResults.txt file

-u Runs the stand-alone GUI version.

-<report-level> Determines whether warnings or failures are reported. The
<report-level> may be eithera, w, orf:
a (all results)
w (warnings only)
f (failures only)
By default, only warnings and failures are reported.
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Glossary

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

abstract schema
The part of an entity bean’s deployment descriptor that defines the be
persistent fields and relationships.

abstract schema name
A logical name that is referenced in Enterprise JavaBeans™ (EJB QL) q
ries.

access control
The methods by which interactions with resources are limited to collecti
of users or programs for the purpose of enforcing integrity, confidential
or availability constraints.

ACID
The acronym for the four properties guaranteed by transactions: atomi
consistency, isolation, and durability.

activation
The process of transferring an enterprise bean from secondary storag
memory. (Seepassivation.)

applet
A component that typically executes in a web browser, but can execute
variety of other applications or devices that support the applet programm
model.

applet container
A container that includes support for the applet programming model.
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Application Component Provider
A vendor that provides the Java classes that implement components’ m
ods, JSP page definitions, and any required deployment descriptors.

Application Assembler
A person that combinescomponents andmodules into deployable applica-
tion units.

application client
A first-tier client component that executes in its own Java virtual machi
Application clients have access to some (JNDI, JDBC, RMI-IIOP, JM
J2EE platform APIs.

application client container
A container that supports application client components.

application client module
A software unit that consists of one or more classes and an application c
deployment descriptor.

authentication
The process by which an entity proves to another entity that it is acting
behalf of a specific identity. The J2EE platform requires three types
authentication:basic,form-based, andmutual, and supportsdigest authenti-
cation.

authorization
The process by which access to a method or resource is determined. A
rization in the J2EE platform depends upon the determination of whether
principal associated with a request through authentication is in a given s
rity role. A security role is a logical grouping of users defined by an Applic
tion Component Provider or Assembler. A Deployer maps security roles
security identities. Security identities may be principals or groups in
operational environment.

authorization constraint
An authorization rule that determines who is permitted to access a w
resource collection.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

basic authentication
An authentication mechanism in which a web server authenticates an e
with a user name and password obtained using the web client’s bui
authentication mechanism.
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bean-managed persistence
Data transfer between an entity bean’s variables and a resource man
managed by the entity bean.

bean-managed transaction
A transaction whose boundaries are defined by an enterprise bean.

business logic
The code that implements the functionality of an application. In the Ent
prise JavaBeans model, this logic is implemented by the methods o
enterprise bean.

business method
A method of an enterprise bean that implements the business logic or r
of an application.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

callback methods
Component methods called by the container to notify the componen
important events in its life cycle.

caller
Same as caller principal.

caller principal
The principal that identifies the invoker of the enterprise bean method.

cascade delete
A deletion that triggers another deletion. A cascade delete may be spec
for an entity bean with container-managed persistence.

client certificate authentication
An authentication mechanism in which a client uses a X.509 certificate
establish its identity.

commit
The point in a transaction when all updates to any resources involved in
transaction are made permanent.

component
An application-level software unit supported by acontainer. Components are
configurable at deployment time. The J2EE platform defines four types
components:enterprisebeans,webcomponents,applets, andapplicationcli-
ents.
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component contract
The contract between a component and its container. The contract inclu
life cycle management of the component, a context interface that
instance uses to obtain various information and services from its conta
and a list of services that every container must provide for its componen

connection
Seeresource manager connection.

connection factory
Seeresource manager connection factory.

connector
A standard extension mechanism for containers to provide connectivit
enterprise information systems. A connector is specific to an enterp
information system and consists of aresourceadapter and application devel
opment tools for enterprise information system connectivity. The resou
adapter is plugged in to a container through its support for system-level c
tracts defined in the connector architecture.

Connector architecture
An architecture for integration of J2EE products withenterpriseinformation
systems. There are two parts to this architecture: a resource adapter pro
by an enterprise information system vendor and the J2EE product that al
this resource adapter to plug in. This architecture defines a set of cont
that a resource adapter has to support to plug in to a J2EE product, for e
ple, transactions, security, and resource management.

container
An entity that provides life cycle management, security, deployment, a
runtime services tocomponents. Each type of container (EJB, web, JSP,
servlet,applet, andapplicationclient) also provides component-specific se
vices.

container-managed persistence
Data transfer between an entity bean’s variables and a resource man
managed by the entity bean’s container.

container-managed transaction
A transaction whose boundaries are defined by an EJB container. Anentity
bean must use container-managed transactions.

context attribute
An object bound into the context associated with a servlet.

conversational state
The field values of a session bean plus the transitive closure of the ob
reachable from the bean’s fields. The transitive closure of a bean is defi
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in terms of the serialization protocol for the Java programming langua
that is, the fields that would be stored by serializing the bean instance.

CORBA
Common Object Request Broker Architecture. A language independent,
tributed object model specified by the Object Management Group.

create method
A method defined in thehomeinterface and invoked by a client to create a
enterprise bean.

credentials
The information describing the security attributes of aprincipal.

CSS
Cascading Style Sheet. A stylesheet used with HTML and XML docume
to add a style to all elements marked with a particular tag, for the direct
of browsers or other presentation mechanisms.

CTS
Compatibility Test Suite. A suite of compatibility tests for verifying that
J2EE product complies with the J2EE platform specification.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

delegation
An act whereby oneprincipal authorizes another principal to use its identi
or privileges with some restrictions.

Deployer
A person who installs modules and J2EE applications into an operatio
environment.

deployment
The process whereby software is installed into an operational environm

deployment descriptor
An XML file provided with each module and application that describes h
they should be deployed. The deployment descriptor directs a deploym
tool to deploy a module or application with specific container options a
describes specific configuration requirements that a Deployer must reso

destination
A JMS administered object that encapsulates the identity of a JMS queu
topic. Seepoint-to-point messagingsystem,publish/subscribemessaging
system.
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digest authentication
An authentication mechanism in which a web client authenticates to a w
server by sending the server a message digest along its HTTP request
sage. The digest is computed by employing a one-way hash algorithm
concatenation of the HTTP request message and the client’s password
digest is typically much smaller than the HTTP request, and doesn’t con
the password.

distributed application
An application made up of distinct components running in separate runt
environments, usually on different platforms connected via a network. Ty
cal distributed applications are two-tier (client-server), three-tier (clie
middleware-server), and multitier (client-multiple middleware-multip
servers).

DOM
Document Object Model. A tree of objects with interfaces for traversing
tree and writing anXML version of it, as defined by the W3C specification

DTD
Document Type Definition. A description of the structure and properties o
class ofXML files.

durable subscription
In a JMSpublish/subscribemessagingsystem, a subscription that continue
to exist whether or not there is a current active subscriber object. If ther
no active subscriber, JMS retains the subscription’smessages until they are
received by the subscription or until they expire.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

EAR file
A JAR archive that contains a J2EE application.

EJB™
See Enterprise JavaBeans.

EJB container
A container that implements the EJB component contract of the J2EE ar
tecture. This contract specifies a runtime environment for enterprise be
that includes security, concurrency, life cycle management, transact
deployment, naming, and other services. An EJB container is provided b
EJB orJ2EE server.

EJB Container Provider
A vendor that supplies an EJB container.
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EJB context
An object that allows an enterprise bean to invoke services provided by
container and to obtain the information about the caller of a client-invok
method.

EJB home object
An object that provides the life cycle operations (create, remove, find) for
enterprise bean. The class for the EJB home object is generated by the
tainer’s deployment tools. The EJB home object implements the enterp
bean’s home interface. The client references an EJB home object to per
life cycle operations on an EJB object. The client uses JNDI to locate an
home object.

EJB JAR file
A JAR archive that contains an EJB module.

EJB module
A software unit that consists of one or more enterprise beans and an
deployment descriptor.

EJB object
An object whose class implements the enterprise bean’s remote interfac
client never references an enterprise bean instance directly; a client alw
references an EJB object. The class of an EJB object is generated by a
tainer’s deployment tools.

EJB server
Software provides services to anEJB container. For example, an EJB con
tainer typically relies on a transaction manager that is part of the EJB se
to perform the two-phase commit across all the participating resource m
agers. The J2EE architecture assumes that an EJB container is hosted
EJB server from the same vendor, so does not specify the contract betw
these two entities. An EJB server may host one or more EJB containers

EJB Server Provider
A vendor that supplies an EJB server.

enterprise bean
A component that implements a business task or business entity and re
in an EJB container; either anentity bean,sessionbean, ormessage-driven
bean.

enterprise information system
The applications that comprise an enterprise’s existing system for hand
company-wide information. These applications provide an informat
infrastructure for an enterprise. An enterprise information system offer
well defined set of services to its clients. These services are exposed to
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ents as local and/or remote interfaces. Examples of enterprise informa
systems include: enterprise resource planning systems, mainframe tra
tion processing systems, and legacy database systems.

enterprise information system resource
An entity that provides enterprise information system-specific functiona
to its clients. Examples are: a record or set of records in a database syst
business object in an enterprise resource planning system, and a transa
program in a transaction processing system.

Enterprise Bean Provider
An application programmer who produces enterprise bean classes, re
and home interfaces, and deployment descriptor files, and packages the
an EJB JAR file.

Enterprise JavaBeans™ (EJB™)
A component architecture for the development and deployment of obj
oriented, distributed, enterprise-level applications. Applications writt
using the Enterprise JavaBeans architecture are scalable, transactiona
secure.

Enterprise JavaBeans Query Language (EJB QL)
Defines the queries for the finder and select methods of an entity bean
container-managed persistence. A subset of SQL92, EJB QL has exten
that allow navigation over the relationships defined in an entity bea
abstract schema.

entity bean
An enterprise bean that represents persistent data maintained in a data
An entity bean can manage its own persistence or it can delegate this f
tion to its container. An entity bean is identified by a primary key. If the co
tainer in which an entity bean is hosted crashes, the entity bean, its prim
key, and any remote references survive the crash.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

filter
An object that can transform the header and/or content of a reques
response. Filters differ fromweb components in that they usually do no
themselves create responses but rather they modify or adapt the reques
a resource, and modify or adapt responses from a resource. A filter sh
not have any dependencies on a web resource for which it is acting as a
so that it can be composable with more than one type of web resource.
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finder method
A method defined in thehomeinterface and invoked by a client to locate a
entity bean.

form-based authentication
An authentication mechanism in which a web container provides an appl
tion-specific form for logging in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

group
A collection of principals within a given security policy domain.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

handle
An object that identifies an enterprise bean. A client may serialize the h
dle, and then later deserialize it to obtain a reference to the enterprise b

home interface
One of two interfaces for anenterprisebean. The home interface define
zero or more methods for managing an enterprise bean. The home inte
of a session bean defines create and remove methods, while the home
face of an entity bean defines create, finder, and remove methods.

home handle
An object that can be used to obtain a reference of the home interfac
home handle can be serialized and written to stable storage and deseria
to obtain the reference.

HTML
Hypertext Markup Language. A markup language for hypertext docume
on the Internet. HTML enables the embedding of images, sounds, vi
streams, form fields, references to other objects with URLs and basic
formatting.

HTTP
Hypertext Transfer Protocol. The Internet protocol used to fetch hyper
objects from remote hosts. HTTP messages consist of requests from clie
server and responses from server to client.

HTTPS
HTTP layered over the SSL protocol.
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impersonation
An act whereby one entity assumes the identity and privileges of ano
entity without restrictions and without any indication visible to the recipien
of the impersonator’s calls that delegation has taken place. Impersonati
a case of simpledelegation.

IDL
Interface Definition Language. A language used to define interfaces
remote CORBA objects. The interfaces are independent of operating
tems and programming languages.

IIOP
Internet Inter-ORB Protocol. A protocol used for communication betwe
CORBA object request brokers.

initialization parameter
A parameter that initializes the context associated with a servlet.

ISV
Independent Software Vendor.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

J2EE™
SeeJava 2 Platform, Enterprise Edition.

J2ME™
SeeJava 2 Platform, Micro Edition.

J2SE™
SeeJava 2 Platform, Standard Edition.

J2EE application
Any deployable unit of J2EE functionality. This can be a single module o
group of modules packaged into an .ear file with a J2EE application dep
ment descriptor. J2EE applications are typically engineered to be distrib
across multiple computing tiers.

J2EE product
An implementation that conforms to the J2EE platform specification.

J2EE Product Provider
A vendor that supplies a J2EE product.
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J2EE server
The runtime portion of a J2EE product. A J2EE server providesEJB and/or
web containers.

JAR Java ARchive
A platform-independent file format that permits many files to be aggrega
into one file.

Java™ 2 Platform, Enterprise Edition (J2EE)
An environment for developing and deploying enterprise applications. T
J2EE platform consists of a set of services, application programming in
faces (APIs), and protocols that provide the functionality for developi
multitiered, web-based applications.

Java™ 2 Platform, Micro Edition (J2SE)
A highly optimized Java runtime environment targeting a wide range of c
sumer products, including pagers, cellular phones, screenphones, digita
top boxes and car navigation systems.

Java™ 2 Platform, Standard Edition (J2SE)
The core Java technology platform.

Java™ 2 SDK, Enterprise Edition (J2EE SDK)
Sun’s implementation of the J2EE platform. This implementation provid
an operational definition of the J2EE platform.

Java™ Message Service (JMS)
An API for using enterprise messaging systems such as IBM MQ Ser
TIBCO Rendezvous, and so on.

Java Naming and Directory Interface™ (JNDI)
An API that provides naming and directory functionality.

Java™ Transaction API (JTA)
An API that allows applications and J2EE servers to access transaction

Java™ Transaction Service (JTS)
Specifies the implementation of a transaction manager which supports
and implements the Java mapping of the OMG Object Transaction Ser
(OTS) 1.1 specification at the level below the API.

JavaBeans™ component
A Java class that can be manipulated in a visual builder tool and compo
into applications. A JavaBeans component must adhere to certain prop
and event interface conventions.
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Java IDL
A technology that provides CORBA interoperability and connectivity cap
bilities for the J2EE platform. These capabilities enable J2EE application
invoke operations on remote network services using the OMG IDL and IIO

JavaMail™
An API for sending and receiving email.

JavaServer Pages™ (JSP™)
An extensible web technology that uses template data, custom elem
scripting languages, and server-side Java objects to return dynamic co
to a client. Typically the template data is HTML or XML elements, and
many cases the client is a web browser.

JDBC™
An API for database-independent connectivity between the J2EE platf
and a wide range of data sources.

JMS
SeeJava Message Service.

JMS administered object
A preconfigured JMS object (aresourcemanagerconnectionfactory or a
destination) created by an administrator for the use ofJMS clients and
placed in aJNDI namespace.

JMS application
One or moreJMS clients that exchangemessages.

JMS client
A Java language program that sends and/or receivesmessages.

JMS provider
A messaging system that implements theJava MessageService as well as
other administrative and control functionality needed in a full-featured m
saging product.

JMS session
A single-threaded context for sending and receiving JMSmessages. A JMS
session can be non-transacted, locally transacted, or participating in a
tributed transaction.

JNDI
SeeJava Naming and Directory Interface.

JSP
SeeJavaServer Pages.
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JSP action
A JSP element that can act on implicit objects and other server-side ob
or can define new scripting variables. Actions follow the XML syntax f
elements with a start tag, a body and an end tag; if the body is empty it
also use the empty tag syntax. The tag must use a prefix.

JSP action, custom
An action described in a portable manner by a tag library descriptor an
collection of Java classes and imported into a JSP page by ataglib direc-
tive. A custom action is invoked when a JSP page uses a custom tag.

JSP action, standard
An action that is defined in the JSP specification and is always available
JSP file without being imported.

JSP application
A stand-alone web application, written using the JavaServer Pages tech
ogy, that can contain JSP pages, servlets, HTML files, images, applets
JavaBeans components.

JSP container
A container that provides the same services as aservletcontainer and an
engine that interprets and processes JSP pages into a servlet.

JSP container, distributed
A JSP container that can run a web application that is tagged as distribut
and is spread across multiple Java virtual machines that might be runnin
different hosts.

JSP declaration
A JSP scripting element that declares methods, variables, or both in a
file.

JSP directive
A JSP element that gives an instruction to the JSP container and is in
preted at translation time.

JSP element
A portion of a JSP page that is recognized by a JSP translator. An elem
can be adirective, anaction, or ascripting element.

JSP expression
A scripting element that contains a valid scripting language expression
is evaluated, converted to aString, and placed into the implicitout object.

JSP file
A file that contains a JSP page. In the Servlet 2.2 specification, a JSP
must have a .jsp extension.
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JSP page
A text-based document using fixed template data and JSP elements
describes how to process a request to create a response.

JSP scripting element
A JSPdeclaration,scriptlet, orexpression, whose tag syntax is defined b
the JSP specification, and whose content is written according to the scrip
language used in the JSP page. The JSP specification describes the s
and semantics for the case where the language page attribute is "java".

JSP scriptlet
A JSP scripting element containing any code fragment that is valid in
scripting language used in the JSP page. The JSP specification desc
what is a valid scriptlet for the case where the language page attribut
"java".

JSP tag
A piece of text between a left angle bracket and a right angle bracket th
used in a JSP file as part of a JSP element. The tag is distinguishab
markup, as opposed to data, because it is surrounded by angle bracket

JSP tag library
A collection of custom tags identifying custom actions described via a
library descriptor and Java classes.

JTA
SeeJava Transaction API.

JTS
SeeJava Transaction Service.
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life cycle
The framework events of a component’s existence. Each type of compo
has defining events which mark its transition into states where it has vary
availability for use. For example, a servlet is created and has itsinit method
called by its container prior to invocation of its service method by clients
other servlets who require its functionality. After the call of itsinit method
it has the data and readiness for its intended use. The servlet’sdestroy

method is called by its container prior to the ending of its existence so
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processing associated with winding up may be done, and resources ma
released. Theinit anddestroy methods in this example arecallbackmeth-
ods. Similar considerations apply to all J2EE component types: enterp
beans, web components (servlets or JSP pages), applets, and applicatio
ents.
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message
In theJava MessageService, an asynchronous request, report, or event t
is created, sent, and consumed by an enterprise application, not by a hu
It contains vital information needed to coordinate enterprise applications
the form of precisely formatted data that describes specific business acti

MessageConsumer
An object created by aJMSsession that is used for receivingmessages sent
to adestination.

MessageProducer
An object created by aJMS session that is used for sendingmessages to a
destination.

message-driven bean
An enterprise bean that is an asynchronous message consumer. A mes
driven bean has no state for a specific client, but its instance variables
contain state across the handling of client messages, including an open
base connection and an object reference to anEJBobject. A client accesses a
message-driven bean by sending messages to the destination for whic
message-driven bean is a message listener.

method permission
An authorization rule that determines who is permitted to execute one
more enterprise bean methods.

module
A software unit that consists of one or more J2EE components of the s
container type and one deployment descriptor of that type. There are t
types of modules:EJB, web, and application client. Modules can be
deployed as stand-alone units or assembled into an application.

mutual authentication
An authentication mechanism employed by two parties for the purpose
proving each other’s identity to one another.
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naming context
A set of associations between unique, atomic, people-friendly identifiers
objects.

naming environment
A mechanism that allows a component to be customized without the nee
access or change the component’s source code. A container implemen
component’s naming environment, and provides it to the component a
JNDI namingcontext. Each component names and accesses its environm
entries using thejava:comp/env JNDI context. The environment entries ar
declaratively specified in the component’s deployment descriptor.

non-JMS client
A messaging client program that uses a message system’s native clien
instead of theJava Message Service.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

ORB
Object Request Broker. A library than enables CORBA objects to locate
communicate with one another.

OS principal
A principal native to the operating system on which the J2EE platform
executing.

OTS
Object Transaction Service. A definition of the interfaces that perm
CORBA objects to participate in transactions.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

passivation
The process of transferring an enterprise bean from memory to secon
storage. (Seeactivation.)

persistence
The protocol for transferring the state of an entity bean between its insta
variables and an underlying database.

persistent field
A virtual field of an entity bean with container-managed persistence, i
stored in a database.
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POA
Portable Object Adapter. A CORBA standard for building server-side ap
cations that are portable across heterogeneous ORBs.

point-to-point message system
A messaging system built around the concept of message queues. Eachmes-
sage is addressed to a specific queue; clients extract messages from
queue(s) established to hold their messages.

principal
The identity assigned to an user as a result of authentication.

privilege
A security attribute that does not have the property of uniqueness and
may be shared by many principals.

primary key
An object that uniquely identifies an entity bean within a home.

publish/subscribe message system
A messaging system in which clients addressmessages to a specific node i
a content hierarchy. Publishers and subscribers are generally anonymou
may dynamically publish or subscribe to the content hierarchy. The sys
takes care of distributing the messages arriving from a node’s multiple p
lishers to its multiple subscribers.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

queue
Seepoint-to-point messaging system.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

RAR
A JAR archive that contains a resource adapter.

realm
See security policy domain. Also, a string, passed as part of an HTT
request duringbasicauthentication, that defines a protection space. The p
tected resources on a server can be partitioned into a set of protection sp
each with its own authentication scheme and/or authorization database.

re-entrant entity bean
An entity bean that can handle multiple simultaneous, interleaved, or ne
invocations which will not interfere with each other.
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Reference Implementation
SeeJava 2 SDK, Enterprise Edition.

relationship field
A virtual field of an entity bean with container-managed persistence, it id
tifies a related entity bean.

remote interface
One of two interfaces for anenterprisebean. The remote interface define
the business methods callable by a client.

remove method
Method defined in thehomeinterface and invoked by a client to destroy a
enterprise bean.

resource adapter
A system-level software driver that is used by an EJB container or an ap
cation client to connect to an enterprise information system. A resou
adapter is typically specific to an enterprise information system. It is av
able as a library and is used within the address space of the server or c
using it. A resource adapter plugs in to a container. The application com
nents deployed on the container then use the client API (exposed by ada
or tool generated high-level abstractions to access the underlying enter
information system. The resource adapter and EJB container collabora
provide the underlying mechanisms—transactions, security, and connec
pooling—for connectivity to the enterprise information system.

resource manager
Provides access to a set of shared resources. A resource manager partic
in transactions that are externally controlled and coordinated by a tran
tion manager. A resource manager is typically in different address spac
on a different machine from the clients that access it. Note: Anenterprise
informationsystem is referred to as resource manager when it is mentio
in the context of resource and transaction management.

resource manager connection
An object that represents a session with a resource manager.

resource manager connection factory
An object used for creating a resource manager connection.

RMI
Remote Method Invocation. A technology that allows an object running
one Java virtual machine to invoke methods on an object running in a dif
ent Java virtual machine.
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RMI-IIOP
A version of RMI implemented to use the CORBA IIOP protocol. RMI ove
IIOP provides interoperability with CORBA objects implemented in an
language if all the remote interfaces are originally defined as RMI interfac

role (development)
The function performed by a party in the development and deploym
phases of an application developed using J2EE technology. The roles
Application ComponentProvider, Application Assembler,Deployer, J2EE
ProductProvider, EJB ContainerProvider, EJB Server Provider, Web Con-
tainerProvider, Web Server Provider, Tool Provider, andSystemAdminis-
trator.

role (security)
An abstract logical grouping of users that is defined by the Applicati
Assembler. When an application is deployed, the roles are mapped to s
rity identities, such asprincipals orgroups, in the operational environment.

role mapping
The process of associating the groups and/or principals recognized by
container to security roles specified in thedeploymentdescriptor. Security
roles have to be mapped by the Deployer before the component is insta
in the server.

rollback
The point in a transaction when all updates to any resources involved in
transaction are reversed.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

SAX
Simple API forXML. An event-driven, serial-access mechanism for acce
ing XML documents.

security attributes
A set of properties associated with a principal. Security attributes can
associated with a principal by an authentication protocol and/or by a J2
Product Provider.

security constraint
A declarative way to annotate the intended protection of web content
security constraint consists of aweb resourcecollection, anauthorization
constraint, and auser data constraint.
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security context
An object that encapsulates the shared state information regarding sec
between two entities.

security permission
A mechanism, defined by J2SE, used by the J2EE platform to express
programming restrictions imposed on Application Component Providers

security permission set
The minimum set of security permissions that a J2EE Product Provider m
provide for the execution of each component type.

security policy domain
A scope over which security policies are defined and enforced by a secu
administrator. A security policy domain has a collection of users (or prin
pals), uses a well defined authentication protocol(s) for authenticating u
(or principals), and may have groups to simplify setting of security policie

security role
Seerole (security).

security technology domain
A scope over which the same security mechanism is used to enforce a s
rity policy. Multiple security policy domains can exist within a single tech
nology domain.

security view
The set of security roles defined by the Application Assembler.

server principal
The OS principal that the server is executing as.

servlet
A Java program that extends the functionality of a web server, genera
dynamic content and interacting with web clients using a request-respo
paradigm.

servlet container
A container that provides the network services over which requests
responses are sent, decodes requests, and formats responses. All servl
tainers must support HTTP as a protocol for requests and responses, bu
also support additional request-response protocols such as HTTPS.

servlet container, distributed
A servlet container that can run a web application that is tagged as distri
able and that executes across multiple Java virtual machines running o
same host or on different hosts.
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servlet context
An object that contains a servlet’s view of the web application within whi
the servlet is running. Using the context, a servlet can log events, ob
URL references to resources, and set and store attributes that other se
in the context can use.

servlet mapping
Defines an association between a URL pattern and a servlet. The mappi
used to map requests to servlets.

session
An object used by a servlet to track a user’s interaction with a web appl
tion across multiple HTTP requests.

session bean
An enterprise bean that is created by a client and that usually exists only
the duration of a single client-server session. A session bean performs o
tions, such as calculations or accessing a database, for the client. Wh
session bean may be transactional, it is not recoverable should a sy
crash occur. Session bean objects can be either stateless or they can ma
conversational state across methods and transactions. If a session bean
tains state, then the EJB container manages this state if the object mu
removed from memory. However, the session bean object itself must man
its own persistent data.

SSL
Secure Socket Layer. A security protocol that provides privacy over
Internet. The protocol allows client-server applications to communicate
way that cannot be eavesdropped or tampered with. Servers are al
authenticated and clients are optionally authenticated.

SQL
Structured Query Language. The standardized relational database lang
for defining database objects and manipulating data.

SQL/J
A set of standards that includes specifications for embedding SQL st
ments in methods in the Java programming language and specification
calling Java static methods as SQL stored procedures and user-defined
tions. An SQL checker can detects errors in static SQL statements at
gram development time, rather than at execution time as with a JDBC dri

stateful session bean
A session bean with a conversational state.
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stateless session bean
A session bean with no conversational state. All instances of a stateless
sion bean are identical.

System Administrator
The person responsible for configuring and administering the enterpri
computers, networks, and software systems.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

topic
Seepublish-subscribe messaging system.

transaction
An atomic unit of work that modifies data. A transaction encloses one
more program statements, all of which either complete or roll back. Trans
tions enable multiple users to access the same data concurrently.

transaction attribute
A value specified in an enterprise bean’s deployment descriptor that is u
by the EJB container to control the transaction scope when the enterp
bean’s methods are invoked. A transaction attribute can have the follow
values: Required, RequiresNew, Supports, NotSupported, Mandatory,
Never.

transaction isolation level
The degree to which the intermediate state of the data being modified
transaction is visible to other concurrent transactions and data being m
fied by other transactions is visible to it.

transaction manager
Provides the services and management functions required to support tra
tion demarcation, transactional resource management, synchronization
transaction context propagation.

Tool Provider
An organization or software vendor that provides tools used for the deve
ment, packaging, and deployment of J2EE applications.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

URI
Uniform Resource Identifier. A compact string of characters for identifyi
an abstract or physical resource. A URI is either aURL or aURN. URLs and
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URNs are concrete entities that actually exist; A URI is an abstract sup
class.

URL
Uniform Resource Locator. A standard for writing a textual reference to
arbitrary piece of data in the World Wide Web. A URL looks likeproto-
col://host/localinfo whereprotocol specifies a protocol for fetching
the object (such as HTTP or FTP),host specifies the Internet name of the
targeted host, andlocalinfo is a string (often a file name) passed to the pr
tocol handler on the remote host.

URL path
The URL passed by a HTTP request to invoke a servlet. The URL cons
of the Context Path + Servlet Path + Path Info, where

• Context Path is the path prefix associated with a servlet context that
servlet is a part of. If this context is the default context rooted at the b
of the web server’s URL namespace, the path prefix will be an em
string. Otherwise, the path prefix starts with a / character but does not
with a / character.

• Servlet Path is the path section that directly corresponds to the map
which activated this request. This path starts with a / character.

• Path Info is the part of the request path that is not part of the Context P
or the Servlet Path.

URN
Uniform Resource Name. A unique identifier that identifies an entity, b
doesn’t tell where it is located. A system can use a URN to look up an en
locally before trying to find it on the web. It also allows the web location
change, while still allowing the entity to be found.

user data constraint
Indicates how data between a client and a web container should be prote
The protection can be the prevention of tampering with the data or prev
tion of eavesdropping on the data.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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WAR file
A JAR archive that contains a web module.
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web application
An application written for the Internet, including those built with Java tec
nologies such as JavaServer Pages and servlets, as well as those buil
non-Java technologies such as CGI and Perl.

web application, distributable
A web application that uses J2EE technology written so that it can
deployed in a web container distributed across multiple Java virt
machines running on the same host or different hosts. The deploym
descriptor for such an application uses the distributable element.

web component
A component that provides services in response to requests; either aservlet
or aJSP page.

web container
A container that implements the web component contract of the J2EE ar
tecture. This contract specifies a runtime environment for web compon
that includes security, concurrency, life cycle management, transact
deployment, and other services. A web container provides the same ser
as aJSPcontainer and a federated view of the J2EE platform APIs. A w
container is provided by aweb orJ2EE server.

web container, distributed
A web container that can run a web application that is tagged as distribut
and that executes across multiple Java virtual machines running on the s
host or on different hosts.

Web Container Provider
A vendor that supplies a web container.

web module
A unit that consists of one or more web components and a web deploym
descriptor.

web resource collection
A list of URL patterns and HTTP methods that describe a set of resource
be protected.

web server
Software that provides services to access the Internet, an intranet, o
extranet. A web server hosts web sites, provides support for HTTP and o
protocols, and executes server-side programs (such as CGI scripts or
lets) that perform certain functions. In the J2EE architecture, a web se
provides services to awebcontainer. For example, a web container typical
relies on a web server to provide HTTP message handling. The J2EE a
tecture assumes that a web container is hosted by a web server from
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same vendor, so does not specify the contract between these two entiti
web server may host one or more web containers.

Web Server Provider
A vendor that supplies a web server.
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XML
Extensible Markup Language. A markup language that allows you to de
the tags (markup) needed to identify the content, data, and text, in XML d
uments. It differs fromHTML the markup language most often used t
present information on the internet. HTML has fixed tags that deal mai
with style or presentation. An XML document must undergo a transform
tion into a language with style tags under the control of a stylesheet befo
can be presented by a browser or other presentation mechanism. Two
of style sheets used with XML areCSS andXSL. Typically, XML is trans-
formed into HTML for presentation. Although tags may be defined
needed in the generation of an XML document, a Document Type Definit
(DTD) may be used to define the elements allowed in a particular type
document. A document may be compared with the rules in the DTD to de
mine its validity and to locate particular elements in the document. J2
deployment descriptors are expressed in XML with DTDs defining allow
elements. Programs for processing XML documents useSAX or DOM
APIs. J2EEdeployment descriptors are expressed in XML.

XSL
Extensible Stylesheet Language. AnXML transformation language used for
transforming XML documents into documents with flow object tags for pr
sentation purposes. The transformation aspect of XSL has been abstr
into XSLT with the XSL name now used to designate the presentation fl
language. XSL is a direct descendent of the DSSSL style language
SGML (Standard Generalized Markup Language), the language from wh
XML was subsetted. It was designed to have all the capabilities ofCSS, the
stylesheet often used withHTML. XSL flow objects can be presented by
specialized browsers, and themselves transformed into PDF documents

XSLT
XSL Transformation. An XML file that controls the transformation of a
XML document into another XML document or HTML. The target docu
ment often will have presentation related tags dictating how it will be re
dered by a browser or other presentation mechanism. XSLT was form
part of XSL, which also included a tag language of style flow objects.
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